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Introduction

Welcome, and thank you for using Origin!

Origin is a powerful data analysis and publication-quality graphing software, tailored to the needs of scientists
and engineers. What sets Origin apart from other applications is the ease with which you can customize and
automate your data import, analysis, graphing and reporting tasks.

Customizations can range from simple modifications to a data plot, saved as a graph "template" for later use,
to customized data analyses which produce publication-quality reports, saved as an Analysis Template. Batch
plotting and analysis operations are also supported, wherein templates are used for repeat analysis of multiple
files or datasets.

We are confident that you will find Origin to be an effective tool for analyzing your data and presenting your
findings. And to help you get the most from Origin, we offer first-class customer and technical support,
training and consulting services.

In this guide, unless otherwise noted, "Origin" will refer to both Origin and OriginPro. OriginPro offers all the
features of Origin, plus extended analysis tools for Peak Fitting, Surface Fitting, Statistics, Signal Processing
and Image Handling.

The purpose of this guide is to try and present a broad overview of Origin's capabilities. We hope that new
users will find this to be a valuable orientation to the Origin workspace and its primary features. For those who
are already using Origin, we hope you will find useful information on new features and perhaps learn a thing or
two about Origin features that you had overlooked previously.

More detailed information is provided in the Origin Help file (Help:Origin from your Origin software’'s main
menu) and numerous other learning resources exist. For a complete listing of available resources, see the
Origin Resources chapter of this guide.

Some things to look for in this guide:

We have added short tutorials to numerous topics throughout this guide. These short
tutorials are intended to give you a quick introduction to a key Origin feature. These
tutorials will be marked with this icon.

Also, sprinkled throughout this guide, you'll find tips on using Origin. These tips are
marked with this icon.

e Features that are new to this version of Origin will be marked with this icon.

Important changes to key features and other critical information will be marked with
this icon.

We like to get feedback from our users on ways to improve and expand Origin's data analysis and graphing
capabilities. We would love to hear from you. You can find contact information in the Origin Resources chapter
of this guide.


http://www.originlab.com/doc/User-Guide/OriginPro
http://www.originlab.com/doc/User-Guide/Resources
http://www.originlab.com/doc/User-Guide/Resources




2 Installing and Updating Origin

2.1 Notes for Upgrade Users

e The Origin upgrade installs into a new program folder - it does not update a previous version. It is

therefore not necessary to install or uninstall a previous version of Origin before upgrading.

e |If you are upgrading from Origin 2018 or a later version, the process should be pretty painless. Origin
2018 and later versions share a common license file and User Files Folder. The first time you run Origin
2023, it should be licensed and know where your User Files are located.

. If you are upgrading from Origin 2017, you will be prompted to pick a new User Files Folder (see
Selecting a User Files Folder, below). If you have custom Origin files from your previous version, you

can transfer them to your new User Files Folder. From the Preferences menu, select Transfer User

Eiles. Provided your Maintenance has not expired, you should not have to re-license your software. If
your Maintenance has expired, you will need to re-license your Origin 2023 software (See Registering
Origin, below).

. If you are upgrading from Origin 2016 or earlier, you will need to complete the license management
process. When your upgrade is launched for the first time, a license dialog will display asking for your
Product Key If you have custom Origin files from your previous version, you can transfer them to your

new User Files Folder. From the Preferences menu, select Transfer User Files.

e |If you have a dongle package, please update your dongle after the Maintenance renewal to make sure
your dongle is available for the latest version. Upgrade your dongle by entering a Product Key in the
License Activation dialog. Once done, you can use this dongle for Origin installed with the same serial

number on any other computers without re-activating the dongle.

Lastly, we want to point out that your Origin software has some great new features. For more information on
key features by version, see the originlab.com/VersionComparison page on our website.

2.2 Notes for Administrators of Multi-user Packages

Instructions for getting started with the multi-seat node-locked and concurrent network packages are
available on the OriginLab website (originlab.com/GetStarted).

In addition to the InstallShield setup that runs from the Product DVD, an MSI installer and sample transform
are available. The MSI installer is ideal for use at multi-user sites, as it can be used to build an Origin
installation package for distribution. Information on the MSI installer and alternate deployment techniques can
be found on our website:

° MSI Installation
e Silent Install

(] Building an Installation Package

(] Installing Origin on a Remote Access Server such as Windows Terminal Server or Citrix.



http://www.originlab.com/doc/User-Guide/Installation-Startup
http://www.originlab.com/doc/Origin-Help/UserFilesFolder
http://www.originlab.com/doc/Origin-Help/FileShare-UserFileTransfer
http://www.originlab.com/doc/Origin-Help/FileShare-UserFileTransfer
http://www.originlab.com/doc/User-Guide/Installation-Startup
http://www.originlab.com/doc/User-Guide/Installation-Startup
http://www.originlab.com/doc/Origin-Help/UserFilesFolder
http://www.originlab.com/doc/Origin-Help/FileShare-UserFileTransfer
https://www.originlab.com/VersionComparison
https://www.originlab.com/getstarted
https://www.originlab.com/index.aspx?go=Support/DocumentationAndHelpCenter/Installation/Multi-userDeployment/MSIInstall
https://www.originlab.com/index.aspx?go=Support/DocumentationAndHelpCenter/Installation/Multi-userDeployment/SilentInstall
https://www.originlab.com/index.aspx?go=Support/DocumentationAndHelpCenter/Installation/Multi-userDeployment/BuildanInstallPackage
https://www.originlab.com/index.aspx?go=Support/DocumentationAndHelpCenter/Installation/Multi-userDeployment/RemoteAccessServer
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2.3 Installing Origin

Origin is a Windows application. You can run Origin on an Intel-based Mac from Boot Camp or by running a
virtualization software. For more information, see the Running Origin on Mac using Virtualization
Software, on the OriginLab website.

There are three steps that must be completed to prepare Origin for use:

(] Installation

(] Selecting a User Files Folder

o License management

Both the Origin upgrade and the newly-purchased products install into a new program folder. Origin does not
overwrite previous versions when upgrading, so your old version continues to function. Likewise, your original
version does not have to be installed when running the upgrade.

If you are installing from a DVD, the startup program that launches when you insert the Origin DVD, includes
an Origin installation button. If the startup program does not automatically run, you can browse the DVD to
launch the setup.exe.

Please note that Origin and OriginPro 2023 are only available as 64-bit versions.

2.3.1 How to Proceed if You Already Have the Origin Trial Version Installed

If you already have the trial version of Origin installed on your computer, you can convert it to the full product
or upgrade.

. If you have purchased the Origin package with node-locked license management, run Origin and select
Help:Convert Trial to Product; or you can use Help: Activate License, click the “Or if you have
purchased already” radio button and choose Activate for this computer. In either case, you will be
asked to enter the Product Key that was generated when you registered your software purchase on
originlab.com.

e  For all other license management packages, run the Origin Add or Remove Files program located in the
Origin program icon folder, or rerun the Origin installer (both require a log in account with administrator
permissions). When the Origin setup program starts, select the Modify option and then select Install

Product (requires serial number).

2.3.2 How to Correct or Change your Serial Number After you Complete an
Installation

If you installed Origin with an incorrect serial number, you can correct it by running the Origin Add or
Remove Files program located in your Origin program icon folder, or rerun the Origin installer (both require a
log in account with administrator permissions). When the Origin setup program starts, select the Modify
option and then click Yes to change your serial number.

2.4 Selecting a User Files Folder

Each Windows login user must maintain a User Files Folder (UFF) for storing Origin user data:


https://www.originlab.com/index.aspx?go=Support/DocumentationAndHelpCenter/Installation/RunOriginonaMac
https://www.originlab.com/index.aspx?go=Support/DocumentationAndHelpCenter/Installation/RunOriginonaMac
https://www.originlab.com/index.aspx?go=Support/DocumentationAndHelpCenter/Installation/DirectInstall
http://www.originlab.com/doc/License/Single-User-Node-Locked-Lic
http://www.originlab.com/doc/Origin-Help/UserFilesFolder

Installing and Updating Origin

e |If you are upgrading from Origin 2018 or later versions, your User Files Folder (UFF) location is unchanged.

. If you are upgrading from Origin 2017 or earlier, you will be prompted to pick a location for a new UFF.
You must choose a different path from your old UFF.

e To transfer the contents of your old UFF and your toolbar and workspace configurations to the new UFF,
you can run the Origin software and selecting Preferences: Transfer User Files. For more information,

see Transfer User Files.

Consider these points in selecting your UFF:

. If you have a mobile computer, it is best to select a location on your computer rather than on your
network.

e  For non-mobile computers, you can select a location on the computer or on the network, as long as you
have stable access to the folder.

e Do not select the same UFF as other Origin users. To learn how to share custom files with other Origin

users, please see the chapter on Sharing Origin Files, later in this Guide.

Each time Origin starts, the program checks to see that your UFF is accessible. If Origin cannot connect to the
UFF, you will be prompted to select a new location for the UFF. Note that you can change the location of your
UFF at any time while running Origin. From the Preferences menu, select Options and then click the System
Path tab.

2.5 Licensing Origin

All Origin packages include license management. The type of license management provided with your package
is determined at the time of your Origin purchase.

2.5.1 Node-locked

Each Origin computer requires a license to run Origin. The license is obtained from the OriginLab website by
entering a Product Key in the License Activation dialog when you start Origin. In-dialog instructions are
provided for computers with no internet access.

2.5.2 Concurrent Network

Each Origin computer must connect to a FLEXnet license service to run Origin. Your IT department or Origin
administrator installs a FLEXnet license server provided by OriginLab (available from the Origin DVD), obtains
a license for this server from the OriginLab website, and then sets up a license service. The license service
counts and restricts the number of Origin computers that can run concurrently. For more information, see the
Help Center on the OriginLab website (originlab.com/HelpCenter).

2.5.3 Dongle
A dongle (USB hardware key) is provided with the Origin dongle-license package and must be present in the
computer's USB port to run Origin. From Origin 2019, dongles are cross-version.

2.6 Registering Origin
Registering Origin is required to obtain product support from OriginLab and the team of Origin distributors.

Registration also activates Origin's Check for Updates menu command (Help: Check for Updates), allowing
you to obtain patch and help file updates directly from your Origin software. In addition, Origin's App Center


http://www.originlab.com/doc/Origin-Help/FileShare-UserFileTransfer
http://www.originlab.com/doc/User-Guide/Sharing-Files
https://www.originlab.com/index.aspx?go=Support/DocumentationAndHelpCenter
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and Template Center dialog, which provide direct access to Apps&Templates and their updates from your
Origin software, requires that your installation be registered.

For Node-locked licenses, registration is completed automatically when you enter a Product Key into the
License Activation dialog box that opens when you start Origin. To verify that you are registered, select About
Origin from the Help menu. The dialog should display the Registration ID that is assigned to your Origin
installation.

Serial Mumber: GF354-6089-1234567
Registration [D: ABC-12D-E3F

Computer Name:  MyComputerName

Maintenance Expiration (Y¥YYY/MM/DD):  12/31/2017
This copy of Origin is owned by:

Acme Corporation

For all other license management packages, open Origin, and then select Register on-line... from the Help
menu to open the Registration dialog box. Use the Registration dialog to register your Origin installation on
the Origin website. During this process, a Registration ID is issued. Enter or copy and paste this Registration
ID into the Registration dialog to complete the process. The About Origin dialog should now display your
Registration ID.

2.7 Maintenance

Most Origin packages are sold with the first year of Maintenance included. Maintenance provides you with free
Origin upgrades, and may also include priority technical support, discounts on Origin training and consulting
services, and a home-use license.

Maintenance customers should receive notice of their eligibility for a free upgrade, when
choosing Help: Get Help Files/Check for Updates.

® To check if your Origin package includes Maintenance, select the Help menu and then select About
Origin. If your package includes Maintenance, the About Origin dialog will show your Maintenance

expiration date.

® To learn about the benefits of Maintenance, contact OriginLab or your local Origin distributor.

® As your maintenance expiration date approaches, Origin will display a maintenance expiration message
with a link to the OriginLab website to learn how to renew your maintenance. This reminder message

provides a check box to prevent showing in the future.

2.8 Service Releases

When called for, OriginLab publishes free service releases (patches). A service release typically provides bug
fixes and may include some minor improvements. All customers are encouraged to apply service releases to
ensure that your Origin software performs correctly. To check if a patch is available, select the Check for
Updates command from the Help menu. Patches are also available from the Support area of the OriginLab
website (originlab.com/Support).



https://www.originlab.com/index.aspx?go=PURCHASE/Maintenance
https://www.originlab.com/index.aspx?go=PURCHASE/Maintenance
https://www.originlab.com/index.aspx?go=SUPPORT
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2.9 Notification of Upgrade

OriginLab regularly releases new versions of Origin, adding features and feature improvements based on
customer input. Customers with maintenance are entitled - and encouraged - to use the most recent Origin
version. After a new version release, OriginLab and the team of Origin distributors notify maintenance
customers by email. However, to make sure you receive notification of a new version release, please create an
account on the OriginLab website (originlab.com) and select the check box in your user profile to receive
"product updates".

E-mail Subscriptions:

#| a-Mewsletter- Tech Tips, User Stories, 6 issues per year

#| Product Updates: Service Releases, New Version Nofification

QriginLab will not seif or rent your personal contact infarmation. See our privacy policy for defails.

2.10Setting the Origin Display Language

Origin packages sold to organizations in a limited number of countries, including Japan, Germany, Switzerland,
Austria, Liechtenstein, and China, may support running Origin with English display, or with Japanese, German
or Chinese display. To access this language control, select Change Language from the Help menu.

2.11System Transfers - Deactivating a License

2.11.1Node-locked Licenses (Computer I1D-based)

A system transfer is required if you plan to replace your licensed Origin computer with a different computer.

. If Origin can still be used on your computer:

Open Origin and then select Deactivate License from the Help menu. After successful deactivation, your
Computer ID will be removed from OriginLab’s server so that you can install and activate on another computer.

. If your licensed Origin computer is no longer available:

Log into your portal at www.originlab.com.
Under Licensing, click the Manage my License(s) link.

Click on the Serial Number associated with the license that you want to deactivate.

> W N PR

Click the go link in the Deactivation column.

2.11.2Concurrent Networks

A system transfer is only required if you need to replace the FLEXnet license server. A system transfer is not
required when replacing an Origin computer.

To obtain a replacement FLEXnet server license file, complete the "System Transfer Request Form" available
from the Support area of the OriginLab website.



https://www.originlab.com/
https://www.originlab.com/restricted/Login.aspx?ReturnUrl=%2frestricted%2fSystem_Transfer.aspx
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2.12 Uninstalling Origin

To uninstall Origin, run the Origin Add or Remove Files program located in the Origin program icon folder,
or use the Windows Uninstall or change a program tool. In both cases, the Origin Setup program displays
providing options to Modify, Remove, or Repair. Select the Remove option and complete the wizard as
prompted.

The Remove program deletes all folders and files that were installed by the Origin setup program. It also
deletes folders and keys created by the installer in the Windows registry.



3 Origin Resources

The following tables list key Origin resources available to you. If you purchased Origin from a local distributor,
your Origin distributor may provide additional resources. Please contact your distributor to learn more.

3.1 Direct Support Resources for Origin

In addition to the following support resources, there is now an in-software Help: Send
"MNE Feedback menu link that will open a web form so that you can provide direct feedback
oS (positive or negative), and/or allow you go make suggestions for improving Origin.

For Information On ... Go Here

e  Contact information for OriginLab
or your Origin Distributor
Technical Support ® Report a bug originlab.com/Support

®  Suggest a feature

e  Chat online with an OriginLab originlab.com

Chat Online representative e [ e
... and click : in the
lower-right corner

®  Share information with and get

help from the Origin user

User Forum . originlab.com/Forum
communlty

e  Making optimal use of OriginLab

products
Training and . . . -
Consulting e Help in developing custom tools originlab.com/Training

for your particular application
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3.2 Resources Installed with your Origin Software

For Information On ... Go Here

e Load graph samples and
analysis samples

e  Transfer User Files when
upgrading to the latest version

Learning Center e Learning Center for direct Help: Learning Center (or press F11)

access to Tutorials, Videos,

Origin Blog, User Forum and

social media pages.

®  Online or local (CHM) Help for
Help: Check for Updates (to update

i Origin (GUI, P i .
Help Files rigin ( rogramming) CHM files)

e  Control-by-control explanation

of Origin dialog boxes

Press F1 when the dialog box is open
e The dialog box must be open 9 P

Context-sensitive e Some dialogs have multiple or

Help sections/tabs and you may

Click il in the upper-right corner of the

have to click on that .
dialog box

section/tab to set the focus

i Press F1 when no dialog box is
® Recent files

. open

e  Help with problems or
questions that arise while
using Origin or

e Direct access to Origin features

Start Menu and dialog boxes Click the Start menu icon at the
- Windows-like
Search e  Open or search for Apps bottom-left of the workspace.

relevant to a particular task -

e Location of Origin menu gi; << Start menu (F1)

commands for searched-for
features . . . .
For additional information on using
this feature, see

The Origin Interface, Start Menu.

10


http://www.originlab.com/doc/User-Guide/Origin-Interface

Step-by-step instructions on
performing many Origin
operations, from the simple to

the complex

Origin Resources

Help: Origin : Tutorials

3.3 Online Resources for Origin

e  Product documentation

originlab.com/Doc

e  Resources list

. Installation and License

Documentation

L] Contact Info

originlab.com/HelpCenter

e Help with a range of Origin
features including "tips and

tricks"

e Available in playlists and
categories

®  Search Origin video or YouTube
pages by keyword
or type v <key phrase=> in the

Origin Start menu.

originlab.com/Videos
youtube.com/user/TheOriginlab

e Live and recorded webinars

highlighting key features

originlab.com/Webinars

®  Blog posts with plenty of

software tips and tricks

blog.originlab.com

11


http://www.originlab.com/doc/User-Guide/Origin-Interface
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For Information On ... Go Here

e How others are using Origin in

Case Studies their work originlab.com/CaseStudies

e  Qutstanding examples of Origin

graphs, many of them submitted

Graph Gallery . . originlab.com/GraphGallery
by the Origin community

Information on key Origin features often can be found by just doing a quick web
search. Open a browser and search on phrases such as... "Origin shortcut keys",
"LabTalk graph legend"”, or "OriginC NAG functions".

12




4 OriginPro

OriginPro, the professional version of Origin, provides all of the features of Origin, plus additional analysis
tools and capabilities. If you don't know which product you have -- Origin or OriginPro -- look to the title bar.

@023 - UNTITLED

File Edit View Data Plot Column Worksheet Forn
OERBBE/- BaH@E ¢ EHE
€ 8L Hr oiaew BER G

| Users of standard Origin will note that some menu commands are marked with (Pro),
/ indicating that the feature is available only in OriginPro. If you own the standard version of

Origin, but find that you need features of OriginPro, you can upgrade by contacting your
Origin representative.

If you wish to continue using standard Origin without seeing (Pro) menu commands, click
Preferences: System Variables and enter the following in the Set System Variables
dialog box and click OK (Comment is optional):

B Set System Variables ? *
Variable Value | Comment 2
RPM 1 Turns off menu display of (Pro) features
"
System Variables List
OK Cancel

4.1.1 Curve Fitting

In addition to Origin's linear and nonlinear curve fitting capabilities, OriginPro includes support for the
following:

Linear fitting with X error.

Nonlinear fitting with X and Y errors (orthogonal regression).

13
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e  Fitting with implicit functions (orthogonal distance regression).

e  Fitting Comparison: Fit and rank all functions in a category, compare two models to one dataset or two

datasets to one model.

e  Global fitting of multiple curves using different functions, with the option of sharing parameters.

For more information, see these web pages: Linear and Polynomial Fitting and Nonlinear Fitting.

4.1.2 Surface Fitting

With OriginPro, you can perform 3D Surface Fitting. Choose from 21 built-in surface fitting models including
Gauss2D, DoseResponse2D, Exponential2D, and Polynomial2D; or define your own function.

e  Fit worksheet data (XYZ) or matrix data (Z values).

e | ocate and fit multiple peaks using one of several peak identification methods.
e  Automatic peak parameter initialization.

e  Apply constraints and bounds to parameters and fix parameter values.

e  Output parameter and statistical results plus residual curves.

®  Find specific Z values along the fit surface and include them in your output.

e  Option for automatic recalculation of results and saving tool settings to a Theme file for repeat use.

For more information, see this web page: Surface Fitting.

4.1.3 Peak Fitting

OriginPro includes the Peak Analyzer tool with support for the following:

e  Peak finding (Local Max, Window Search, 1st Derivative, 2nd Derivative, Residual after 1st Derivative).

® Detect and subtract baseline (Constant, Dataset, XPS, End Points Weighted, Straight Line, User-Defined,

None).
®  Fit Peaks with built-in or user-defined functions.
e Fit individual peaks with different fitting functions.
e Fit Baseline as part of the peak fitting process (user-defined or built-in functions).

e  Control fit parameters (fix, share, set bounds).

For more information, see this web page: Peak Fitting.

4.1.4 Statistics

OriginPro includes support for advanced statistical analyses in these areas:

e  Descriptive statistics (cross-tabulation, distribution fit, correlation coefficient, partial correlation

coefficient).

e ANOVA (one-/two-way repeated measures, three-way).

14


http://www.originlab.com/index.aspx?go=Products/Origin/DataAnalysis/CurveFitting/LinearAndPolynomialFitting
http://www.originlab.com/index.aspx?go=Products/Origin/DataAnalysis/CurveFitting/NonlinearFitting
http://www.originlab.com/doc/Origin-Help/Fitting-2DSurf
http://www.originlab.com/index.aspx?go=Products/Origin/DataAnalysis/CurveFitting#Surface_Fitting_PRO
http://www.originlab.com/doc/Origin-Help/PeakAnalyzer
http://www.originlab.com/index.aspx?go=Products/Origin/DataAnalysis/PeakAnalysis#Peak_Fitting_PRO

OriginPro

e  Multivariate analysis (principal components, cluster, discriminant/canonical discriminant analyses; partial

least squares).

e  Survival analysis (Kaplan-Meier, Cox Proportional Hazards, Weibull Fit, test of equality of survival

functions)

e Parametric hypothesis tests (two-/pair-sample t-Test on rows, one-/two-sample test for variance, one-

/two-sample proportion test).

e  Nonparametric tests (one-/paired-sample Wilcoxon signed rank, paired-sample sign test, Mann-Whitney,
two-sample Kolmogorov-Smirnov, Kruskal-Wallis ANOVA, Mood's median test, Friedman ANOVA, support

for simultaneous tests).

e  Power and sample size (one-/two-/paired-sample t-test, one-/two-proportion test, one-/two-variance test,

one-way ANOVA).

e ROC curve analysis.

For more information, see this web page: Statistics.

4.1.5 Signal Processing

In addition to Origin's standard suite of signal processing tools, the following are available in OriginPro:

e  Signal transforms (short-time Fourier analysis, Hilbert transform, 2D FFT/2D IFFT).
e  Filtering (IIR filter design, 2D FFT filter).
e  Correlation (2D correlation).

e  Wavelet Analysis (continuous wavelet transform, discrete wavelet transform, inverse discrete wavelet
transform, multi-scale wavelet decomposition, smoothing, noise removal, 2D wavelet decomposition, 2D

wavelet reconstruction).
e Rise-time Gadget (linear search, histogram, largest triangle).
e Decimation (moving average, finite impulse response).
e  Coherence.

e Envelope curves (upper and/or lower, smooth during envelope detection).

For more information, see this web page: Signal Processing.

4.1.6 Gadgets

Origin Gadgets provide a quick and easy way to perform exploratory analysis on plotted data. While there are
specific Gadgets for each analysis, all work by allowing you to graphically and interactively position a region-
of-interest (ROI) object around the data that you wish to analyze. OriginPro includes these additional Gadgets:

e Cluster Gadget (stats on points inside/outside the ROI; with support for masking, editing, copying and

deleting points).
e 2D Integration Gadget (integration on image plot or contour plot from matrix or worksheet data).

® Rise-time Gadget (analyze rise/fall time of stepped signals).

15
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For more information, see this web page: Exploratory Analysis.

4.1.7 Image Processing

Origin and OriginPro include a collection of easy-to-use image processing tools. OriginPro includes additional
tools in the following areas:

. Image adjustments (function lookup table, leveling).
e Image conversion (dynamic binary, threshold, RGB merge/split, image scale).
e  Spatial filters (user filter).

e Arithmetic transforms (alpha blend, extract to XYZ, image simple math, math function, morphological

filter, pixel logic, replace background, subtract background, subtract interpolated background).

For more information, see this web page: Image Processing.

4.1.8 Apps
Many add-on Apps are coded to integrate with an OriginPro feature and therefore, they require an OriginPro
license to run. OriginPro-only Apps will be listed in the Oriqgin File Exchange with a red symbol beside
them.

Here are some of our more popular OriginPro Apps:

. Redundancy Analysis

(] Speedy Fit
(] Correlation Plots

o Neural Network Regression

e  X-Ray Diffraction Analysis

e  Phylogenetic Tree
(] 2D Peak Analysis

(] Standard Curve Analysis

(] Linear Mixed Effects Model

° Rank Models

e  Peak Deconvolution

. Design of Experiments

(] 2D Confidence Ellipse

. Independent Component Analysis (Requires R software)

(] Logistic Regression

e  Sequential Fit
®  Piecewise Fit

®  Piecewise Smooth

(] Principal Component Analysis

(] Principal Component Analysis for Spectroscopy
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OriginPro

e  Slope Analyzer
(] Global Peak Fit
(] 3D Smoother

e Cyclic Voltammetry

[ Enzyme Kinetics

e  Polynomial Surface Fit

. Heat Map with Dendrogram

For general information on Apps visit www.originlab.com/apps.

17


https://www.originlab.com/fileExchange/details.aspx?fid=346
https://www.originlab.com/fileExchange/details.aspx?fid=395
https://www.originlab.com/fileExchange/details.aspx?fid=415
https://www.originlab.com/fileExchange/details.aspx?fid=383
https://www.originlab.com/fileExchange/details.aspx?fid=335
https://www.originlab.com/fileExchange/details.aspx?fid=282
https://www.originlab.com/fileExchange/details.aspx?fid=223
http://www.originlab.com/apps




5 What's New in Origin 2023

5.1 Origin 2023 New Feature Highlights

Visit www.originlab.com For Origin 2023 Feature Highlights, including a Highlights
video.

5.2 Features and Improvements by Category

521

5211

5.2.1.2

Graphing

New Graph Types

Two independent Y Axes in a Single Graph Layer

Vector Plots in Ternary Coordinates

3D Stacked Heatmap
3D Stacked Surfaces

General

Hotkey for Export Graph (Advanced) <Last used>

Export Path Output as Clickable Link in Messages Log

Todgale Layer, Plot and Graphic Object's Selectability

More Control when Merqging Multiple Graphs to Layout or Page

Set Default Reference Line Style

More Locations for Reference Line Labels

Axis Reference Line Improvements

New Stack Plot Option

Better handling of Short Name in Batch Plotting

System Variable for Turning off Data Highlight Mode when Switching to Worksheet

Scale the Size of Minor Tick Labels

Fit Layers to Page more Accurately

Keep Graph and Worksheet Dimensions when Pasting between Layouts of Different Sizes

Plot Type = Column added to Plot > Multiple Y Axes dialog

Move Data Points Improvement

Build Color Dialog Interpolate Colors Improvements

Replace 3D/Contour Plot Matrix with Another Matrix

Rename Layer in Object Manager
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5.2.1.3 Text, Legend, Annotation

. Layer Title Improvements
e Add a Page Title

e Angle Annotation Tool

e Custom Display of Positive/Negative (+/-) Sign in Worksheet, Text Labels

° Hide Legend Entries for Function Plots

. Prevent ""Function Plot" as Axis Title when there are Other Plots in the Layer

e Specify Sort Order for Point-by-Point Legends

(] Manually Add Custom Color Block to Legend

(] Symbol Map Dialog Improvements

° In-place Edit of Wrapped and Unwrapped Text

(] More Asterisk Bracket Shapes

e Add Box Scale to Box Chart

. Enhancements to Worksheet Cell Substitution Format

(] Separator Button Added to Legend Object Dialog for Inserting White Space

(] Display Actual Formula in Function Plot Legend

5.2.1.4 Graph Customization

(] Data Plot Sort Option by LabTalk Property

. More Skip Points Options for Scatter, Line & Symbol Plots

e Control Auto Rescale on 2D/3D Layer-level with Mini Toolbar

(] Display Ticks and Labels on Alternate Axes

(] Support Shorter Z Axis Length

[ Contour Plot Improvements

e Set Column/Bar/Box Gap Separately for Linked Layers

e Sunburst/Doughnut Chart Improvements

e Color Data Points by Column Values for Grouped Box Charts

(] Support Spline Connection for 3D Line/Scatter/Trajectory

e Apply Palette to Gradient Fill for 3D Bar

5.2.2 Data Handling

5.2.2.1 Worksheet

° Banded Rows (Alternately Shaded) in Worksheet

(] Freeze Panes in Worksheet

e GUI Support for Protect Worksheet

. Hide Sheets in the Workbook

e Stack Worksheet to Skip Hidden
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What's New in Origin 2023

e Worksheet Cell Rich Text Wrapping

(] Moving Worksheet Ease-of-Use Improvements

° Deselect Cells by Pressing CTRL

o CTRL+SHIFT+Arrow keys for Row/Column Selection

e Align and Format URL Linked Cells

e More Merge by Options for Reduce Columns (wreducecols)

. Intellisense/Auto complete Improvement

e  Autofill Column Formula Improvement

(] Status Bar Reports Stats of Label Row Selection

(] Easier Editing of URL Cell Link Notation

e Select Column Improvements

e Worksheet Cell Insert Image Adds Direction Support

e Unstack Columns (wunstackcol) Control over Output of Grouping Info

(] Move Selected Worksheet Rows with Mini Toolbar Buttons

(] Force Clear Cell Cache

5.2.2.2 Notes

. Better Positioning of Cell Notes when Close to Window Edqge

e Cell Notes Font and Gap Improvements

5.2.2.3 Import

(] New Options for CSV and Excel Connectors, including Script after Import

e  Support Importing Shapefiles in WGS84 Format

° Import Excel with Merged Cells improvements

e GUI Additions to iwFilter Dialog for Editing User-defined Filters

e Connect to Web Dialog Improvement

5.2.2.4 Export

(] Better GeoTIFF Support when Export Matrix to Image

(] Export Worksheet as Image Improvements

e Simple Export Preview Option
e Export Browser Graph as Video (GIF, TIFF, AVD)

5.2.2.5 Matrix

XY Coordinates Addition, NetCDF

5.2.3 Analysis
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5.2.3.1 General

. Normalize (rnormalize) by Group Column

e Reduce XY (reducexy) By Reference Column(s)

(] Support Change Group, etc. Variables to Same Sheet as Input Data

® Convert XYZZZ... Columns to Multiple Matrix Objects in One Sheet

(] More Control of Data Identifier in OQutput Columns

e  Statistics on Columns OQutput Improvements

e Added Footnote to Results for Two-Sample t-Test and (PSS) Two-Sample t-Test

(] Input Improvements in Analysis Tools

5.2.3.2 Gadgets

e Control Gadget Button and Label Size

e Cluster Gadget Support for Z Stats and Fade Outside ROI

5.2.3.3 Image Processing

e Create Linked Matrix from Image Window ROI

(] Intensity Profile Improved for Very Small ROI

5.2.4 Programming

5.2.4.1 LabTalk

(] LabTalk-related Additions, 2023.

5.2.4.2 Python

(] Python-related Additions, 2023.

5.2.5 Miscellaneous

5.2.5.1 Ease of Use

e Toolbar for Folder and Window Navigation

e Add Folder Notes for Project Explorer Folders

. Project Explorer Folders Mini Toolbar

. New Default Toolbar Layout for Origin 2023

e Arrange Windows Improvements

(] Improve Shortcuts to Show Windows from Two Folders

(] Restore Window Size
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What's New in Origin 2023

e Simpler Hotkeys for Zoom and Scale In

e Save Window as Dialog (windowsaveas) Options for Easier Save to Project Folder

° Recent Project History Added to UFF for All Oriqgin Files

(] End Support for Saving as OPJ, Must Save as OPJU

(] Decimal Customization of Graph Maker Result

. Higher Default Color Depth for Raster Images

e  Support Export of Image, Graph Windows as AVI, GIF, TIFF

(] Excel Export Support for Cell Formatting

5.2.6 New Apps for Origin 2023

(] Bootstrap Sampling

e  Pulse Fit

(] Propagation of Error

e  (Classify Points in Graph

(] Gardner-Altman Plot

e  Steel-Dwass Test

. Effect Size for ANOVA

(] Torsional Angle Wheel Plot

(] Stiegele MDF Connector

To find out more about Origin Apps, including where you can get the free add-on Apps listed above, see the
Apps for Origin chapter of this User Guide.
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6 The Origin Interface

6.1 The Origin Workspace

This chapter contains basic information on navigating the Origin workspace. Long-time Origin users can skim
this chapter.
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Window size and position are automatically adjusted to accommodate different
displays. This is done to accommodate switching between your laptop and a higher-
resolution monitor, without having to resize/reposition every window and dialog box.
There is a system variable to control rescaling behavior: @SRWS (0 = previous
behavior; 1 = fit width, scale y; 2 = fit height, scale x; 3 (default) = fit width and

height).

6.1.1 Windows File Explorer Previews

While not part of the Origin interface, you can use Windows File Explorer (previously "Windows Explorer") to
preview graphs in a project file.
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6.1.2
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Windows Explorer's Large or Extra large icons views (right-click in File Explorer and choose View:

Large Icons or Extra Large Icons or select from the Explorer View menu) will show an image of the

last active graph before the project file was saved.

Open the Preview Pane (ALT + P) and scroll through all graphs in the project file.

If you do NOT wish to save graph previews into the file (either in icon view or in the Explorer Preview

Pane), you can set LabTalk system variable @PESS=0 or =-1. For information on changing the value of a

system variable, see FAQ-708 How do | permanently change the value of a system variable?

Origin Menus and Menu Commands

Context-sensitivity of menu bar and menus: The menu bar and menu commands are context-

sensitive; they change as you change window type (from worksheet to graph to matrix, for instance).

Only menus pertinent to the active window will display.

Menu bitmaps, toolbar buttons and shortcut keys: Some menu commands also have bitmaps that

display to the left of the command. Additionally, you may see a shortcut key combination listed to the

right of a menu command. The button bitmap and the shortcut keys indicate alternate ways to access the

same functionality.

Shortcut menu commands: Many commands are available from shortcut menus. To open a shortcut

menu, right-click on an Origin object (worksheet window, graph axis, text object, etc.). Only pertinent

menu commands will show.

Collapsible menus: By default, main and shortcut menus in Origin are "collapsed”, meaning they display

an abbreviated set of commands. When you use a menu item which isn't included, it is added to the menu.
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If you prefer to always see full menus, click Preferences: Options > Miscellaneous tab and clear the
Enable Collapsible Menus box.

e Most recently used analysis menu commands: Most-recently used menu commands will appear at the
bottom of the analysis menus (Worksheet, Analysis, Statistics, Image, etc.). This gives you quick
access to tools when performing repeat operations.

e Most recently used files: Several File submenus (e.g. File: Recent Projects) keep a list of your most
recently opened or saved files. Thus, files that you are currently working on are easily located and opened.

e Custom Menu Organizer: Since Origin 8.1, Origin users have been able to use the Custom Menu

Organizer to add or remove menu items. To learn more, see the chapter Customizing Origin, later in this

Guide.
Origin 2023 adds a plain-text log of all Origin file activity. The file is named as
"OriginProjHistory.txt" and saved to User Files (Help: Open Folder: User Files
Folder). Maximum number of entries is controlled by system variable @MHF (default =
e 1000).

6.1.3 Origin Toolbars

Toolbar layout is modified slightly for Origin 2023. A new Folders and Windows
toolbar is added for working with Project Explorer folders and folder contents. When
first running Origin 2023, you may see this new toolbar "floating" in the Origin
workspace. You can drag it (by the title bar) to an empty portion of the toolbar spacer;
or you can choose View: Toolbars and click the Reinitialize button to reset toolbars
to the standard 2023 configuration.

Folders and Windows w X

€ A F,

In addition, a couple of lesser-used toolbars (Arrow and Layout) have been hidden, by
default, in the workspace. For information on modifying toolbar configurations, see
Customizing Toolbars and Buttons.

Use the Customize Toolbar dialog box (View: Toolbars) to control toolbar display and reset or reinitialize
toolbars.

e Customize toolbar button appearance: Use controls on the Options tab of the Customize Toolbars

dialog box to modify button and toolbar appearance.

e Dock/Float a toolbar: Toolbars can be undocked and made to float on the workspace. To float a toolbar,
hover over the left-end of the toolbar. When the pointer becomes a four-headed arrow, drag the toolbar
off of the toolbar space. To return the toolbar to its former docked position, double-click the toolbar title

bar.

e Hide/Show a toolbar: Clicking the Close button on a floating toolbar removes the toolbar from view. To
restore a hidden toolbar, open the Customize Toolbars dialog box and on the Toolbars tab, place a

check mark beside the toolbar.
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e Hide/Show a button: Click the small arrow at the right end of a toolbar and open a flyout menu to

enable/disable toolbar buttons.

€« >4 é.y e E %dd L e O e Folders and Windows ~ » '€= Folder Backward

check button to show or —— 5 Arrange Windows (last used)

Customize..,

Cirl+T '—) Folder Forward

clear check to hide.
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ﬂ. Add Active Window Shortcut for Seesaw  Cirl«5Shift«F7
f,.. Add shortouts from previous folder

R | Pin Active Window

Reset Toolbar

e Move/Hide button: Alt + drag a button to move it to a new position within or between toolbars. Alt +

drag to an empty portion of the workspace to create a new toolbar; ; or to hide a button, Alt + drag a

button to any child window (cannot be empty workspace) and when the button displays as "X", release to

hide the button in the toolbar.
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For more information on customizing Origin's standard toolbars, see Customizing Toolbars and Buttons,
later in this User Guide.

6.1.4 Mini Toolbars

OriginLab continues to add Mini Toolbar support for common objects and tasks. These toolbars appear when
the user selects an object or when the user clicks in certain key areas inside the page. Available controls
depend on context (selected object, window type, etc).

| Double ¥ Box Plot = |
i .: Yot Height and Weighs by Gender
ias 2
EEFrL L
y Eha
z

Available tools depend on context —- window type, selected

] body

| Long Hame |
Units

i 1 o YD
XYZ~1=g |f

2
3

11+ Iy body

Jang
Sophia
Grace
Tom

UnstackCos]

object, where you have clicked on the page, etc.

e  Before using Mini Toolbars, make sure there is a checkmark beside View: Mini Toolbars (default).
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e To display the toolbar, select an object such as a data plot, a text label, or a worksheet cell.

. In addition, there are toolbars for more-general page- and layer-level customizations and these toolbars

are displayed by hovering near the margins of the window. When you see your mouse cursor change to

something like this , this is your cue that clicking in this spot will display a Mini Toolbar of relevant

tools.
(x5) J(Y5) /’"&
013 2015 6"

e  Most Mini Toolbars have a Properties button : that gives access to more complex settings (e.g. a

graph window's Plot Details dialog box).

. If you move away or you do not act quickly enough, a Mini Toolbar will fade away. To restore a Mini

Toolbar after it has faded, press the SHIFT key.

e To add or remove buttons from a Mini Toolbar, click on the three dots at the bottom center of the toolbar.

This opens the Customize Mini Toolbar dialog box where you can enable or disable buttons as needed.

8 Customize Mini Toolbar b
Group  Single
[ Select All

600 57 Line Color

& E

== |ncrease Line Thickness,Decrease Line Thickness Line Thickness
400 - 57 05
. = Show Data Labels

[{5 CcopyPiot
Change Plet to

<A {3
200 ' [

:_'E Ungroup
£} Open Plot Details

BEEEE
Lo

[ Hide. To show again, press SHIFT.

Cancel

6.1.5 Start Menu

Enter keywords and phrases into the Find box to return relevant Menu entries, Apps, FAQs, Videos and X-
Functions. Open recently-opened Files, Menus and Apps.

Open the Start Menu by (1) pressing F1 (when no other dialogs are open), (2) by clicking the magnifying-

glass icon at the bottom left corner of the Origin workspace, or (3) by clicking Help: Activate Start Menu
(main menu).
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Samples -
Batch Processing - Script Before Process in Batch Pi opiu
Batch Processing - Script Before Process in Batch Processing. opju
Balch Processing - Batch Peak Analysis.oppi
Batch Provessing - Batch Processing Grouping Colurmins.opju
Batch Processing - Balch Processing with Analysis Template.opju
Batch Processing - Batch Analysis Word Template for Reporopju
Batch Processing - import Multiple Files to Sequential Waorksheet for Batch Processin
Batch Processing - Batch Processing with Gadget Tools.opju
Batch Processing - Analysis Template with Matri in Workbook.opju
Baich Processing - Clone Impon.opju
Projects
Bstch Processing Multiple Datazsts.opju
Menus
E 55 M File: Batch Processing..: Parform Batch Processing with Analysis Template
& B Analysis: Batch Peak Analysis Using Theme..; Perform batch processing of muitip
Tools: Protect Project.: Set password to protect project
Help: Unzaved Projects
File: Euit: Quit the applicatson prompis (0 save diocuments
File: Append_: Append a project 1o the curment open project
File: Save Project As..; Save the project with a new name
Shortout Manus
Wiorkspace gray area- »File- >Recent Projects->[None)
Warkspace gray area- > File- = Ext: Cant the application: prompis to save documents
Apps
o Distributed Batch Processing: Batch processing with multiple Origin instances
Il Gadiget Replicator: Programmatically slide gadget and generate output,
i} Impnrl Files from a Folder: Imiport files with same extension, oreate subtodder with s
1l Font Changes: Batch modify fonts in a gragh
+ Sequential Fit: Perdorm fitting on all datasets in worksheet sequentially.
1l Choneable Template Plotter: Create graphs wsing multiple Cloneable Tesnplates that
I Maonte Carlo Simulation: Simulate your prooess by supplying a transform equation ;
I Constrained Multipbe Regression: Perform constrasned multiple regression and sohs
0 Crperations Manager: View and manage a list of operations {(anabyses, etc) in the o
1 OPF Packes: Pack preject file Including fAtting lunctsshs and templates e

£ >

thmpw w2

<< Start Menu (F1)

To narrow your search, type the following letters in front of the search term(s):

m = search only Menu entries

a = search only Apps

h = search only Help + FAQ

v = search only Videos

X = search only X-Functions

p = search your recent projects

s = search sample projects

e = search Menus + Apps + X-Functions (only executable)

Alternately ...

Click the "gear" icon beside the search field to open the Settings box. Here you can restrict search results and
tweak other search settings.
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Find |linear fit

6.1.6 Learning Center

B Settings 4
Multiple Terms: O Use AND @ Use OR
Results Display:

[] Compact

[ Show Preview for Samples

Search Categories:
b Menu Il Apps l#i X-Functions
1 Help 1 Video 1 Project Files » Samples

You can begin with the following single letter keyword to override:
m: Menu & Apps = ¥-Functions
he Help w: Video p: Project Files s Samples
& Menu & Apps & X-Functions

Example: m Filter

will search Filter only amaong menu items.

[o] (o]

Learning Center is a "startup"” dialog that gives quick access to graphing and analysis examples, plus
learning resources (tutorials, videos, the OriginLab blog, etc.).

1. To open the dialog, choose Help: Learning Center or press F11.

2. Check or clear the Show on Startup box to show or hide this dialog each time Origin starts.
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B Learr ing Center

l Filter by Plot Type l l Search by Plot Type
X
' a A

Graph Samples

.
e

Analysis Samples

Learning Resources

Ve

TTTTT
[EI['

Learning
Center

Version
Number

Transfer User Files

Opens
Transfer User Files
Dialog Box

Double-click on a panel
to open
Sample Data and Plots

Show or Hide
Learning Center
on Startup

e View and load sample graphs, including sample data and notes on re-creating the graph.
® Load analysis samples with data.

e  Browse the Learning Resources tab for tutorials and videos and links to the Origin Blog, User Forum and

Origin social media pages.

e  Move files from your previous User Files Folder to your new User Files Folder.

To see new graphs in Origin 2023, open the Learning Center, click the Graph
Samples tab, set the plot filter drop-down to All Plot Types and search on 2023.
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6.1.7 Project Explorer

There are many new features added in support of Project Explorer for Origin 2023.
"ME These are listed and explained under Folder and Window Additions for 2023,
ROt below.

Project Explorer (PE) is a tool to help you organize the contents of your Origin project files (OPJ).

] Menu for Float, Dock,
Title Bar

xﬁ\utohide, etc. x
Project Explorer [6) w O W Pin/Autohide
P

[3 20 and Contour Graphs Toggle

|__| 20 Parametnic Fuction Plot

» 1 Area
>[4 Column, Bar < Primary Panel
a1 Contour
| .3 Contour Plot with Vector Overlay
[ Heat Map
11 Polar Contour
|; "'; Profile
1 Ternary Contour
I ¥YZ Contour
1 | temm mem P I wree PN | 7
Mame Comments -+ Long Mame Short Hame Type = Column header,
{ontour Profile Contour Profile  ContourProfile Graph Details View
%F‘mfileData _ ProfileData ProfileData2 Workbook .
A Mates - Motes Motes35_E Motes Sub;gz?:rl-lts:c;?rlng
EMBook1C MBaok1C Matrix highlighted folder

Project Explorer (PE) is split into two panels. The primary panel shows the OPJ folder structure. The sub-panel
shows windows contained in the folder that is highlighted in the primary panel.

Using Project Explorer to manage your projects:

e  Right-click the PE title bar or click the drop-down menu to display the panels stacked (Vertical

Alignment) or side-by-side (Horizontal Alignment).

e Context menus in both panels provide options to delete, hide, print, etc. Menu options vary depending on

what is selected or where you have right-clicked.

e  Multiple-selection of windows in the sub-panel is supported (press Shift or Ctrl while clicking with your
mouse).

e  The sub-panel supports differing views of windows: Details (default), List, Small Icons, Large Icons,
Extra Large Icons.

. In any view, mousing over a window icon shows a popup preview of the graph, worksheet, matrix or

layout window. Notes window content is shown in a tooltip.

e  Control display of popup previews by right-clicking in the subpanel and placing a check mark beside Hold

Ctrl Key for Preview Popup. Henceforth, popups will only appear as you press CTRL.
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£ Test_ OGWU_Preview Layout1
[ Folderl &) Notes
E] Function Plots - 20 Functi Scatter with Mﬁn Connected
[ Line and Symbol Graphs - B Stocks.dat
{7 Line and Symbol Graphs - - Boage Soock Monisly Persmance n 3012
L. Line and Symbol Graphs - T
< > 1¢ 3, PR

e When displaying windows as Extra Large lcons, the PE sub-panel displays a thumbnail of graphs, layout

windows, workbooks and matrixbooks. Notes window content is shown in a tooltip.

3 Test_QOGWU_Preview
3 Folderl
[l Function Plots - 30 Functi
{3 Line and Symbol Graphs -
|5 Line and Symbol Graphs -
[ Line and Symbol Graphs -

o et e, e s

|

< 3 Layoutl Motes Scatter with Mean Connected Stocks.dat

Border indicates Active Window

=

Prior to 2018, the PE sub-panel listed sub-folders in the folder selected in the top panel.
To restore this display mode, set the value of system variable @PEF = 1.

You can right-click on PE folder (upper panel) and choose Copy -- or select the folder
and do a CTRL + C and CTRL + V -- to copy and paste the folder structure and content
to (a) another folder in the current project or (b) another project running in a second
Origin session. To copy a single workbook window, right-click on the window (lower
panel) and copy and then paste the window to (a) another folder in the same project,
or (b) to a new project running in a second Origin session.

1. Select Help: Open Folder: Program Folder, click the Samples subfolder, then drag

the file Tutorial Data.opj to your Origin workspace.

2. By default, Project Explorer is docked to the left side of the Origin workspace in

auto-hide mode. Mouse over the Project Explorer tab to show the PE window.
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- Multi-line-plot with Special Position Annotation Line
- Multiple Axis Breaks

- Multiple Fill Area

- Multiple Layers with Step Plot

- Multiple Surfaces in Same Layer

0

3.

----- . Open-High-Low-Close-Volume Stock Chart
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2 E(Y) FY
Low Clos

20 913

v |63 19.07

Click on the "push pin" icon on the PE title bar to pin the window in the docked

position.

Project Explorer (71}

{1 Map Combining Line and Contour Plots
[ Multi-Level Filter

BA i lime et vaeidl Cemeial Dmeidimm 8 meedatme | e e

vIElx
~

4. By default the sub-panel is in Details view. In this view, window metadata such as
Name, Size and Comments show below these column headings. Try dragging
column headers to reorder them.

Mame Long Name Short Name CommTQts - iy e Commgnts -

[ eastcaliy... eastcaliz053 Workbook Normal 282KB  9/23/2014 17:30

EMBDDM MBookd Matriz Mormal  193KB 10/25/2013 11:39

@Notes MNotes MNotes7_E MNotes MNormal 537 bytes  12/18/2017 15:52

5. Right-click on the column headings and show or hide any of the headings by
checking or unchecking the box beside each.

MName Long Name  Short Name Comments12& Alhfglumns 1o Fifa,, Size Madified slide

] eastcaliz0s3 eastcali305 [v] Name | 282KB  9/23/201417:30

7 7 192017 10

@Notes Motes MotesT_E Long Name 537 bytes  12/19/2017 10:33

EMBDDk-dv MBookd 193KB 10/25/2013 11:38

Short Name

View

Size

Madified
Created
Dependents

Comments

[v] siice

6.

Shaow All

To add a comment in the Comments field, click once, pause briefly and click a

second time. This puts you into edit mode. Enter a comment.
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Mame Long Mame Short Mame Comments - Type View Size Modified
eastcali3053  [Typeyour comments here .| |Normal 282KB  9/23/2014 17:30
Motes Motes7_E Motes Mermal = 337 bytes  12/18/2017 153:52
EMBDDM MBookd Matrix Normal — 193KB 10/25/2013 11:39

To change the Name of a window, right-click in the row and choose Rename. By
default, the Name field displays the window Short Name; or if a window Long
Name exists, the window Long Name (all windows must have a Short Name but
Long Names are optional). Click the SN or LN button to the right-side of the
editable Name field to edit the Short Name or Long Name. If the Long Name does

not exist, you can enter one.

MName Long Mame Short Mame Comments ~ Type View Size Maodified
SN eastcali3053 Typeyour.. Workbook Normal 282KB  12/18/2017 16...
Motes? E MNotes Hidden 337 bytes 12/18/2017 16:27
i MBookd short Mame Matrix Hidden 193KE 1042572013 11:39
Click to switch to editing Long Name J

In the top panel of Project Explorer, scroll to the folder 3D Surface with Point
Label and click on it. The sub-panel shows that there are three windows in the
folder. Note that the worksheet window eastcali3053 is bold indicating that it is the
"active" window - the window that is being acted upon as well as the window that
determines what operations are available. There is also a Notes window, and a

matrix window named MBook4.

; e

... 3D Scatter with Line Projections

[ = 3D Surface with Point Label

L 1 AN Ternars Surfare

MName Long Mame  Short Name Comments = Type View Size !
% eastcali3053 eastcaliZ053 Workbook Mormal 282KB !
@Nntes Motes Motes?_E Motes Mormal 537 bytes
@MBDDM MBookd Matrix Mormal  193KB

In the sub-panel, double-click on MBook4 and note that it is now bold and has a
magenta "halo", indicating that it is the active window. You will also see that the
whole window(in the workspace) displays with a halo which can be customized in

color with the system variable @AWC-- another indicator that this is the "active"

window. Double-click on this MBook4 icon again and note that the icon is now
dimmed. Note also that the actual window disappears from the workspace. This is
because MBook4 is now hidden. Double-click the MBook4 icon again and the

window is restored and made active.
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B

i 3D Scatter with Line Projections

[E>r 3D Surface with Point Label Icon is dimmed indicating that the
/ window is hidden in the workspace J
L. 3N Ternare Surface
Mame Long Mame ort Name Comments + Type View Size Maodified
%eastcalﬂﬂﬂ eastcali3053 Workbook Mormal 282KB 9/23/2014 17:30
Motes Motes7 E Motes Mormal 337 bytes  12/19/2017 11:03
MBookd Matrix Hidden 193KB 10/25/2013 11:39

10. With MBook4 active, click Plot > 3D: Surface: 3D Colormap. This creates a 3D
colormap surface graph (close the attention message). Note also that a new window --

Graphl -- has been added to the sub-panel of Project Explorer.

11. Right-click in an empty portion of the sub-panel and choose View: Extra Large

Icons. Note that Graphl now displays a graph thumbnail.

eastealizlag Grapghl

Notes

12. Right-click again and choose View: Large Icons. Note that windows are now

represented by icons but if you hover on them, you can see the window contents

as a pop-up.

&
=) e
=
Grapl Bookd

To disable PE previews, open the Script Window (Window: Script Window) and type
one or both of the following, then highlight the text and press Enter:

@PESS=-1; //turn off window preview in PE, show window comments
as tooltip
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@PESH=0; //turn off window comments tooltip

When you set the value of a system variable using the Script Window, you are altering
Origin's behavior for the current session only. To set the value of a system variable
across sessions, see this FAQ.

6.1.7.1 Folder and Window Additions for 2023

6.1.7.1.1 Folder Notes

You can add Folder Notes to a Project Explorer (PE) folder Origin 2023.

1. Right-click on a folder and choose Folder Notes .
O If no folder Comment exists, this adds a blank Folder Notes window to the folder (see this page
for options for adding and displaying Notes window content).
O If there is existing Comment (hint: right-click on the folder and choose Properties), adding
Folder Notes will copy the Comment to the Folder Notes window.
O When switching between folders, for example using the new Folders and Windows toolbar,

these Folder Notes will always be displayed in the workspace, if pinned or minimized.

O If you close Folder Notes (i.e. by clicking the Close button ), they are embedded in the
folder and will only be displayed again by right-clicking on the folder in PE and choosing Folder

Notes.

In addition ...

® Press Ctrl + hover on a Project Explorer folder to see rendered Notes window content.

e System variable @FNS is added to determine which is the default Folder Notes syntax (= O (Text), = 1
(HTML), = 2 (Markdown), or = 3 Origin Rich Text (default)).

e A Mini Toolbar is added for adding Folder Notes, Duplicate Folder or to Open Folder Properties

Dialog.
Project Explorer [71) - 0 X
[ Tuterial Data ~
-1 2D Frequeng L4 (L] £ | Folder Notes..
1_'}' 20 Vector » 5

----- {1 30 Bar on Flat S5urface

i ] 30 Bar with Labels
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6.1.7.1.2 Folders and Windows Toolbar

There is a new Folders and Windows toolbar for Origin 2023. The toolbar makes it

easier to switch between Project Explorer (PE) folders (Seesaw) or to add the active
ME! window as a shortcut in the previous folder; plus, to pin the active window in place or
= = to arrange windows in the active folder Window: Arrange Windows <Last used>.

Folders and Windows w X

€ A F,

e Folder Backward: From current folder, return to previous folder.

e  Folder Forward: From previous folder, return to current folder.

e Seesaw: Alternate between two folders (Ctrl + Alt + X). From the menu,
Windows: Seesaw.

e Add Active Window Shortcut for Seesaw: Share the active window to the
previous folder as a shortcut (Ctrl + Shift +F7). Alternately, right-click the window
title and add shortcut to previous folder.

e Add shortcuts from previous folder: Add shortcuts by window type, to the
current folder.

e Arrange Windows (last used): Same as Window: Arrange Windows <Last
used=>.

® Pin Active Window: Pin window so that it isn't included when Arrange Windows
(last used) is clicked. Alternately, right-click the window title and Pin Window

(or unpin).

6.1.7.1.3 Window Shortcuts

When you are in a Project Explorer folder, you can hover on another folder, right-click and Add Shortcuts.
This opens a dialog for adding windows as shortcuts, by type, to the active folder.

B Add Shertcuts to Active Folder 7 e

Show windows from selected folder as shortcuts in active folder

Add from folder: 3D Surface Plots - 3D Surface Map from DEM
Choose window types, counts are inside ()
Graph (1) :
Workbook (0)
Matrixbook (1) |
Layout (0}

Cascade Added Windows [ |

Cancel

39



UserGuide 2023

e  When a shortcut window is added to the active folder, a home button (“Go to original®) . Clicking the

button will navigate to (and activate) the original window in its containing folder.

e A shortcut window will display the name of the PE folder in parentheses, on the window title bar.

e Clicking Close Eon a shortcut window will hide the shortcut in the current folder.

e To remove shortcuts from the active folder, right-click on the folder in Project Explorer and Remove

Shortcuts (dimmed when there are no shortcuts to remove).

e  Minimized or maximized windows added as shortcuts will be restored up or down so that they are visible

but do not fill the workspace.

6.1.8 Apps Center and App Gallery

Apps are add-on applications for Origin that perform specific graphing and/or analysis tasks. A small number
of Apps that are broadly applicable to science and engineering fields are pre-installed with your Origin software.

Apps - 0 X

TEX

LaTex

[Fizy = “Frac{i}{{sigms “sqrt {Z>p1 } hpe~{{{ - “lef|

P(x) = ——e (=012

Use the App Center dialog for browsing, updating or downloading Origin Apps. This new dialog gives you
direct access to all of the Apps on the OriginLab File Exchange without you having to open a browser and
navigate there.

App Center - ol EN
=N - ~

Spectral Broadening m Allan Variance
= Origanlab i . Origanlab ¢
Min. Versiore OngnPro 20017 SRD Min. Versione OngnPro 2017 SRO
A% waps online D) P q Import Filas from a Folder
v Originlab L OriginLab -L.
Min. Version: Orign 2017 SR2 Min. Versionc Orign 2017 5SRO
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To launch the App Center, click the Add Apps button that appears on all tabs of the Apps Gallery, docked at
the right-side of your Origin workspace. If you do not see the Apps Gallery, click View: Apps (or ALT + 9) and
verify that there is a check mark beside Apps.

v

. Installed and Up-to-date Apps will appear in the App Center with a green check mark beside them

Ty
o Installed Apps for which there is a newer version will appear with an Update icon beside them e

X 1

e  Those not installed will appear with a clickable Download and Install icon beside them

Origin's Statistics, Analysis: Fitting and Analysis: Peaks and Baseline menus include a Find Apps entry.
Clicking Find Apps opens the App Center to show only Apps that relate to the current menu (e.g. Statistics).
You can download or update Apps directly from the App Center.

Use the Apps Gallery to organize and access your installed Apps.
P New Apps and App updates are are continually made available to Origin and OriginPro

users. Be sure to open your App Center occasionally (press F10) and if it displays the
red Download Now button, click to get the latest list of available Apps.

MNew App
Information
Is Available

For more information on Apps, please visit www.originlab.com/apps.

6.1.9 Object Manager

The Object Manager is a dockable panel that opens to the right side of the workspace, by default. Use the
Object Manager for guick manipulation of the active graph or workbook window.

Graph Windows
e  Select an element (layer, plot group, data plot or special point) in the Object Manager to select the

corresponding element in the graph window and vice versa. Selection also (a) dims all other plots in the

graph layer and (b) selects the source data in the worksheet.
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Object Manager can show a "Graph Objects" view and a "Plots" view of graph windows. To toggle
between the two views right-click in an empty portion of the Object Manager and choose Show
Plots/Show Graph Objects; or press Ctrl + Shift + S.

Graph2 * El
1

Object Manager

I-V Curve for Single Electron Transistor |

1000

300 -

&00

B Graph

1 [] Layer1
T % Axs Title (XB)
T ¥ Axis Title (YR)
[T % Axs Title (xT)
T ¥ Ais Title (YL)
T Test
/ Line
Line1

1)
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400
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e Hide or show plots or graph objects by clearing or checking the corresponding box in the Object Manager.

1an JTATE 5 : [+ Layer2 ]

G000 4

(cm®iem)

4000

2000 H

Cumulative Drain Discharge

e At the graph level, change Object Manager list order (Drawing Order or its reverse -- Order of
Appearance ).

e At the layer level, change layer order.
e At the plot level, show labels, show or hide plots, reorder plots or create plot groups.

e  Within a plot group (labeled as gN), ungroup plots, re-order plots by dragging or by shortcut menu
command, change plot type.

e Remove a plot (permanently) from the graph window.
e Access the Plot Details, Layer Contents and Plot Setup dialog boxes.

® Right-click on the layer icon and Reverse Plot Order.

Workbook or Matrix Windows

The Object Manager also supports certain actions for workbooks and matrices:

e List all sheets in the active workbook or matrix.
®  Quickly select multiple sheets by pressing CTRL + Up/Down arrow.
e Click a sheet in Object Manager to activate the corresponding sheet in the workbook or matrix.

e Right-click in Object Manager for access to common worksheet operations, including Delete, Insert, Add,
Move, Copy, and Duplicate.

®  Right-click on a matrix or virtual matrix in Object Manager to Rename.
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Layout Windows

2 Peaka Insert
Delete
BOYY) aae
Peak Fit of Sheet1 B Add Graph as Sheet
Add Matrix as Shest
Long Mam | Baseline . R
Units F'-‘*P"“E“T Right-click on
Baseineliata sheet in Object
LANCK On 812.91663  0.22654 Manhagr[ar :D ol 5t
- : . a shortcut menu [y sheet
"::;E.Et T 82583326 0.22654
lec 333?4939 DEEEM B rin g e g LII.III.IIJE Drata
Manager o 85166651  0.22654 g  Duplicate
activate sheet 86458314 022654 8
z I — T — . Meve Befare 3
[+]] INWOrkDOOK [ Sheeti B j FitPeakCurvel £ PeskProf ysove to pegin
Y
\\-___‘-’_’/. Move Lo End
Sheet Name to Show L4

Mame and Motes...
Exclude from Flotting Dialogs
Ewtlude from Excel Expart

Protect Sheet

Mawigate...

Properties...

When a Layout Page is active, the Object Manager lists and allows arrangement of objects via shortcut

menu commands.

e All objects, including added graphs, tables and text objects, list in the Object Manager.

e Hide or show objects by clearing or checking the adjacent box.

e  Select multiple objects in Object Manager, then right-click and align or distribute them using shortcut

menu commands.

6.1.100rigin Child Windows
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Active windows -- the window that will be acted upon by graphing and analysis
operations -- display a colored frame to make the active window more obvious. You can
customize the active window indicator properties (frame color, where the frame shows,
frame line style) with "@ System Variables" @AWC (color) and @AWI (style).
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"Halo" indicating
Active Window

Workbooks: The Origin workbook provides a framework for importing, organizing, analyzing,
transforming, and plotting your data. The tabbed workbook contains between 1 and 1,024 sheets. Each
sheet may contain more millions of rows and more than 65,000 columns of data. In addition to your data,
workbook windows may also store graphs, annotations, column-based functions, scripts and

programmable button objects, LabTalk variables and import filters.

Matrixbooks: Like the worksheet, a matrixsheet is a grid of cells, arranged in rows and columns. The
primary difference is that in the worksheet, each column is a dataset and each dataset can be configured
to contain various types of data (text, text & numeric, numeric (double), numeric (int), etc). In contrast,
the matrix is a single, numerical dataset of Z values, related in the XY plane by row (Y) and column (X)
index numbers. The matrixbook contains between 1 and 1,024 sheets. Each sheet can contain multiple
matrix objects (up to 65,504).

Graphs: The graph window is the primary container for your data plots. Origin supports over 100 chart
types, chosen specifically for their applications in various technical fields. Each chart is created using a
built-in, user-modifiable graph template that can be saved with your custom settings. In addition to data
plots, the graph may also contain annotations (text and drawing objects) or button objects that, when
triggered, perform some custom graphing or analysis task. Graph windows can be inserted into worksheet
cells or "floated" on worksheets (outside the grid) in a workbook window.

Images: The image window is a window for importing, viewing and editing raster images and videos
(.avi, .mov, .mp4).

Function Graphs: The function graph is a specialized graph window that displays a curve described by a
function. The function graph differs from other Origin graphs in that it is not produced from a dataset of
discreet values (though you can generate data after plotting).

Layout Pages: The layout window allows you to combine and arrange graph and worksheet windows and
various annotations onto a single "display panel." It is used primarily for creating presentations.

Excel workbooks. Excel workbooks can be opened or created in Origin. Workbooks can be saved
separately or as part of your Origin project file.

Notes: The Notes window supports plain text, Rich Text, HTML and Markdown. Use it for simple tasks
such as recording analysis procedures, making notes to students and colleagues, and cutting and pasting
text from other applications; or use it for rendering highly formatted text, including HTML reports and

mathematical expressions.
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Note: For more information on Origin's child windows, see

Help: Origin: Origin Help > Origin Basics > Elements of the Origin Workspace > Creating a
Child Window

Help: Origin: Origin Help > Origin Basics > Elements of the Origin Workspace > Basic Child

Window Operations

To save an Origin child window independently of the Origin project file:

® Select File: Save Window As... to save active window. File extensions OGW(U), OGG(U), OGM(U) are for
Origin Workbook, Graph and Matrix windows, respectively.

e  Right-click the window title bar and choose Save as... from the context menu.

Note: To save an Excel window as an external Excel file, right-click the Excel window title in Origin and choose
Save Workbook as... from the context menu.

Origin 2023 adds some useful path options to the Save Window as File Path drop-down.

.I_'ni. '_I._F i N .
W 1" Save Window as: window_saveas 4 X

Save a graph, workbook or matrix window to file

Category UserDefined

File Path ChiUsers\mike\DocumentsiOriginLabiUser Filesy -
Chllsersymike\DocumentshOriginLab\User Filesy

File Name <User Files Folder=
<Project Folders>

File Type <Project Folder> < PE Path>
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i Origin 2018 added Unicode (UTF-8) support for Origin projects, child windows and
' templates. When you save a window file -- with the exception of the project file which
as of Origin 2023 can only be saved as Unicode-compliant (*.opju) -- you will have the
option of saving a file with or without a "u" appended to the file type (*.otp or *.otpu).
If you intend to use the file only in the latest version of Origin, you should choose the
Unicode-compliant (appended "u™) option as it offers some performance advantages.

To open a worksheet, graph, matrix, or notes window that was saved to a file:

_ _ = _ .
e Select File: Open or click the Open button J on the Standard toolbar to open window files.

e Select File: Recent Books, File: Recent Graphs to open recently saved workbook and graph window

files.

Note: Origin supports window Short Name, Long Name and Comments and the Short Name must be
unique in the Origin project. The window Short Name will be renamed if such a name has already exists in the
project. If you open window file in the current project, then save the project, the window will be included in
the project.

To open an Excel workbook file:

If you are intending to work with Excel files in Origin, please see this section of the
Origin Help file before proceeding.

e Select File: Open Excel menu to open a external Excel file. Or, you can click Import Excel button in the
Standard toolbar or select Data: Import from File: Excel (XLS, XLSX, XLSM)... from the main menu

to import the Excel file.

Note: If you choose Open Excel, the Excel file is opened as an Excel workbook, in an Excel session that runs
inside Origin. In this mode, you have only limited access to Origin features. If you choose Data: Connect to
File: Excel or Data: Import From File: Excel, the Excel file is imported into an Origin workbook and all
Origin features are available.

.1.10.1 Arranging Child Windows

Origin includes some window arranging tools that go beyond the basic Tile and Cascade functionality. Users
in industry and research who work with high resolution monitors and many windows should find the tools
helpful.

Origin 2023 includes a couple of improvements to arranging of child windows:

e The Arrange Windows dialog adds an Include Minimized Windows check box.

e The new Folders and Windows toolbar has a Pin Active Window button that is

used to exclude the active window when windows are arranged by menu command

or toolbar button. Clicking this button adds a pin button lIl to the window title

bar. Alternately, right-click on any window and choose Pin Window from the
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shortcut menu.

®  QOccasionally, you may decide -- after arranging windows -- to enlarge a window for
better viewing. You can restore the window to its previous size and position by
clicking Window: Restore Window Size (Ctrl + Shift + Z).

6.1.10.1.1 Arrange Windows Dialog

Central to using these tools is the Arrange Windows (winarrange) dialog (Window: Arrange Windows).

B Arrange Windows: winarrange — et
Dialeg Theme | + b
Arrange windows in a certain sequence, o

Columns 3 | [ Auto

Sorting Order By Window Mame Ascending e

Window Name Short Name -

First by Window Type ]

Direction (®) Horizontal First

(") Wertical First

Owverlap Each Column E

Offset (Title Bar Height=10) | 10

Include Minimized Windows [] |

Restore Apply OK Cancel

Use the dialog to sort and arrange windows in the Origin workspace.

e  Arrange windows into columns.

e  Sort by order of activation, Project Explorer order, or window name (ascending, descending).
e  Sort within window type.

e Horizontal (left to right) or vertical direction (top to bottom).

e  Overlap each column (cascade) by user-defined Offset.

®  Save settings as a Dialog Theme.

6.1.10.1.2 Snapping Windows

Windows that are arranged in rows and columns can be "snapped"; that is, dragged and resized along a
common edge. The visual cue for engaging the snap is a green bar.

1. Toggle this feature off or on using Window: Snap Windows (Ctrl+F12).
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® To resize a single window without snapping, press SHIFT while dragging window border.

®  When tiled windows cover the workspace, swap two window positions by pressing ALT while dragging the

window title bar.

e To snap a window into an empty space, press SHIFT while dragging.

6.1.11The Command Window and Script Window

The Command Window can be used to issue LabTalk commands to Origin, to do simple mathematical
calculations, or to check the value of LabTalk variables. The Command Window maintains a time-stamped
command history that can be carried over from session to session, and intellisense which provides auto-
completion features when writing X-function commands.

The Command Window is dockable and has two panels. The left-hand panel displays the command history,
while the right-hand panel provides the command line.

The Script Window provides some of the same functionality as the Command Window. It lacks some of the
Command Window's features (no intellisense, no command prompt, no command history) but it is handy for
running simple LabTalk commands (e.g. changing the value of a LabTalk system variable). The window's Tools
menu also opens the LabTalk Variables and Functions dialog box where you can view a list of Origin
variables, functions, macros, loose datasets, etc.

To open the Command Window:

®  Click the Command Window button on the Standard toolbar. Alternately, select Window:

Command Window menu or press ALT+3.
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To open the Script Window:

®  Select Window: Script Window menu or press SHIFT+ALT+3.

6.1.12The Formula Bar

The Formula Bar is similar to formula bars in OpenOffice and Excel. While it is not necessary to use the
Formula Bar to enter cell expressions, it does offer the advantages of function search, interactive range
selection and improved visibility of expressions, particularly of long expressions that exceed cell width.

Currently- ™"

Selected Plot  Column ‘Worksheet Format Amalysis  Statistics Image Tools Preferences Comnectivity Windc
Cell Eeh sEEB wox - RERBHE BEE & AlEDRe 6.
= L@ o . % Ga @ Defauit Adal w9 - BT U =- M-
€1 7~ % o fx =stddev(B1:810) ~\
A € o fx =stddev(B1:B10)
Cancel Expression/Text, N
oK I

Current Cell

i
Function Lookup Drag Edge to Resize

1. With a workbook active, toggle the Formula Bar on or off by clicking View: Formula Bar on the main
menu.

2. To change font size, change the value of LabTalk system variable @FBFS (default is "130").

For more information, see the Workbooks, Worksheets and Columns chapter.

P ® The Search Functions dialog that is opened from the Function menu in certain

dialogs (e.g. Set Column Values) can be opened by clicking Tools: Search

Functions.

6.1.13The Status Bar

\"‘ Cell Formula: =stddev(B1:E10) 5 Average=0.35958 Sum=0,35958 Count=1 AlU:ON 1: [Book1]Sheet1!3[1:1] Radian

The Status Bar is located at the bottom of the Origin workspace. It reports multiple parameters, including:

e Help messages and tool descriptions.

e  Statistics on the current workbook, matrix or graph selection.
e  Whether the AutoUpdate analysis feature is turned on.

e The name of the System Theme, if any.

. Information pertinent to the active window.

e  Angular unit (radians, degrees, or gradians).

® Tool tips for functions listed in the Set Values F(x) menu.
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e Notifications from OriginLab, represented by a small red flag to the right side of the Status Bar.

Average=0 Sum=0 Count=0 ™} All: ON 1: [Bookl1]5heet

(1 otifications from OriginLab
| Dismiss All|
Qrigin Central Update v2 X

Graphing and Analyzis samples updated’addad

- Line and Symbaol Graphs - Colermapped Line Series opju

- Columin and Bar Charts - Evenly Spaced Column Flot with Numeric X.opju
- Line and Symbol Graphs - B&W Line Plot.opju

= Multi-Panel Graphs - Treat Each Source Graph as a Unit and Add

Labals apju

- Batch Processing opju

Customize and Copy Status Bar Data

®  You can select what shows in the Status Bar by right-clicking on the Bar and selecting (or clearing) items

from the context menu.

e Copy displayed statistical values by selecting Copy Statistics from the context menu. The copied data are

TAB separated between quantity and values, with each key value pair separated by a CRLF delimiter.
6.1.14Smart Hints and the Smart Hint Log

Smart Hints are triggered by user actions and are intended to give the user help with current task. These
hints may appear briefly inside a dialog box, as in this example.

Symbol | Drop Lines | Label | Color List |

b Size ColiC): "Mass'  Scaling Factor 21.6116 - In-Dialog
O E Edge Thickness Default | Smart Hint
Edge Color  findex:Col(D): "Ty... w /
Fill Calor

Go to Color List tab to further customize the colors
Transparency |_J [ Do not show this message in the future I}

Alternately, Smart Hints may appear in the lower left corner of the Origin workspace, as in this example.

=6

You can press Shift key and dick on the menu to open the
dialog with theme loaded,

[ Do not show this message in the future Ik
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Unless you hover over a Hint, it will quickly fade. You can prevent display of individual Smart Hints by checking
the "Do not show this message in the future" box at the bottom of a Smart Hint.

Hints are logged for the current Origin session and can be reviewed by clicking the Smart Hint Log tab,
docked at the edge of the Origin workspace (Note that in-dialog Hints are not logged).

[ YL AL L ULUYL L s SLULLFLALLF 11U

Origin menu for quick analysis.

[B7/14/72813 16:89:86 2325
Select Gadgets: Quick Fit from
Origin menu for quick analysis.

£7 B0 JUIH Hew s

To open (and close) the Smart Hint Log window:

1. From the Origin menu, select View: Smart Hint Log or press ALT+7.

To prevent a particular Smart Hint from displaying again in the current session, right-click on the hint in the
Smart Hint Log window and check Do not show this hint again from the context menu. A message asks you
to confirm that you do not want to show or log this message.

To turn off all Smart Hint display in the session, open the Script Window and type the following:

@SHS = 0;

To turn on Smart Hint display (including those were individually hidden), type @SHS = 1, and click Help:
Reactivate All Hints.

When you set the value of a system variable using the Script Window, you are altering
Origin's behavior for the current session only. To set the value of a system variable
across sessions, see this FAQ.

6.1.15Code Builder

Origin integrated development environment (IDE) is called Code Builder. Code Builder provides tools for
writing, compiling, and debugging your Origin C functions. Additionally, it can be used for running and
debugging Python code.

To open Code Builder:

i 5
1. From the Origin menu, select View: Code Builder or click the Code Builder button ﬂ“” on the Standard
toolbar or press ALT+4.
2. Code Builder can also be opened by clicking Connectivity: Open untitled.py. In this mode, you can

paste and run Python code by pressing CTRL + F5.

52


http://www.originlab.com/doc/Quick-Help/permanent-change-system-variable-value
http://www.originlab.com/doc/python/Running_Python_Code
http://www.originlab.com/doc/python/Running_Python_Code

The Origin Interface

6.1.16Messages Log

The Messages Log window shows messages about operations including Output Information, Results and
Errors. It displays messages that are not sent to the Script Window or the Command Window.

To open (and close) the Messages Log window:

1. From the Origin menu, select View: Messages Log or press ALT+6.

Beginning with Origin 2023, these export dialogs (see bullet list in image) will add a date-
time stamped clickable link to the Messages Log. Click the link to open the file with the
Li=l default application (e.g. Notepad for *.dat).

Messages Log * 0 X

[7/28/2022 11:49:28 expGraph]
Graph114 is exported to

"ChUsers\mike\DocumentsiOriginLabh\User ) body weight_height.dat - Notepad ~ — 0 W

Files\GraphQ1.pdf"

File Edit Format View Help
F F M M
height weight height weight
146 42.2 148 e

150 55.4 150 5B

[7/28/2022 15:58:32 expASC]
UnstackCols1 is exported to
"ChUsershmiketDocumentshOriginlal®User

= - 136 33.2 126 35.9
Files\body t height.dat"” 163 €5 160 44,5
128 28.7 155 46.9
148 50.6 143 42.6
~ 150 47.9 146 35.2
' : 155 42.2
. ) B . o8 44

+ expm2video: Export matrix objects as an image stack &0 536
* expG2img: Export graph with a simple dialog i58 41.3
* explmage: Export matrix image to file e “1‘ -8
* expExcel: Export worksheet data as Excel shest b =0

*  expASC: Export worksheet data as ASCII file G 57.

* cvExport: Export the active image as file o

® To open file location in Windows Explorer without opening the file, right-click on a link
and choose Open File Location; or press Ctrl while clicking on the link.
e Two system variables are added to control image export link behavior. See Exporting

Graphs and Layout Pages to an Image File for more information.

6.1.17Results Log

Origin automatically types many analysis and fitting results to the Results Log. Each entry in the Results Log
includes a date/time stamp, a window name, a numeric stamp which is the Julian day (see Dates below), the
type of analysis performed, and the results.

In most cases, when results are reported to the Results Log, it opens automatically. Manually open (or close)
the Results Log by doing one of the following:
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1.

) == o
Click the Results Log button on the Standard toolbar. Alternately, from the Origin menu, select

View: Results Log or press ALT+2.

Right-click in the Results Log to open a shortcut menu with commands to Copy, Print, Clear..., and View
Results.

6.1.18Float, Dock and Auto-Hide Windows

There are several Origin windows, which can be floated, docked, auto-hidden, or hidden. These windows
include Project Explorer, Results Log, Command Window and Messages Log. This allows you to
customize your Origin workspace so as to maximize utility and save screen space.

6.2 Numbers in Origin

54

Displayed vs. Actual Cell Value: When you import or type your data into a workbook or matrixbook,
Origin uses a combination of user-specified settings to determine how to display the data in each cell.
What displays is a visual representation of the data value. The actual data values are stored with the full
precision allowed by the dataset's Data Type (see table below). When you perform calculations, it is the
actual data values that are used and not the displayed values.

When Contents Exceed Cell Width: Prior to Origin 2020b, if the sequence of characters in a sheet cell
exceeded what could be displayed at the current cell (column) width, Origin represented cell contents as a

series of pound signs (######). This has changed to mimic MS Excel's worksheet behavior:

e  Text strings will not trigger display of pound signs ####+#+# regardless of column width. To
view the full string, you must increase column width.

e  Numeric values that exceed column width will first be rounded to the nearest decimal and
only if that is not sufficient to display the full integer value, will pound signs ####H#+H#

display in place of the numeric value.

e This rounding of numeric values affects the displayed value only. The internally-stored value
does not change.

® To restore the old behavior of displaying pound signs #####+# whenever cell contents were
not fully displayed, set system variable @WPE = 1. For information on changing the value of
a system variable, see this FAQ.

Missing Values in the Worksheet: When spreadsheet programs first appeared it was recognized that
there was a need for a special number that was "not a number" which would - when used in a calculation -
generate itself. Origin has such a number and its internal value is -1.23456789E-300. Because Origin
recognizes this value as a special value, it can be used to enter a missing value into a worksheet or matrix
and it can be used in calculations or scripts (for instance, to return a missing value unless some condition
is met). Origin displays missing values in a worksheet or matrixsheet as "--". However, you shouldn't
confuse this display (output) with what you enter as a missing value (input).

Decimal, Scientific and Engineering Notation: You can display workbook or matrixbook data in

Decimal:1000, Scientific:1E3, Engineering:1k, and Decimal:1,000 notations. You can manually
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choose from these data display options but you can also pre-define thresholds for automatic display of
scientific notation. By default, these thresholds are set to 6 (upper) and -3 (lower).

e Dates and Times in Origin: Origin's long-time mathematical system for dates and time is based on
Astronomical Julian Day Numbers, with a 12 hour offset. This system defines January 1, -4712 (January 1,
4713 BCE), 12 hours Greenwich Mean Time as zero. Recently, two alternate time systems were added: (1)
a true Julian Date value (O is at noon instead of the following midnight) and (2) a "2018" system in which
0 is defined as 00:00 on January 1, 2018. The 2018 system supports greater precision when, for instance,
importing data with the Import Wizard (e.g. Custom Date Format supports "MM'/'dd'/'yyyy
HH':'mm':'ss'."######"). Previously, precision was limited to 0.0001 seconds. For more information, see

Dates and Times in Origin.

Note: For more information on numbers, see

Help: Origin: Origin Help > Origin Basics > Elements of the Origin Workspace > Numbers in

Origin

Origin workbooks and matrixbooks support the following Data Types:

Workbook Matrixbook Bytes Range of Values
double double 8 +1.7E4+308 (15 digits)
real float 4 +3.4E+38 (7 digits)
short short 2 -32,768 to 32,767
long int 4 -2,147,483,648 to 2,147,483,647
char char 1 -128 to 127
byte char, unsigned 1 0 to 255
ushort short, unsigned 2 0 to 65,535
ulong int, unsigned 4 0 to 4,294,967,295
complex complex 16 +1.7E+308 (15 digits), each 8 bytes
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6.3 Topics for Further Reading

56

Project Explorer

Customizing Toolbars

Mini Toolbars

The Object Manager

Finding Data in your Origin Project

Basic Child Window Operations

Numbers in Origin

Dates and Times in Origin

FAQ: How do | turn off the collapsible menus and show full menus?

Customizing Toolbars

Setting Your Preferences

The Numeric Format Tab of Preferences: Options
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7 Origin File Types

7.1 Roundup of Origin File Types

A series of Unicode-compliant (UTF-8) file types was added for Origin 2018. Users
upgrading from previous versions may recognize that the old familiar file types now
have a Unicode counterpart, denoted by an appended ‘u’ (e.g. *.opj ==> *.opju). With
the exception of the *.opj file type, Origin 2023 will read and write both the Unicode
and non-Unicode file types and non-Unicode file types remain backward compatible
with earlier versions of Origin.

e Origin 2023 will still read the older, non-Unicode *.opj file type but you can no
longer save as *.opj. Going forward, you will need to save your project files as

Unicode-compliant *.opju files.

e Origin 2023 still supports saving other non-Unicode file types such as *.ogw,

*.otp, *.0gg, etc.

File Type File Extension Used As

Origin Project

Files *.0pj;*.opju A container for all data. See Alert, above.
Child Window . - . - The child windows for workbooks (.ogw(u)), graph
Files -0gw/(u);*.0gg(u);*-ogm(u);*.txt (.ogg(u)), matrix(.ogm(u)), notes (.txt).

A stored customizable suite of data-handling and
Template Files *.otp(u);*.otw(u);*.otm(u) format options: graphs(.otp(u)), worksheets
(-otw(u)), matrix(.otm(u)).

Import Filter * oif An external file which handles basic import file
Files ) parsing and data extraction.

Fitting Function |, 4 A fitting function definition file.

Files

Region of One or more sets of XY coordinates that define the

*.roi position of one or more regions-of-interest (ROI)

Interest Files within a given matrixsheet or Image Window.

LabTalk Script

Files *.00s A text file organized in sections of LabTalk script.
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File Type File Extension Used As

Origin C Files *.c;*.cpp;*.h;.etc A file used for developing Origin C programs.

X-Function An Origin tool with a flexible mechanism for

Files *, oxf;*.xfc; performing a wide variety of data manipulation
tasks.

Origin Package — A package file created for distributing custom

Files -op applications.
A file that contains Origin menu information. An

Origin Menu * yml*ome: * xml can be edited outside of Origin for menu

Files o ’ customization purposes. An *.omc file contains the
configuration of customized menus.

Initialization % ini A file that controls the configuration of some Origin

Files ) features on startup.

IC:ticl)enSflguratlon *.cnf A text file that contains LabTalk script commands.

Custom Plot - A binary file that holds the bitmap images of custom

origin.uds
Symbols symbols.

7.2 Topics for Further Reading

®  Opening, Closing and Backing Up the Origin Project File

(] Protecting Origin Projects

(] Origin Template Files

e The Theme Organizer

e System Themes

. Import Wizard, Save Filters Page

e  Origin Fitting Functions, the Fitting Function Organizer and the Fitting Function Builder

(] OGS Files and Getting Started with LabTalk

(] Running LabTalk Script from OGS Files

L] Using X-Functions in LabTalk

(] Packaging Multiple Files as an OPX File
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8 Import Data

For data import tasks, click the Data menu or toolbar button

we g (Dot Ju G

Data menu ... Data menu...

Connect to File
> G5V Excel, HTML, JSON, ORJU, etc.

Import From File
> ASCIl, Image, 3rd party

5 Hﬁﬁﬁ.m.mmmm@m.m
Solumn  Warshert Ryt

B A o

Copy & Paste
(Clipboard)
- may require use of

Import Wizard

Connectto Web
> SV, Excel, HTML, JSON, ORJU, etc.

Connectto File
> Origin, HDF, Matlab, etc.

Connect to Database
> 50L data

Connect to Web
> Origin, HDF, Matlab, etc.

Import From File
> ASCII, Excel, many 3rd party

> Import Wizard (ASCII, Binary, U-def) : ; P
de
Data menu__ Drag & Drop Import E ﬁ"wf'
Import Wizard > Connectors (limited types) 5 i
> ASCII, Binary > Import Filters {builtn) ' e
. fic:|
> Import Filters [custom) ] Emm.
Insert menu_ defined w/ Import Wizard : '
Images from Files : A |scmemaie
> BMP, GIF, JPG, etc. PR - R T S TR T T TR
Exeripea Suned CourtaQ M G0 Of 1 Boakifneeti| Radan

A new generalized data import mechanism we call Data Connectors was added in Origin 2019b. As the name
implies, Data Connectors create a link between your project and an external source file. The source file may be
local, it can be on a company network; it can even be on a web-server. Data Connectors support options for
excluding imported data when saving the project (smaller files, plus, maintain a live link to source data) and
for protection of data against accidental alteration or deletion. Data Connectors also make possible import of
previously-unavailable data sources, including HTML Tables and JavaScript Object Notation (JSON). Data
Connectors support drag-and-drop and Auto Import on Project Open. In addition, OriginLab continues to
expand Connector support to new data formats. In Origin 2021b, for instance, we have improved Connectors
for National Instruments TDMS and NetCDF files; plus we've added a new Thermo Fisher Scientific
MSRawfFile Connector.

Other supported import mechanisms:

e  OriginLab continues support for Origin's long-standing X-Function + filter-based routines for ASCII,
CSV, Excel, binary files, and many third-party formats, including MATLAB, pClamp, NI TDM and NetCDF. If
you are a long-time user and you have import filters and Themes that you have long relied on, they
should still work as they always have.

e Copy-paste for quick import of simply-structured data (mostly useful for quickly adding data to
worksheets).

e  For complex ASCII, binary or User-defined file types, you can use the graphical interface of the Import
Wizard to parse your file and save settings to an import filter file. The Import Wizard supports power
features such as saving file metadata to variables and use of custom Origin C functions for data
processing and import.

e If you work with SQL databases, you can use Origin's Database Connector and SQL Editor interface to

create connection strings and SQL queries.
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8.1 A Note to Upgrade Users

Longtime Origin users who are upgrading from older versions should note that import routines have moved
from the File menu to a new Data menu. Here, you will also find Origin's newest data-import tool: Data

Connectors.

@ OriginPro 2022b - UNTITLED *

File Edit View |Data| Plot Column Worksheet Format Analysis  Statistics  |mage Tools

[

18 1 - Connect to Cloud...
R S R
Connect to Web...
Ko Ix

o) Connect to File

Y

Connect to Database
Connect Multiple Files...

Clone Import...
Re-Import Directly Ctrl+4

Re-Import...

- 32 pd pf =l

Import All Connected Data
Import From File

Define Mame... Ctrl=L
MName Manager... Ctrl+F3

1implmage: <Last used=

2 impASC: <Llast used=

3 Connector - Text/C5V [File]
4 Connector - Excel [File]
5 Connector - NetCDF [File)

-

0m - SBERE B=EE

Preferer

Fe = & | Fp Default: Arial |0

*

B I

e [Data Connectors

Older Routines

Import Wizard... Ctrl+3
Single ASCIL..
Multiple ASCIL..

VarsFromFileMameAndHeader...

Image to Matrix...

Thermo [5PC, CGM)...
pCLAMP [ABF, DAT, ABT)...

Princeton Instruments [SPE]...
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8.2 Data Connectors

The XML Connector is installed, by default, for Origin 2023.

- o
( ! } W E”] | I A Lpt il =
P
~eafig Name Rank Couniry km2) Density Mank o | Coumiry o  Popuistion » | Ares fkmi) e m:l':r“"'mzr
Units 1| —Cingagons 5638, 700 Ll T2
Commenis | [l Bangladesh | 155090,000 143558 1453
Fix)= 3| [l Taiwan 25577 468 56,193 L]
1 1 Singapore 5638700 710 7942 4| == Letancn £.083,509 10,422 &3
2 2 Bangladeshyf 16G01EB | 143008 1153 5[5 seunavea | 515250 = =
3 3 Taiwan 235TT5E7 | 36193 651 e F—— — e
4 4 Lebanon 5093509 10432 283 7 :u-r:'u-:. nds | 17.300.000 1 596 7
5 5 South Korea | 5.16353E7 | 99538 518 = ;_ml e = e
6 & Rwanda 1.20011E7 | 26338 456 e EE RN =
! 7 |Netherands 17367 41526 il 10| = terat £.980,000 22072 407
8 8 Haiti 1111297 27085 411 | ., = =
Q 9 lndia 13431FE9 | 3987740 ann — .
4 [ v |\ Sheet1 £ Sheet2 / < =

Data Connectors are a general mechanism for importing data to your Origin projects from local or from web-
based files and pages. Data Connectors differ from older Origin import methods primarily in two default (but
modifiable) behaviors:

e Data imported via Connector is locked to editing. This helps ensure data integrity.

e Data imported via Connector is not saved with the project. This helps to keep your project files smaller.

Data Connectors support a number of common data formats, including:

e Text/CSV

e Excel

e Origin File (project, workbook, matrix)
L] MATLAB

e JavaScript Object Notation (JSON)
e HDF

e TDMS

e HTML Table

e Import Filter (use a custom import filter with the Data Connector mechanism)

e  Shapefile
e NetCDF

e XML
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To connect to SQL database, see Database.

To import data with a Data Connector:

1.

8.2.1
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With your workbook active, click the Data menu.

e |If you are connecting to a local or network file, click Connect to File and pick a file type.
e To connect to multiple files, click Connect Multiple Files.

. If you are connecting to web data, click Connect to Web and enter a URL.

For Origin 2023, the Connect to Web dialog splits out Sample URLs from Recent
URLs: The Recent URLs will continue to list your connections, while Sample URLs will
list some example connections in formats such as CSV, HTML, JSON, and MATLAB.

& Connectto Web =] *
Sample URLs¥|Recent URLsW File Type J
®Basic O Advanced

URL

vau can use LabTalk string variables in the url above)

Things to Know about Data Connectors

By default, when import data file size exceeds 500kB, the imported data and graphs made from that data
are NOT saved with the Origin file (see LabTalk system variable @ESE). All analysis output resulting from
imported data ARE saved with the Origin file. Not saving raw data with your project file can significantly
reduce file size and improve performance when working with large projects.

IMPORTANT: Since, by default, connector-imported data (> 500kB) is not saved with the project file,
users should always ask themselves whether they need to preserve imported data. This could be an issue
when the data source is web-based and stored in a place beyond your control. If you prefer to save all
data imported via a Data Connector, with your Origin file, click the Data Connector icon and clear the
check mark beside Exclude Imported When Saving prior to saving your file'. Note that each Data
Connector-containing book will have its own Exclude... check mark. Alternately, if you decide the Data
Connectors are not needed, you can click the Data Connector icon and choose Remove Data Connector

(from this book) or Remove Data Connectors from All Books (in the project).

Data can be re-imported at any time by clicking the Data Connector icon (E‘ or E‘) in the upper left

corner of the worksheet and choosing Import (Ctrl+4) or Import All.
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By default, imported via a Data Connector is locked from editing. You can graph it and analyze it but you
cannot modify it. While this ensures against accidental modification, some users may find this too
restrictive. Unlock sheet data by clicking the Connector icon and choosing Unlock Imported Data. See
this FAQ for more information on removing editing restrictions from Connector-imported data.

A workbook can have only one type of Connector (e.g. Text/CSV). For files with a simple structure such as
Text/CSV, you can have multiple sheets with each connecting to a separate file, as long as they share the
same Connector. For files with more complex structures such as Excel or MATALAB, you will initially
connect to one sheet/variable, then use the Data Navigator's Add and Connect Sheet(s) shortcut menu
command to add other sheets/variables in the book, as needed. You can only connect a single Excel or

MATLAB file to a single Origin workbook or matrixbook.

In books containing files with a simple structure (e.g. CSV), when you right-clicking on a sheet tab and

add a new sheet, the sheet is added with an empty Connector. The unconnected state is denoted by a

pale-yellow Connector icon % (see Connector states, below). Click on the Connector icon to open a

shortcut menu where you can connect the sheet to a data source.

[ ]
| A
Import
Import All Sheets
Import All Books
Auto Import 4
Unlock Imported Data
———— Disconnect Sheet B4
IE'W Remove Data Connector... < » |r

Remove Connectors from All Books...

Exclude Imported When 5aving
Common Data Path (Undefined)...

Data Connectors that you do not use can be hidden by choosing Data: Connect to File: Customize...

and clearing the checkbox next to unused Connectors.

Data Connectors for file formats not shipped with Origin, are available by clicking Data: Connect to File:

Add New.... New Data Connectors are added to the Data menu.
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Data | Plot Column Worksheet Fo

Connect to File - IS0
i’ Connect to Web... Crigin File
Connect to Database L4 HTML Table
¥ Connect Multiple Files.. e AL
B3 Clone Import AT
B =~ HDF
8% Re-Import Directly Ctri+4 Excel
Bt | Rempot... NetCDF
ﬂ;-_, Import All Connected Data Text/CSV
Impart From File ¥ 3 Customize...
e A d Mew..,

TOrigin caches data imported by Data: Connect to Web, for a period of time
determined by LabTalk system variable @CFDT, plus file size. By default, a 10MB file
will use cached data for ~24 hrs. In other words, if you re-import (i.e. reconnect to the
web file) within 24 hrs, you will be using data that was cached on first import. If you
re-import to this 10MB file after 24 hrs passes, the cache is cleared and the data are
freshly imported. To learn how to control this caching behavior see, these topics:

e |abTalk system variable @CFDT.

e The LabTalk delete -web command.

8.2.2 Data Source File Path

A Data Connector icon appears in one of five states:
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When the data source is connected, the icon looks like this: !—"

When data in the sheet are unlocked to editing (either by the Connector menu or @IPDC=0), the icon

looks like this: %
When a data source import is pending, the icon looks like this: r;_l—"
When a new sheet is added to a connected book, an empty Connector is added to the sheet and the icon

looks like this: %

When the data source is no longer viable (e.g. the data source has been moved), the icon looks like this:

2

When the sheet is protected against all edits (worksheet protection), the Connector menu is disabled and

the icon looks like this:%


http://www.originlab.com/doc/LabTalk/ref/sys-var-list
http://www.originlab.com/doc/LabTalk/ref/Delete-cmd
http://www.originlab.com/doc/Quick-Help/Change-Data-When-Connector-Used
http://www.originlab.com/doc/User-Guide/Worksheets-Columns

Import Data

Regardless of the state of the connection, you can click the Connector icon, then use the Data Source File
Path and Common Data Path to help you maintain the connection between your Origin files and your source
data.

B Data Source File Path ? x

ou can click the radio choice to switch to relative file path

: (@) Relative to Project path )
[ . ata path

File path \Origin2019b\Samples\Batch Processing\ T273K.csv
Import Project Path E:\Project_Data\Origin 20190\ Project Data
Impaort All Common Data Path  E:\Project_Data\Origin 20196\ Project Data'\ Origin2019b\Samples\Batch Processing,

Disconnect Shee I oK | Cancel

— Remove Data Connectar...

B Exclude Imported When Saving

B Common Data Path (Undefined)...

8
13 1’ Common Data Path ? b4
4 [» \T275K £ T285K £ 1
E-\Praject_Data\Origin 2019\ Project Dats\Origin2013b\Samples\Batch Processing\ |E

This path is saved into the project for connectors in all the books to share

0K Cancel

e Relative to Project Path: If your data are stored in folders under the project file, you could set Data
Source File Path to Relative to Project path. You can then move the project and data sources together,
and their relative paths are preserved. No path corrections are then needed when re-opening the project

file from a different location on your network.

e Relative to Common Data Path: If data sources are under some common path, you could set Data
Source File Path to Relative to Common Data Path. If the files are subsequently moved, you can re-

establish the Common Data Path and then Import All Books.

8.2.3 Data Navigator

The Data Navigator is a collapsible panel that is automatically added to the workbook when you connect to
multi-page/multi-variable files such as Excel, MATLAB or Origin Projects.
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8.2.4

Hide Mavigator, Restare by clicking B and choosing
Data Show Data Navigator

Navigator | x |»| «—————— Collapse or expand
Excel Sheets MNavigator panel
Gil
Natural Gas «—————— Right-click on a sheet name:
Coal Add and Connect Sheet(s) Add dimmed sheets
Total Primary Eneray Delete Connected Origin Sheet(s) Delete connected sheets
= [ ]
B A) | B0 | cw) [ om [~
Lang Mame Year Crude Ol Production | Estimated Petroleum MNet Exparts Ol Consumption
ol Units 1K BamelsDay 1K Barrels/Day 1K BamrelsDay
aan Commenis || = Enerq.l'lramwﬂon .:dmumstrahﬂ.l
alra Fixe
1 2013 7441 4904 -6618.3613 189461,1285
2 2012 6496 6967 TIT15197 18480.2136
3 201 B§44.7918 -B753 8067 18882.0725
4 2010 B481.8712 -Bad4 537 19180.126
5 20049 5349.8328 -0641.315 187714 | ¥
[«T+T\oa f 1K e

Origin will import data from the first sheet and list other sheets in dimmed type.

Right-click on a dimmed sheet -- or press CTRL or SHIFT and select multiple sheets -- then choose Add

and Connect Sheets.

The file name is assigned to the book Long Name and sheets are the original sheet name is assigned to

sheet Name.

Connected sheets can be deleted from the current Origin workbook.

Data Connectors and Drag-and-Drop

There is drag-and-drop support for the file types listed under Data: Connect to File:

For files with a simple header information (e.g. only column name and units), a Data Connector is added
and the file is properly parsed with no need for an import filter.
For files that are not properly parsed (i.e. header information ends up in the data portion of the

worksheet), consider making an Origin Import Filter (*.0if) file using the Import Wizard.

Import filters can be saved to the data file folder, the User Files\Filters folder or in the current window. If
you intend to use a template for your data import, you can save the filter to the window; otherwise the

filter file (*.0if) should be placed either in the data file folder or in \User Files\Filters.

8.3 Connecting to Text/CSV

You can use a Data Connector to import local or web-stored text files (TXT, DAT, CSV). Data Connector
methods work well for these file types, simplifying and in some cases eliminating, some of the problems
associated with Origin's older X-Function-based import routines. For instance, import of date-time data always
required manual configuration of date-time columns. With Connectors, if your date-time data are of a standard,
easily-recognized format, that configuration is done for you automatically.
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Origin's Text/CSV and Excel Connector improvements for Origin 2023:

Rename using File Name: CSV only. Options for Sheet and Book Long Name.

e Save as Default: CSV only: Button for setting Sparklines and Rename settings as

default.

e Post Import LabTalk Script: Run script for post-processing of data on import.

8 CSV Import Options
ASCI CSV wath Quotes.csw

? X

Main header lines

Data has column name Z
Data has units A
Data has Comments HNone

Main header lines detected: 0

Import first 50 lines as preview [
Partial Import O

| Data Block Marker O

To connect to a file on a local or LAN drive:

|87 Other Options =

Bl Add Sparkiines

OINe

() Ves

() s if <= 20 columns

() ¥es if <= 50 columns
El Rename using File Name

Sheet =1

Book Longname |

Post Import LabTalk Script

| whks.col3type=3 //set 3rd col as Y Error ‘

Example:

whs.ncols=wks.ncols+ 1;whks.col=wks.ncols;wks.col.formula$=B-A;

Set as Default Cancel

With the workbook active, choose Data: Connect to File: Text/CSV.

Browse to and select your file.

Set your CSV Import Options. In many cases, you can simply accept defaults and your file will be

cleanly imported, so as a test, try importing data without modifying defaults. If the results are

unsatisfactory, rerun the import and modify the default settings.

In this mini-tutorial, we use the Text/CSV Connector to import a text file with a date-
time component. While older Origin import methods treated the date-time data as text,
requiring the user to manually set the date-time column to Date after import, the Text/CSV
Connector is able to automatically configure the worksheet column on import.
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Click the New Workbook button

= and choose Data: Connect to File: Text/CSV.

Browse to the <Origin Program=>\Samples\Import and Export\ folder and open Date

with higher precision.dat.

In the CSV Import Options dialog, accept default settings and click OK. Data are

imported to the workbook.

Click on the column A header to select the column, then right-click and choose

Properties. Note that Format has been automatically set to Date, Display has been

set to Custom Display and a custom format shows in Custom Display.

11 0
|« [+ [\, Date with higher precision

B width
1.0427 Column Width [15.8
1.4317
12281 Apply to all |
1.3622 E options
1.8348 Plot Designation X v
1.7184
1.3528 Format Date L¥]
1.9785

Display Custom Display W

[ ]
H—F‘LJAA\“N,.\/\,JH pa

Comments T

Custom Display

MM/ddyyyy HH:mm:s5.8## w

Apply to all columns to |_|
the right

In this mini-tutorial, we use a Data Connector to import multiple files. These identically-
structured files have multiple rows of metadata that we want to preserve. So, you will
make use of an import filter file that has been developed using the Import Wizard, to
import the files and write file metadata out to multiple column label rows in each
worksheet. In so doing, you will see (a) how to import multiple files using a Data
Connector and (b) how you can use an import filter file (*.0if) developed with an earlier
version of Origin, to import files using Origin's newer Data Connector technology.

4.

Start a new project and with the workbook active, choose Data: Connect Multiple

Files.

In the files2dc dialog box, set the following:

O Data Connector = Import Filter

(0]
o

(o}

Source = Specified Files

File Names = <Origin Program=>\Samples\Import and Export\S15-125-

03.dat, S21-235-07.dat and S32-014-04.dat

Same Book = enabled (checking the box will bring all files into one book)

Click OK and in the dialog that opens, set Import Filter = Data Folder:

VarsFromFileNameAndHeader.oif

Click OK and the three files are imported as separate sheets in the workbook.
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To connect to a file on the Web:

1. Choose Data: Connect to Web.
2. If you have a file URL, enter it in the URL box. Otherwise, set File Type to Text/CSV (optional but helps
to filter Recent URLSs), then click directly on Recent URLs and pick from the list.

& Connectto Web O »
Sample URLs¥]Recent URLSV | == File Type TEKUCW E
® Basic O Advanced
URL

... ar paste a URL here

URL Preview (vou can use LabTalk string variables in the url above)

You can use the CSV Import Options dialog to specify a partial import of web-stored
files just as you can for locally-stored files. Check the Partial Import box for guidance
on the syntax used to define Column and Row import.

Note: To learn more about working with the Text/CSV Connector, see the Origin Help:

Help: Origin: Origin Help > Text/CSV Connector

8.4 Connecting to MATLAB Files

While Origin continues to support older X-Function based MAT file import, Data Connectors offer some distinct
advantages for import of both locally-stored and web-stored MATLAB files:

e Connecting to a MATLAB file at the root level will add all variables as Origin matrix objects in the

matrixsheet.

e Aslider is added so that you can flip through Origin matrix objects in the sheet. You can toggle between

slider and thumbnails using the Slider or Thumbnails Mini Toolbar button.

e The Connector also adds a collapsible Data Navigator panel to the window. If you wish to add variables

as individual sheets, you can right-click on the Data Navigator list and add them.
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To connect to a MATLAB file:

1.

and enter a URL to your .mat file.
Select the variables that you want to import (add them to the Browser's bottom panel) and click OK.

2.

With a workbook or matrixbook active, click Data: Connect to File: MATLAB or Data: Connect to Web

Help: Origin: Origin Help > JSON/MATLAB

Note: To learn more about working with the JSON/MATLAB Connector, see the Origin Help:

8.5 Connecting to NetCDF and Shapefiles

The NetCDF file format is used for sharing multi-dimensional scientific data. The format is widely used in
climate science. Shapefiles are commonly used to store geographic boundaries and other geo-spatial data.

8 Data Connectes Browser =
| Comtents Double- chek to select)
| Data Typs flaat
|
| Bimension Names tirmelB] * bat{ 120] * lon{300]
| Bemensionalicy El
| Uinits mmdday
 Daily Arcumulsted Precipretion QS Maonthiy Average of Daily Accumulated Precipiation
=

15 Precistation, Monthly &verage {mm/day), 1959 °

Cata Range

[

HetCDF/precip

| precip

[MiElock Tprecp! Mat
[MiBiock Trect! Mat ™
[MBiook Tiprecinl Mab {1 965-00 &
[Mfkock Tiprecip! Mat]
Mook Tprecn! Mat
[MBck ThsemcialMat ™
[Mfkock Tiprecin| Mat ]
[MiBook Tjprecin!Mat{™
[MiBkook Tprecr! Mat "1

13650201 D0-00"
00 - 15650301 08:0

W esithly & s it

o008

vyt 19501181 00:00 -

808 1060 1500 008 2500
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To connect to a NetCDF file:

1. With a workbook or matrixbook active, click Data: Connect to File: NetCDF; or Data: Connect to Web
and enter a URL to your .nc file.

2. Select the variables that you want to import by adding them to the Browser's bottom panel.

3. Adjust Import Options ("pencil” button) as needed and and click OK twice.

4. If a workbook is active but the variable requires a matrixbook, you will be prompted to add a new

matrixbook or an embedded matrixbook in the active workook.

To connect to a Shapefile:

1. With a workbook or matrixbook active, click Data: Connect to File: Shapefile and browse to and choose

your .shp file.
2. Specify whether to Load Attributes and (optionally) encoding and/or Convert to WGS84, and click OK.

For Origin 2023, the Shapefile Import Options dialog gets a Convert to WGS84
check box to convert shapefiles with distances in meters, to the WGS system with
longitude and latitude.

Ly |

B Shapefile Import Options ? .
1995g.5hp

Load Attributes

Code Page Auto e

Convert to WGS84 [

QK Cancel

Note: To learn more about working with the NetCDF Connector, see the Origin Help:

Help: Origin: Origin Help > NetCDF Connector

8.6 Connecting to a Cloud Drive

You can connect to Origin, MS Excel and ASCI I files stored on MS OneDrive or Google Drive. Once you've
established your account credentials, connecting to cloud files is similar to connecting to local files:

1. With a workbook active, click Data: Connect to Cloud. This opens the browser for picking files.

2. Use the browser's drop-down controls to switch cloud services or accounts, if needed.
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B’ Onelrve - OriginUser2022@0utlook.com x

< OneDrive W Refresh fOriginlab,/Test_Connect_2022

Type Size| Descrip

Flefolder | |
Batch Peak Analysis.opj Origin Project 224 KB
ColorScale_in_image_Plot.opju Origin Project 10 ME
Connected _xlsx_csv.opju Ongin Project 61 KB
E| Experimentl.xlss MS Excel 11EB
H Fl.dat octet-stream 9372 Byte
L pulse_indexed.xt text/plain £25 Byte
Sensor Analysis.ogw Origin Window 221KB
2] T2T5Kecev octet-stream GEE
£ >

o) Cancel

3. Pick a file and click Open.

Note that the first time you connect to a cloud account, you'll be asked to verify that account. OriginLab will

only access and transfer data between your cloud account and your local computer using a temporary file. No
other communication of information occurs.

8.7 Working with Excel Data

There are several ways to work with MS Excel data in Origin:

®  You can copy Excel data to the Clipboard and paste or paste link that data into Origin.

® You can use a Data Connector to import a local Excel file by (1) clicking Data: Connect to File: Excel,

(2) clicking the Ebutton on the Standard toolbar, or (3) dropping your Excel file onto the Origin
workspace.

®  You can use a Data Connector to import Excel data from the web by clicking Data: Connect to Web:
Excel (see below).

®  You can use Origin's older X-Function-based routines to import a local Excel file by clicking Data: Import
From File. This option was recently hidden to accommodate the Excel Connector but if you prefer to use
this method, see this section of the Origin Help file.

Things to know:

e  Origin imports files of type .xls, .xIsx or .xlsm.
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e |If you are importing data using the Excel Connector, you can refresh your Origin-side data at any time by

clicking the Connector icon %and choosing Import; or re-import your Excel data at the time that you
open the Excel-connected Origin project.

. If you are using the older (X-Function based) impMSExcel import routine: Certain file import information is
saved to the workbook on import. Having once imported an Excel file to an Origin workbook, you can use
the Re-import button on the Standard toolbar to re-import an updated Excel file -- including those that
contains multiple sheets -- to your Origin workbook.

e  Origin does not support dynamically linking one Excel workbook with another Excel workbook, nor does it

recognize or translate Excel formulas.

Note: To learn more about working with Excel data, see the Origin Help:

Help: Origin: Origin Help > Working with Microsoft Excel and Connecting to File > Excel

Both the Excel Connector and impMSExcel routines support partial import of Excel
data. For more information, see the Origin Help file topic Partial Importing and Re-

importing.

8.7.1 Connecting to Excel Files

In addition to new import options for Text/CSV and Excel Connectors for Origin 2023,
the Excel Connector better handles merged data cells on import:

. e  For merged cells in the label rows that are designated as Comments in Excel Import
Options, (1) vertically-merged values are imported as one value; (2) horizontally-
merged values are duplicated across merged cells.

e Merged cells in the data area (3) are not kept; merged cell values will be duplicated

across merged cells.
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Origin's Data Connectors create a live link between your external data files and your Origin project.
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To connect to a local file, click Data: Connect to File or click the Jbutton located on the Standard

toolbar.

To connect to a web-stored file, click Data: Connect to Web.

You can connect one Excel file per Origin workbook.

If the file is a multi-sheet file, you must first connect to a single sheet. This opens the the Data

Navigator panel (described above) where you can connect to additional pages, as needed.

When all sheets are identically structured, ensuring that the first sheet is properly parsed (e.g. the header

information is correctly handled) will allow you to connect additional sheets without making adjustments.

A B C D

E E G

C

Source: U.S. Energy Information Administration

Estimated

B Excel Import Options ? x

United States Energy (1980-2013) xls

Petroleum Oil B| Excel Sheet il w
orts—Eensumption Main header lines Auto
1K 1K 1K E] Column Labels
sDay BarrelsDavy BarrelsDay Ba oy B
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1. Click the New Workbook ™= putton to create a new workbook, then choose
Data: Connect to File: Excel.

2. Browse to and open <Origin Program=>\Samples\Import and Export\United States
Energy (1980-2013).xls.

3. In the Excel Import Options dialog that opens, accept default settings and click
OK.

4. In the Data Navigator panel that opens to the left side of the workbook, hold the
CTRL key and select the other three (dimmed) sheets, right-click and choose Add
and Connect Sheet(s). The remaining sheets -- Natural Gas, Coal and Total
Primary Energy -- are imported into the workbook. Note that if the unconnected

sheets are large in size, you can opt to connect to them one-at-a-time, as needed.

8.8 Import from File

The import routines listed under Data: Import From File pre-date Data Connectors. While the Import From
File routines are no longer being developed, they are still supported.

Note, also, that Connectors may not exist for some of the file types listed in this table. If no Data Connector
exists, you should use the Data: Import From File methods.

1ty
The Standard toolbar Import Single ASCI1 button B now calls the Data: Connect
to Files: Text/CSV routine. For the impASC routine, see the next section.

8.8.1 Importing ASCII Files with impASC

FLEEY
e The Data: Import From File: Multiple ASCII... (H?E ) method is generally satisfactory for importing

text files having a simple structure (works for single or multi-file import). This routine will typically handle
files with commonly-used delimiters and a simple header structure, without adjustments.

. If the file import needs adjustments, select the Show Options Dialog checkbox when selecting your
file(s) in the ASCI I dialog. This will open the impASC dialog box prior to file import, allowing you to

tweak the way that the files are handled.
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Calurmns

[ Header Lines
Murnber of Main Header Lines [exclude subheader lines) 1 -
Auto Determine Subheader Lines [
Line Murnber Start frorm Battarn
Mumber of Subheader Lines B -
Eutract Long Mames and Units from S ame Line [
Short M ames 1 -
Long Mames 2 -

[ - 2 -

Note: To learn more about working with the ASCI1 Import using the impASC dialog, see the Origin
Help:

Help: Origin: Origin Help > Customizing the ASCII Import Options

8.8.2 Saving Import Settings

Once you've adjusted impASC dialog import settings, you can save them in one of two ways:

e  With the worksheet template.

e As a Theme file from within the impASC dialog box (including saving for drag-and-drop).

Saving import settings with the worksheet template offers portability (e.g. templates are easily shared with
colleagues). Saving import settings as a Theme offers the advantage of being able to recall any number of
import options combinations (Themes) when importing via the impASC dialog box.

For more information on Themes and templates, see the Customizing Origin chapter later in this User Guide.
Additionally, see topics listed under "Topics for Further Reading", below.

|, You can quickly load your custom import theme from the list at the bottom of the Data
' menu. You can also use the Data: Import from File: Add/Remove File Types ...
menu to open the Import Menu Customization dialog box where you can select and
add User Themes to the Data: Import From File menu.

8.8.3 Third Party Formats

If a Data Connector does not exist for a certain third-party format, you can still use Origin's older X-
Function-based import routines. These include many widely-used formats, including pClamp, NI TDM, and
NetCDF. As with all X-Function-based routines, you can customize third-party file import options and save your
settings with the worksheet template or as a dialog Theme for later use. As with other supported file types,
you can import third party files by drag-and-drop.
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To Learn More, see

File Type Method Help: Origin: Origin Help > Importing

and Exporting Data

Thermo (SPC, CGM)
pCLAMP (ABF, DAT, AB?)
Princeton Instruments (SPE)
Sound (WAV)

NetCDF (NC)

CDF (CDF)

HDF5 (H5, HE, HDF5)

NI DIAdem (DAT)

Famos (DAT, RAW)

ETAS INCA MDF (DAT, MDF)
IgorPro (PXP, IBW)

Prism (PZFX, XML)

MATLAB (Mat)

Minitab (MTW, MPJ)
KaleidaGraph (QDA : . i i
SigmaPlot ?JNI(B) ) Eitrﬁ ;Wep:ort > Importing Third Party Files
MZXML(mzData, mzXML,
mzML, imzML)

EarthProbe (EPA)

EDF (EDF, BDF, REC, HYP)
Somat SIE (SIE)

JCAMP-DX (DX, DX1, JDX,
JCM)

HEKA (DAT)

SPSS (SAV)

BRUKER OPUS

SAS (sas7bdat)

Tektronix (ISF)

Data Translation (DCF, HPF)
Binary 2D Array (IMG, B2D)
Image

Note: Some of these 3rd party file formats are hidden by default. To add, choose Data: Import From
File: Add/Remove File Types.... This opens the Import Menu Customization dialog box where you
can choose which file types to show in the Import From File menu. To insert a separator after a menu
command, right-click on the command in the right-hand panel and choose Add Separator. To remove a

separator, double-click on it in the right-hand panel.

If no Data Connector exists for a given file type (i.e. those listed in the table above),
then drag-and-drop support is managed by file extension, using the Filter Manager
dialog. From the main menu, click Preferences: Import Filters Manager....

Note: To learn more about working with the Third-party Formats, see the Origin Help:
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Help: Origin: Origin Help > Importing Third Party Files

8.9 The Import Wizard

For import of complex ASCII files -- those not satisfactorily handled by the methods previously discussed --
you can use the interactive Import Wizard. Files with an optional header section followed by a sequential
binary structure, can also be imported using the Import Wizard:

Another advantage to using the Import Wizard to your ASCII data is that you can create import filters that are
targeted to a group of similarly-named data files. This is especially helpful when those files contain metadata
that that needs to be handled in a certain way. The filter can then be used for drag-and-drop import
operations and it can be added to the Data: Import From File menu.

Origin 2023 adds GUI support for editing of import filters (*.oif) developed using Python
or Origin C code:

® The user can access this dialog by choosing Preferences: Import Filters Manager,
then picking a filter and clicking the Edit button. User-defined filters in the User
Files\Filters folder will list here.

e Note that the iwFilter dialog now has a User Defined branch with three options:
Python Code (incl. a text box for adding or editing code); Python File for pointing to

a .py file; and Origin C for specifying your Source File and Function Name.

8 Impert and Export: maFilter 7 x

Create or edit an import filter

Filter Mame Ci\Users\mike\DocumentsiOnginLab\User Files\Filters\CustomExcellmportFilter.oif

[# General Impaort Setting
= User Defined
B Python Code [+

import originpro as op
import pandas as pd

def read_file(file):
whks = op.find_sheet()
wh = wks.get_book()

#= cycle sheet

df = pd.read_excel(file, sheet_name=2)

header = list{df.columns)

cols = [6, 5, 4, 3] W
PO S T 1]

Pythan File ]
Origin C |:|

Load... Save As... Save Close

For basic information on programming options in Origin, see the Programming in Origin
chapter.

To run the Import Wizard:
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o
1. Choose Data: Import From File: Import Wizard... or click the @ button located on the Standard

toolbar.

e Develop Origin import filter files (*.oif) for import of ASCII files not handled satisfactorily by the Text/CSV

Connector.
. Import data from the web pages using the Clipboard (see below).
e  Extract variables from the import file name and header.
e  Specify custom delimiters and date formats to parse your data.

e  The ability to post-process your imported data using a custom LabTalk script.

Note: For more information, view the help topic:

Help: Origin: Origin Help > Importing and Exporting Data > The Import Wizard

8.10Copy/Paste the Clipboard Data

One obvious way to get data into Origin is simply to copy data to the Clipboard and paste it into Origin. This
can be as easy as selecting a block of data in an Excel workbook and pasting it into an Origin workbook.
However, Clipboard data may not be formatted, arrayed or delimited in a way that makes it easy to paste your
data into Origin. Here are some things you should know:

e Data copied from Excel and pasted to Origin will be brought over with full precision, regardless of the
number of displayed decimal digits in Excel.

e  When working with Excel files with header information, paste the Clipboard data into data row 1 in Origin
(not into the column label rows), then select a row and use the (right-click) shortcut key commands Set

as Long Name, Set as Units, Set as Comment, etc. to tag your header information.

e Data copied from the web can be formatted in various ways. You may have to experiment a bit to find a
method that brings the data over cleanly. If a simple copy and paste doesn't work, try using the Import
Wizard. The Import Wizard provides an interactive interface for parsing Clipboard data, with the added
benefit that you can save your procedure to an import filter file (.oif) for reuse with identically formatted

data. For more information, see the tutorial Using the Import Wizard to Import Clipboard Data.
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8.11 Selectively Import Data by Querying an Origin File

You can selectively import columns of data from an external Origin file by specifying an SQL-like Query in the
Data Connector Browser prior to import.

B Data Connector Browser

Contents (Double-click to select)
I ]
= QueryEx Folder
= Folder1 Folder
= Book? - 521-23 W7 Select Query
Trial Run 2
= MyBook - §15-| Ju ——
Trial Run f<J/Select Column from Project where _LMa 1iw
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To selectively query Origin files using the Origin Connector:

1. With the worksheet active, choose Data: Connect to File or Connect to Web.

2. Browse to your Origin file and click Open. This opens the Data Connector Browser.

W

Click the Select Query button

J

Enter your Query in the Select Query dialog, then click OK.

Data will be selectively imported into the active workbook as specified by your query.

Common Keywords:

Keyword Description
_SName short name, e.g. _SName, Sheet_SName
_LName long name, e.g. _LName, Book_LName
Comments comments, e.g. _Comments,
- Sheet_Comments
Column_D1 column user-defined parameter, where 1

is the parameter index

Column_[Name]

column user-defined parameter, where
[Name] is a parameter name containing

spaces

Examples:

Select Column from Project where _SName == "A";

Select Column from Project where _Comments like ""S*3";

Select Column from Project where (Column_P1 like "*y*" and Column_D1 > 3);
Select Column from Project where Sheet_SName like "Trial*";

Select Column from Project where (Book_SName like ""Book*" or Book_LName like

UEFITETY)

For more information, see Examples of using SQL query condition in Origin Connector.
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8.12 Database

Origin supports connecting to databases by ODBC and OLE DB. Additionally, Origin includes a simple SQL
Editor to add connection strings and generate SQL queries within Origin.

To import SQL data, start with the Data: Connect to Database menu command:

Open lets you browse for and open a saved connection (ODS) or query (ODQ) file.

New opens the Database Connector dialog.

® | Databaze Connector ? >

El What would you like to use to make the connection?
() Connection string
(®) ODBC data source

() ODBC driver
OWindnws's ‘Data Link Properties” dialog

|:| Encrypt Connection Credentials

QK Cancel

e Connection string: Select this if you already have a text-based connection string for a
given data source (ODBC or OLE DB).

e ODBC data source: Select this if you have defined an ODBC data source via the Windows
ODBC Data Source Administrator applet.

e ODBC driver: Select this if you have an ODBC driver and want to create a data source
applicable to this data connector instance.

e Windows Data Link Properties dialog: Select this if you are using an OLE DB-based data

source such as some SQL Server or Access client libraries.

Other things to note:

82

Use the LabTalk system variable @IPDB to control protection of imported range (0O = no protection, 1 =
protected but allow reorder, 2 = protected).

Similar to other Connectors, you can opt to Exclude Imported (data) When Saving as OPJU/OGWU.
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Comn

Exclude Imported When Saving |
Remove SCL E

110100 Jk=r | 110000 4f=
110101 ZRiE 110100 | 1%
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Note: For more information, see the Origin Help

Help: Origin: Origin Help > Importing and Exporting Data > Importing Data from a Database

8.13Digitizer

At times, you may only have a graphic representation of some data that you would like to explore further. Use
the Digitizer to import an image file, then digitize the plots, converting your image to numeric data that you
can study and re-plot using Origin's analysis and graphing tools.
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e |Import most common image formats.

® Rotate the imported image, remove noise and calibrate scales by picking start and end values.
®  Pick points on curves manually or automatically.

e  Manually add curve inflection points, as needed.

o Interactively remove points that you do not want digitized.

e  Support for Cartesian, polar and ternary coordinate systems.

To open the Digitizer:

1. Click the Digitize Image Eﬁ button on the Standard toolbar or choose Tools: Digitizer... from the

main menu.

8.14 Saving Origin Files without Imported Data

Users have long had the option of saving Origin files without data. Save Template As..., Save Workbook As
Analysis Template and Save Project without Data, were three options for saving Origin files without data
while preserving settings and operations with the file.

Users now have the option to save Origin files without imported data. This is a particularly attractive option for
those who work with large data files, where saving of that data with the file would hinder performance or
waste disk space.

e By default, data imported using a Data Connector, will not be saved with the book when the import file

size exceeds 500kB. Each book has its own Exclude Imported When Saving check mark and clearing

the check mark on any page in the book will cause all imported data to be saved with the book.

ALK) B(Y) CY) D(Y)
Long ¥ Data Source... L, Area D
(kmz2)
Select...
Comr import
Import All H:I 710
8 143998
Disconnect Sheet -T 36193
Remove Data Connector... 19 10452
. T 99538
E— . Exclude Imported When 5aving ;? 26338

[ T MNetherlands 1.73E7 41526

® Any book in the project -- not only those with Data Connectors -- can be configured to exclude imported
data by right-clicking on the window title bar, selecting Properties, then checking the Exclude imported

data when saving project box at the bottom of the dialog.
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oK

Import Data

Cancel

The act of excluding data when saving differs from saving a template file in a couple of important

ways:

e When you exclude imported data, you are still saving all output resulting from analysis operations on

imported data -- fitting results, statistical analyses, Set Values calculations, etc. -- you just don't save

imported data or graphs of that imported data.

e  Books which you have saved without imported data retain a "live" link to the original data source. For

Data Connector-containing books, click the Data Connector icon and click Import (active sheet) or

Import All (all sheets in book). For books used for standard file import, activate the empty book and click

Data: Re-import Directly; or click the Re-Import no dialog button on the Import toolbar (see next).

8.15Re-Importing Data Files

There are two import commands in the Data menu that are specifically intended for repeat import of the

same file (i.e. the file path and name must be the same):

e Re-Import Directly. When you import a file into an Origin worksheet or matrixsheet, by default a

number of parameters, including file path and name, are saved in the sheet. If you have an external data

file that is periodically updated or you want to reload a standard file into the worksheet, you can re-import

directly without opening an import dialog.

e Re-Import.... This menu command opens the corresponding X-Function import dialog box for the file

type so that you can adjust your import options before re-importing.

Notes:

dialog will open instead of the Import Wizard.

®  Only one file can be re-imported at a time. When you use either of these two menu commands,
only the file associated with the active worksheet or matrixsheet, will be imported. If the selected

data are imported from multiple files, re-importing will fail.

. If you import an ASCII file via the Import Wizard and select Data: Re-Import..., the impASC

e Re-import does not work for Binary or User Defined data types brought in with Import Wizard.
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8.16Clone Import

Clone import works by "modeling" an import -- and optionally, an associated analysis operation -- and then
applying what was done to the initial file, to a series of similar files. As long as the active book contains
imported data and associated operations, it can be cloned. In this sense, cloning is similar to creation of an
Analysis Template but is somewhat more limited in power (e.g cannot be used with the Batch Process tool).

Clone import is supported by both Data Connector and X-Function-based import methods. A brief tutorial
will show you the basics of cloning import and analysis operations.

7.

8.

86

Click the New Workbook button H to open a new workbook.

Using Window's File Explorer, browse to your <Origin Program=>\Samples\Curve Fitting
folder and find a file called SensorO1.dat. Drag-and-drop the file onto the new
workbook. The .dat file is imported using the Text/CSV Connector.

Click the column B header to select the column, then click the Scatter button * to
create a scatter plot.

Click on the X or Y graph axis scale and in the Axis dialog box that opens, click the
Scale tab, then press Ctrl and select both Horizontal and Vertical axis icons in the
left panel. Set Rescale to Auto and click OK.

With the graph active, click Analysis: Fitting: Linear Fit and open the dialog box.
Set Recalculate = Auto, accept other default settings and click OK. Answer No to the

Reminder Message and click OK.

Right-click on one of your workbook tabs and click Add Graph as Sheet. This will

add your scatter plot with the linear fit results, as a page in your workbook.

[ 1]
| IIEI\SE e Citl imear]l { EitlimearComeal 4 ||
Insert L

Delete

Add
Add Graph as Sheet: [Graph1]

Add Matrix as Sheet

Make sure the sheet with data imported from SensorO1.dat is active and click the

B3
Clone Import button B on the Import toolbar.

Browse, once again, to your <Origin Program>\Samples\Curve Fitting folder, press
Ctrl or Shift and select files SensorO2.dat - Sensor07.dat. Click Add Files and then
click OK. What you should see is that using the original book as a model for import
and analysis operations, the Sensor files are imported using the Text/CSV Connector
and, one-by-one, they are processed (it may take a few seconds for all operations to

go to completion).
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8.17 Topics for Further Reading

(] Data Connectors

o Importing Simple ASCII Data Files

e  Customizing the ASCII Import Options

e  Updating Excel Data in Origin.

e Video: Use Clone Import to Batch Process More Data Files

(] Tutorial: Importing Multiple Files into Workbooks Cloned from Active Workbook

° Importing Third Party Files

o Importing Data by Drag-and-Drop

e  Tutorial: Updating Graphs by Re-importing Data from a Database

e  Tutorial: Connect to Web Data by Copy Link Address

. Importing Data from a Database

(] Drawing or Deleting Data Points

(] Tutorial: The Digitizer
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9 Workbooks Worksheets Columns

Formula
Row far
Math
Operations

Column Label

D tOI'I { Rows for
alasets o Display of File-
Long Name Wavelangth Intens ity Wavelength Intensity or Columa-
Units nm arb. unit am b, unll sqjlcorﬂcrgiaf
Comments Date: 03-27-2013, 11:25:03 (yellow rows)
Integration Time (mseck 200
User-defined 1mn: Nmeagnfrm
Parameter Numbser of Pixels in File: 2048
Row X Cofr- 5.30
Y Corr. -152 68
~ Fixe A+ ncf B + ycf
I Comsction Facior 5.30 -152 68
Peak Value 85494 4095 85024 | =
»__ Gparkding —_ | e L}
189.41 0 184,71 182
189.77 15588 195.07 32
190.13 156.44 195.43 376 User-defined
[ 19049 157 68 195.79 5
190.85 1574 106.15 an2 Earar;wefter
Sparklines - 19121 16052 196,51 784 0w DeIng
Thumbnail 19157 161.08 106.87 8.4 Used for
S 19193 160.8 197.23 8.12 CellHevel
"
Graphic View of 19220 16424 197.59 11.56 — Calculation
Column Data Batch No. 1 {Batch No. 2 A Batch No. 3 ) Batch No. 4 ) Batch No. 5 A Batch Ng | < [

Multiple Sheets in Book
(up to 1024 w/ Unicode File Types)

9.1 Workbook, Worksheet and Column Basics

The Origin workbook is a nameable, moveable, sizeable window that provides a framework for importing,
organizing, analyzing, transforming, plotting and presenting your data.

e  Each workbook is a collection of one or more worksheets (up to 1024).

e  Each worksheet contains a collection of columns (up to 65,500) and each column contains rows of cells
(up to 90,000,000).

e  Each column has a Short Name (e.g. "A") that uniquely identifies it within the worksheet and a Column
Designation (e.g. "(X)" which determines how it is handled, by default, in plotting and analysis
operations.

e Each worksheet, and each worksheet column, has data-containing cells identified by row (index) number;

and a preceding metadata containing area (“header™) comprised of optional label rows, including Long

Name, Units, Comments, etc.
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P Two convenient buttons were recently added to the workbook window: Add Sheet and
Show/Hide Organizer.

) U3

4" 121
A+ [ANRLARZLR

| ..r"'f \\ = .

Add Sheet | Show/Hide Organizer |

9.1.1 Some Workbook, Worksheet and Column Limits

Object Maximum Number
Worksheets in a workbook 1024t
Rows in a worksheet, 1 column 90,000,000
Rows in a worksheet, 5 columns 90,000,000
Rows in a worksheet, 32 columns 90,000,000
Columns in a worksheet, 1 row 65,500
Columns in a worksheet, 100 rows 65,500
Columns in a worksheet, 1000 rows 65,500

T = 255 sheets requires saving file to Unicode-compliant (e.g. *.opju) file format. Unicode formats not
compatible with Origin versions prior to Origin 2018.
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9.1.2 Naming Workbooks, Worksheets and Columns

Workbook
Short Name Column Short Name

and
Long Name

Plot Designation (XY, Z, Er, Label, etc)

SN

s
@ BookShortMame - - Workbook Lon Tame (spaces, numbers and special characters allowed) EI@
AK) | B(Y) | cv | bm In
Lang Name Time Delta Temperature  Magnetic Field  Position L4
Units (sec) (=K (Qe) (mm)
Comments
Fix)= \
Sparklines —
1 .01 40 Bl.6 T071.¢
2 0.02 405 13 100.9 Column Label Rows
3 0.03 40.2 §1.9 100.3 (optional)
4 0.04 40.1 B62.5 100.8
5 0.05 40.2 53.1 100.8
& 0.06 396 63.7 101.7
7 0.07 39.7 64.3 100.8
8 0.08 399 G54.8 102
g 0.09 39.9 65.4 101.2
10 01 39.4 65.9 101.1
11 011 39.3 6G.5 101.2 -

v [+]v] 515-135:03 £521-235-07 £532-014-04 f ] T} am

Baclkward
Forward
Add Sheet
Show/Hide Crganizer

e A Workbook has a Short Name and an optional Long Name and Comments.
Origin uses the Short Name for internal operations.

e Short Name must be unique within the project file, can contain only alpha-
numeric characters (letters and numbers), must begin with a letter and are
limited to 13 characters.

e A Workbook Long Name is optional, need not be unique within the project

Workbooks file, can use any characters in any order and has a limit of 5,506 characters

(including spaces).

To name a workbook, right-click on the window title bar and choose
Properties. Here you can edit Long name, Short name and Comments. Use
the Window Title drop-down to control which name(s) show on the window

title bar.
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Worksheets

A Worksheet has a Name and optional Label and Comments.

The Name must be unique within a workbook.

A Worksheet Name has a 64 character limit, including spaces. These special
characters are not allowed: {}|"<=>Q![].

Worksheet Label and Comment are optional. They need not be unique within
the project file, can use any characters in any order, and can be of any
practical length.

To name a worksheet, double-click on the sheet tab, or right-click on the tab
and choose Name and Comments. More details are listed under

Worksheets, below.

Columns

A Column has a Short Name and an optional Long Name.
The Short Name must be unique within the worksheet. When spreadsheet
cell notation is enabled (default setting), you cannot edit the column Short

Name (see Column Short Name Restriction). When cell notation is disabled,

you can edit the column Short Name. When editing Short Names note that
they must use only alphanumeric characters (no special characters), must
begin with a letter or number, and cannot exceed 18 characters.

A Column Long Name is optional, need not be unique within the project file,
can use any characters in any order and has a limit of 30,000 characters. The
Long Name can be edited directly by clicking in the Long Name cell or by
right-clicking on the column header and choosing Properties from the
shortcut menu.

Dialog box and Status Bar references to data range will use Long Names,
provided that (1) Long Name exists and (2) you have selected Use Long
Names when available (Preferences: Options: Miscellaneous).

Otherwise, Short Names are used.

9.1.3 Workbooks

Origin workbooks are highly customizable and can be saved with data (e.g. Workbook File) or without data
(e.q. Workbook Template). Since they can be configured for many different applications, there is a good

chance that you will collect a number of custom files over time. The New Book dialog is useful for organizing
and choosing these files for use.
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9.1.3.1 New Book and Book Templates

Workbooks Worksheets Columns

Browse to Select and
Add Templates

Delete/Show/HIde User Templates

L

Scan User Files Folder to
Add Templates

"Manage" Mode:

\

/

—

S\ S

Sort by Name, Book Type, |

Category or Location
we | sm | em | om | sm
——

Hover for Preview

i
I ¥ ) s |

OneXManyY

1 X column and B ¥ cobumns

Chlsersymike\AppData\Local OrigenLabh Templates

\OneXManyY.otwu

All Categores

To open the New Book dialog:

1. Click File: New: Workbook: Browse or press Ctrl + N.

Siats by Groupeng Column

nght-click

e XMy

Mol olsmnd, i
Edit

Image Colgn
Set as Default

Fidgefegres

Regresuan Clustenng

LR with Resichual Analysis

List Template in
File: New:

Workbook/Matrix Menu

TR "

All Categories
UserDefined
Statistics
Mathematics
Fitting

Signal Processing

Miscellaneous

Workbook File
B Workbook Template
Analysis Template
Matrxbook File
Matricbook Template E-
Fiter Resat
a2
-]
Statsstars nded -~
Mol whended
Open Template ¢
Center
Stattcs Extended
Statrstes Extended
Fittng Estended e
Open Close

> &

[  or Double-click on Name ]

An Open Template Center button uwas recently added to the New Book dialog.
Click the button to browse for additional workbook templates that you can download
and add to your template list.

e The dialog lists both add-on (Extended) and User-defined (User) files.

e  Files can be sorted by Name, Book Type, Category or Location.

e A file preview shows when you hover on the o icon.

e  Right-click on a template name and Edit metadata or Set as Default (e.g. New Workbook button ).

Also, right-click to Clear Default.

(] Enable Show in Menu to list a window in the New: Workbook or New: Matrix menus.

e  Filter windows by category using the "All Categories" menu.

e  Filter windows by type using the Book Type drop-down menu. Reset to show all.

e Right-click on a template to Set as Default or Edit metadata.

e  Enable/disable Show on startup and new project.
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Each window's Properties dialog has a Comments box for entering text. These
comments are included in the New Book dialog previews and the Project Explorer
previews. In addition, comments are searchable from the Edit: Find in Project tool.

9.1.3.2 Spreadsheet Cell Notation (SCN)

Origin workbooks support Spreadsheet Cell Notation (SCN). Spreadsheet Cell Notation allows the sort of
cell-level calculations that are familiar to users of spreadsheets (more details below).

By default, SCN is ON for all new workbooks.
A-Z
In Origin 2017 - 2019, when SCN was enabled in the workbook, you saw this icon Bin the upper-left

corner of the worksheet.
Beginning with Origin 2019b, the SCN icon is hidden (by default) but SCN remains enabled (also by
default) to make room on the workbook window for the Data Connector icon.

Most users will want to leave SCN enabled but in rare cases (e.g. you need to customize the column Short

Name), you may want to turn SCN off. To disable SCN, right-click on the workbook title bar and choose

Properties. Look for the Spreadsheet Cell Notation check box about half-way down the page.

When SCN is turned off, users of all versions will see this icon in the upper-left corner of the workbook.

If you open a project or workbook window in Origin and SCN is turned OFF in a particular workbook, the

SCN OFF button iII display in the upper-left corner. This includes projects or workbooks that were
created prior to Origin 2017. To enable SCN, right-click on the book title bar, choose Properties and
check the Spreadsheet Cell Notation check box.

9.1.3.3 What Types of Data Can | Store in the Workbook?

The workbook serves as a flexible container for all of your work-related data -- not just text and numeric data.
You can add graphs, matrices, images, notes; and store calculations, scripts and variables, text objects and
programmable buttons, and create live links to other project data. Beyond its role as a flexible data container,
the workbook can also serve as a medium for batch analysis and reporting.
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Workbooks Worksheets Columns
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This table summarizes the kinds of objects that can be saved in the workbook window at the workbook,
worksheet and worksheet cell levels, and how to access them.

Element Workbook Worksheet Worksheet Cell
Right-click on the sheet Right-click in the gray P
Graphs tab > Add Graph as area beyond the last :i'g:;:tcg(;g O";' the cell >
Sheet column > Add Graph ANSert oraphn
Right-click on the sheet
Matrices tab > Add Matrix as -- --
Sheet
Right-click on the cell >
Insert Images from
Files
Images - - :
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Element Workbook Worksheet Worksheet Cell
Right-click on workbook Click thg Workbook_'s Click on the cgll and
Notes title bar > Properties > Show/Hide Organizer In_se_zrt Note with the
C eps s o button > Data Sheets > Mini Toolbar (see
omments T
E— enter notes in box below).
Click the workbook's
Show/Hide Organizer
button > page.info,
Imported Files, User
Tree, etc.
Right-click on the
. The Insert Variable . WorkSheet-Ce" and
. Added text objects Insert Variables; or
Variables

Dialog Box (Used

linked to data/variables

with Worksheets)

° The Insert Variable

Dialog Box (Used
with Text Labels)

select a cell and Define

Name using Mini
Toolbar.

Functions and

Right-click in the gray
area to the right of last

Select a column, right-
click and Set Column
Values. Alternately,

Click on a cell and use
the Formula Bar or

Show Script : - [ :
Formulas column > Show Script enter formula in F(x)= direct cell entry, to

Panel cell create cell formula.

®  Right-click the
selected column >
) o Set Column
Right-click in the gray |
. area to the right of last Values

Scripts -

column > Show Script
Panel

e Added text/drawing
objects and
associated scripts

File Metadata

Click the Show/Hide
Organizer button on the
workbook toolbar
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Element

Workbook

Worksheet

Worksheet Cell

Links

Enter cell-level links to
URLSs, other worksheet
ranges/cells, project
graphs, matrices and
image files.

Text and Drawing
Objects

Add Programmable
Buttons and Text

Labels and Drawing

Objects to the
worksheet.

Arrows

Right-click and Insert
Arrow

For Origin 2023, the Insert Images from Files (nsertimg) dialog gets an Insert
Direction control, handy when inserting multiple files into the active workbook (choices are
Horizontal First or Vertical
First). :

8 Insert Images from Files: insertimg

Dialog Theme | a5t ysed> *

Insert an image into 2 worksheet cell

File Mame

Resize Cell

C:\Program Files\OnginLab'\ Ongin2022b\5amplesi\image | ~ Q
CAProgram Flﬁ‘nﬂ'ng|nlah\ﬂrlglnlﬂ&h\kmplu\lmagz I
CAProgram Files\QriginLa

Cell

Ch\Program Files\Origin -
C\Program Files\Origin ﬁ Sook!™ = !
A Dermmrnen Eilart Cirieinl AX) I B(Y) | e | A
LI Long Mame
Insert Direction | Horizontal First w Units
Commenis
|| [Book1]Sheet1!1[1] Flx)=
1 ) -
2 | 0 |
3 etc.
4
5
5]
4 r[+]v ]\ Sheett f €
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Improvements to handling of hyperlinked cell text in Origin 2023:

i ol e To edit previously-entered hyperlinked text, press ALT while double-clicking on the
linked cell. Previously, one had to select Edit: Edit Mode to edit the linked cell.

e  You can format and align text in hyperlinked cells. This is supported in both the label

row and data row areas of the worksheet.

Format - X
#p Lucida Calligrapl = 16 ~ . Fu =l - A~
i [ = Left
Long MName —
_ Units | = Center
Comments = Right
ﬂfomepagaE\
Fixj=
1 ‘ https:/iwww_originlab_.com Homepage
2 Homepage
3

9.1.4 Worksheets

A workbook can have up to 1,024 sheets. A sheet has a single Name which can contain spaces and special
characters. Optionally, you can add a Label and/or a Comment.

To edit the sheet Name

1. Double-click on the sheet tab and enter a Name. Alternately, right-click on the sheet tab, choose Name

and Comments and edit the Name field.

System variable @SSL can be used to modify sheet naming behavior. Look for @SSL in the LabTalk System
Variable List.

When mousing over the worksheet tab, Name, Label and Comments appear as a
tooltip.

To add worksheets to the workbook, right-click on a worksheet's tab and choose one of the following:

e Insert. Inserts a single worksheet ahead of the active sheet.
e Add. Appends a single worksheet.
e Duplicate Without Data. Duplicates the active worksheet without duplicating the data.

(] Duplicate. Duplicates the active sheet, including the data.

Each sheet in a workbook can have its own set of customizations. When you Insert or Add a worksheet, the
new sheet is based on the ORIGIN.otwu file (specifically the version of ORIGIN.otwu that is saved to your User
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Files Folder if you have customized this file). To add a sheet that is based on another sheet in the workbook
(including number of columns and special formatting), you would use the Duplicate or Duplicate Without
Data shortcut command.

To move sheets between existing books or use them to create new books:

You can also (a) drag existing sheets between books or (b) drag and drop sheets onto an empty portion of the
workspace, to create a new book.

Measured on | 12001120 1200112004 1210172004  12/101/20
Time: | 03:20:39  03:20:39 AM 03:20:39 AM | 03:20:39
Run Type: | Trial Run Trial Run 1 Trial Rur
SamplelD| 315 515 515 | HE Booke* = =
=
“Runo] 03 ® = axn | By | oo | pia
Flx}= Long Name Time Deita Magnetic Field | Pos
1 0.01 40 Temperature
2 0.02 40.5 Units| (sec) (K) (Oe) (n
£l 0.03 402 Comments | 515-125- 815-125-03 215-125-03 515
4 0.04 401 03 (
5 0.05 402 Sparklines| __— T Wi
6] 006 39.6 e 21 21 21 z
7 0.07 307
| Trial Run 1 Trial Run 3 f Mo. of points| 1000 1000 1000 1
Sample |YBCOmi,  YBCO milled YBCO milled [YBC
Measured on| 12/01/20 12101/2004 120012004 12K
"\ Time: | 03:20:39 03:20:39 AM 03:20:39 AM | 03:2
"Rl Type: | Trial Run Trial Run 1 TrialRun1 |[Trna
Sa 515 515 515 s,
Baich 125 125 125 ) —
[« [» [+ [v]\ Trial Run 1 f E >

For Origin 2023, you can select multiple sheets when dragging between books or
when dropping sheets onto the workspace to create new books:

1. Press Shift/Ctrl on multiple worksheet tabs, then drag selected tabs to another

window or an empty portion of the workspace.

or...

1. Right-click on a worksheet tab, and choose Navigate. In the Navigate Worksheets
dialog, Ctrl/Shift + select sheets, then right-click and choose Move to, then New

Book or Selected Book.

9.1.4.1 Worksheet Properties

To open the Worksheet Properties dialog

1. Right-click in the gray area to the right of the worksheet grid (but inside the workbook window) and

choose Properties.
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You can use the Worksheet Properties dialog box to customize properties of the sheet, including...

e Display of row labels, header labels and grid lines (View tab).

e  The number or rows and columns and other sheet dimensions such as column or row header height (Size
tab).

e  Enabling of rich text, text wrap, how to display truncated cell content, sheet font and color (Format tab).

e  Auto add rows, ignore hidden rows in plotting and analysis, cell resizing (Miscellaneous tab).

e  Printing/exporting of grid lines, headers and footers, background color (Print/Export tab).

e  Script to run after import or upon data change (Script tab).

e Display and edit a user tree (e.g. the user adds some configuration info for use in the template) (User

Tree tab).

Note that many of the sheet customizations can be applied at the cell level by right-clicking on a selected cell
and choosing Format Cells.

For more information, see The Worksheet Properties dialog box.

e  Prior to Origin 2023, you could not enable Rich Text and Wrap Text of worksheet
JE cells, simultaneously (i.e. the Worksheet Properties dialog warned that Wrap Text
s would be ignored for Rich Text). You can now enter longer text strings into a Rich
Text-enabled cell and text will automatically wrap on exiting edit mode (cell resize may

be needed to display entire cell contents).

e You can toggle Wrap Text ON/OFF for column label rows by selecting a row and

clicking the Wrap Text button on the label row Mini Toolbar.

=) ADX) B(Y)
Long Name Crude Oil
Year !
Production
Inits 1K Barrels/Day
Comments

Wrap Text | Information
—t 0]

countries/country-data.
LIS#pet
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Origin 2023 adds Mini Toolbar support for (color) banding of worksheet rows:

i
.}
o

|.'_ il -n..
¥ £ Book1 *

Banded Rows I
Long Mame
Units
Comments \ )
; " B Worksheet Banded Row... ? x
2
4 2 :
[ Banded Row Color 2D2FFDC w
6
7 @ColorOdd Rows
3 W OCoIorE\ren Rows
b \Sheeﬂ i | < > ||— Cell Background Color Auto -

1. Hover to the right of the worksheet columns and when the Mini Toolbar cursor shows,
click to show the sheet-level toolbar.

2. Click the Banded Rows button to (a) shade alternate rows and (b) add a Banded
Rows Color button to the Mini Toolbar.

3. Click the Banded Rows Color button to open a dialog where you can manage

banding.

9.1.4.2 Manipulating Sheets with Object Manager

Use the Object Manager's shortcut menu commands to manipulate display of workbook content:

e List all sheets in the active workbook.
e Click a sheet in Object Manager to activate the corresponding sheet in the workbook.

e Right-click in Object Manager for access to common worksheet operations, including Delete, Insert, Add,
Move, Copy, and Rename.
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Insert
Drlcte
fad
Add Graph as Sheet
Adid Matrix a_s Sheet

Long Mam | Bas .
Units : Right-click on
eta! sheet in Object
Click on Manager to open |
sheet in 81291663 0.22654 | a shortcut menu [ sheet
. 82583326 022654
ﬂh].‘l:-t §38.74980 0.22654 [ copmeare e ithout Data
Manager to 85166651 0.22654 al | Duplicate
activate sheet 86458314 022654 8
i R o mm——— Move Before ]
(o) InWOrkbOOK [ofSheet1 B j, FitPeakCurvel £ PeakProf wove to pegin
S, =

\\\_—_’/ Move Lo End

Sheet Name to Show L
Mame and Motes..,

Exclude from Flotting Dialogs
Exclusde frivm Excel Expaort

Protect Sheet
Mavigate...

Properties...

9.1.4.2.1 Hide/Show Sheets

Starting with Origin 2023, you can hide (and show) worksheets. This is conveniently
done using the Object Manager.

1. In the Object Manager, select one or more worksheets.
2. Right-click and choose Hide. Hidden sheets are dimmed in Object Manager and hidden in the workbook.

3. To show the sheet(s), right-click on the dimmed sheets and choose Show.
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~

&4 Book1 * E=S{EcR~==
=] A1) B(Y1) SR
Long HName Dela = -
Time Temperature Magnelic Field | Position
Units] (sec) (K) (Oe) (mm}
Comments|S1SI25  s1s.42503 15125 Object Manager
Spardines| _— ~—1 = - Book 1
Version 21 21 Trial Bun 1
Mo of pointz| 1000 1000 :
Sample|YBCO mi  YBCO milleg Trial Run 3
Measured on | 12/01/20
Time: | 03:20-39
Run Type: | Trial Run Tl Rumn 1
SamplelD| S15 515 S15
BalchNo| 125 125 125
RunMa 03 03
Fix=
1 o001
2| 002
el nnI A0 3
[« [+ [+1 ]\ Trial Run 1 £ Trial Run 3 f

e Note that you can also right-click on one or more worksheet tabs and choose Hide/Show.

e  Additionally, there is a Navigate shortcut menu item, available in both sheet-tab and Object

Manager shortcut menus, that opens the Navigate Worksheets dialog. You can hide or

show sheets by clearing or checking the Show check boxes in this dialog.

e  Another way to show sheets is via the Workbook Organizer:

1. Right-click in the gray area to the right of the last worksheet column and choose Show

Organizer.

2. In the lower left panel, hidden sheets will be dimmed (grayed-out). Double-click on the

dimmed sheet to Show.

Dimmed sheets in

Crganizer are hidden,
Double-click on the
dimmed sheet to Show. |j

Raw data for all manufacturers, 1992 to |

EDescnﬁr\re Statistics El tayecinto
= Result Sheets No Info.
» E] User Tree
(=l page info Me Info.

SYSTEM.IMPORT

SYSTEM.PLOTTING w

9.1.4.3 Worksheet Views: Split and Freeze

ngh‘l‘- click on the node to edit

Origin has two utilities for locking the view in part of the worksheet, while allowing you to scroll through the
remainder of the sheet. The two could be used interchangeably in some situations.
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9.1.4.3.1 Splitting the worksheet into panels using dividers

This places a moveable, vertical or horizontal divider at the selected row or column; or if a single cell is
selected, both a vertical and a horizontal divider. This divides the worksheet into identical and scrollable views
of the worksheet data area. The user is able to scroll within each panel while rows or columns in the other

panel(s) remain visible.

ARR B8R
[ [ [ I\ Watertall £ <

EH Book? - Waterfall.dat * =0 ESh ="
Ea A | BN | cn | b | Em | Fv | 6w | kA
LongName| X B00 602 604 606 608 | B1D
Units
Comments
File Header
Flx)=
Sparklines /_PJW\-\ J\M
1 835 -1549 1347 494 543 1619 866 W
2| 83604 -1205 056 1372 1662 -1515 459
A 3| 837.09 1147 1235 1097 1447 052 107
4| 83813 -1319 898 219 134 1671 204
5| 83947 918 505 4152 1608 522 1631 |
B| 84022 1205 -1067 1756 0 1254 459 |w
“J10] 84433 057 73 494 1447 1567 051 -a
11| 84543 688 225 823 420 575 255 | |
12| 84647 229 898 0 161 209 153
¥ 13| 84752 220 581 1152 59 1567 0
14| 84856 287 1347 1701 1179 679 153
15| 8496  -459 1123 1372 1233 679 561 X
16| 850.64 115 561 165 1233 575 11.21
17| 85169 516 73 1372 322 104 1172
18] 85273 631 112 494 536 313 5.1
19| 85377 459 1403 203 1126 1254 1274
20| 85481 746 2189 320 1233 313 -255
AN RT -220 214 2 na -2 RR b

Window: Split

N\

both panes can be
scrolled independently

> [

1. Select a worksheet row/column or a single cell and choose Window: Split.

2. To remove the split choose Window: Remove Split.

9.1.4.3.2 Freeze rows or columns in the worksheet

JES New feature for Origin 2023

The user can freeze the first 1 to 10 rows or columns in the worksheet, thus locking them in view while the
remainder of the rows or columns remain scrollable. Locked row and column headers are shaded in a darker

color to indicate freeze.
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View:
Unfreeze/Free Panes

(Ctrl + Shift + F)

7 Book3 - Waterfall.dat * E=nEcE <"
2 a0 | Ben | e | b | Em | Fm | e | A
LongName| X 500 | 602 | 604 606 608 610
Units
Comments
File Header
Fix=
835 1549 1347 494 643 1619 866
83604 -1205 056 1372 -1662 -1515  -450
83700 -1147 1235 1097 1447 052 107
83813 -1319  -898 219 -134 1671  -204
2017918 505 -1152 -16.08  -522 -16.31
84022 1205 1067 —=Tro0 o127 450
84126 -1434 1123 713 054 261 459
8423 516 617 2524 543 1149 -12.23
84335 1377 1291 11 1233 1149 107
74| 911 1664 449 11 054 679 459
75| 91204 1319 617 1866 2198 1149 815
76| 91308 344 1572 2524 134 1567 316
77| 91412 2352 898 219 420 209 3.06
78| 91516  -115 1347 1591 2198 0 663
79| 91619 1262 1067 1975 697 1097 2192
«[r [+ v ]\ waterfall / || < >

Frozen rows

Highlight a row or column, or a single cell between index row/column = 1 and 10, then do one of the

following:

® Choose View: Freeze/Unfreeze Panes.

®  Press Ctrl + Shift + F.

e Select a row/column or a single cell and click the Mini Toolbar button Freeze Panes.

®  Click in upper left-most cell in the sheet and click the Unfreeze Panes button.
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4] co2 Emissions =N =l ==

( Qm\ ?E : % 143‘ * === | Unfreeze Panes "
¥ 4

Ldog NS
ol #+Ea D@ o)

Comments
Fixj=
Categories | Unsorted  Unsorted
1[IMD 1880 0.44927
2| CHM 1880 1.49525
3| KOR 1880 353765
4| MEX 1980 3896175
5| GBR 1980 1028676
6| DMK 1980 11.78401
T CAN 1880 18.07962 O .
T 1980 70 78549 HH aun m IE Freeze Panes
9|RUS 2511342 E-]‘ 3.1
11| CHM 1.87105
12| KOR 4 3703

O S F0OS00

W
[ [+[v]\Sheett /7 IE >

9.1.5 Worksheet Columns

To add a new column to the right end of an existing worksheet, right-click in the gray area to the right

of the worksheet columns and choose Add New Column or Click the Add New Column button +E on

the Standard toolbar.

To add multiple columns to the worksheet, make the worksheet active then choose Column: Add New
Columns... from the main menu. Specify the number of columns to add in the Add New Columns dialog
box and click OK; or use the Format: Worksheet... menu item or the F4 hot key to open the

Worksheet Properties dialog, then set the desired value for Column Number in the Size tab.

To insert a column into the worksheet, highlight a column, then right-click and choose Insert. A column

is inserted ahead of the selected column and column Short Names are adjusted accordingly.

Worksheet columns can be renamed by:

106

Double-clicking on the column heading opens the Column Properties dialog box. Enter/edit Short Name

and/or Long Name.
Type a Long Name directly into the worksheet header cell by double-clicking in the cell.
Import a data file and specify that the workbooks, worksheets, and columns be named upon import.

Use the Enumerate Labels tab of the Worksheet Properties dialog to enumerate or duplicate column

names and labels.
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e Type names into a few columns (e.g. Peak 1 and Peak 2), then highlight the cells and drag the bottom-
right corner of the selection to auto fill and enumerate the names for other columns. This also works for

other column label rows such as Comments.

See the above table for rules on worksheet column naming.

9.1.5.1 Column Designations

As mentioned, worksheet Column Designations (aka "Plot Designations™) generally determine how data are
handled during analysis and plotting operations. For instance, you might select an X column + three Y columns
to perform a simultaneous linear fitting of each Y dataset against a common set of X values. Or you might
select the same columns to graph 3 line plots against a common set of X values. In addition, there are
designations for Z values, for error data, for labels, etc. (for more information, see Column Designation in the
Origin Help file).

Disregard
ar
X Y z XError Y Emor  Label Group  Subject Mone
E=REER T
AR | B(Y) ‘ c@) |D(}{Er¢}‘ E(yEri}‘ F(L) | c(G) ‘ H(S) | |O‘ ~
Lang Mame
Units
Commenis
Flx}=
L [~
[ I\Sheett / | < >

While there are a number of places in the user-interface where you can designate columns during some
analysis or plotting operation, at a basic level, they are set in the worksheet by (1) clicking on the column
header to select a column, then (2) doing one of the following:

e Choose an option from the column-level Mini Toolbar.

e  Click a button on the Column toolbar.

®  Right-click on the column and choose Set As and choose an option from the shortcut menu.

®  Right-click on the column, choose Properties and set Plot Designation.

9.1.5.2 The Column Properties Dialog Box

The Column Properties dialog box is used to customize properties of the column including...

. Long Name, Short Name, Units, Comments, etc.

(] Format (Numeric, Text, Time, Date, etc.).

° Plot Designation.

To open the "'Column Properties™ dialog box:

1. Double-click on the column header.

2. Right-click the selected column(s) and choose Properties....

107


http://www.originlab.com/doc/User-Guide/Worksheets-Columns
http://www.originlab.com/doc/
http://www.originlab.com/doc/Origin-Help/Mini-Toolbar
http://www.originlab.com/doc/User-Guide/Toolbars
http://www.originlab.com/doc/Origin-Help/ColProperties-Dialog-Properties-Tab
http://www.originlab.com/doc/Origin-Help/ColProperties-Dialog
http://www.originlab.com/doc/Origin-Help/Format-Wks-Data
http://www.originlab.com/doc/Origin-Help/WksCol-SetDesignation

UserGuide 2023

Use the Properties tab to edit the column Short Name, if desired. Other properties -- Long Name, Units

and Comments -- can be edited here or entered directly into the column label row cells.

9.1.5.3 Formatting Column Data

Data in the Origin worksheet is treated as either text or numeric data. While the display of text data in the

worksheet is fairly straightforward, the display of humeric data is more complicated.

Unless otherwise specified, all numbers in the worksheet are stored internally as floating point, double
precision (Double(8)) numbers. This includes date and time, data which is formatted to display in degrees-

minutes-seconds or numbers that are formatted to display a fixed number of decimal digits.

When dealing with numeric data, understand that what you see in the worksheet is a representation of a
number that is stored internally. This is important for two reasons:

9.1.5.3.1 Numeric Display Formats

108

Calculations involving worksheet values are always done on the double-precision number that is stored

internally, not the value that is displayed in the worksheet.

You can apply various Format and Display options to change the way that this stored number displays in

the worksheet.

Double-click on a column heading to open the Column Properties dialog.

While the central place for formatting worksheet data is the Properties dialog, as described
above, keep in mind that there are quick-access Mini Toolbar buttons for changing the
Display of numeric and date-time data. Note that the Format of selected columns must first

be set as Date or Numeric/Text & Numeric for these buttons to be visible.

25.01.2004 09:39:34.5

MM/ddiyyy HH:mm:ss #8888
MM/ddfyyyy hhimm:ss.##s#s#

M/ diyyyy
yyy-MM-dd
yyyMidd
M-d-yyyy

dd. MM.yyyy HH:mm:ss.## %

Date-time
Format

Click the Properties tab, then set Format = Numeric.

o Riiifl iR N
XY Zrtt g
Displayed

Digits

Set Display to Decimal: 1000, Scientific: 1E3, Engineering: 1K, Decimal: 1,000 or Custom (see

below).
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9.1.5.3.2 Date and Time Formats
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By default, Origin stores date-time data as a modified Julian Day value and it uses this number for date-time
calculations. Typically, however, you will prefer to display this Julian Day value in a more meaningful date-time

format:

P wNPR

Set the Display list to one of the listed options.

Double-click on a column heading to open the Column Properties dialog.

Click the Properties tab, then set Format = Time, Date, Month or Day of Week.

custom date-time string using these date-time format specifiers.

If none of the listed options are appropriate you can choose Custom Display and construct your own

When importing date-time data into the worksheet, Origin will sometimes treat this data
as text (QOrigin's CSV Connector generally does a better job of recognizing date-time

data). If your date-time data are left-aligned in the worksheet cell, Origin "sees" it as text.
You will need to open the Column Properties dialog box and choose your Format and
Display options. When you see that your date-time data are right-aligned in the cell, you
know that Origin "sees" the data as numeric data, displaying in a date-time format.

2 imported Date and Time.dat * ol nE) 3H imported Date and Time.dat * =5
AD) [ sm [~ A0 | sm |~
Long Name Time Signal Long Name | Time Signal
Units Units
Comments | Text | Comments | Numeric Formatied as Date |
Fix= / Fixl=
Sparidines MVN Sparklines \ WM
1]25.01.2004 09:38:58.50 85.55 7 25.01.2004 09:39:20.50 854
2|25.01.2004 09:39:04.50 B5.55 B 25.01.2004 09:39:34.50 85.45
3(25.01.2004 09:39:09.50 85.55 i) 25.01.2004 09:39:39.50 354
4(25.01.2004 09:39:14.50 856 10 25.01.2004 09:39:44 .50 85.35
5125.01.2004 09:39:19.50 B5.S 1 25.01.2004 09:39:49.50 85.25
6| 25.01.2004 09:39:24 50 8555 ¥ 12 25.01.2004 09:39:54 50 8535 ¥
E]\Cumm Date and Time} "( > |r Ilzl\ﬁ.rstam Date and 'I"mef |¢ )|r
9.1.5.3.3 Color Format
Origin 2021 introduced a new column and cell Format -- Color.
[ Source: https://www.wischools.com/colors/colors_names.asp * = @
AlX) | B(Y) cn | owm | EM | Fn @) A
Lang Name HTML Color Name Hex Value R G B color{ ) function
Flx)= color(C,D.E)
1|Black 0 0 0
2|Na 0 0 128
vy Save As Increment List
3 |Dark Blue 0 0 139
4 | Medium Blue 0 0 205
5|Blue 0 0 255
6| Dark Green 0 100 0
7| Green 0 128 0
8|Teal 0 0 128
9| Dark Cyan 0 0 139
10 | Deep Sky Blue #O0BFFF 1] 191 55
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e  Supports direct entry of HTML color codes into the worksheet cell to set cell background color, with the
option to display or hide the HTML codes in the Color cell.

e  Use the color() function to calculate hex values and set colors from RGB values in other data columns
using Set Column Values or cell formula (e.g. color(A,B,C) sets color using RGB values in columns A, B
and C).

e Select a column in which Format = Color and use a Mini Toolbar button to Save as Increment List

(color list) for use in your graphs.

e Alternately, from the Custom colors menu in the Color Chooser, choose Create Color List from

Column and pick a Color worksheet column from the flyout.

EEEEE A EEEEEENN
| O |

Muore Colors: Systermn Color List

1
EEEENEEEEEE
EEEEEEEEEEE
Custom: test_color_custom_add -
N RN+
Recent colors

Create Color List from Column... » > [Bookl]colsplit!B(Y) : Hex Value

e [Bookl]colsplit!F(Y) : color( ) function

.

Open Increment Editor...

Last Customn Celors

9.1.5.3.4 Other Custom Display Formats

Origin can display numeric values in the worksheet in a variety of custom formats. This illustration shows
various formats applied to the same set of numeric values (column A(X)).

AR | B(Y) | c(Y) | D(Y) | ECY) G(Y) | HiY)

default T&N *2 5.3 E.2 % # HHHH DMS
055737 0.56 5.574E-01 B57.37Tm 34461 0=3327
097082 0.97 9.703E-01 970.82m 3334 0=5g15"
0.65831 0.66 6.593E-01 659.31m G0/91 0%39°34"
0.8485 0.85 8.495E-01 249.50m 79/93 0=a0ag”
0.82661 083 8.266E-01 826.61m B2/75 04936
0.80461 0.80 8.046E-01 804 61m 70187 0=4817"
0.66641 0.67 6.664E-01 666.41m 213 03959
0.65464 0.65 6.546E-01 654 64m 36/55 03917
0.74152 074 7.415E-01 741.52m {5 66/89 0°44'29"
0.62085 0.62 6.208E-01 620.85m 2% | PR il #8129 A°3715

Format Text & Numeric ~ |

Column Properties > Properties tab Do not convert text to

numeric during data entry

1. Select the column.
2. Right-click and choose Properties.

3. Click on the Properties tab. Custom Display [ =00 il

Apply to all columns to the
right D

Display Custom ~

The following is a sample listing of some supported custom format options (this just happens to be the pre-
populated list that ships with Origin 2019). Note that you can enter custom formats directly into the Custom
Display list and they will be saved to this list.

There are many other format options. For more information, see Custom Numeric Formats.
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Origin 2023 adds a positive/negative (+/-) format option that can be combined with
other custom formats. For instance, if you had a column containing both positive and
y MEWY negative numbers, you might set Custom Display as "-+.2" to display numbers to 2
H*" decimals with a prefix of "-" or "+". Normally (by default), the "-" does display while
the "+" does not. However, this syntax also substitutes a "long minus" in place of the
usual "short minus" used in displaying worksheet negative numbers. Note that the "-"
and "+" symbols may be combined in your custom string (e.g. "-+") or used alone (e.g.

"oy
Custom Display =
2 -+.2
0.35 35
(-9.00 00
1.38 +1.38
-0.56 —-0.56
1.04 +1.04
0.59 +0.59
-1.02 -1.02
Format Description Eeume
P if cell value = 123.456
*n Display n significant digits. *3 displays 123
.n Display n decimal places. .4 displays 123.4560
Sn Display n decimal places, in scientific notation of the S.4 displays
’ form 1E3. 1.23456E+02
E.n Display n decimal places, in engineering format. E.2 displays 123.46
- Display a number as a decimal, followed by the *"pi" displays
P symbol . 39.29727m
— Display a number as a fraction of 1, with a Wt
#/4 "pi denominator of "4". #14 "pi" displays 1571/4
#1# "pi" Display a number as a fraction of . #/# "pi" displays 275m/7
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Display a number as two digits, a "+" separator, then

A two digits (e.g. surveying stations). #+i## displays 01+23
S M Dlsplgy_a number as one f}lllglllt, a "+" separator, then #+##M displays 1+23M
two digits, plus a suffix of "M".
#n Dlsp_lay a number as an integer of n digits, pad with 45 displays 00123
leading zeros as needed.
#% Display a number as a percentage. #% displays 12346%
# #H1#H Display a number as proper fraction. g;ﬁ;## displays 123
# #/n Display a number as proper fraction, in nths. # #/8 displays 123 4/8
DMS Display a number in Degree® Minute' Second", where DMS displays
1 degree = 60 minutes, and 1 minute = 60 seconds. 123°27'22"
Display a number in Degrees and Decimal Minutes.
D MDn EW P ifies decimal ol Positi |
(longitude) arameter n specifies decimal places. Positive values D MD3 EW displays
will have "E" or "N" appended, Negative values will o
D MDn NS A e . 123°27.360 E
(latitude) have _W or "S" appended. If you wish to preserve
negative values do not append "EW" or "NS".
Display a number in Degrees and Decimal Minutes.
D MDn EWB Parameter n specifies decimal places. Letter "B"
(longitude) ("before") specifies that positive values should have D MD3 EWB displays E
D MDn NSB "E" or "N" prefixed, negative values will have "W" or 123° 27.360
(latitude) "S" prefixed. If you wish to preserve negative values
do not append "EWB" or "NSB".
Display a number as a 32-bit hexadecimal (max 8 .
0, 0,
/oi#x hexdigits). The "#" symbol specifies "Ox" prefix. /6féx displays 0x7b
Display a number as a 32-bit hexadecimal (max 8
%#0Nnx hexdigits) notation, as an n-character string, pad with %#06x returns 0x007b
leading 0 as needed.
Display a number as a 64-bit hexadecimal notation o
%#0n164X (max 13 hexdigits, 15 total including #="0x"), as an n- %##014164X returns

character string, pad with leading 0 as needed.

0X00000000007B
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9.1.6 Column Label Rows

Column label rows store metadata -- data that is used to describe other data. Typically, this metadata may be
brought in as header information in imported files, or it may be manually entered. Display of column label rows
is optional and the user can selectively show them or hide them, as needed.

Column label row information is often used in plotting operations (e.g. worksheet Long Names used as graph
legend text or Axis titles). The F(X)= row is used in performing math operations on columns of data (see
below). Data stored in User-defined Parameter rows might be used in labeling or grouping of datasets in
plotting, data manipulation, statistical analysis or math operations (see Tutorial 2, below).

=2 Book1 - automobile. dat

A BiL) YY) By Eiv) i) Y
Long Mame 0~G0 . Gas Engine
Manth Make Fovver miph Weight Mileage Displacemen
b SEC ko rmpg Lo
Comments
Sparklines fﬂ,ﬂ “l Mwl || /"’H.’M
Cec Buick 132 2238 arv36.5
Dec Acura 154 12 2324 11 212
Dec GMC 148 13 1631 10 a900.4
Cec Chrysler 132 10 20848 12 B277.4
Cec kia 121 12 1202 12 a736.5
Cec Suzuki 106 10 1417 14 a736.5
Cec Yoo 45 14 166G 13 a0y
Dec Mercedes 132 14 2208 12 573645 _
\autnmnhilef ﬂ 1 | | LH

You can copy a selected subrange of worksheet cells and include associated column
label row information with the copy-paste operation. To copy label rows with data cells,
right click on your subrange selection and choose Copy (including label rows).

; Beginning with Origin 2023 you can highlight label row cells and stats will be reported
R, to the Status Bar.
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HE) Book1 * ==
A0 | B | em om | Eew | Fw e | Hn | o | sm | ke
Long Mame | Emission
Units| nm
Comments
Fi=
Excitation Wavel X 504 506 508 510 512 515 [
Max| 135882 1120.37 78 9487 57 980.35 994 48 9986.93 10164 101514 1017.02 10:
Min 835 15.49 2.91 -25.24 -16.62 -15.15 -16.31 -22.35 -18.41 -13.25 -1
1 835 -15.49 47 494 -6.43 16.19 8.66 -8.45 339 473 -
a2 =0 T-4 1 19 N8 e ¥ 13 79 16 B9 AE 18 A RO 0 A4 249 AT2 p—
(5 [ [\ Waterta 7 AN 1< N
B . start Menu ) - @U : ON (126x540) 512  [Book1]Waterfalli2(3] Radian |

9.1.6.1 Managing Display of Column Label Rows

Display (showing or hiding) of column label rows is controlled by shortcut menu commands:

Y

B 51512502 - 515-125-03.dat * 1 I (o [@][=]
ALK) BiY) CY) DY) i
Long Mame Time Delta Temperature  Magnetic Field  Position L4
Inits (sec) (K} (Oe) (mmj}
Sparklines f,f’ '\‘ [—
1 0.01 60.5 101.7
2 0.0z 4!:!.5 61.2 100.49
3 0.0z 40.2 61.9 100.3
4 0.04 40.1 G625 100.8
5 0.05 40.2 63.1 100.8
] 0.06 39.6 637 101.7
[ 0.07 397 64.3 100.8
| r |} 51512503 f || « | i | r|F

1. Right-click here and choose View from the shortcut menu.

Right-click here and choose Edit Column Label Rows or other label row command.

Right-click here to control worksheet elements (display Row Label, Column Header, etc) or select a cell in

this area, then right-click to Set Comments Style.

There is also a worksheet column label row Mini Toolbar for managing label rows. Use it to do such things as

hide selected label rows, enable Rich Text or change label row order.
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Long Mame Time Delta Temperature  Magnetic Fielc
LInits (sec) (K (Oe)
Cor S £ na 515-125-03 515-125-03

£} | Rich Text

Sample fBCO milled  YBCO milled YBCO milled
Measured o [ 12/01/2004 12/01/2004 1210142004
Time: [03:20:39 AM 03:20:39 AM 03:20:39 AM

Fun Type: [ Trial Run 1 Trial Run 1 Trial Run 1

9.1.6.2 Column List View

Origin 2019 introduced a new view mode for the worksheet called Column List View that is a transposed
view of the column label row metadata. This view is potentially useful if your worksheets have many rows of
metadata and you want to focus on some particular aspect of that metadata. With the worksheet active,
choose View: Column List View or press Ctrl + W.

fi vk tampie =
=
1 Al BYT | ooy | Dove} | £ | FreR ] [P 7| [T ] om | o wa |-
Lang Hims Tims Dafts Temgaisu Megradi Fisd Paslian Ti=w s Tevgamhi  Msgeic Fietd Poalion Time Dwlta Tamgesrih  Wagnatic Fisid [T
Unis (o) = O = e = On - ) " O, -
FlERITE ) gueraea) | 12500 SRS | SN0 | SNaM4T | ER20] SIS0 SERISNT | SEROMOM | BION60L BINOMGE  SK0MO4
| Copge| __ — et 0 B Y P g PR 1, S0 Py e, T S o
sEron 21 HE] A 1 21 i1 21 15 35 15 15
e of powes 1080 1200 008 1080 mo Toe o B0 80 [ B0
Samgle| TECOMASS | VECOmiEs  YECOmiet  THOO miisd VECOmiles  YECOmuied  YHCOmilisd BCO sihed-squsiSCO miles 0uaBC0 Milled ssusBCd milled-aqui
Muasared on 13017004 12004 122004 RO B ) 12190004 N0 1IN RI00E 130V00 12000 APL-A s ) 120%700H
Tonw | 032030 A0 D20 MAN | 0I0039PN | OI0RDPN  ORODDOPM  DIM0MOPY | OAJ0OAAN  GATDOAAN  GOIOMAM  GH20B4AN
Fewn Tapw Tril R 1 — = == e = —rr——
|l
Eatrhiz | .
Ll 1 FI] 008 TECT mabed TB012004 012009 M ThalFun 1 515 [7]
i Delts Tempeaatary (K} SRS e 21 108 YECO miled 12012004 DIZNIFAN  TalAun 1 515 125 (3]
L ou) B T 21 1008 VECO mied 12012004 032039 MM ThalFun 1 B15 125 0
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Further, you can apply a data filter to metadata in Column List View. When you return to the standard
worksheet view (clear the mark beside View: Column List View), only data associated with the filtered
metadata will show in the worksheet.

Column List View displays column index number ahead of column short name (+ column
designation). In addition, you can hover on the left edge of column long name and a tooltip
reports dataset size. To disable the display of column index, set @DSI=1.
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Column Toaoltip reports dataset size on hover
index Long Name\ | Units |Comments]|

1 1) ime (sec) 515-125-0
1) @ erature (k) 515-125-0
3 C(Y1) |/[1,000] icField (Oe) §15-125-0
_40(1) 'z n {mm) 515-125-0
S5EMZ) | 202 (sec) S521-235-0
6 F(Y2) 203 emperature (K} S521-235-0
T GY2) | 204 icField (Oe) S521-235-0
_BHY2) |zos n (mm) 521-235-0
QX3 [Time (sec) S32-014-0

10 J(¥3) |Delta Temperature (k) S32-014

9.1.6.3 Sparklines

Numeric data stored in a column will graphically display in the column header in a special label row called
Sparklines. A sparkline is, by default, a small inset line plot of the data in a column, plotted as the dependent
variable (Y) against the row number or the associated X column as independent variable (X). When importing
data, Origin displays sparklines by default when the number of columns is less than 50.

ALK) B{Y) C(Y) DY)
Long Mame Time Delta Temperature  Magnetic Field Position
LInits (sec) K} (De) (mmj}
Comments
F(x)=
Sparklines T ran
1 0.01 40 60.6 101.7
2 0.0z2 40.5 61.3 100.9
3 0.03 40.2 61.9 100.3
4 0.04 40.1 2.5 100.8
5 0.05 40.2 631 100.8
] 0.06 39.6 637 101.7

To Show or Hide Sparklines:
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Show Sparklines by clicking Column: Add or Update Sparklines. This opens the sparklines dialog.

Show Sparklines for selected columns by clicking the Add Sparklines button ﬂon the Column toolbar.
Right-click on the worksheet's Sparklines column label row and choose Add or Update Sparklines.
Delete sparklines by right-clicking the Sparklines column label row and pressing the Delete key.

In addition to the default line plot, Sparklines can display as Histogram or Box Charts. Highlight one or
more columns by clicking on the column header, then choose Column: Add or Update Sparklines. In

the dialog box that opens, set the Plot Type to Histogram or Box.



Workbooks Worksheets Columns

cn | obw | Em | Fm | &(Y) | AX) B(Y) cy | om |
Long Mama Powear O~60 mph | Weight | Gas Mileage  Engins Displacemant Long Mame | Sepal Length | Sepal Width Petal Length Petal Width
Units fw SEC kg mpg cc Units cm cm cm cm
Comments Comments
Fix)= Fix)=
Sparklines Sparklines I ; ,—L| r___
1 132 14 2238 11 5736.5 11 54 37 15 0.2
2 154 12 2324 11 5212 12 43 34 1.6 0.2
3 158 13 1531 10 5000.4 13 4.3 3 14 0.1
4 132 10 2088 12 6277.4 14 43 3 11 01
[ 121 12 1202 12 5736.5 15 58 4 12 0.2
G 106 10 1417 14 5736.5 16 5.7 44 15 0.4
7 95 14 1661 13 5031.7 17 54 390 13 0.4
8 132 14 2208 12 5736.5 18 5.1 35 14 0.3
a 128 13 1412 12 5736.5 19 a7 38 1.7 0.3
10 124 17 1518 13 5800.4 20 5.1 38 15 0.3
11 110 1n 1R1N 11 R212 24 EA 24 47 N

e  Sparkline plot properties can be customized. Double-clicking on a sparkline pops open a graph window.
Double-clicking on the pop-up window opens the Plot Details dialog box where you can customize the plot.

When you close the pop-up window, your customizations are applied to sparkline.

Sparklines can, in large numbers, cause Origin to act sluggishly. If your project is
difficult to work with and you suspect sparklines may be contributing, you can prevent
sparkline creation and hide existing sparklines in the project using system variable
@SPK. Additionally, you can delete sparklines from the current project using delete -

g

9.1.7 The Workbook Organizer

As mentioned, the workbook commonly stores metadata, some of which is visible in the column label rows.
Other metadata may be hidden in the workbook. Such hidden metadata might include things like import file
path and name, date and time of data import, file header information not written to the column label rows,
variable names and values, etc. This hidden metadata can be viewed in the Workbook Organizer panel.

To show (or hide) a workbook's Organizer panel:

e  Click the Show/Hide Organizer button on the workbook button bar.

e  Right-click on the workbook title bar and select Show Organizer
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] F3-Fadat” | [ | [
ALX) B(Y) C(Y) ~
Long Mame | Experiment Data: 09/01/07
Lnits | Temperature: 372
Comments -
ime
ser Sample Error
Fix)=
Sparklines / f _/\*‘
1 0 0.32975 0.00163
2 26 033097 0.00232
3 532 0.32563 0.00188 sheet-level notes
4 7a 0.33003 0.00219
5 105 0.33067 0.00208
N 17084 0 0N20A

— 134
[ [ AN AR/

B F3

R

s== |1

= Data Sheets

/
/I|<

]

First sample set. Readings taken after 24 hr treatment with Na25204,

B F2
B F3

Right-click on the nede to edit

= page info Bl layerinfo
SYSTEM.IMPC No Info.
SYSTEM.PLOT B user Tree
= Imported Files Mo Info.
=§| F1.dat W W
9.1.8 Managing Workbooks with Mini Toolbars
A number of common book-, sheet-, column and cell-level properties can be set or toggled ON/OFF with a
Mini Toolbar button.
@ Book
r o —
ACY) ‘ B(Y) | cM DhrEri} @ i lnﬂ G %’ TﬂI [ Setas Y Err |
Long Name Area Maonths Y1961 Y1967 o T
Units (°C) . Y Z m?"”“ 5Ol IS
Comments Temperatu||EElhEs . L Standard O
Fix)= | i
Filter Africa
) Metearalog
Am?;li:;lca ical year

® To see which tools are available, make a worksheet selection and then hover on your selection.
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e  Page-level formatting options are shown by hovering in the upper-left corner of the sheet or near the

window margins in the gray area to the right of the worksheet columns.

®  Go here for a full list of worksheet Mini Toolbars.

For Origin 2023, you can move one or more selected worksheet rows up or down, using a
Mini Toolbar button.

’ [ ,, ) Book1 - US Mean Temperature.dat * EI@
l":;l_]) ARG [ mn | £ry) D(Y) EQn ~
Data Source... \‘-tﬂng Mame @ %ﬁ tﬂJ @ ﬁ‘\? Move Row Down fude | January Februa
Units
Select...
e Comments L] f w = E't
Import Fix)=
Sparklines

Auto Import 3

(I{ELUR 0 -
SO LR L 2[ASTORIA, OR 1238 462 424 4
Disconnect Sheet 3| EUGENE, OR -123.1 44.1 39.8 42
Y Ay S—— 4| SALEM, OR 123 448 403 4
5| OLYMPIA, WA 122.9 47| 331 40
Exclude Imported When Saving G| MEDFORD, OR -122.9 423 391 43
. 7| PORTLAND, OR 1227 455 399 43
e L e Y 8|REDDING, CA 1224 406 455 49 v

« [ [+[v]\ US Mean Temperature / | <77 NI

Note that there are a couple of restrictions:

. If you have imported data using a Data Connector, you will have to click on the

green Connector icon % and Unlock Imported Data before you can move rows.

e  Analysis report sheets in which Recalculation is enabled do not allow moving of rows.

9.1.9 Find and Replace in Worksheets

& i V(R o MY ER & @8 [
XY Z =1} HDHEE-EI-

L

e Clicking Find opens a small dialog for searching the current worksheet selection.
e Small dialog supports string or numeric, forward and backwards search.

e  While the dialog is minimized, you can edit within the selection or press CTRL + Page Up/Page Down to
search backwards or forwards; or change the worksheet selection and restore the dialog to perform a new

search.

®  Click the ellipsis button (...) to open Origin's larger Find and Replace dialog.

119


http://www.originlab.com/doc/Origin-Help/Mini-Toolbar
http://www.originlab.com/doc/User-Guide/Import-Data
http://www.originlab.com/doc/User-Guide/Handling-Repetitive-Tasks

UserGuide 2023

i’ Find and Replace )
i [Bookd]"Custom D.. — X Find  Replace
Data Type:  ® Mumeric () String
Find l@ Condition: Find what (Enter -- for missing value):
Minimize or Win+Down to work in worksheet = - |35'5 V‘ﬂ
. Look in:
Ctrl + Page Up/Diown to search previcus/next.
Active Worksheet

Skip linked cells

Find/Replace in selected range
[ Use absolute value

[]5earch up

Tolerance: le-8

Origin has another "Replace" tool that can be scripted: wreplace. To open a Ul dialog,
open the Script Window (Window: Script Window) and type wreplace -d. To learn
about scripting options, see X-Function documentation for wreplace.

9.2 Simple Utilities for Filling Columns with Data

Some new data selection methods for Origin 2023:

' -2 a‘lli-.' e  When selecting a range of worksheet data, press Ctrl + click or Ctrl + drag, to
deselect unwanted cells.

Select a column and press Ctrl + Shift + RIGHT arrow to extend selection to the

the last occupied column. Select a row and press Ctrl + Shift + DOWN arrow to
extend selection to the last occupied row.

Origin provides several utilities for filling a worksheet range or column, with data. The simplest of these use a
menu command to fill a worksheet column with either row index numbers, uniform random numbers or

normal random numbers. This is useful for generating quick datasets to test and try out other Origin
features.
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These simple procedures create a dataset in a pre-selected worksheet range or column(s):

Action

Toolbar Button

Menu Command

Fill a range or column with row
numbers

or

Column:Fill Column With:Row

Numbers

Right-click and select Fill
Range/Column(s) With Row

Numbers

Fill a column with uniformly
distributed random numbers between
Oand 1

or

Column:Fill Column
With:Uniform Random

Numbers

Right-click and select Fill
Range/Column(s) With

Uniform Random Numbers

Fill a column with normally distributed
random numbers

or

Column:Fill Column

With:Normal Random Numbers

Right-click and select Fill
Range/Column(s) With Normal

Random Numbers

Fill a column with a patterned or
random set of numbers

Right-click and select Fill
Range/Column(s) With A set

of Numbers...

Fill a column with a patterned or
random set of Date/Time Values

Right-click and select Fill
Range/Column(s) With A set

of Date/Time Values...
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Action Toolbar Button Menu Command

e  Right-click and select Fill
Range/Column(s) With

Fill a column with arbitrary set of Text
& Numeric values

Arbitrary set of Text & Numeric

values...

The auto fill feature can be used in filling column label rows and the worksheet data cells:

To use auto fill to extend a pattern in the data across a range of cells (numeric data only):

1. Select a contiguous block of cells and move the mouse cursor to the bottom right corner of the selection.

2.  When the cursor becomes a "+", hold down the ALT key and drag the mouse to the bottom or the right.

To use auto fill to repeat a pattern in the data across a range of cells (text or numeric data):

1. Select a contiguous block of cells and move the cursor to the bottom right corner of the selection.

2. When the cursor become a "+", hold down the CTRL key and drag the mouse toward the bottom or to the

right.

Datasets can also be generated quickly using LabTalk script. As an example:

1. With a new worksheet active, open the Script Window from the Windows menu, and copy-paste the

following lines of script code into that window:

col (1)={0:0.01:4*pi};

col(2)=sin(col(1));

3. Highlight the two lines and press ENTER to execute them. The first two columns of the worksheet will be

filled with data.

9.3 Setting Column Values

|, Access to Origin's built-in functions has been improved in recent versions:

e The Set Values dialog and the F(x)= cell get Auto Complete support. Begin
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typing to see a list of possible functions.

e The Search Functions dialog that is opened from the Function menu in the Set

Values dialog can now be opened directly from the Tools menu (Tools: Search
Functions).

The Auto Complete hint is improved for Origin 2023 to ensure that it persists until all
"ME! function arguments are entered. This applies to the Set Values dialog, the F(x)= label
(RIS row and cell formulas.

The Set Values dialog box is used to set up a mathematical expression that creates or transforms one or
more columns of worksheet data. The dialog box includes a menu bar, a control used to define output range, a
tool for searching and inserting LabTalk functions into your expression, a column formula box used to define a
one-line mathematical expressions, a Before Formula Scripts panel (usage optional) intended for data pre-
processing and defining of variables used in your one-line expression and for Python users, a Python
Function tab for defining and using Python functions which can also be used in your expressions.

el

] Set Values - [Bookl]Sheetl!Col(D) (= || = || =

Formula weol(l) ColfA) Function Variables Options

Faow [} From <autox To <autor h
Menu commands

Search and insert functions

ColD) = Save formula —3 | [ E|

rpeak - rbase * dnorm

Put column formula here

1 (5] (o) (2]

Before Formula Scripts = Python Function

// Polnt to spectrum, baseline, and ocutput column -
range rpeak = 2, rbase = 3, raub = wcol(j)r

S/ Compute normalization facteor using lst data point
double dnorm = rpeak[l] / rkase[l]: \

m

LabTalk script to be executed before applying formula ™

Since Origin 2017, the column formula box (the upper box) in Set Values has supported a simplified
spreadsheet cell notation like is used in MS Excel and Google Sheets. A cell is addressed using column

Short Name + row index number (e.g. the first cell in column A -- formerly represented as "col(A)[1]" -- is
now simply "A1").

In new workbooks, spreadsheet cell notation is enabled by default. Spreadsheet cell notation can only be used
in defining the column formula. It cannot be used in the Before Formula Scripts panel of Set Values, nor can
it be used in your LabTalk scripts. Note that the "old" column and cell notation will work in spreadsheet mode,

so if you are an experienced user and you prefer to use the old notation, you may enter it as you always have.
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For an introduction to the spreadsheet cell notation syntax as well as a contrast with the "old" methods, see
Column Formula Examples.

To open the Set Values dialog box for a single column:

1. Select a worksheet column or a range of cells in a worksheet column.
2.  From the menu, choose Column: Set Column Values... or right-click on the worksheet column and

choose Set Column Values... from the shortcut menu.

To open the Set Values dialog box for multiple columns:

Select multiple, contiguous worksheet columns (skip no columns) or the entire worksheet.
2.  From the menu, choose Column: Set Multiple Column Values... or right-click on the worksheet column

and choose Set Multiple Column Values... from the shortcut menu.

P

ElSet‘u’aIues-Mul‘tipleColumns EI =] @

Forrnula weel(l) Col(A) Function Variables Options

Raow [ From <auto: To <autor

_ Specify the range of
Col (i) From 5 To 8 columns by column index

weollj) = = E ke| [<<] [22] |22

wool({j-3) * 5

j refers to the index of current column

(o) (oes) (o)

Before Formula Scripts | Python Function

Mote: Other controls and panels are similar
to the Set Values dialog for single column
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9.3.1 Set Values Menu Commands

(] Formula: Load a saved formula into the column formula box. Formulas are

saved using Formula: Save or Formula: Save As....

e wcol(1): Use the menu to include worksheet columns in either your column
formula or your Before Formula Scripts (column reference is inserted at the
cursor). A Column Browser is available to help in selecting the correct

columns. Columns are listed by column index.

e Col(A): Similar to wcol(1) menu functionality but columns are listed by

column name (including Long Name, if it exists).

e Function: Add LabTalk functions to your expressions (function name is
Menu

inserted at the cursor). Note that when you hover over a function in the menu
Commands

list, the function description will be shown in the Status Bar. When a function
is selected, its description will be displayed in a pop-up Smart Hint.

e Variables: Add a variable or a constant to Column Formula or Before
Formula Scripts; Add range variables (including by selection) or file
metadata, to Before Formula Scripts.

e Options: Allow direct editing of column formula in worksheet Formula row;
add a comment about the column formula; or preserve text in Set Values

columns (do not treat as text as missing values).

e Add a single line expression for generating data. Functions, conditional

Column Formula operators and variables can be used.

e LabTalk scripts to be executed before the expression in the column formula
Before Formula
Scripts

box is executed.

e Define and use Python functions in your expression.
Python Function

I When you mouse over one of the functions listed in the Function menu in Set Values
; dialog, a one-line tooltip is displayed in the Status Bar. If you select the function, a
Smart Hint appears with a more detailed explanation and a link to the full function
description, syntax, examples, etc.

Additionally, you can click the Search and Insert Functions button M to search for
available functions by keyword and, once found, insert the function into your
expression.

To learn more, see Set Column Values - Quick Start
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9.3.2 The "F(X)="" Worksheet Column Label Row

For simple expressions, you can use the F(X)= row to set column values. Any expression you enter here is
directly entered into the Set Values dialog and vice versa. Note that the simplified spreadsheet cell notation
that works in the formula box in Set Values also works in F(xX)=:

1. Double-click in a cell in the F(x)= column label row.

2. Enter an expression to enter output in the data column below.

AX) B(Y) cry) @& DY) &
Long Mame Wavelength Intensity Wavelength Intensity
LInits nm arb. unit nm arb. unit
Fix)= A+ucf | B +ycf
Correction Factor 530 -152.68
1 189.41 0 18471 -152.68
18877 16588 185.07 32
3 18013 166 44 18543 376

Ease of use improvements to the F(x)= label row for Origin 2023:

The Auto Complete hint is improved for Origin 2023 to ensure that it persists

until all function arguments are entered. This applies to the Set Values dialog, the

F(x)= label row and cell formulas. If you prefer not to use Auto Complete, you

can disable it by setting system variable @FAC=0.

There is now support for Autofill for column formulas. Previously, dragging a

column formula to the right would simply copy the same formula to other F(x)=

cells. Now, the formula will auto-adjust to use a sequence of new input datasets.

To use, hover at the lower right corner of the cell and when the cursor becomes a

"+", press Ctrl and drag to the right with your mouse.

£ Book1 o2 | | £ Booka * =R EcR ==
a0 | Bon [ en [ om [ Em [ Fon | ~ a0 | 8n [ ev [ om [ Em [ fm [+
Long Name Long Name
Units Uni /
Comments Comi
Fix)= Flx)=
1] 0.0§646 1 1 0.04831 1] 0.06628 1 046991 0.8984 031861 0.0408
2| 0.2§514 2 2 002027 2| 084017 2| 086849 037551 013688 071902
3] 0.3§374 3 3 023519 3| 0.84933 3 011672 054146 024537 021815
4| 0.8§525 4 4 071033 4| 0.25045 4| 039409 04763 0.88260 093376
51 0.43428 5 5 082215 51 052889 5 008468 0092146 095380 015943 —
[T eI\ sheet] / I [T eI\ Sheett / I N
] Book3 * pd [E=BEon =
ACX) & ~ B(Y) &) ca) ®) DY) &) *
Long Mame
Units v
Commasts?
Fix)={ [Book1}Sheetiid+[BookZ]Sheet 00K1]She@ool&]shse@ [B nnk1]3he&t@aol¢2}9hes@ﬁook1]9hsannm]SheeBunH]Shetﬂ
£ Ll 1.46991 094771
E 1,128 4 286849 039578
3 X [ 311672 0.77665
r | Press CTRL + drag with mouse | & 439400 118863
5 o797 10 508488 1.74361
[i] 1.17249 12 6.12877 088882
7 1.13988 14 7.38836 0.57399
] 1.51019 16 §.82039 0.49887 - |
[P [+[v]\Sheett [ | < >|r
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9.3.3 Set Column Values Tutorials

Tutorial 1: A Quick Units Conversion using F(X)=

Start with a new workbook and import the file \Samples\Graphing\WIND.DAT.
2.  We will assume that column B contains Speed values in miles per hour (MPH). Click
on the column heading for column C, then right-click and choose Insert. Origin
inserts a new column C and moves Power values to column D.
3. Now, we'll convert the MPH values in column B to kilometers per hour (KPH).

Double-click in the F(x)= cell of column C and enter

B*1.6
and press Enter. Column C is filled with values in units of KPH.

Tutorial 2 : Computing Moving Average and Moving Standard Deviation
1. Import the file Samples\Signal Processing\fftfilter1.DAT.

s + .

Add two more columns to the worksheet by clicking the E twice.

Click on the header of the 3rd column to select it, then right-click and select Set
Column Values... from the context menu.

4. In the Set Values dialog, enter the following in the upper panel:

movavg(B,5,5)

and press Apply. Column 3 is filled with an 11-point moving average of the data
from column B (note that you can insert functions such as movavg from the

Function menu of the Set Values dialog box).

Click the >=> button above the edit box to switch to the 4th column.

In the edit box for the 4th column, enter the formula:
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movrms(B,5,5)

and press OK. This 4th column will be filled with root-mean-square (RMS) values,

using a window size of 11 at each point.

Tutorial 3: Set Values for Multiple Columns

3

1. Create a new project by clicking the New Project button on the Standard
toolbar.

1t
2. Click the Import Multiple ASCII button HEH to import the files F1.dat and F2.dat

in the <Origin Folder=>\Samples\Import and Export\ path. In the impASC dialog,
set Multi_File (except 1st) Import Mode to Start New Books and click OK.

3. Two workbooks are created, named as F1 and F2. Click the New Workbook

button = on the Standard toolbar to create another workbook.

. . . +

4. With the 3rd workbook active, click the Add New Columns button E to add a
column. Highlight all columns and select Column: Set Multiple Columns Values
from the main menu or right-click the columns and select Set Multiple Columns

Values from the shortcut menu to open the Set Values dialog box.

et
5. Expand the bottom panel by clicking the Show Scripts button . Enter this script

in the Before Formula Scripts edit box,

range rl=[F1]F1lwcol(J); //"j" is the column index.
range r2=[F2]F2!wcol(j);

Enter (r1+r2)/2 in the Column Formula edit box
Select Options: Direct Edit Formula Cell to clear this option.
Select Options: Formula Text... and enter (F1+F2)/2 in the Formula Text
dialog, then click OK.

9. Click the OK button in the Set Values dialog box. You will see the results in the
worksheet, and (F1+F2)/2 will display in the F(xX)= column label row instead of the

formula.
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9.4 Setting Cell Values

Origin supports cell-level expressions similar to those used by spreadsheet programs. Cell-level expressions
which return a single value (numeric, string or date/time) can be entered into any worksheet data cell or into
cells in a User-Defined Parameter row of the column label row area. When Edit Mode (Edit: Edit Mode) is
toggled on, cell formulas display. When Edit Mode is toggled off, the formula result is displayed. Cell content
can be edited regardless of Edit Mode state.

a0 | em | em | om | ag | ew | em | om |
Long Mama Moming Evening Stats Long Name Moming Evening Stats
Units (=F) Units (=F)
Commenis Marming Evenin: Commenis Marning Evening
Count User Parameter =Countia, 1) :muntfﬁ?ﬂ Count User Parameter 49 55 |
Fiw= Fix)=
1 §7 05375 5708043 =meaniA) =meaniB) 1 §7 05975 §7 06043 5623468 5815745 |
2 g97.2 97.09497 =StdDevia) =StdDew(B) 2 g7.2 97 09497 0.4952297 0.50379
3 97 20991 97 46701 3 97 20991 97 46701
4 97.40002 97 53114 4 97.40002 9752114
5 - 87.51223 L] = 87.51223
6 - 97.40301 6 - 97.40901
7 = 97 5766 7 - 97 65766
g - a7 83376 8 - 9763376
Il - 97.44921 ] - 9744921
10 - 97 52057 10 - 9752057
11 87.60003 97.71328 11 97.60003 97.71328
12 97.59993 97.58163 12 97.59993 97.58163
Edit Mode ON P Edit Mode OFF

e To use cell formulas, Spreadsheet Cell Notation must be enabled (it is by default).

e  Cell formulas begin with an equal sign (e.g. =B1 - C1).
e  Cell formulas can return a numeric, a string or a date-time value.

e  Cell formulas can incorporate cell references, variables, operators, LabTalk-supported functions and

constants.
e  Cell formulas can reference values in other sheets or books.

e Cell formulas can be extended to other cells by dragging with your mouse.

To learn more, see Using a Formula to Set Cell Values.

Cell Formula improvements for Origin 2023:

'
=
1
e

B e The Auto Complete hint -- which shows as soon as you enter the first character

beyond "=" -- is improved for Origin 2023 to ensure that it persists until all
function arguments are entered. This applies to the Set Values dialog, the F(X)=

label row and cell formulas.

® There is a periodic refresh performed on cell calculations. If the sheet contains
large numbers of cell formulas, this can slow your work. System variable @SCNT is
added to manage the recalculation time (default is 5000 millseconds) so if the
continual recalculation is annoying, you can set a longer time period. Later, if you
need to force a refresh, you can open the Script Window/Command Window and
run @SCNT = -1.
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9.4.1 The Formula Bar

When creating cell formulas, or column formulas using F(xX)=, the Formula Bar makes it easier to find and
insert functions, select cell ranges and view and edit expressions, particularly long expressions that exceed cell
width.

Currently- |[™°"

SEIECtEd Plot  Column ‘Worksheet Format Analysis Statistics |mage Tools Preferences Copnedivity Winde

Cell DERh FEEHB wx - GEFHE FHEE & aARBERe 8.
oL@ I - ¥ U3 W Defait Adal w9 -B I U == - L

w om m o= — w1 w =

K " fx =stddev(B1:B10)

Cancel .
OK Expression/Text, e
, Current Cell o : .
Function Lookup Drag Edge to Resize
To enter an expression into a cell (data cell or F(x)=), click on the cell, then:
1. Enter an "=" and type your expression; or click the fx button to open the Search and Insert

Functions dialog.
Search for the desired function then double-click on it to insert it into your Formula Bar expression.
Interactively select your data range going to the worksheet and (a) clicking on a column heading or (b)

dragging to select a range of cells.

4. When your expression is complete, click the v button or press Enter.

Note that you can drag the edge of the Formula Bar to resize it. You can also change
the default font size by changing the value of LabTalk system variable @FBFS (default
is "130").

9.4.2 Set Cell Values Tutorials

Tutorial 1: Extending a cell formula to other cells

1. Click the New Workbook button 2| to open a new book.

2. Click on the column A heading to select, then right-click and choose Fill Column

with Row Numbers.

3. Click on cell B1 and enter:

=A1+A$1
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Press ENTER. This adds the value in Al to the value in Al.
5. With the cell still selected, hover on the selection handle in the lower-right corner
of the cell and when it looks like a "+", double-click to extend the cell formula to

the bottom of the column.

6. Click the Add New Columns button +E to add column C.

7. Click on the Cell in C1 but this time enter (omitting the "$"):

=Al1+A1

Press ENTER. This adds the value in Al to the value in Al.
With the cell still selected,hover on the selection handle in the lower-right corner of
the cell and when it looks like a "+", double-click to extend the cell formula to the
bottom of the column. Note that this time, the resulting values are different.

10. Click Edit: Edit Mode to display the underlying cell formulas. Note that the "$" in
column B "locked" the second cell Al reference so that it didn't change but that the
A1l reference in column C changed with the row index number as we extended the

cell calculation to other cells.

=AT+AST | =A1+AT
—AZ+AS1 | =AZ+AZ
SAI+AGT | =A3+A3
“A4+AST  =Ad+Ad
—AS+AS1 | =AS+AS

=AR+AS] | =AG+AR

Tutorial 2: Quickly finding maximum values in multiple columns of data using
special keyword "This"

The only place where you can use cell formulas in the worksheet column label rows
(worksheet header rows), is in a User Parameter row.

1. Create a new workbook and then choose Data: Import From File: Single ASCII
and import the file \Samples\Import and Export\S15-125-03.dat.

2. With your mouse, hover just to the left of the F(X)= row label and when the
pointer becomes an arrow, right-click and Add User Parameters.

3. In the dialog box that opens, enter "MaxValue" and click OK.
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4. In column A(X), in the MaxValue cell, enter:

=Max(This)

5. Click outside the cell and cell should now display "10".
Click back on this cell, then grab the selection handle in the lower right corner of
the cell and drag to the right to extend the cell formula to MaxValue cells in
columns B(Y), C(Y) and D(Y). All MaxValue cells should now display the

maximum values in their respective columns.

Tutorial 3: Use a column label row value in a cell calculation

All data in the worksheet column label rows, including User Parameter rows, is stored
as string data. To use a "number" stored in a column label row in a cell calculation, you
must convert the string to a numeric value. In the following example, we use the
LabTalk value() function to convert column label row data to a numeric so that it can
be used in a cell calculation:

1. Create a new workbook and then choose Data: Import From File: Single ASCII
and import the file \Samples\Import and Export\S15-125-03.dat.

2. With your mouse, hover just to the left of the F(X)= row label and when the
pointer becomes an arrow, right-click and Add User Parameters.

3. In the dialog box that opens, enter "Correction” and click OK.

In column D, enter the value "0.2" into the Correction cell.

5. Click the Add New Columns button +E to add column E.

6. Incell E1, enter:

=D1+value(D[Correction]$)

7. Press ENTER. This converts the Correction value to a numeric and adds the

numeric to the value in cell D1. The cell should display 101.9.

NOTE: The "$" in the above expression does not function to create an absolute cell
reference as in the first example above. In this context, the "$" syntax is used to
express a string variable stored in a user-parameter cell, before converting that string
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to a numeric value.

9.4.2.1 Naming Data Ranges

You can assign a name to a worksheet data range and use the name in cell formulas or column formulas and
to define Reference Lines in graphs.

Named ranges can be used in column label rows, for instance, to incorporate a label
row parameter value in your Set Column Values calculations.

To create a named range:

B Mew MName X
Refers to [Bookl]Sheet1!D
Name | myMameRange |
Scope Project W

Sheet

Define as Function
X Column

Comment

=

QK Cancel

Highlight a cell or a range of cells and choose Data: Define Name.
In the New Name dialog box, enter a Name for the selected (Refers to) range.

Assign a Scope to your named range.

P w NP

Optionally: if you wish to use the named range to return interpolated values, enable Define as Function

and/or add a Comment.

To manage named ranges:

1. With the worksheet active, choose Data: Name Manager.

2. Use the dialog to modify name, scope, range and comments.
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B ' Mamed Range Manager x
Marme Scope Refers To Comment
Daspl Book [Book3]Sheet!B[1:1] Sensor displacement in mm
LeftPis Project [Book]"Step Signal with Random Meise®!D[1:1]  Meoving average left window
RightPts Project H [Book?]"Step Signal with Random Meise*!D[2:2]  Mowving average right window
Tired Shest |E| [Bookl]labrasion_rawlA Tire A" Lbrazion Tire &
TireB Sheet |1] [Book!]abrasion_raw!E Tire B Abrasion Tire B

9.5 Remove Formula/ZLinks

Removing formulas and links can make it easier to share project data with colleagues without having to share
such things as externally-linked (DDE) Excel files. It is also useful for significantly reducing project size before
archiving data.

® | Remove Formula/Links ? 4

Replace formula, links with their current values

Remowve Links in Project e

Cell Formula and Links
Column Formula
Excel(DDE) Links

QK Cancel

Things you can convert to raw numbers:

(] Cell formulas

e  Column formulas

e Linked cell values (e.g. values copied a report sheet and paste-linked to other worksheet cells in the
project).

e DDE links (e.g. paste-linked values from an external Excel sheet).

To open the tool:

1. Click Edit: Remove Links...

for more information, see the Origin Help file.
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9.6 Cell Notes

Any worksheet cell -- data row or column label row -- can contain a cell note; even those that contain data or
other objects such as images or embedded graphs (Note: cells containing Links are not supported).

Worksheet cell Notes support Rich Text, meaning you can style text using Origin Rich Text syntax. In addition,
you can add images and graphs, and link to worksheet cell values, report table values, etc. See Notes
Windows for Reporting.

Cell notes improvements for Origin 2023:

.,-'. Ia''s
W ® Fix an issue with adding cell notes to a cell at the edge of the worksheet. The popup

text box is now better-positioned with respect to the containing cell.

125 125 edge of window |
No 03 03 03 03

101.71
1009
100.3
100.8

1008
1017 =

< > [

', Trial Run 1

e There is now a system variable @CNF (default=12) for control of cell notes preview

font (independent of font when opened in a Notes window).

e  When editing in the Notes window, enable Font Size drop-down and Increase Font

and Decrease Font buttons.

e Column List View now supports cell notes in the label row area.

[T [TV I\ Tin Rum 1 / I >

5 Book2-515-125 Bt | @ [ [lertricn =
LongName | Units | Comments | ... Mo, ofpoints| Sample | -

1 A[X) [Time (sec) [515-12503 | 21 1000 YBCO milled

2B(Y) | Detta Temperature (K) 51512503 ~~—_ 21 1000 YBCO milled

3 C{Y) |Magnetic Field (Oe) S1512503 /21 1000 YBCO millad

4D(Y) | Position jmm) S15-125-03 A\ 21 1000 YBCO milled

Il

1. To add notes, select the worksheet cell and click the Mini Toolbar Add Note button and enter your

text.
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iY) H(Y)

Fited Curv | 2 Q@

SON's 1

39587

Insert Note

rson's I
- —

5(Y)

H{Y)
Fitted Curv

2. While editing your cell note, use Format toolbar buttons to format your text.

E=R(I==

.—.IT|I

a0 | B | cvn | om |

d.l.

195.18
188.67

@ Book? - Exponential Decay.dat *
(=]
Long Mame| Time
Units sec
Comments
Fix)=
Sparklines
1
2
3 .
4 0.04
5 0.05
G 0.06
7 0.07
8 p.0a
9 0.09
(] 01
\Expunential

17R RR
Decay

4.l

Decay 1 | Decay 2  Decay 3

d.l.

Adj. R-Sguare = 0.99596

Farmat v X
T Segoe Ul - 10 - B I
U x xiab X &=~ - A -
—

TZEET
127.59
126.75

LAL
60.74
54.55

A FitPolynomiall i Fif| <

>

3. Note that a right-click inside the notes popup brings up a shortcut menu for inserting various Origin

objects, for resizing the popup to fit added content and to Edit Raw Text in Notes Window.

4. Alternately, you can select the cell, then click the Mini Toolbar Open in Notes Window button to

open content in a Notes window. Rich Text is enabled by default.

) | HW
Fitted Cury

30M's T

19587

Open in Notes Window

]

5.  While editing in the Notes window, use Format toolbar buttons (a) to format your text. To see your

note in "Render" mode (b), press CTRL + M (Notes: Render Mode). To insert the finished Note into

the worksheet cell, click the Close button (c).
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T Default: Arial 1] 2 - - & -

This is \bibold) text. ?
This is \i(italicized) text. o

This is [0 text. Render Mode (CTRL + M)
This is subscript text.

This is Greek text. ]
=
This is larger text. o] -E [aim] | c-
~

6. The reinserted Note can be see by hovering on the worksheet cell.

T Default: Arial i) 2 - [ - A .

" This is bold text.
This is italicized text.
This is red text.
This is ¢ pscripted text.

This is Tpeek text.

This is larger text.

Notes:

For text that is not assigned a paragraph style (see next section), you can use the Font Size
control on the Format toolbar, to control text size. Font Size can be set for each window but all

Notes windows must share a common Font (e.g. Segoe Ul).

Origin supports "substituting” cell Notes in graph legend and text objects using @WN (e.g. %(1,
@WN, B, 3) for Note in col(B), 3rd cell of 1st plot's source worksheet).

9.6.1 Text Styles Manager

In addition to styling text with the Format toolbar, you can apply a simple set of styles to each line/paragraph.
Manage styles with the Text Styles Manager dialog box.

1. With a worksheet active, choose Tools: Text Styles Manager.
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2.

Select a Style to Modify and Apply or Close.

List

8 Modify Text Style 7 x
Style to Modify Body Text el
Font Face T Default: Anal v
Size Factor (%) 100 wr
Color . Auto -
[] ustification
=2 Font Style

Bald O

ltalic a

Underline ]
= spacing

Extra Line Spacing (%) o o |

Before Paragraph (pts) o w |

Aafter Paragraph (pts] 2 W |

Indentation (3 of font size)

[elete

None i

Apply Cloze

Note that you can add styles by selecting <new> from the Styles to Modify drop-down list; or select a style
and Delete.

To apply a paragraph style to Notes window text:

Open the cell note in a Notes window.
With Render Mode off (CTRL + M, to toggle), click on a line of text then right-click, choose Paragraph

Styles and choose a style from the popup menu.

To check results, press CTRL + M (Render Mode).

9.7 Processing Worksheet Data

Origin provides a number of utilities for manipulating worksheet data. Most of these are found on the
Worksheet menu while some are on the Edit, Column or Analysis menus (note that a worksheet must be
active). Some utilities are available from a shortcut menu: select your data and right-click.

Utility

Menu Access

Sorting Data

Worksheet: Sort Range
Worksheet: Sort Columns
Worksheet: Sort Worksheet
Worksheet: Sort Columns by Label
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Utility Menu Access
Edit: Find in Project
Edit: Find in Sheets
Edit: Replace
Edit: Go To
Edit: Select
In order to make it more visible, Edit: Select has
. il been duplicated at Column: Select Columns, in
Find "MEW Origin 2023.
Replace In addition, there is now a Mode = By LabTalk
Go To (sheet Scr!pt option with several simple examples
available from the flyout menu.
row/column)
Select/Hide Select - [Book] [Wated=ll! x
Columns
Mede By LabTalk Scrpt .
®[10] 2.5
|
v Salect by Value of Min Raw
Gelect by Mean of Column
Select Blresia= Select by Specified Columng
Hide

Hide Column

Hide Rows

Column: Hide/Unhide Columns

Hide/Unhide Rows (shortcut menu only)

Move Columns

Swap Columns

Column: Move Columns or Column toolbar.

Column: Swap Columns

Query Worksheet
Data

Worksheet: Worksheet Query

Copy Columns to

(new locations)

Worksheet: Copy Columns to

Append
Worksheet

Worksheet: Append Worksheet
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Utility Menu Access

e Join Worksheets Worksheet: Join Worksheets by Column
Worksheet: Join Worksheets by Label

*  Split Columns Worksheet: Split Columns

e  Split Worksheet .
Worksheet: Split Worksheet

(] Split Workbooks
P Worksheet: Split Workbooks

No menu access. To open the dialog box:

*  Split Cell Strings 1. Click Window: Script Window.

to Multipl
0 Muttiple 2. At the cursor, type text2cols -d and press Enter.

Columns

For more information, see this link

Worksheet: Stack Columns

Worksheet: Unstack Columns

e  Stack Multiple
Worksheet: Stack Worksheets

Columns into One

with Grouping
Unstack Columns improvement for Origin 2023.
® Unstack Grouped When (a) Put Grouping Info to = Custom, (b)

2 Labels to Store Grouping Info specifies labelling
output using one or more user-parameters, and (c)
the Group Column(s) have a Long Name, Origin
will use the Long Name as a user-parameter row to
identify output in the Output Worksheet.

]
o

Data into Multiple

Columns

(] Stack Columns
Common to
Multiple Sheets by
Label You can now hide sheets in the workbook. To

by accommodate this change, Stack Worksheets now
has a Skip Hidden Sheets check box.

e

=

1
-

e Summarize Data
with Pivot Table Worksheet: Pivot Table

e  Filter data by

defining conditions Column: Filter menu, or Worksheet Data toolbar

on one or more )
See Also: Data Masking
columns
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Utility

Menu Access

Data Reduction

Worksheet: Remove/Combine Duplicated Rows

Worksheet: Reduce Columns

Worksheet: Reduce Rows

Analysis: Data Manipulation: Reduce Duplicate X Data

Analysis: Data Mani

ulation: Reduce by Grou

Analysis: Data Mani

ulation: Reduce to Evenly Spaced X

]
o

Origin 2023 additions:

New Merge by options to Reduce Columns
(wreducecols), including a Custom option that
allows you to specify output of multiple
quantities (e.g. "ave sd" for average and

standard deviation).

New SubGroup Method = By Reference
Column(s) for Reduce by Group (reducexy)
dialog box.

For data reduction output (X-Functions =
reducedup, reducexy, reduce_ex), label row
Method is created to hold key methods
information (system variable @CCL = 1). In
addition, Long Name and Units from source
sheet used in output sheet (previously, output
might have been tagged with generic

information about the analysis operation).

Worksheet

Transpose

Worksheet: Transpose

Convert

Worksheet Data

Convert to XYZ Convert to Matrix

Apply Conditional
Formatting to

Worksheet Cells

Worksheet: Conditional Formatting: Highlight
Worksheet: Conditional Formatting: Heatmap
Worksheet: Conditional Formatting: Duplicates

Reverse Order

Column: Reverse Order
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9.8 Conditional Formatting of Worksheet Data

In addition to the above worksheet data utilities, the Origin worksheet supports Conditional Formatting.
Conditional Formatting has three modes:

e Highlight mode opens a dialog box with controls to apply color to worksheet cells based on one or more
conditions (e.g. "equal to", "not equal to", "text that contains", etc).

e Duplicates mode opens a dialog box with controls to apply to worksheet cells that contain duplicate
values.

e Heat Map mode opens a dialog box with controls to apply a color map to cells based on worksheet values.
The worksheet Heat Map is zoomable and scrollable, making it easy to get a "big picture" overview of data

variation in three dimensions.

4 15 e o s =
B gt | e [ o [oem{ema] e e v v | e ke e e {ue ora ] roa| ~
Long Hama iy Longiude| Lalluda  Jan | Fab | Mar  Apr | Bay  Jum Bl | Aug | Sop . OO Mow | Dac
i e T (L el sdih sl nal P nedie Pl el - Annual Average Tempearature
i KALESPELL NT - ¥ B 5431 S5r7 635 &30 834 | 428 e
3 CLABGOW, NT ) | &5 03 Q28 k2 T =
3 SPOKANE, Wi ar Lot g3 R . - - -
4 GREAT FALLE NT 475 6.2 438 e L L o
[ FaR, HD i e 15
0 EEN-F;:.ND [ o4 23 - b * .“'0«“'- L .P
7 CARIBOU, VE £E 856 n2 i 4 A o B
[ YAKIMA, e o LLE} @8 B -
[] BAULT STE NARIE, NI L3 639 a1 B ...
A0 ASTORIA OR 452 801 CH el &
1 BILLPSGS, NT L1 kri iva
i FaERDEEN 80 e T as| | ™7 e
4 or [ 2
:s er:‘EE:: wr u: ::: L: Sl [ oo le] b in 58 Google INED
18 BURLINGTOR, T 5 T8 =3 2o A1 Ao aaae e
o e - 4
i EUGENE, R 41 w2 #62 521 =
« [+ i, S Mhean Temperature | 1l =
Manage conditional formatting in the active sheet using the Conditional Format Manager.
n / When using 3-Color Limited Mixing to apply color to worksheet heatmaps, you can now
precisely control where the middle color falls. Specify by Percentile, by Percent or by

Value.

9.9 Protecting Worksheet Data

Beginning with Origin 2023, there is GUI access to worksheet protection.

You can apply blanket protections to one or more worksheets and, in the process, provide for a few exceptions.
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Gray Data Connector icon indicating that

the Connector menu is disabled. Sheet Mini Toolbar

~ [@ =
. [:ID B = % Protect Sheet
ap) | ey | e | ppa | =g IJ Q
~Tong Nama Time Ten?pz:mre Magnetic Field Fosition s us
B (e *) 08} {mm) i1 | Object Manager shortcut menu
Sl 5155;25 51512503 515125-03 5155;25' Move Before [
Sparklines | _—" | T/ L Maove to Begin
e 21 21 21 21
Move to End

No_ofpainls| 1000 1000 1000 1000

Sample|YBCOmI  YBCO milled  YBCO milled | YBCO mi & Tial Fun 3 T S 5

Measured on | 1201/20 1200112004 120012004 | 12101720
Time: (03:20:39 03:20:39 AM 03:20:39 AN | 03:20:39

Exclude from Plotting Dialogs

Run Type:| Trial Run| Trial Run 1 Trial Run 1 | Trial Run
ERES 515 i Lk L Exclude from Excel Export
BalchMo| 125 125 125 125
Runto| 03 03 02 03
= Protect Sheet
1 0.01 40 60.5 01.7 Havigate
2 002 405 613 1009 protecﬂon lock -
E I TE 402 619 1003
4 0.04 40.1 100.8
5 0.05
5
7 L
alef+]vhm

®  Click the sheet-level Mini Toolbar Protect Sheet button.
®  Press Ctrl/Shift + select on multiple worksheet tabs then right-click and Protect Sheet.

®  Press Ctrl/Shift + select on multiple sheets in Object Manager then right-click and Protect Sheet.

Any of these actions produces a Protect Sheet Options dialog so that you can set some exceptions. This
dialog is also available by clicking Preferences: Protect Sheet Options.

B Protect Sheet Options ? *

Protect Worksheet Contents but allow users to:

Data Masking T
Sort Worksheet ]
Resize column/rows and change color etc
Change column designation like set as X |:|

Add/Modify Cell Notes

|:| Do not ask me again
This dialeg can be open from Preferences = Protect Sheet Options

You can also choose Help > Reactivate Reminder Messages

QK Cancel
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1. To remove protections from one or more worksheets, select the worksheets and remove the check mark
beside the Protect Sheet Mini Toolbar button; or from the Object Manager or sheet tab shortcut menus'
Protect Sheet option.

9.10Workbooks for Analysis and Reporting

Apart from text and numeric data, the workbook can contain various other types of information -- images,
graphs, notes and matrices; links to cell values in other books, project variables, documents or web pages;
plus, import file metadata, variables and scripts -- making the workbook a flexible medium for collecting
research data or for creating custom reports.

Further, as we will see, the workbook can "store" a complex sequence of analysis operations -- for instance,
the application of a data filter, plus a fitting operation on the filtered data, combined with a customized plot of
the results -- into something that we call an Analysis Template. The Analysis Template makes it possible to
automatically generate a custom report of results, simply by supplying new input data.
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One attractive option for generating reports (there are others -- see the tip at the bottom of this section) is to
export data to a custom MS Word template, and optionally, a PDF file. This is done by running an output-
generating analysis in Origin, then associating key results with bookmarks in a Word template, and, finally,
saving the workbook as an Analysis Template. To generate your report, you open the Batch Processing tool,
point to both your Analysis Template and your Word template, run the batch process and generate your
reports.

e  For information on generating custom reports using an MS Word Template, see the tutorial

Batch Processing with Word Template for Reporting.

e  For information on batch analysis and generating custom reports, see the Batch Analysis

section of the "How to Handle Repetitive Tasks" chapter of this Guide.
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Another option for generating reports is to create HTML reports using Origin's Notes
window. A Notes window can link to graphs, worksheet cells, etc., either directly or
using a placeholder sheet. For more information, see HTML Reports from Notes

Windows.

9.11 Topics for Further Reading

The User Files Folder

Origin Template Files

What is Saved with the Workbook Template?

The New Workbook Dialog

Arranging the Worksheet
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Displaying Supporting Data in the Worksheet Header Rows

Controlling How Numeric Data Display

Dates and Times in the Worksheet

Generating Simple Worksheet Datasets

Column Short Name Restriction

Using Formulae to Set or Transform Worksheet Column Values

Using a Formula to Set Cell Values

Simple Manipulation of Worksheet Datasets

Inserting Graphs, Images and other Objects into Worksheet Cells

Inserting Links into Worksheet Cells

Inserting Variables into Worksheets

Conditional Formatting of Worksheet Cells

Analysis Report Sheets and Columns
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Show XY

Display Book Short Mame and/or Long Mame,
plus active objectftotal matrix objects
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10.1 Matrixbooks, Matrixsheets and Matrix Objects

__-_'_'_-—_

Up to 1,024 Matrixsheets

with Multiple (Up to 65,527) Matrix Objects per Sheet

A matrix is a dataset of Z values arranged as an array of columns and rows which are linearly mapped to X
and Y values. The following table summarizes some important matrixbook limits:

Maximum Number of... 32Bit OS 64Bit OS
Matrixsheets in a matrixbook 1024+t 1024+t
Matrix objects in a matrixsheet 65,527 65,527
Cells in a matrix (Note) 90,000,000 90,000,000

T > 255 sheets requires saving file to Unicode (e.g. *.opju) file format. Unicode formats not compatible with
Origin versions prior to Origin 2018 SRO.

Note: The product of any combination of rows and columns must not be greater than 90,000,000.
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10.1.1Naming Matrixbooks, Matrixsheets and Matrix Objects

% MBookl - Mt. 5t. Helens before and after eruption 1,2 Eefu% E@

Matrix Book Mame
Thumbnail of Short Name - Long Name: active object/total objects
Matrix Object

_ Columns mapped to M3 trisc
Befare fifter r—. linearly spaced X values Window

c|2|3'|4|5";4 Menu

T)\ 444364  0.98748 -50.96561 198.2151 5574458 5368206 5440881 £~
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1 || 145776 -3.23971 214703 1 9891984 987.9827 ¢

12 |[1466156  -3.25173  217.182 8 0969863 9999008 ¢

C
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e The matrixbook has a Short Name whether you display it or not. Origin uses

the Short Name for internal operations.

e Short Names must be unique within the project file, cannot contain spaces,
must begin with a letter, consist only of alphanumeric characters (A to Z and 0
to 9), and limited to 13 characters. You can use lowercase characters and the

Matrixbook text will appear as such, but upper and lower case are not unique characters.
(You cannot name one matrix MBOOK1 and another mbook1.)

e Long Names are optional, need not be unique within the project file, can
contain spaces, can begin with a letter, a number or a special character, and

the length cannot exceed 520 characters, including spaces.
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Matrixsheets

The sheet Name must be unique within the matrixbook and is limited to 32

characters.

Can contain spaces and numbers.

Can contain special characters except ~ 196" | Q[{3}<>.
Can begin with a letter, number or allowed special character.

Optionally, sheet can have Label and Comments.

Matrix Objects

By default, Origin assigns a matrix object index number to each object, as it is

created. This index number cannot be changed.
You can add a name to the object by clicking on the yellow object icon -

for a data matrix or @ for an image matrix - in the upper right corner of the
matrixsheet and choosing Rename from the menu. Alternately, you can
double-click on the matrix object number/name below the thumbnail and enter

a name.

10.1.2Different Views of the Matrix

In the worksheet, a dataset is contained in a single column and the dataset may consist of X,Y,Z, Error, or
Label data. In the Origin matrix, a dataset is arranged in a specified dimension of rows and columns. The
matrix contains a single dataset of Z values.

e  Matrix columns are mapped to linearly-spaced X values.

®  Matrix rows are mapped to linearly-spaced Y values.

Note that the matrix window has two column and row heading view modes:

e By default, matrix row and column headings display as row and column index numbers (View: Show

Column/Row from the menu or press Ctrl+Shift+C).

®  You can opt to view matrix row and column as X and Y values by choosing View: Show X/Y from the

Origin menu (or press Ctrl+Shift+X). The displayed X and Y values are the X and Y coordinate values,

calculated by linear interpolation of the axes From and To values by the number of columns and rows.
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In addition to the two row and column heading view modes, there are two matrix display modes:
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In Data Mode (View: Data Mode from the menu or press Ctrl+Shift+D), the matrix object displays as

raw numbers.

In Image Mode (View: Image Mode from the menu or press Ctri+Shift+1), the matrix object displays

as either a gray scale image or a color image, depending upon the type of data in the matrix. A matrix of

real numbers or complex numbers displays as a gray-scale image while RGB values will display as a color

image.
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Note: If the matrix object is an image, the object icon will display as Whether you are viewing the
matrix object in Image Mode (View: Image Mode) or Data Mode (View: Data Mode). Similarly, when

you import numeric data into the matrix, the object icon will display as regardless of View mode.

10.1.3Matrixbooks

Like the workbook window, the matrixbook window is created from a customizable template (.otmu file). The
matrix template stores such things as number of sheets in the book, the nhames of the matrixsheets, matrix
dimensions, data type, math functions, data import handling instructions as well as various style and format
options.

When you create a new matrixbook, the book is named MBookN, with N reflecting the order of window creation.
Appended to the book name, you will see something like ":1/3" where the first integer denotes the active
matrix object and the second denotes the number of matrix objects in the active matrixsheet. Following the
above example, if you click the yellow object icon to the right side of the matrix, the menu shows three matrix
objects with the first being the active one - the one with a check mark placed beside it (note that in our
illustration, the objects are empty).

[

[ MBookt 173 =)
1 2 3 | 4 | 5 |B Insert
1 _ _ _ _ .
- . ~ ~ - ] Add
3 = - - - - Rename
4 - - - - -
g - —- — - ] Delete
E - - - - 7 .
7 _ _ _ _ ol Properties
<[ » [\ MSheet1 }MSheet2 f || « | M N
2
3
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i You can right-click on a worksheet tab and Add Matrix as Sheet and insert a
; matrixbook into a workbook. This is useful when building Analysis Templates that
involve matrix-based operations such as 3D surface fitting or 3D plotting operations.

Insert

Delete

Add

Add Graph as Sheet...

Add Matrix as Sheet...

Add Motes as Sheet

10.1.4Matrixsheets

|, Prior to Origin 2018, an Origin matrixbook could have a maximum of 255 sheets. That
number is now increased to 1024. When you have more than 255 sheets in a book, you
will need to save the file using one of the new Unicode-compliant formats (opju, ogmu,
etc).

A matrixbook can have up to 1024 matrixsheets. The default matrixbook template - ORIGIN.otmu - has a
single matrixsheet containing 32 rows and 32 columns. Each matrixsheet can differ in dimensions(number of
rows and columns and X & Y range).

To specify the dimensions of the matrixsheet:

1. Click on a tab to activate the sheet and choose Matrix:Set Dimensions/Labels. This opens the Matrix
Dimensions and Labels dialog box.
Specify a number of columns (X dimension) and rows (Y dimension).

Specify a From and To value for X (columns) and Y (rows).

Note: The X and Y coordinates of the matrix are evenly spaced. The first X is mapped to the first matrix
column and the last X is mapped to the last matrix column. The X coordinates of other columns are
interpolated. Matrix rows are similarly mapped using the From Y and To Y values. When plotting or
analyzing matrix data, the position of a point in 3D space is determined by the column X and row Y
coordinate values (not column or row index) and the Z value contained in the cell intersected by the row

and column.
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A matrixsheet can contain up to 65,504 matrix objects, though the actual limit is likely to be far less
(determined by system resources). Objects in a sheet share the same X/Y dimensions and column (X) and row
(Y) headers, but every object can have its own Z header. Other matrix object properties include internal data

type and numeric display options.

Matrix object properties are set in the user interface via the Matrix Properties dialog box. To open the dialog

box:

1.

2. Choose Matrix:Set Properties... from the main menu.

Make sure that the matrix object is active (check mark shows beside it in the object menu).

i You can set properties for multiple matrix objects without closing the Matrix Properties
' dialog box by clicking the << Previous or Next >> buttons at the top of the dialog

box.
B " Matrix Properties - [A3D5SurfaceCon]"3D 5.  — X
<< Previous Mext == mE
Properties
Long Mame | 30 Surface & Contour |
Units | |
[ asen file import | - |
Digits Default Decimal Digits e
Data Type Double(g) v
OK Cancel Apply

10.1.6Import Image to Matrix

Origin has two structures for importing multi-frame images -- the matrix window and the Image window. The
matrix window is better-suited to performing data analysis tasks (e.g. surface fitting, statistics, mathematic
transformations of data, etc.) and some graphing operations, but take note of the following:

Mode" (View Data Mode) and "Image Mode" (View: Image Mode).

second window in the sequence below.

When you import an image to the matrix, you can -- as with other matrix data -- switch between "Data

However, until converted to data, matrices contain RGB values (regardless of View mode), as seen in the

153


http://www.originlab.com/doc/Origin-Help/MatOb-Header
http://www.originlab.com/doc/Origin-Help/Images-Conversion

UserGuide 2023

e  Performing certain analysis or graphing tasks (e.g. Nonlinear Matrix Fit or creating an Image Plot) requires

that the matrix first be converted to Z values by choosing Image: Conversion: Convert to Data.

Imported
Image
| Cart - Carbmp 111 Carbmp * [E=2EcE === Image in
I%l "Data Mode"
Converted Image,
I p— ==

i 2 [ 3 | & | s @ short ( 2)

190207 18| 1912101 ¢ .
18420719 1912081 | 2 Mookl /1

196,205 19 194 207 1 1| Image Plot
4| 157 209 19 193 207 1 3 51657
5[ 19621013 1962101 B i =
6] 19521018 1962101 3 BT o[-
7| 18521013 1042081 3| 52685
167 206 19 194 207 1 S 52835 R
9920519 198,207 1 | e @
0] 19820319 199 2081 = —
71| 201 206 19 200 208 1, =1 o
12| 201208 13| 2002112 8| s217
any 20020713 198208 1 o] s1400 )
204 206 19| 204 2081 1 =2 .
208204 19 204 207 1 2 52685 —
204 207 19 200 2091 [E] 52428 )
73;.20543_1&7.?.104_ 14 52428 .
Lele f\Car 5 2 =z
16|  sosas pr—
Uy 521
B0 (T — o
"
) s
a0

For more information, see Image Conversion in the Origin Help File.

To import an image or image stack to the matrix window:

1. With the matrix active, choose Data: Import From File: Image to Matrix.
2. This opens the Image to Matrix (implmage) dialog. Note that there are are controls for Import

Grayscale GeoTIFF as Data, Show Image Thumbnails and multi-file import-handling.
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D mpimag e

Impert image file into a new Matrix window
- E\Project_Data\Origin 2021\ Test_Data\pt : F
= File Info
10542 tif File Size: 138,19 MB
Import Grayscale GeoTIFF as Data E
= impart Options
Show Image Thumbnails | Only if Multiple bd
15t File Import Mode Replace Existing Data
Multi-File [except 15t) Impart Mode Start New Objects |
[ (RejMaming Matrix Sheet and Matrix Book
Output | [MBook1]MSheeti!] A

10.1.6.1 Image Thumbnails and Image Slider

i When importing multi-frame TIF files, thumbnail/slider display is controlled by system
¥ Y variable @MSS (default value =10):

e |f the sheet contains a single frame, don't show thumbnail/slider.
e For 1 < frames < 10, show thumbnail

e  For frames > 10, show slider

When the sheet contains multiple objects, you can display those objects as a series of thumbnails in a spacer
at the top of the matrix window.

1. Right-click on the matrix window title bar and place a check mark beside Show Image Thumbnails.
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1H MBock :2/100 0001 *

Show Organizer

T2 s

0003

Show Script Panel
Show Column/Row Ctrl+5hift=C
Showe X5 Ctrl+Shift =%
0000 0002 . Show Image Thumbnails Ctrl= Shift=M
¢ 3
Save As..
=) 1 | 2 | 3 | 4 | s
1] 0.00968 0009638 000968 | 0.00968 0.009 Hide
2| 0.00968 000968 0.00968 0.00968 0.009
2| 0.00968 000968 0.00968 0.00968 0.009¢ .:;.I Print... Ctrl=P
41 0. DEIEIEE 0. EIEIEIEE 0. EIEIEIBE 0. EIEI!-]EB 0.0094
g 00097 Add Shortcut to Favarites
i 0.009¢

Alternately, you can use a slider control to view these objects in the active matrixsheet.

] MBook1 :53/100 0052 *

E=H KON ===

%

"< » ]\ MSheet1

O,

>

N

0.0~

0.0
0.0
iga 0.0
s | 0.0

B2 0.0

If you are seeing thumbnail images in the spacer at the top of the window, you can switch to the slider by

doing the following:

1. Hover in the space between the thumbnails and when the cursor changes to a grid icon , click to show

the page Mini Toolbar (you can also click in the gray area to the right of your matrix image).

2. Toggle the Slider or Thumbnails button to show slider or thumbnails.
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3. Likewise, you can turn off both thumbnails and slider by clicking the Image Selector button. Click the

View Image button to toggle between Data Mode and Image Mode.

Image Selector

View Image l Slider or Thumbnails
Cal —+
& =g === Image-related

[l « En £ Toggles

10.1.6.2 Naming Matrix Objects

You can assign a name to a matrix object:

1. With the matrix object active, choose Data: Define Name.

2. Give the matrix a Name, set Scope and, optionally, add a Comment.

Named ranges can be used in Matrix: Set Values (e.g. to perform math operations on other matrix objects of
the same dimensions).

10.1.6.3 Import GeoTIFF to Matrix

GeoTIFF is a public-domain image format that stores spatial information in a TIFF file and which has
applications in mapping. Origin supports import of GeoTIFF files to both matrices and Image windows.

To import a GeoTIFF file to the active matrix:

1. Click Data: Import From File: Image to Matrix.
2. In the Image to Matrix dialog (implmage), check the Import Grayscale GeoTIFF as Data box and click
OK.
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El File Info
alaligiieiiibinamiPonl. Wintaaiamatl Pvbesat ivisip™ WP | File Size: 211.75 MB
Import Grayscale GeoTIFF as Data |

Import Options

For more information, see the Origin Help file page for GeoTIFF Importing and Processing.

10.2 Extracting Information from the Matrixsheet or Object

The Intensity Profile dialog gets a Weighted ROI check box for Origin 2023. When

this option is selected, each pixel is weighted by the area of the intersection of the pixel

rectangle and the ROI polygon. This is to improve results when the ROI coordinates do
o not fully cover a pixel.

When viewing matrixsheets or matrix objects in Image Mode (View: Image Mode), you can extract
information from the matrix using the Region-of-Interest (ROI) tools:
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Go to Tools: Region of Interest Tools and verify that there is a check mark beside the menu item. If

not, click on this item or press CTRL + SHIFT + T to enable the ROI tools.

To add an ROI, click on the displayed ROI tool (e.g. Rectangle Tool :---:4) on the Tools toolbar and
choose an ROI shape from the flyout menu (rectangle, circle, polygon, region). Alternately, you can right-
click on the image (make sure no existing ROI is selected) and choose Add ROI from the shortcut menu.
Using your mouse, drag out an area on the image (not needed if adding from the shortcut menu) and
double-click to set your selection. Once the selection is set, additional clicks allow rotating, stretching, or
skewing the ROI.
You can add multiple ROIs using either the Add ROI shortcut menu (hint: right-click on the matrix image)
or with the Tools toolbar buttons. Note that when adding multiple ROIs using the toolbar buttons, you'll
need to rename each as it is created (otherwise, it will be destroyed when you create a new ROI). Double-
click on the ROI to open a small dialog and change the Name of the object (hint: simply append a unique
number to each Name).
Right-click on your ROI and choose an option from the shortcut menu. To discard the selected ROI, press
Delete:

O Crop: Crop the image to the minimum rectangular area that will contain the ROI. By default,

values outside the ROI will show black (zero values in Data Mode).
O Copy: Rectangle only. Creates an image from the ROI.
O Clear: Clear data within the ROI(s). Available only for TIFF stacks, NetCDF data; otherwise
unavailable (dimmed).

O Add ROI: Adds and enumerates name of each ROI (so that manual renaming is unnecessary
when adding multiple ROIs).
Copy Positions: Copy the position of the selected ROI.
Paste Positions: Paste the position of the selected ROl to another ROI (width, height...all).
Export ROI: Save the ROI object(s).

O O O O

Import ROI: Replace the object(s) with those in a saved *.ROI file (hint: create a "dummy" ROI

to import).
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O Create ROI from XY: Opens the Create ROI from XY (xy2roi) dialog where you designate XY

coordinates for creating ROI.

O O O 0O 0O O ©

Clear All ROIs: Remove ROIs from matrixsheet.

Convert to Data: Convert RGB image to data.

Convert to Gray: Convert RGB image to grayscale.

@ myocytel - myacytel tif :1/1 myocyte.tif *

regions of interest

« =

v [+ v\ myocytel f

Intensity Profile

"

Crop
Copy

Clear...

Copy Positions

Paste Pasitions »
Expart ROl

Impart RO,

Create ROl from XY...

Create Mew...

Extract as XYZ...

Create New: Use the mroi2mat tool to generate a new matrix from the ROI.

Intensity Profile: Use the mroiprofile tool to generate statistics for the ROI.

View Complex Image: View components of the complex image.

shortcut menu, ROI selected

Extract as XYZ: Use the mroi2xyz tool to generate a new worksheet of XYZ values.

shortcut menu, no RO selected
.

@ Paste

Add Text...

<«

Set Matrix Dimension/Labels...

Set Matrix Properties...
Set Matrix Values...

Add ROI

Export RO,

Import ROL..

Create ROI from XY...
Clear All ROls

Convert to Data..
Convert to Gray

View Complex Image

Properties...

Cirl=W

Ctrl+5hift+G

F4

159


http://www.originlab.com/doc/X-Function/ref/xy2roi

UserGuide 2023

P ROI stats are automatically reported to the Status Bar. Right-click on the Status Bar to hide
' or show statistics.

Average=133.76614 Count=198616 Min=69 Max=487 AU: ON A10482(1024x1024) U2 1

John Murray (University of Pennsylvania), Ke Hu (Indiana University, Bloomington) |
Toxoplasma gondii RH. CIL. Dataset hitps:idoi.org/doi-10. 7285 WSCIL10542 (Publi

10.3 Image Plot

Data in a matrix can be plotted as an Image Plot. Axis scales are determined by the matrix XY coordinates
(when the matrix is active, choose View: Show X/Y).

Note that if you import an image to the matrix (Data: Import From File: Image to Matrix) you must first
convert the image to data (Image: Conversion: Convert to Data) before creating your Image Plot (Plot:
Contour: Image Plot).

1. Activate a matrix window and choose Plot: Contour: Image Plot.

EJ Graph =Nl
1

1300

1200

1100

1000

900

600 650 T00 750 800
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By default, the image plot will use the same colormap, Z scale range and missing value color, as matrix image

mode (View: Image Mode). See Matrix: Apply Palette to Color Map, below.

10.4 Image Window

The Image Plot described above is used to plot values in a single matrix object. The Image Window can be

used to:

e  Open an image file for basic manipulation (flip, rotate, convert to gray-scale) using the Image Window's

Mini Toolbar.

e Edit an image inserted into a worksheet cell or graph window (double-click on the inserted image).

e Import an image set such as the common "TIFF stack".

. Import multiple discrete image files as an image stack.

® Open and play a movie (.avi, .mov, .mp4) file.

(] Define one or more regions-of-interest (ROI) for which you can Copy Positions, Paste Positions (from

another ROI), and Export or Import position information saved to an Origin *.ROI file (a text file with

position information on each ROI on the image).

® Open and operate on images inserted to worksheets or graphs: crop, copy, export ROI, etc.

10.4.11mage and Video Import

1. Choose File: New Image, then choose an option from the flyout menu.

e Empty Window: You can later add a file by right-clicking and choosing Import or Import

from Web. Alternately, click the New Image button @on the Standard toolbar.

E Image3 *

(= [ [n)

Right-click to choose an image

-

e Image/Video (CTRL + ALT + 1): Use the file type drop-down to specify an image or video

file format.
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E7 image1 - 34517_web.mp4 * (o[- | (S
202x206 pixels; 143/144 x=193, y=5; RGB(0,0,0)

[<= < ES ] =53 -

Paula Bubuwlya, David Spector (2011) CIL:34517, Homo sapiens, cervical
carcinoma. CiL. Datasel. hiips.Ydof.org/doi: 10. 7295 WICIL34517
Public domain image: hitp.Yeellimagelibrary.orgiimages 34517

e Multiple Image Files (CTRL + ALT + T): Specify which files to import as a stack, including

GeoTIFF. Note that the resulting stack will show an image slider, by default.
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[ image3 - myocytel tif...myocytel tif * o[ ]
myocyted: 1024k 1024 pocels; 4/8; (386,5) value =111 |

X images - 2001 ti..2020.tF =R ol ==

| 2005: 720x360 pixels; 5/20; (692,301) x= 165.28956, y=-50.91505, value=---; 2(0,315.52001)

e Web Image (CTRL + ALT + L): Enter a URL in the dialog to link to a web-stored image. Hint:
to grab an image URL, right-click on the web image and choose Copy image link or Copy

image address.

8 Enter Image URL ? =

Image Link | https:/fwww.originlab.com/images/header_logo.png b

For example: https:/fwww.originlab.com/images/header_logo.png

Right-click on a web image and choose "Copy image link” or "Copy image address”

Cancel

10.4.1.1 Import GeoTIFF as Image

GeoTIFF is a public-domain image format that stores spatial information in a TIFF file and which has
applications in mapping. Origin supports import of GeoTIFF files to both matrices and Image windows.

To import a GeoTIFF file as an image:

1. Click File: New: Image: Image/Video and choose the GeoTIFF image.
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To import multiple GeoTIFF files as image:

1.

Click File: New: Image: Multiple Image Files and choose your images. Images are imported to the

active Image window and a slider is added to scroll images.

£ image - 2001.4if...2020.tif * | -E | 3]

2010: T20x360 pixels; 10/20; (667,60) x=152.82425, y=59.91644, value=13.69; 2(0,315.52001)

> | -

e All Images must be the same size.
e Negative numbers (e.g. -999) are treated as missing values.
e The Image window Mini Toolbar has a button for setting Missing Value Color

e  Convert an Image window containing multiple GeoTIFF files to matrix using Image: Convert

to Matrix. Each image in the stack becomes an object in the output matrix.

Click inside the window, somewhere near the top, to show the Mini Toolbar.

For more information, see the Origin Help file page for GeoTIFF Importing and Processing.

10.4.1.2 Image Import Notes

164

To help control Origin project file size, right-click on an Image Window image and enable Linked File.
This saves a link to the image file into the window but excludes the image from the saved project. When
you reopen the saved project, the window will appear empty; at this point, you can decide whether you
need to re-import the image (CTRL + 4 or Import from the window shortcut menu).

Actual Size Mode is turned on by default for images of max width or height of less than 800 pixels. The

size threshold can be adjusted using system variable @IWP (see this FAQ for info on changing the value

of a system variable).
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10.4.2Image Window Navigation

Display of image information and navigation controls is enabled or disabled via the the View menu and/or the
Image Window Mini Toolbar (None, Thumbnails, Video or Slider).

View ) 3 - 1
Toolbars... Ctrl=T

Status Bar

Command Window Alt=3

2 A 2 A o o 4

Messages Log =6
Smart Hint Log Alt=,

Show Information
Show Mavigation

[ image - myocyte? tif..myocytes.tif * =8 =R

myocytel: 1024x1024 pixels; 1/8; (53,2) ,value =93

‘ -

Stack Navigation

| |
Mone

Thumbnails

Video

Slider

The same Mini Toolbar button is shown for GeoTIFF images:

B imaget - 2001 £F...2020.4f *

(===

2008: 7206360 pixels; 8/20; (358,10) x

=-1.24688, y=84.71 I:I 1:1 IE _-'i=_ f Stack Mavigation

Mone

I e

Thumbnails

Additional Keyboard control for Video navigation

10.4.3Image Resize

Pressing the left/right arrow keys will move the frame by 1.
Shift + arrow key will move the frame by 5.

Shift + Ctrl + arrow key will move the frame by 20.

To resize the image by one of several interpolative methods:

1. With the Image Window active, choose Image: Resize.

165




UserGuide 2023

2. Choose options including your Interpolation Method (Nearest Neighbor, Bilinear, Bicubic, Pixel Area

Relation, Lanczos) and click OK.

Resize...: cvResize ? >

Dialog Theme »

Resize an image

Keep Aspect Ratio

Width

Height

By a Factor

Interpolation Method | Bilinear w

Cancel

10.4.4Mini Toolbars for Image Window

Mini Toolbar buttons are available for performing simple image manipulation, including rotating, flipping or
converting to grayscale.

E Irmaged - Carbmp ® @ E Imaged - Car.bmp * E’@ -

|500x3?5 pixels; 1/1; x=497, y=113; RGB(193,210,196) ‘ ‘5&0:«3?5 pixels; 1/1: (492,2) value =198 |

You can apply a color palette to a grayscale image using the Palette button @ on the
Style toolbar. Click More Palettes to open the Color Manager dialog box and add
more palettes.
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10.4.5ROls in the Image Window

If your ROI is hard to see against the background image, you can select the ROl and

N
use the Style toolbar Line/Border Color button ﬂ to change outline color.

You can define one or more regions-of-interest in the Image window using the Rectangle Tool ) on the
Tools toolbar.

1. Select the tool and drag out an ROI. Once added, adjustments to size and position can be made by
selecting the object and dragging the blue selection handles.

2. To add multiple ROIs to an image, click on the Rectangle Tool and drag out your ROI; right-click on the
image and choose Add ROI (CTRL + Q); or use the Add ROI button on the Image window Mini Toolbar.
In either case, you'll need to rename added ROIs as you go: double-click on the ROl and give it a unique

name so that it is not replaced by the next added ROI.

B | ROl Position >

Mame RO

Bl Enter new coordinates for the ROI:

From To
| 50 | |15 |
| 25 | [150 |
Apply 0K Cancel
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Right-clicking on the ROI produces a context menu with the following options:

168

E Imag
Copy A02:249 picels; 177, (375,246), RGB(128,179,213)

o m i

Copy Positions

Paste Positions

Export ROL..
Import ROL...

Create ROI from XY...

Create Linked Image ,
[ reate Linked Matrix ‘

e  Clip: Available when the image is opened from a graph (e.g. by double-clicking the
graph image). This clips the graph image to the Image window ROI. The original graph
image size is reduced to the size of the clipped region. To restore the full image in the
graph window, right-click outside of the ROl and choose Remove Clipping.

e Crop: Crop Image window image and graph image (if exists) to the ROIl. Graph image
size and position are kept.

e Copy: Copy the ROI as an image. You can then paste it to other windows inside Origin,
e.g. a graph or worksheet window, or to other applications. For multi-frame image, only
the active frame is copied.

e Apply Scale to Graph: Available when the image is inserted into a graph by Image
from Image Window. This updates the graph image to the Image window ROI.

e Copy Positions: Copy the ROI box coordinates of 4 vertices. You can choose to paste it
as plain numbers, or, Paste Position to another ROI box. For the latter option, you can

choose to paste only ROl Width/Height, or Horizontal/Vertical location.
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e Export ROI: Saves details (e.g. ROl name, position of vertices, etc.) to a .ROI file.
. Import ROI: Applies details of a previously-saved ROI, to the selected ROI.

e Create New from XY: Create a new ROI box of arbitrary shape from a set of XY
coordinates (boundary) and index data. Support for gray-scale image only. See also

Create ROI from XY in NetCDF data.

e Create Linked Image: Outputs the ROI to a new Image window. Changes to the ROI

will be passed to the new Image window.

e Create Linked Matrix: Outputs the ROI data to a new matrix window. Changes to the

Image window ROI will be passed to the matrix.

Origin 2023, adds support to Create Linked Matrix of the Image window ROI (see
image of shortcut menu, above). This makes it easier to carry out many analysis and
statistics operations that cannot be done on an Image window (i.e. a matrix is
required). Previously, you needed to perform several steps to produce matrix data from
an Image window ROI. Now, it can be done by simply creating the linked matrix. Since
the matrix is linked to the ROI, moving or adjusting the ROl updates matrix data.

10.5Profiling Matrix Data

Data in a matrix can be viewed in profile -- either in the X, Y or arbitrary cross-section.

1. Activate the matrix object and choose Plot > 2D: Profile: Image Profiles from the main menu.

This creates an image plot and opens the Image/Contour Profile dialog box. Use the dialog box to specify X
and/or Y profile plots and the location and appearance of the cross-sectional lines. Note that this dialog box is
interactive. You can make adjustments to your image profile -- move the cross-sectional lines or change the
configuration or the appearance of the plots -- without closing the dialog box. After closed the dialog box, a
button Profiles...will appear at the right-top corner of graph window, which can be used to reopen the
Image/Contour Profiles dialog.
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10.6 Setting Matrix Values

The Set Values dialog box is used to generate or transform data in a matrix object.

You can assign a name to a matrix object and use the name Set Values (e.g. to
perform math operations on other matrix objects of the same dimensions).

To open the Set Values dialog box, make sure that the matrix object is active, then:

1.

or

1.
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From the menu, choose Matrix: Set Values.

Select the matrix by clicking in the upper-left corner (in the empty header cell just below the matrix

icon/name), then right-click on the matrix and choose Set Matrix Values from the shortcut menu.
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P

B Set Values - [MBook2]MSheetl!Mat(1) o = || = |
Formula Mat{A) Function Vanables K

Faw [i] Fram |1 To |32 Menu commands

Col [j] From 1 To |32

Cellij) = Searchand __, 2 <] <2 [22] [321

insert functions

mat(2) + mat {3)\

Type in formula here

£ () () (o)

Before Formula Scripts |
// Prepare twWo eXtra cbjects in the matrix sheet P
wk3.nmats =
msetvalue im:i=mat({2) formula:="X";
msetvalue im:=mat(3) formula:="vy";

Script to be executed before applying formula ™

1L

Menu
Commands

Formula: Load a saved formula into the matrix formula box. Formula are

saved using Formula: Save or Formula: Save As....

Mat(1): Use the menu to include matrix objects in either your matrix formula
or your Before Formula Scripts (matrix object reference is inserted at the
cursor). A Matrix Browser is available to help in selecting the correct objects.
Objects are listed by object index.

Mat(A): Similar to Mat(1) menu functionality but matrix objects are listed by
object Long Name, if one exists.

Function: Add LabTalk functions to your expressions (function name is
inserted at the cursor).

Variables: Add a variable or a constant to Matrix Formula or Before
Formula Scripts; Add range variables (including by selection) or file

metadata, to Before Formula Scripts.

Matrix Formula

Add a single line expression for generating data. Functions, conditional

operators and variables can be used.

Before Formula
Scripts

Enter one or more lines of LabTalk script to be executed before the expression

in the Matrix formula box is executed.
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P Use the Before Formula Scripts panel at the bottom of the Set Values dialog box to
; define variables or LabTalk functions that you wish to use in your matrix formula.

Click the Search and Insert Functions button Elto search for built-in LabTalk
functions.

10.7 Manipulation of Matrix Data

Utility Menu Access

®  For an XY coordinate pair picked
with the Screen Reader, output Z
values for for the matrix stack ) ) )

. . . Matrix: Pixel Extraction

(multiple matrix objects) to a

worksheet.

e  Flip or Rotate a matrix. Matrix: Rotate90
Matrix: Flip: Vertical

Matrix: Flip: Horizontal

Matrix: Resize

For Origin 2023, when
®  Resize a matrix using one of four method (Resize Option) is
methods (Expand, Shrink, Interpolate, a new
Interpolate Method =
Barycentric is added.
Subsequently, two fields -- X
Coordinates Matrix and Y
Coordinates Matrix, are
added to set boundaries.

.

 :

Interpolate and Pad).

e  Transpose a matrix. )
Matrix: Transpose

® Generate a 3-dimensional

dataset by transforming XYZ ) )
Matrix: Generate Grid
values by formula.

e Expand the matrix by scaling in Matrix: Expand
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the X and Y directions.

®  Shrink the matrix by some

row/column factor, using one of ) )
) Matrix: Shrink
several shrink methods.

e Use a palette file to transform a
matrix in Image Mode. Set a
system variable to apply a color
palette (Style toolbar, Palettes )

. . Matrix: Apply Palette to Color Map

button) to all matrix objects

(@MAP=0, default) or only the

active matrix object (@MAP=1).

(] Convert a matrix of values to

worksheet columns (see next

. Matrix: Convert to Worksheet
section).

10.8Changing the Color Scheme of a Matrix

You can use the Palette Q button and the Missing Value Color & button in the Mini Toolbar to customize
the color of the matrix window.

The selected palettes and missing value color will apply to all matrix objects in the
active matrix sheet, but will not change the palettes and missing value colors of objects
in other matrix sheets in the same matrix window.

10.9Converting Matrixes to Worksheets

To convert a matrix to worksheet:

1. With a matrix active, choose Matrix: Convert to Worksheet: Open Dialog.

There are two methods for converting matrix data to worksheet data -- Direct and XYZ Columns. Starting,
for instance, with the following arrangement:
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[

] MBookl :1/1 *

X1

| 325

5.5 7.75 |

Y 1
1.12
1.24
1.36
1.48
1.6

<> \ESheetl /

[y B S T L R

Lo Ay B S T R L R
Lol Ay B SR S L R

[mr iy R C R U R L R

L= R I R O R ]

I

m

10.9.1Direct

This copies the Z values in the matrix to a worksheet with no reordering. If the matrix consists of M rows by N
columns of Z values, this method produces a worksheet which has M rows and N columns. By default, the X
and Y coordinates of the matrix Z values are not copied to the worksheet. You can opt to copy X coordinates to
the 1st worksheet row or a parameter row and the Y coordinates to the 1st worksheet column.

@ Boold * |i”ﬂ”£|
e ALY B(Y) C{Y) D{Y) E(Y) Fy) |-
Long Mame
Units (" X Coordinates L
Comments
Parameters 1 3.25 5.5 775 10 |
1 1 1 1 1 1 1
2 112 2 2 2 2 2
3 124 3 3 3 3 3
4 1.36 4 4 4 4 4
5 148 5 5 5 5 5
B 16 B B B B 67
41» \Data1 / Y Coordinates | « 0 V[

10.9.2XYZ Columns

When there is a single matrix object, this method produces a worksheet with three columns: X,Y, and Z, with
X and Y columns containing the X and Y coordinate values and the Z column containing the matrix Z value at

each XY coordinate.
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-

£ 8002 SE=E EoE
= ACK) B(Y) ca | -
Long Mame
Lnits
Comments
1 1 1 1 =
2 1 1.12 2
3 1 1.24 3
4 1 1.36 4
i) 1 1.48 5 £
] 1 1.6 i
7 3.25 1 1
a 3.25 1.12 2
g 3.25 1.24 3
10 3.25 1.36 4
11 3.25 1.48 5
12 3.25 1.6 i
13 5.5 1 1
14 5.5 1.12 2
15 5.5 1.24 3
[<[> ]\ Sheet1 / | « G+ [

In addition, this method:

®  Saves matrix object Long Name, Units and Comments to the Z column label rows.

e |f the converted matrix contains a color image, the resulting Z column will display a Color column of HTML
colors for each matrix cell.

ZH Car - Carbmp :1/1 Carbmp * Lo B e | & sookz* =N
[x] ax) B B B cz)®~

Long Name Car.bmp
Units
Comments
Fix}=
34805 92 z04 EEEENE
34806 a2 305 -

34807 a2 305 #BTA38E
34803 92 307

34809
309 [ #920A92
34811 92 310
34812 92 At w
DADAD 07 24 —_—
(<1 NGar f |l < > [ L P Gar f 1< > ][«

When converting multiple matrix objects:

When there are N matrix objects, you can set Convert On = All Objects and output columns as X, Y and Z x
N (i.e. XYZZZ...).
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Trim Missing Values [

Convert to Worksheet: m2w >
Dialog Theme »
Convert the Matrix data into a Worksheet

Recalculate hanual

Input Matrix [MBookl]MSheet] % b
Method X¥Z Columns A

Conwvert on All Objects

Option X Const 1st e

Output Worksheet | [Bookd]MSheet1!1:6

== [

0K

Cancel

10.10Converting Worksheets to Matrixes

1. With the worksheet active, choose Worksheet: Convert to Matrix and choose one of the following

methods:

Method Conversion Type

Notes

e X across columns

) ® Y across columns
Direct
e NoXandyY

Ideal for spreadsheet data that
conforms to the following:

e X data values in the 1st
column, Y data values in the
1st row and Z values in
columns 2 to N and rows 2 to
M.

e Y data values in the 1st
column, X data values in the
1st row and Z values in
columns 2 to N and rows 2 to
M.

Note: See Virtual Matrix,
below.
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Method

Conversion Type

Notes

Expand

(] Row

e Column

Some ASCI! files have an upper limit
for characters allowed on a single line.
Use this method when your file breaks
a single line of data across multiple
lines.

e Expand by Row: specifies
the number of ASCII file
rows comprising one matrix

row.

e Expand by Column:
specifies the number of
ASCII file columns
comprising one matrix

column.

XYZ
Gridding

e Regular

e Sparse

e Random (Renka Cline)

e Random (Shepard)

e Random (Thin Plate Spline)

e Random (Kriging Correlation)

e Random (Weighted Average)

Conversion Type depends upon XY
spacing:

® Choose Regular applied for
data that are regularly
spaced in XY.

® Choose Sparse when you
have missing values.

® Choose Renka-Cline,
Shepard, TPS, Kriging or
Weighted Average
methods for data that are
irregularly spaced in XY.
Option for No Extrapolation

outside Boundary.

XYZ Log
Gridding

methods same as XYZ Gridding

Calculates logarithmic values for X
and Y, then performs XYZ Gridding.
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Beginning with Origin 2023, XYZ Gridding and Log Gridding will convert a worksheet of

"""r'-;:';' XYZZZ... columns to a matrixsheet with each Z column as a separate object.
] Book * (= E ]
a0 | B [ e [T o [ eq | o, | 6@ | -
Long Name
Units
Comments
Flx)=
1| 082052 072209 0
2| 042961 069371 0
3| ose:2 oeerii o 2 i \ \ =R IR )
4 0.98602 0.16798 | -
5| 047374 048257 O
6| 050738 032472
7 0.13271 081755 0Oy
8| 027376 092247 | 2 3 1 5
9| 056223 078
10| 0.64682 092704
11| 04272 021217 O NI | =T | | s 5
[«[» [+]v\Sheet1 / 1] 055008 034113 046225 052083 052857
) 0.84923 02082 0.35029 0.42027 0.33831
3| 05373 016651 04566 069024 039853
4| 000872 053601 092828 028438 079338
= 0.35634 1.00138 1.20171 0.91292 1.42911 w
[« [ [+]v \Output Matrix £ 1< >

10.11Virtual Matrix

Data arranged in a block of worksheet cells can be treated as a "virtual matrix". As is the case with regular
matrix data, virtual matrix data can be used to create 3D plots, such as color mapped surfaces or contour plots.
The data can include a column or label row with the X or Y values. Unlike a regular matrix which only supports
a linear spacing in the X and Y dimensions, a virtual matrix supports irregular spacing of X and Y coordinate
values (provided those values are in ascending or descending order).

B & Wistual Matrin weith Monlingar Spacing of X aned ¥ Values = = & | 230 Sutsce Created from a Virfual Matre:
an | cm - |3
I.III"IH Mame | ¥ Coordnale
Units ]rﬂ'.‘gulﬂ' Spacing in X and ¥
Comimenis
¥ Coordnaly P 391 1172 1953 2734 )
1 (,.-..[h Teay e .
z 0.0z D413 0.087 003 -0.006
3 0025 014 034 026 0494
1 0037 |  -0ose| -0628 -0.455 076
5 aos| 0191 0784 -0.588 0627
3 nosz | -0.254 0623 -0.632 aTI7
T no7s | -nzEd 076 06 -n.452
] 0.087 0257 061 0481 -0.055
] noos | ;e 039 035 0.451
0 otz -now3 0113 -0.067 1.048
11 0124 a0 0.204 0247 171
[ 0.137 0172 0,645 0,626 2414
[E] 0,149 0.326 0.8a7 1.087 314
4 0162 0485 1242 1566 1,064
3 D74 ) nEdn 1586 2123 4566 =
[T Ty watertais 155 [E 3

Note: You can create 3D plots from XYZ columns of worksheet data in which data are irregularly spaced in
the X and Y dimensions. This is not considered a "virtual matrix."
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10.12Topics for Further Reading

(] Matrixbooks, Matrixsheets and Matrix Objects

(] Matrixbook and Matrixsheet Operations

e \What is Saved with the Matrix Template?

(] Matrix Dimensions and XY Coordinates

. Matrix Object Data Properties

e  Setting Matrix Values

(] Matrix Conversion and Gridding

(] Creating 3D and Contour Graphs from a Virtual Matrix

e Viewing and Profiling Matrix Data
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11 Graphing

11.1Creating a Graph

Graphs can be created from both hard data and from mathematical functions. With Origin, you can create over
100 graph types using Origin's built-in graph templates. Each of these graphs has been specifically chosen for
its applications in various technical fields.

All graph types are accessible from the Plot menu. Note that while most graph types also have a
corresponding 2D Graphs or 3D and Contour Graphs toolbar button, some do not. Until you've had time to
familiarize yourself with available toolbar buttons, the Plot menu should be your "go to" place for creating
graphs.

Creating most graphs involves just two steps.

1. Select your data.

2. Select the plot type.

Some Origin graph types have very specific data requirements. Other graphs can be created from multiple
data arrangements. See the Origin Graph Types section for specific requirements.

11.1.1Creating Graphs from Worksheet Data

Origin's most generic graph types -- line, column/bar, pie -- plus a lot of the more specialized types, are
created from worksheet data. The following quick tutorial demonstrates importing an ASCII data file and
creating a simple graph.

Tutorial: One click to create graph with selected data

1. Open a new workbook and select Data: Import from File: Single ASCII... from
the main menu.

Choose the file Samples/Curve Fitting/Multiple Gaussians.dat and click Open.

3. Now highlight columns B(Y), C(Y), D(Y) and E(Y) by clicking and dragging across
the four column headings.

4. Click Plot = Basic 2D: Line & Symbol: Line & Symbol. A graph window is
created with four line and symbol plots. Note that the plots differ by line color and
by symbol type.

Return to the worksheet, and again select columns B(Y), C(Y), D(Y) and E(Y).
This time, select the Plot > Multi-Panel/Axis: 4 Panel menu item. Note that a

very different plot is created using the same datasets.

We were able to quickly create two different graphs using the same data. The chapter Customizing Graphs
discusses customizing graphs and saving templates in more depth.

We are also able to create 3D plot types from worksheet data. The following tutorial demonstrates creating a
3D surface plot, then overlaying it with a 3D scatter plot.
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Tutorial: 3D Surface Plot from XYZ Data

10.

Create a new, empty workbook window and import the file \Samples\Matrix
Conversion and Gridding\XYZ Random Gaussian.dat.

Highlight column C and right click. Select Set As: Z from the fly-out menu.

Select Plot > 3D: 3D Colormap Surface to create a 3D Colormap Surface plot.
Select the Graph: Layer Contents... menu item or right click the layer icon on the

left-top of the graph to open the Layer Contents dialog. In this dialog, click on

drop-down next to the ﬂbutton and select 3D Scatter/Trajectory/Vector

from the fly-out menu.

Select column C from the left panel and click on the Add Plot ﬂbutton to add
the 3D scatter plot to the graph. Click OK to close the dialog.

Double-click on the plot to open the Plot Details dialog. In the left panel, expand
the Layerl node and then expand the 2nd node which represents the scatter plot.
Click and select the branch named Original. Be sure to leave the node-level check
box selected, otherwise this plot will be hidden.

In the Symbol tab on the right side, set Shape to Ball, Size to 12 and Color to
Color Mapping: Col(C).

In the Drop Lines tab, clear the Parallel to Z Axis check box.

Select Layerl from the left panel of the Plot Details dialog. In the Lighting tab,
under Mode, select Directional. Click OK to close the dialog.

Click on the scatter plot in the graph to select this plot, then in the Style toolbar,

click on the @ button and select the Rainbow palette.

Your graph should look like this:

1115
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7030
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3340
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You can hold down the R key on your keyboard and use the mouse to freely rotate the
3D surface. With the pointer tool active, click on the layer for additional controls to
move, stretch and rotate the surface.

Origin 2023 supports a minimum Z axis length of 10% -- reduced from a previous 25%
(Plot Details layer level, Axis tab).

11.1.1.1 Worksheet Column Plot Designations

The labels (X), (Y), (2), etc. in column headings are referred to as the Column Plot Designation. Columns
can also be designated as Label, Disregard, Y Error or X Error. Each plot type has certain data
requirements (e.g. a simple line plot requires one X and one Y dataset) and column plot designations work in
concert with settings saved in the graph template, to allow you to quickly create a graph.

To set the Column Plot Designation, select a column or multiple columns, then from the menu choose Column:
Set as:<option>; or right-click and choose an option from the Set As: context menu.

In the 1st tutorial above, we plotted 2D graphs, which require Y data from one or more worksheet columns.
The Y data were automatically plotted against the X column data to their left. In 2nd tutorial, we plotted a 3D
graph using Z data. The Z data were plotted against X and Y data columns to the left of the Z data column.

Note: For more information on Column Plot Designations and how they affect plotting behavior, see Plot

Designation, in documentation for the Column Properties Dialog Box.

11.1.1.2 Selecting Worksheet Data

Various ways to select data for plotting:

e Single column: Click on the column heading, e.g. B(Y)

(] Multiple columns: To select a small humber of contiguous columns, click on the first column heading and
drag the pointer to the last column heading. To select a large humber of contiguous columns, click on the
first column heading, use the scroll bar at the bottom of the worksheet to locate the last column, then
press the SHIFT key and click on the last column heading. To select non-contiguous columns, press the
CTRL key while clicking on the desired column heading.

e Arange in a column: Click on the first cell of the range and drag to the last cell of the range.

e Multiple ranges within a column: Select one range. Press the CTRL key while selecting each range.

When plotting, each range will be treated as a separate data plot in a plot group.
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Ranges across multiple columns: If cells are contiguous, click on the first cell and drag to the last cell.

If cells are not contiguous, press the CTRL key while selecting each range. Each range selection will be

treated as a separate data plot in a plot group.

Range(s) across all columns: Click on the first row heading and drag to the last row heading, to select

multiple rows. This will select data in all columns in the worksheet. Press the CTRL key while selecting row

headings for non-contiguous rows. Each range selection will be treated as a separate data plot in a plot
roup.

Entire worksheet: Press CTRL+A to select the entire worksheet; or mouse over the bottom-right corner

of the blank cell in the upper-left corner of the worksheet. When the pointer becomes a downward-

pointing arrow, click to select the entire worksheet.

Specific columns: To select columns by data in column label rows (header rows); or to select columns

using a pattern, choose Edit: Select.

| As noted in the Worksheet Column Plot Designations section just above, if you select Y
' or Z columns, Origin defaults to plotting the Y column against the nearest X column to the
left; or plots the Z column against the nearest X and Y columns to the left. But in the case
of simple XY 2D plots (line, line + symbol, etc.), you can ignore this rule and plot by
selecting XY columns whether or not the selected X is to the left or right of Y.
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11.1.2Creating a Graph from Matrix Data

As discussed in the Matrixbook, Matrixsheets and Matrix Objects chapter, a matrix is a dataset of Z values
arranged as an array of columns and rows which are linearly mapped to X (column) and Y (row) values. Matrix
data is used to create 3D, contour and heatmap graphs -- all of which require require "3D" data. In earlier
versions of Origin you had to have your data in a matrix to create such plot types but this is no longer the case
(see discussion of the Virtual Matrix below). A few graph types such as a color-filled surface with error bars
still require matrix data.

There are still many situations in which you will be creating 3D plots from matrix data. If data are stored in a
worksheet and for one reason or another, you need to convert it into a matrix form, see Converting
Worksheets to Matrixes.

Once your data are in a matrix form, plotting matrix data is simple: activate the matrix window then select
your plot type using a Plot menu command or corresponding 3D and Contour Graphs toolbar button. Since
you cannot plot only a portion of the matrix, data selection isn't necessary. You can, however, choose a subset
of the data plot to display once the graph is created. See Editing Plot Range, below.

11.1.2.1 The Virtual Matrix

The Virtual Matrix concept was covered in the Matrixbook, Matrixsheet and Matrix Object chapter of this Guide.
To recap, a virtual matrix is a block of worksheet cells which contain Z values, with X and Y coordinates in the
first row or column label row, and first column. X and Y coordinates don't have to be evenly spaced and can
even contain text or date/time data.

When selecting and plotting virtual matrix data to 3D, Contour and Heatmap graph types, the worksheet's
Column Plot Designations are ignored. Instead, a dialog box is opened where you designate your X and Y
coordinates. The intersecting data points are then treated as Z values.

Tutorial: Contour Plot from Virtual Matrix

1. With a new workbook active, use the Data: Import from File: Import Wizard...
menu to open the Import Wizard dialog.

2. Press the browse button in the dialog and select the file Waterfall.dat from the
Samples\Graphing subfolder.

3. This file has an import filter already associated with it. Press the Finish button to
import the file.
With the workbook active, press CTRL+A to select the entire sheet.

5. Now select the Plot = Contour: Contour - Color Fill menu item. The plotvm
dialog will open.

6. In the dialog, set the Y Values in drop-down to Column Label, and then set the
Column Label drop-down to Excitation Wavelength(nm).

7. Set the X Values in drop-down to 1st column in selection, then press OK to
close this dialog.
The contour plot will be created.
Use the Graph: Speed Mode... menu item, then in the dialog that opens, set the
Speed Mode drop-down to Off and press OK. This will turn off speed mode so that
all data points are plotted (see the discussion of Speed Mode, below).

10. Click on the contour plot to select this data plot, then from the Style toolbar, click

the Palette button @ and then select the Pumpkin Patch palette. Your graph

should look similar to the image below:
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| Once you customize your contour levels and colors, you can save your settings as a
; Theme, or simply copy-paste your customizations from one graph to another. To save a
Theme, right-click on the graph and choose Save Format as Theme; or use the
Colormap Theme controls on the Colormap/Contours tab of the Plot Details dialog
box.

11.1.32D and 3D Function Plots

Unlike plots from worksheet data or plots from matrix data, parametric plots are not plots of actual data.
Instead, they are plots of mathematical functions.

To create function plots and parametric function plots, select File: New: Function Plot menu. There are four
options to choose from:

Type Function Form
2D Function Plot y = f(X)
2D Parametric Function x = f1(t)
Plot y = f2(t)
3D Function Plot z =f(x,y)
3D Parametric Function X f f(u, v)
Pl y =f2(u, v)
ot -
z =13(u, v)
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These plot types are also accessible from the function plot buttons on the Standard toolbar.

[ |
£+ New 2D Plot
f’\':" Mew 20 Parametric Plot
£2 New 3D Plot
ﬁj:::ﬁ Mew 30 Parametric Plot

Function plot improvements to Origin 2023:

A ®  You can exclude function plots from the graph legend by right-clicking on the
. selected legend object and placing a check mark beside Legend: Hide Legend for

Function Plots (To add them back to the legend, clear the check mark).

e  The function plot name (e.g. "F1") will not be used as an axis title or legend;
instead, the function equation is used (e.g. y = exp(X)+x72).

e  Previously, if the function plot was the first plot in the graph window (e.g. plot
order in Plot Details, Data menu or Object Manager), the function name (e.g.
"F1") was used to label the Y axis. Now, the axis will be labeled with the first data
plot in the list; only when the function plot is the only plot in the layer will the

function be used to label the Y axis.

Tutorial: 3D Function and 3D Parametric Function in Same Layer

1. From the menu, choose File: New: Function Plot: 3D Parametric Function
Plot...

2. In the dialog that opens, click on the arrow button at the top right side of the
dialog, and from the fly-out menu select the built-in example Partial Torus
(System) and press OK to close the dialog. The function plot will be created.

3. With the function plot window active, invoke the menu File: New: Function Plot:
3D Function Plot....

4. In the dialog that opens, enter -5 and 5 for the From and To edit boxes for x and
y scale.

In the Z(x,y) edit box, enter O.
Set the drop-down at the bottom left corner of the dialog to Add to Active Graph
and press OK to close dialog.

7. The Z=0 plane will be added to the graph, and the plane will properly intersect the

parametric surface plot. You can hold down the R key and use the mouse to freely
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rotate the plot.

==

e  Some function plot dialogs provide sample formulas. Click the arrow button beside Theme at the top of

the dialog box to access them. You can download more examples at http://originlab.com/3dfunctions.

e  For 2D parametric, 3D, and 3D parametric function plots, data is generated when the function plot is
created. To create data for 2D function plots, right-click the plot and choose Make dataset copy of

Function or if on the Function tab in Plot Details, click the Workbook button.

e Besides function plots, you can also create graphs with all built-in and user-defined nonlinear curve-fitting
or surface-fitting functions. From the menu, choose Analysis: Fitting: Simulate Curve... or Simulate

Surface.... You can even add noise to the plot. Corresponding data is created as well.

11.1.3.1 Adding Function Plots to Existing Graphs

You can add function plots to existing graph windows containing other plot types. See FAQ-171, specifically
the section entitled Add Function Plot to an Existing Graph.

11.2Plotting without Using Column Plot Designations

While worksheet Column Plot Designations are always used when creating graphs from the Plot menu or one
of the graph toolbars, the Plot Setup dialog box does not make use of them. With Plot Setup, you assign
column designations on an ad hoc basis, allowing you to overcome some of the restrictions of template-based
plotting.

However, to make use of the Plot Setup dialog box, you need to have some familiarity with the hierarchy of
objects contained in the Origin graph window.
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11.2.1Pages, Layers, Plots and the Active Plot

Each Origin graph window is comprised of a single, editable graph page. The graph page is defined by the
white area inside the graph window. Anything that lies outside the page is not printed or exported. By default,
the dimensions of the graph page are defined by the printable area of your default printer driver; without
adjusting settings, a printed graph should fill the printed page.

Active Layer
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/
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The Layer
Frame

e  The graph page must contain at least one, and may contain as many as 1024, graph layers.

e  Each graph layer generally contains one or more data plots (graphical depictions of datasets). Note that

the graph in the image above contains three graph layers, represented by the three non-printing layer

icons in the upper-left corner of the graph page. Note that there is one layer icon which is highlighted,

indicating that this is the active layer.

e Just as there is only one active layer, there is only one active plot in a graph. Usually, the active plot is

the first plot in the active layer. To verify which plot is active, click on the Data menu while the graph is

active. The active plot will have a check mark beside it.

. 1 gl [datatiledepta]Sheetl!
2 gl [datatiledepti]Sheetl!
3 gl [datatiledepti]Sheetl!
4 gl [datatiledepta]Shestl!
5 gl [datatiledeptA]Sheetl!
6 gl [datatiledepta]sheetl!
7 gl [datatiledepta]sheetl!
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The hierarchical structure of the graph page can be seen in these places:

e The Plot Details Dialog Box (Format: Page ...)
e The Object Manager (View: Object Manager)
e The Plot Setup Dialog Box (Graph: Plot Setup...)

7
8 Plot Details - Plot Praperties
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11.2.2The Plot Setup Dialog Box

The Plot Setup dialog box is a flexible all-in-one plotting tool for creating graphs and manipulating the data
plots in an existing graph.

e  Creating graphs without regard to Column Plot Designations

e Creating graphs from a combination of data sources: multiple worksheets, workbooks, matrixbooks, loose
datasets, etc.

e  Creating graphs combining multiple plot types.

e Adding, removing, replacing data plots.

e  Grouping or ungrouping data plots.

e Reordering data plots in a layer or moving data plots to another layer.
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To create a graph with the Plot Setup dialog, make sure no data is selected in the active worksheet and
choose the plot type that you want to create (from the Plot menu or by clicking on a toolbar button).

To open the Plot Setup dialog for an existing graph window, right-click on any layer icon in the upper left
corner of the graph window and select Plot Setup..., or choose menu Graph: Plot Setup....

Tutorial: Creating a Simple Line Plot with the Plot Setup Dialog Box

Click the New Workbook button on the Standard toolbar.

Click Data: Import From File: Single ASCII, browse to the Origin installation folder
and import the file \Samples\Curve Fitting\StepO1.dat. Starting from column B,
columns are actually paired - X data and Y data -- but by default all columns are
assigned a "Y" Column Plot Designation on import.

3. Without selecting any data, click Plot > Basic 2D: Line. This opens the Plot Setup
dialog box.

Click the two "double-arrow" buttons to show all three dialog box panels.

5. In the middle panel, select the "X" box for Column B (Sensor Ax) and the "Y" box for
Column C (Sensor Ay), then click the Add button to add the plot to Layer 1 in the
bottom panel.

6. Select the "X" box for column D (Sensor Bx) and the "Y" box for Column E (Sensor
By), then click Add.

7. Select the "X" box for column F (Sensor Cx) and the "Y" box for Column G (Sensor

Cy), then click Add. Three plots are added to Layer 1.
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8. Press CTRL and click on each plot in the bottom panel to select all three, then right-
click and choose Group.

9. Click OK to create a grouped line plot.

# Plot Setup: Configure Data Plots in Layer L9 [t
Plot List: Drag entries i 13t column to reoeder of to move betwesn lavers. Right click for other options.
Flat Range Show | Plat Type
=i Layer 1 | Rescale v

teplil. dat]Stepl] “Sens

tepl, dat]Stepli! "Sensor

[Step, dat}Stepll! "Sercos |

Tutorial: Creating a Graph with Data from Multiple Worksheets

Click the New Workbook button on the Standard toolbar.
Click Data: Import From File: Multiple ASCII, browse to the Origin installation
folder and select SensorO1l.dat, SensorO2.dat and Sensor03.dat under \Samples\Curve
Fitting\ to import. After Import, 3 workbooks are created.

3. Without selecting any data, click Plot > Basic 2D: Line+Symbol. This opens the Plot
Setup dialog box.

4. Expand the top panel if it is hidden. From the Available Data list, choose
Worksheets in Folder.
Select Sensor01, Sensor02 and Sensor03 sheets in the top panel.
In the middle panel, select the "X" box for Column A (Displacement) and the "Y" box
for Column B (Sensor Output), then click the Add button.

7. Click OK to create a grouped Line+Symbol plot using Sensor Output columns from 3

worksheets.
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®  The Plot Setup middle panel only allows choosing one X column at a time.

e |If your worksheet is set up with the correct Column Plot Designations (e.g. XYXY) but you only want
columns with same Long Name, click the toggle in the upper-right corner of middle panel so that only
plottable columns show (e.g. for 2D plot types, X columns are not shown). Then you can sort the columns
and select all columns with same Long Name and plot them together. The Y columns will be plotted

against corresponding X columns.

e To change a data plot's type, choose the corresponding plot in bottom panel. Corresponding X and Y

columns will show in middle panel. Choose a new plot type in middle panel and click the Replace button.

e All data plots in a group share the same plot type. If you want to change the plot type of a single plot in a
group, right-click the Group node in bottom panel and Ungroup first.

e Drag and drop data plots in the bottom panel to move them to different layers.

e |f the bottom panel is hidden and you have selected columns in the middle panel, you can directly click
the OK button to create your graph.

11.3 Manipulating Data Plots

The following sections discuss higher level modifications to existing graphs such as changing plot type, adding
or removing plots from the layer and controlling the density of plotted points (Speed Mode). For more detailed
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plot customizations, including those involving such things as changing plot symbols, colors, and legend
customizations, see the Customizing Graphs chapter.

11.3.1Changing Plot Type

Some Origin plot types (e.g. scatter, line, line+symbol) allow you to interchange the plot type of an existing
plot with a few other select plot types. Some examples:

e  Scatter, line, line+symbol, column/bar are interchangeable.

e 3D scatter/trajectory/vector, 3D bars, 3D surface are interchangeable.

To change the plot type of an existing plot:

e Right-click on the data plot and choose Change Plot to: Graph Type from the shortcut menu.

e  Click on the data plot and choose Format: Plot... and in Plot Details choose from the Plot Type drop-

down list.

e Click on the data plot, then click one of the supported graph toolbar buttons.

Note that if you switch plot types and the selected plot is part of a plot group, all plots in the group are
switched.

A word of caution: This is an old Origin feature, and for a quick change of common plot
types in a single-layer graph it works well. Changing plot types in a multi-panel, multi-

layer graph can lead to unwanted outcomes. When working with more complex graphs,
it is better to create a graph directly using the specified Plot menu command or toolbar
button .

11.3.2Exchanging Data Plots

You can quickly change the data source (X, Y, or worksheet) of a plot using these context menu commands.
Right-click on a data plot, then select one of these options:

e Change X/Y/Z. These menu items allow you to swap the current X,Y or Z data with data from any column

in the project.

e Select Columns. This opens the Column Browser where you can select another column in the Current

Folder, in the Current Folder (recursive) (includes subfolders) or in Current Project.

e Change Worksheet. This menu item allows you to replace both X and Y with data from another
worksheet. The selected worksheet must have the same Short Names, the same Column Plot Designations

and the same row index range as the current worksheet.

Tutorial: Changing X and Y assignment of a data plot

1. Start with a new workbook and import the file automobile.dat from the

Samples\Statistics sub-folder of the Origin installation folder.
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2. Select the Gas Mileage column and select the Plot: Basic 2D: Scatter menu
item. The Gas Mileage column is plotted against the default X column Year.
3. Right-click on the data plot and select Change X: Engine Displacement. The

Gas Mileage column is now plotted against Engine Displacement.

Note: If new data is significantly outside of the current range for X or Y axes, you will be asked if the
graph should be rescaled. If data are not significantly different, you may want to manually rescale the
graph (Hot key: CTRL+R).

If you have performed some analysis on the data plot (e.g. linear regression with
Recalculate set to Auto), the fit results will automatically update when you change
X/Y or the worksheet.

11.3.3Adding, Removing and Hiding Data Plots

Use the following methods to add or remove data plots from a graph.

Adding or removing data plots from a 2D or 3D graph may result in the need to rescale
axes. Origin will generally ask the user how to handle rescaling; and dialog boxes that are
used to add or remove datasets from a plot (e.g. Layer Contents) typically have a rescale
check box. Starting with Origin 2023, you can select the layer beforehand, then click the
Mini Toolbar Auto Rescale button, to automatically rescale. This is equivalent to opening
the Axis dialog box Scale tab and setting Rescale = Auto.

El 30 Surface with Error Bars El@
1 i O 1V @[T

Mo Auto Rescale

Auto Rescale XY
Auto Rescale XYZ

11.3.3.1 Adding Data by Drag and Drop

You can add data to a graph by drag and drop. When using this method, Origin relies on worksheet Column
Plot Designations to create the plot.

1. Select the worksheet data (one or more columns or a range of one or more columns).

2. Move the mouse over the left or right edge of the selected range.
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R
3.  When the pointer looks like this , hold down the left mouse button and drag the data to the graph
window. Release the mouse.

4. If there are multiple layers in the graph, drag the data to the desired layer, then release the mouse.

Usually the current plot type is used when plotting by drag-and-drop. To change the
global plot type to use when drag and drop, choose Preferences: Options... from the
main menu. Go to the Graph tab and change the Drag and drop plot type.

11.3.3.2 Adding Data with Insert: Plot to Layer

Use the Insert menu to insert some types of plots to the active graph layer. Choice of plot type depends on
the active graph window and the last-activated data source (worksheet or matrix). For instance, if you create a
2D graph, select data in a workbook window, then return to graph window and click Insert: Plot to Layer,
your insert choices will be Line, Scatter, Line + Symbol, Column..., Area and Contour....

To use the Insert menu command, you should have an existing graph window:

1. Go to the worksheet or matrix window and select your dataset(s).
2. Return to the graph window, make sure that the target layer is active layer, then choose Insert: Plot to

Layer: Plot Type.

11.3.3.3 Adding and Removing Data with the Layer Contents Dialog Box

Open the Layer Contents dialog box by double-clicking or right-clicking on the layer icon(s) in the top left
corner of the graph page. Controls in the left panel can be used to filter and list available datasets. The right
panel lists datasets that are plotted in the active layer.
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Filter source data.

Click arrow to Click to switch Group or
choose Plot layers (existing) or ungroup plots.
Type or accept to add a new layer.
A (auto). ] | Reorder
B ° Layer Contents: Add, Rzmaw%mup Older\huu—nur:n—\ ‘—/ 'h( p|0t5 in the
| Workshests in Folder - layer.
¥] Inchude Shortcut
Book Na.n'a . Sheat .ng Mame | Short Mama ;l Short Heme | Lomg Mo | Ngerd | Flarge Pl Type
sutomobile. dat automabie Make BIY) = 1 L= —
automabile. dat automobie Powen  CIY) E :g; zﬂ . :LH;: ::::::
automobile. dat auitomobile 060 mph DY) - .
sutomebile. dat aulomobile Weight  E[Y] ﬂ E[v) Weight [1%112°] Scatter
sutomobile. dat automabie Gas Mileage FiY) o
sutormickile, 22t autamobie Ergine Disp GIY) Opt to rescale graph
19921995 |Weight [BIY) | axes when plots are
added or removed.
.
. i | | | Layer Propesties...| [Pl Setup...| ool | Close | [ Canced
L' Y

Move selected
data into or out of
the layer.

1. Choose data
from this pool ...

2. ..then add it to
the graph layer.

Controls in the center of the dialog box allow you to add or remove plots from the active graph layer. When
adding data to the graph, click the list button (downward-pointing arrow) to pre-select the plot type before
adding data to the layer. Use controls in the right panel to group or ungroup plots, or re-order plots in the
layer.

|, You can use a LabTalk system variable @SCCS modifies Layer Contents sort
behavior: @SCCS = 0 (default) no change (not case-sensitive and sorts as Bookl >
Book2 > Book10); @SCCS = 1 sort is case-sensitive and sorts as Bookl > Book10 >
Book2.

11.3.3.4 Adding, Removing, Replacing or Hiding Data Plots with the Plot Setup Dialog Box

Among other things, the Plot Setup dialog box can be used to add or remove data plots from the graph.

=

To add plots to the graph, use the top panel of Plot Setup to identify your source data.

N

Use the controls in the middle panel to specify the plot type and how the data selection should be treated
(as X, Y, yError or Label).

In the bottom panel, choose the Layer to which you want to add plots, then click the Add button.

To remove a plot from the layer, select the plot in the bottom panel, then right-click and choose Remove.

To hide a plot, uncheck the Show check box for the plot.

2R

To replace a plot, select the plot in bottom panel, then change the X and Y selection and plot type in

middle panel and click the Replace button.
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Plot | Range 'Shaw  Plot Type
=1 Layer1 [ Rescale el
= [#8 Group
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Vo, [Step0_dat]Step0l! “Senso B Group b W< B34, 0MEFI <Y < 026044  [J]  Line + Symbol
Vs, [Step0l_dat]Step0l! “Sensor C Ungroup W< 596,0<Y < 051117 4| Line + Symba
‘| | '
Show Style Holders

Apply Range To Group
Apply Range To Layer
Apply Range To Page

For Origin 2023, Plot Setup adds support for replacing one 3D/Contour Plot/Image
matrix with another. Previously, when selecting a new matrix in the middle panel, the
Replace button remained dimmed.

2 Plot Setup: Configure Data Plots in Layer

Available Data:
[t Project -
[Jinclude Shortcuts

[include Hidden Sheet
Right-click on vanous panels to bring

up context menus.

Plot Type: | Show(s) | (CarlCar [2][%
Z |Matrix |Long Name Position

3D - Matrix Scatter = Carbrp 1

Contour al

Plot List: Drag entries in Tst column to recrder or to move between layers, Right click for other options, Replace Add Hi

Plot Range :Slluw Plot Type | Legend

E[|:-a:'nl_'-:-::._|p£|:'l::_=rr|i:-::-:- “bamboo jpg"(Z 10" 0<X<599, 0<Y <849 0cZ< Image bamboo jpg

11.3.3.5 Adding Data by Direct ASCII Import

You can import ASCII files directly into the active graph window using the the Import ASCI 1 toolbar button.
Note that this method works only with files having a simple structure and it supports only the simplest of
graph types - Line, Scatter, Line + Symbol, Column and Bar charts.

FEEES
1. Click the Import ASCII B putton. This opens the Import ASCII dialog box.

2. Choose a file.
3. Click Open.

The file is imported and plotted in the active graph window.

11.3.3.6 Adding Data by Copying and Pasting a Plot
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With many Basic 2D graphs (e.g. Scatter, Line, Line + Symbol, Bubble, etc.), you can copy a plot from an
existing graph layer and paste it to another layer in the same window or into a separate graph window. Prior to
Origin 2020, this would only produce a black line plot. Origin 2020 expanded copy-paste of plots to other plot
types, while preserving plot properties (symbol size, color, etc.).

1. Click on the plot to select it and press CTRL+C.
2. Click on the target graph and press CTRL+V.

You can also copy a plot by selecting the plot in the graph and clicking on the Copy Plot button on the Mini
Toolbar.

= Eg & » | CopyPlot
Then paste (Ctrl+V) into ancther layer as new plot
B e

|, Previous versions also allowed you to select and copy a simple plot (Line, Scatter, Line
+ Symbol, 2D Column/Bar) and paste underlying data into a worksheet. The default
settings no longer support this but you can reverse this by setting LabTalk system

variable @CPNP=1.

11.3.3.7 Removing or Hiding Plots with the Object Manager

The Object Manager is a dockable panel that allows for easy manipulation of graph layers and data plots.
See the section on The Object Manager in this Guide.

To hide or remove plots, right-click on a plot and choose from the shortcut menu:
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B[S Graph1CCA
Show Labels
ow Plots wi me Mame
[+ 320cm Show Plots with Same Mal
ide Plots wi ame MName
A ——— 330cm Hide Plots with Same N
— J40cm
ow Plots wi ame Mame Only
% 250em Show Plots with 5 M Onl
EI@ Layer2 Show All Plots
=gl Hide All Flots
[A—1
E 110em Set as Group Begin
[+] 120cm Set as Group End
[ ——— 130cm Mave out of Group
E 140em Fove Up
& 1 A D
ove Down
] 160cm
EI@ ayerd Move Plot to 2nd ¥ Axis
= E al move Plot(s) to Other Layer...
Smm
= T Remuove

e  Show or hide plots of the same Long Name.

e  Show all plots.

e Remove a plot from the graph window (hidden plots can be quickly shown again; removed plots must be
added back using one of the above methods).

e |f the plot is part of a group, you can right-click on an individual plot and remove just that plot or you can
right-click on the group icon and remove the entire plot group.

e  When you right-click on a plot, you can use Hide Plots with Same Name and Hide All Plots shortcut
menu items to quickly hide selected plots in the window without removing them entirely (restore plots by

enabling their display in the Object Manager or in Plot Details).

11.3.3.8 Removing or Hiding Data with Plot Details

In the left panel of the Plot Details dialog box (Format: Plot...), right-click on a plot and choose Remove or
Hide from the context menu. Remove will delete the data plot from the graph so if you just want to
temporarily hide a plot, choose Hide. Neither of them will delete data from worksheet or matrix.

200


http://www.originlab.com/doc/User-Guide/Graphing

Graphing

4 [ Layer?
-[#] [datatiledept&]Sheet!! “--“(X), "100cm"[¥) [1*:122*]
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T
V] [datay | REMOVE [1%122°]
] [data Remove All Special Points [1%122%]
V] [data Hide 1122+
V] [datatiledeptA]Sheet1! "--"(X), "160em"(¥) [1%:106%]

11.3.3.9 Deleting Plots using the Delete Key

Click on a data plot (either in the graph window or Object Manager) and press the Delete key. If the selected
plot is part of a group, the entire group is deleted.

Note that this is more sweeping than the Remove shortcut menu command in that it will remove an entire
plot group from the graph window. This action does not delete worksheet or matrix data.

To restore the deleted plots, choose Edit: Undo Remove Plot from the main menu.

11.3.3.10 Editing Plot Range

Once a graph is made, you can edit the plot display range, specifying only a portion of the plotted data:

e Right-click on the plot and choose the Edit Range... shortcut menu command. Edit the From and To
values.

e In the right panel of the Layer Contents dialog box (Graph: Layer Contents), turn on the Range column
by right-clicking on the column headings and choosing Range. Click on a plot's range values, then click
the ... button that appears to the right side of that column.

. In the bottom panel of Plot Setup (Graph: Plot Setup), click on the plot range in the Range column and
click the ... button that appears to the right side of that column.

Choose Graph: Rescale to Show All to rescale the graph after editing the plot range.

11.3.4Grouping Data Plots

When you make multiple range or column selections, then create a graph, Origin groups the resulting data
plots in the graph layer. This applies to most 1D (statistical) and 2D graphs, plus 3D XYY (XYY 3D bar, 3D
ribbon, 3D wall, and 3D waterfall plots) and 3D XYZ (3D scatter, 3D bar) graphs.

Grouping provides for quick creation of presentation-ready graphs because each plot in the group is assigned a
differentiating set of plot attributes (line color = black, red, green...; symbol shape = square, circle, triangle...;
etc.). Assignments are made by cycling through a pre-determined (user-modifiable) increment list of styles.

For instance, the first plot of a grouped line plots might be denoted by a black line; the second plot might be
denoted by a red line (the second color in the color list), the third plot by a green line (the third color in the
color list), and so on.
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Tutorial: Creating a simple grouped data plot

1t
1. Open a fresh worksheet and click the Import Single ASCI1 button B on the

Standard toolbar.

2. Browse to the Samples\Graphing subfolder in the Origin software folder and Open
GROUP.DAT.

3. Select B(Y), C(Y), and D(Y) columns

4. Click the Line & Symbol button ')} on the 2D Graphs toolbar. Note that line and

symbol color and symbol type are automatically differentiated for each plot.

Tutorial: Grouping (or ungrouping) plots manually

e Via the Layer Contents dialog box

1. To open the Layer Contents dialog box, double-click on the layer n icon in
upper-left corner of the graph window.

2. To create a group, select the desired data sets from the Layer Contents list (use
CTRL + select, SHIFT + select, or simply drag the mouse to select multiple data
sets).

3. Click Group. Note that each plot in Layer Contents is now preceded by a gn (for
"groupl"”, "group2”, etc.).

4. To ungroup, click on one of the grouped data plots in the Layer Contents list and

click Ungroup.

e Via the Plot Setup dialog box

1. To open the Plot Setup dialog box, ALT + double-click on the layer n icon in
upper-left corner of the graph window.

2. To create a group, select the desired plots from the Plot List (use the CTRL or
SHIFT keys to select multiple data sets).

3. Right-click and select Group. Note that a Group icon now precedes the selected
plots in the Plot List.

4. To ungroup, right-click on the Group icon and choose Ungroup from the shortcut

menu.

11.3.5Speed Mode

With Speed Mode, you can control the number of data points displayed in a graph layer. This option is most
used when working with large data sets, though note that there have been improvements in this area and
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Origin now has Density Dots and Color Dots graph templates specifically for creating scatter plots of large
datasets.

Speed Mode can be turned on for any 2D or 3D graph. When Speed Mode is enabled, the layer icon displays in
red and a Speed Mode is On banner appears in the layer. The banner is not included when printing, copying,
or exporting the graph.

Color Scale Title

M

IRt

Reminder Message

To speed up your work this graph will be displayed in “speed mode.’ Therefore,
some data may not be visible. To turn off speed mode select Format:Layer from the

Speed Hode menu and select the Size/Speed tab.

Y Axis Title

20 40 €0 80 104
X Axis Title

Do not show this message in the future

0K

To adjust Speed Mode settings:

With your graph active, select Format: Layer... from the Origin menu.

Select the Display/Speed tab.

For plots created from worksheet data, Select the Worksheet Data, Maximum Points Per Curve check
box to enable Speed Mode for all the data plots in the layer that are created from worksheet data. Type
the desired value (n) in the associated text box. If the number of data points in a data plot exceeds n,
Origin displays a subset of the data plot containing n points, drawn by extracting values at regular
intervals from the data set.

4. For 3D data plots created from a matrix or for contour data in the layer, Select the Matrix Data,
Maximum Points Per Dimension check box to enable Speed Mode. Type the desired value (n, m) in the
X and Y text boxes. If the number of data points in a data plot exceeds n or m, Origin displays a subset of
the data plot composed of -- at maximum -- n by m points. This subset is drawn by extracting values at

regular intervals from the matrix columns (X) and rows (Y).

For broad control, you can select Speed Mode from the Graph menu. This opens the speedmode X-
Functiondialog. The dialog lets you specify which windows the settings should apply to ( Target ) and also,
offers several levels of data plot thinning from Off to High, plus Custom.
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v 4
Click the Enable/Disable Speed Mode 1’"’ button on the Graph toolbar, to toggle
Speed Mode on/off for all layers in the graph window.

To turn off the Speed Mode is On banner for all graphs:

1. Select Preferences: Options to open the Options dialog box.

2. Select the Graph tab and clear the Speed Mode Show Watermark check box and refresh the graph, if

needed. Note that this only disables the banner across the graph; it does not disable Speed Mode.

| There is a page-level Mini Toolbar button to toggle the Speed Mode Banner off or on, at
1 the individual graph level.

3D Surface Plot from Virtual Matrix * = |[-E-| [

i 83 @ EE

28 3

11.3.5.1 Notes on Speed Mode

Origin 2023 has another generalized data reduction mechanism for plots with scatter
points (e.g line & symbol). The Plot Details Drop Lines tab has a Data Points Display
Control drop-down and this has been enhanced for Origin 2023 so that you can now

W systematically skip plotting of points by one of several methods (e.g. Skip Points by
Increment).

e Use system variable @SMM to determine method used for thinning points (e.g.
Largest Triangle).

e LabTalk control of where to begin skipping (e.g.
layer.plotl.symbol.skipstart=10, will start skipping at row 10).
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e  Skip Points and Speed Mode plot the last data point, by default, but this is controlled by system
variable @QSMEP.
e The Speed Mode controls on the Display/Speed tab of the layer's Plot Details only apply to what you see

on screen. They do not apply to graphs that are printed or exported, by default.

e |If you wish to skip points in printouts, use controls in the Print dialog. See the discussion of the Skip

Points feature as it applies to some graph windows in the Origin Help file.

e |If you wish to apply Speed Mode settings to graphic export, please see this discussion of Performance
Group controls on the Miscellaneous tab of the Plot Details dialog box or use controls under the Export
Settings node in the Graph Export dialog.

e Speed Mode settings are saved with the graph template. If you make changes to Speed Mode settings for

a particular graph type, you will have to resave the graph template to make those changes permanent.

e  Always exercise judgement when using Speed Mode. Since Speed Mode systematically weeds out a
portion of your data points, any graph in which Speed Mode is turned on, may -- or may not -- accurately
represent your data, to your satisfaction. Always familiarize yourself with your data and adjust and

compare Speed Mode settings to ensure that trends in your data are accurately depicted.

11.4Publishing Your Graph: Copy/Paste, Image Export, Slide Shows and
Printing

There are a number of ways to present your finished graph.

e Copy a graph page and paste it in other applications such as Word, Powerpoint, etc.
e  Export the graph page as an image file (raster or vector).

e Send Graphs to PowerPoint.

e  Printout.

®  Slideshow within Origin.

L] Create Movies.

Please read details in the Publishing and Export chapter of this User Guide and the "Topics for Further Reading"
there.

11.50rigin Graph Types

Origin supports over 100 plot types. Origin's 2D graphs are plotted from Worksheet data. Origin's 3D graph
are plotted from Worksheet data (XYY, XYZ), a worksheet arrangement we refer to as a Virtual Matrix or
from Matrix data.

Origin Graph Samples of most 2D and 3D graph types are included with your Origin
software. To view graphs, supporting data and guidelines for making the graphs,
choose Help: Learning Center(F11).

205


http://www.originlab.com/doc/LabTalk/ref/sys-var-list
http://www.originlab.com/doc/Origin-Help/Print-Dialog
http://www.originlab.com/doc/Origin-Help/Print-Dialog
http://www.originlab.com/doc/Origin-Help/PD-Dialog-Misc-Tab
http://www.originlab.com/doc/Origin-Help/ExpGraph-Dailog
http://www.originlab.com/doc/Origin-Help/ExpGraph-Dailog
http://www.originlab.com/doc/User-Guide/Publishing-and-Export
http://www.originlab.com/doc/User-Guide/Publishing-and-Export
http://www.originlab.com/doc/User-Guide/Matrix-Book-Matrix-Sheet-Matrix-Objects
http://www.originlab.com/doc/User-Guide/Matrix-Book-Matrix-Sheet-Matrix-Objects

UserGuide 2023

The tables below list all Origin graph types, grouped by Plot menu category:

&l

File Edit View | Plot || Column Worksheet Ar
..:E

OB

@i/ R &5l

e Hat e B D

e The Plot menu icon for each graph type precedes the graph name.

e The Notes column provides basic information on data requirements. For more specific data

requirements, click on the graph name beside the Plot menu icon.

11.5.1Plot Menu Graphs by Category

206

Plot menu templates display basic data requirements on hover.

silBl]dE: el

v Owverl... |Box Mormal| Half Box  Bar Overlap  Bar Mormal Scatter Doub

a4y ¥
+% 3

4+ o+ |t
ey

Box Mormal

Select at least one column to create box chart with data points and
‘h_l normal distribution curve on right side,

ulti-Panel Distribution  Distribution  Histogram Stacked  Population  Marg
stogram + Rug with Labels Histograrms  Pyramid  Histoc

You can modify the size of the Plot menu icons using the LabTalk system variable
@PPS. To find out how to change the value of a system variable, see Customizing
Origin Using System Variables.

(] Basic 2D

. Bar, Pie, Area

. Multi-Panel/Axis

(] Statistical

(] Contour

e Specialized

e Categorical

e 3D

. Browser Graph

(] Function Plot
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My Templates
Other Graphing Tools

11.5.1.1 Basic 2D

Graphing

Graph Types

Notes

L] Scatter

IScatter Central

. Column Scatter

Y Error

XY Error

Error Band

fiScatter + Ru

Bubble

Color Mapped

Bubble + Color Mapped

Start with a Worksheet.

If there is an associated X column, X column
supplies X values; otherwise, Y sampling interval
or row number is used.

For specific data requirements, follow links in the

Graph Types column.

Line

Horizontal Step °

Vertical Ste

Spline

Start with a Worksheet.

Select one or more Y columns or at least a portion
of one Y column.

Multiple Y columns are grouped in layer.

If there is an associated X column, X column
supplies X values; otherwise, Y sampling interval

or row number is used.
For specific data requirements, follow links in the

Graph Types column.
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Graph Types

Notes

Lollipop Plot

Vertical Drop Line

Start with a Worksheet.
/\/\/\ . Select one or more Y columns or at least a portion
Line + Symbol
. of one Y column.
""\-\.
* |l ine Series Multiple Y columns are grouped in the graph layer
. E s (except Line Series).
- e
“IBefore and After Graph For Line Series graph, select 2 or 3 Y columns.
A
- " If there is an associated X column, X column
= 2 Point Segment supplies X values; otherwise, Y sampling interval
-
sl or row number is used.
* _* I3 Point Segment i . o
e 4 For specific data requirements, follow links in the
i \
) Graph Types column.
" .
- Spline Connected
Start with a Worksheet.
For Bar, Column or Column + Label, select one or
more Y columns (multiple Y columns are grouped
in layer).
Pa— For Floating Bar/Column, select two Y columns.
_ = For Stack graphs and Lollipop plots, select two or

more Y columns.

If there is an associated X column, X column
supplies X values; otherwise, Y sampling interval
or row number is used.

For specific data requirements, follow links in the

Graph Types column.

#7 _ Ipensity Dots

Color Dots

Start with a Worksheet.

Select one Y (Density Dots) or two Y (Color Dots)
columns.

For more information, follow links in the Graph

Types column.
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Graphing

Graph Types Notes

i e  Start with a Worksheet.

| . .
. . [ )
Colormapped Line Series If there is an associated X column, X column

\\_ supplies X values; otherwise, Y sampling interval
:./'\;_d_ Stacked Lines by Y or row number is used.
Offsets

e  For specific data requirements, follow links in the

Graph Types column.

Row-wise

11.5.1.2 Bar, Pie, Area

Graph Types Notes

B

Column

LK1
=]

Column + Label e  Start with a Worksheet.

e  For Bar, Column or Column + Label, select one or

Bar more Y columns (multiple Y columns are grouped

in layer).
Stacked Column

For Floating Bar/Column, select two Y columns.

For Stack graphs and Lollipop plots, select two or
Stacked Bar

more Y columns.

100% Stacked Column (] If there is an associated X column, X column

supplies X values; otherwise, Y sampling interval

TETERE

100% Stacked Bar or row number is used.

For specific data requirements, follow links in the

Floating Column Graph Types column.
[
[ |
H Floating Bar
il

Kite Diagram
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Graph Types

Notes

3D Color Pie Chart

2D Color Pie Chart

"-""” Doughnut Plot

Pie of Pie

Bar of Pie

Doughnut of Pie

Doughnut with Total

Pie with Different Radius

Doughnut with Different

Start with a Worksheet.

Select exactly one Y column or a range from one Y
column.

If there is an associated X column, the X data are
used in the graph legend; otherwise row number is

used.

For specific data requirements, follow links in the

Graph Types column.

Doughnut Chart improvements
for Origin 2023:

-

iiﬁ e Set Group tab Edit Mode

= Independent, then use
the Rescale Radius (%6
of frame) edit box to

customize individual rings.

Stacked Area

Eloo% Stacked Area

Fill Area

“JFill 2 Colors

Start with a Worksheet.
If there is an associated X column, X column

supplies X values; otherwise, Y sampling interval
or row number is used.

For specific data requirements, follow links in the

Graph Types column.

11.5.1.3 Multi-Panel/Axis
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There is now general support for "Double-Y" graphs in a single layer. Previously, two
independent Y axes meant "two layers." Hence, you will note that, beginning with Origin
2023, the Multi-Panel/Axis category (Plot: Multi-Panel/Axis) has two rows of “"Double-Y"
templates with the new, single-layer on top and the older, two-layer templates below.
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(1M ] 1] ]
o L T Ly e ] - m
B e * ] - 1 NEW: single-layer
’ & ] C ]
Ad Ll Double-Y  Double-¥Y Double-Y
I' N — Column  Column-Lin
1L 10 1
- Multi-Panel/Axis .:';5’“-: C 1 i1 Legacy: two-layer
i - & L 4 L 0 C ]
[0, Sttt o0 2¥sY-Y  2¥s Column 2Y¥s
ot Celumn-Lin
-t

The new and the legacy templates will produce the same graph, the only difference being
that the legacy template will create two layers while the new template will create only one.
The plotting procedure is the same for both:

In the worksheet, select 2 columns of "Y" data.

Click Plot: Multi-Panel/Axis and choose the desired template.

Note: Support for these new "single-layer, two Y axes" templates owes to a new general
plotting mechanism for select graph types such as line + symbol, column and box charts.
See this example in Customizing Graphs.
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Graph Types

Notes

1

E]
" -

Double-Y

Column Graph h

E

Start with a Worksheet.
Select two Y columns.

If there is an associated X column, X column supplies X values; otherwise, Y

sampling interval or row number is used.

For specific data requirements, follow links in the Graph Types column.

Double-Y
Column-Line
Symbol
L] L] )
i ;
. oVs Yoy Start with a Worksheet.
Select two Y columns.
2Ys If there is an associated X column, X column supplies X values; otherwise, Y
Column R .
sampling interval or row number is used.
i For specific data requirements, follow links in the Graph Types column.
1A
H s
Column-Line
Symbol
. 7
gy o Start with a Worksheet.
= _* J13Ys Y-YY
T Select one Y column for each Y axis.
- -
- . 3Ys Y-Y- Multiple Y Axes opens interactive dialog. Choose plot type, number of
Y‘ - axes, plots per layer, axis color to match plot, etc.
- For specific data requirements, follow links in the Graph Types column.
=]/4Ys Y-
YYY
L ]
W "k
=4Ys YY- gl For Origin 2023, the Multiple Y Axes dialog adds
el p MEW support for Plot Type = Column
A W
- Multiple

Y Axes...
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Graph Types

Notes

l——
Lf"'_'.- Vertical 2

Panel

Y

al 2 Panel

L~

Lili4 Panel
o el el
i Pl el
L=~ 9 panel
A,
st |Stack. ..

L~ B

= Multiple
Panels by Label...

Start with a Worksheet.
Select one Y column (or range) per panel.

If there is an associated X column, X column supplies X values; otherwise, Y

sampling interval or row number is used.

For specific data requirements, follow links in the Graph Types column.

New Stack (plotstack) options for Origin 2023:

E R EW T
W e  Stack Direction = Horizontal option is added for

Origin 2023 (previously, there were only Vertical
and Horizontal (X-Y Axes Exchanged) options).
The new Horizontal option works well with

Orientation = Landscape.

e Use Alternate Side to Show Ticks and Labels
check box to alternate tick label position for each
layer (available for any Stack Direction -- not just

vertical).

NEE
0 2 4 B ]
—— 521-235-07 ' ' T

=&
40
o

Fosition (mm})
2

132 1
99 1
— 1 o
- =144 E
o~ 1.2
L : {123
1 w
L 4120 2
(=]
1 L]
L J0e =
— 1 1 1 1

L *IZoom

Start with a Worksheet.
Select at least one Y column or a range from at least one Y column.

If there is an associated X column, X column supplies X values; otherwise, Y

sampling interval or row number is used.

For specific data requirements, follow the link in the Graph Types column.
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11.5.1.4 Statistical

For Origin 2023, you can add a Box Scale to your box charts. The Box Scale diagrams

key user-selected box statistics.

[ up to 01-# 1GR; up to Q3+# IOR 1=

[ Median |
|Mean |
[ Outliers |
I EN—
ttomassorronn [0 |
upto Q3415 QR
Fisher's Iris Data P ——
Labels in Line D
B Font
" ‘. :‘d?:: Font |ﬁ‘ Default: Arial .
!: & Font Size 1 -
.
é‘ Calor Weak ~
i3 ﬁ uptoQ1-151QR || Label Rotate
? + Outliers |m v|
*
1 T % c [Ty [ o Cancel
e —

right-click on box scale
and choose Properties

214



Graphing

Graph Types

Notes

Box Chart

Interval Plot

Bar Chart

_IBox Overlap

Box Normal

“ |Half Box

Bar Overlap

‘IBar Normal

Scatter Interval

Marginal Box Charts

Beeswarm Plot

Start with a Worksheet.

Select at least one Y column or a range from at
least one Y column.

For specific data requirements, follow the link in

the Graph Types column.
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Graph Types

Notes

[ l|h}~ = [Histogram

T JHistogram + Rug

fﬂ-ﬁ:n Histogram + Probabilities

Multi-Panel Histograms

Distribution

[mamnmpDistribution + Ru
[

oL

o
-

Histogram with Labels

Stacked Histograms

pE

Population Pyramid

Marginal Histograms

s

~“Marginal Plots (Grouped

Marginal Histogram)

Start with a Worksheet.

Select at least one Y column or a range from at
least one Y column.

For specific data requirements, follow links in the

Graph Types column.

Scatter Matrix

Start with a Worksheet.

Select two Y columns or a range from two Y
columns.

For specific data requirements, follow the link in

the Graph Types column.
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Graph Types

Notes

£> C%) Violin Plot

Violin with Box

Violin with Point

Violin with Quartile

b &
X.
b b

Start with a Worksheet.

Select at least one Y column (or a range from at
least one Y column).

Split violin requires exactly 2 data columns, plus a
third grouping column.

For data requirements and other information on

plot variations, see Violin Plot.

Split Plot For data requirements and other information on
Ridgeline Charts, follow the link in the Graph Types
column.

Half Violin

,—f# Ridgeline Chart
Start with a Worksheet.
e
I Select one Y columns or a range from one Y
Data Pareto Chart - Binned column (Raw), or a Y column of Binned results.

Em‘;.l.l_Pareto Chart - Raw Data

For specific data requirements, follow the link in

the Graph Types column.

t =+ t
[ -

I-...OC (X-bar R) Chart

Start with a Worksheet.

Select at least one Y column or a range from at
least one Y column.

For specific data requirements, follow the link in

the Graph Types column.
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Graph Types Notes
IIIII e  Start with a Worksheet.
lI Brid Ch
ridge art e  Select one or more Y columns (or a range of one

L]
'!JI“ or more Y columns). If there is an X column to the
© | IStacked Bridge Chart

left of the Y column(s), this X column is treated as

categorical data; otherwise, the worksheet's row

L ___IStacked Total Bridge indices will be used.

Chart

_E e  Origin Bridge Charts are variants of one basic
iHoriz-Bridge Chart chart type. For more information, see Bridge
E M, Charts.

0000

Double Y Box

e  Start with a Worksheet.

? e Select one Y column or a range from one Y
0 Probability Plot column.
. ] e  For specific data requirements, follow the link in
Q-Q Plot the Graph Types column.

(] Start with a Worksheet.

eyt e  Select two Method columns and one Subject

Bland-Altman Plot column (optional).

11.5.1.5 Contour

Contour plot improvements for Origin 2023:

W e The Colormap/Contours tab Insert button now opens a text box for manually
inserting multiple contour Levels.

®  Click twice (do not double-click) on a contour line and popup a Mini Toolbar for

single-level customization.
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Graphing

| | -04531

Show Data Labels
4016

Graph Types

Notes

Gray Scale Map

L
-
e lContour - Categorical Z

Contour Color Fill, B/W Lines + Labels, Gray Scale
Map, Contour Profiles: XYZ, Virtual Matrix,
Matrix.

Contour - Categorical Z: XYZ, Virtual Matrix.
For specific data requirements, follow links in the

Graph Types column.

= ISplit Heatmap

Heatmap and Heatmap with Labels start with a
Worksheet (XY, XYZ), Virtual Matrix or Matrix.

Split Heatmap starts from a Worksheet.

For specific data requirements, follow links in the

Graph Types column.

[
g mContour Profiles
B

@gmlmage Profiles

Start with a Worksheet, Virtual Matrix or
Matrix (Image Profiles, Matrix only).
For specific data requirements, follow links in the

Graph Types column.

it -"g Polar Contour theta(X)

r¢y)

{r.#% polar Contour r(x),
theta(Y)

Start with a Worksheet or Matrix.
For data requirements and other information on
polar contour graphs from worksheet data, see

Polar Contour from XYZ Data.

For data requirements and other information on
polar contour graphs from matrix data, see Polar

Contour from Matrix Data.
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Graph Types

Notes

Ternary Contour

Start with a Worksheet.
Columns should be designated as XYZZ.

For specific data requirements, follow the link in

the Graph Types column.

2D Kernel Density

Start with a Worksheet.

Select at least one Y column or a range from at
least one Y column.

For specific data requirements, follow the link in

the Graph Types column.

| ah |
Image Plot

Start with a Matrix.

Z values are from an imported raster image.

11.5.1.6 Specialized

Graph Types

Notes

5T lvector xyam

i/\ Vector XYXY

Start with a Worksheet.

For XYAM Vector, select three Y columns (or a
range of the three Y columns).

For XYXY Vector, select two X columns and 2 Y
columns (or a range of two X and two Y columns).
For specific data requirements, follow links in the

Graph Types column.

£ Streamline Vector Plot

Start with a Matrixsheet with two matrix objects.

The two matrix objects are the derivatives of the

plotted curve in the (X,y) directions, respectively.

220



http://www.originlab.com/doc/Origin-Help/Ternary-Contour
http://www.originlab.com/doc/Origin-Help/2D-Kernel-Density
http://www.originlab.com/doc/Origin-Help/Image-Plot
http://www.originlab.com/doc/Origin-Help/XYAM-Graph
http://www.originlab.com/doc/Origin-Help/XYXY-Graph
http://www.originlab.com/doc/Origin-Help/Streamline-Vector-Plot

Graphing

Graph Types Notes

Ternary

Ternary, Line+Symbol

Ternary, Line .
e  Start with a Worksheet.

. i e  For specific data requirements, follow links in the
Right-Triangle Ternary

Graph Types column.

Ternary Vector

v
@
©

Ternary Vector plots are new

W for Origin 2023.

=

.

P B>

Stiff
& -
2 Stiff Map
iy, i
ﬂ..
¥ Schoeller

A
o
c
c
(o]
<

(] Start with a Worksheet.

® Select at least one Y column (or a range from at
least one Y column). The X column displays as the
title of the radial axis around the chart. If there is
an associated X column, X column supplies X
values; otherwise, Y sampling interval or row

number is used.
e Radar Charts are also known as "Spider Plots".

e  For more information, see Radar Chart (Spider
Plot).

DOOD
% . C Py
5 8 3 3§
° Iz -
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Graph Types

Notes

A
=S =

0.1 polar theta(x) r(Y)

)

(r.0% polar r(X) theta(y)

.rl Bar theta, r

i'-w% Bar r, theta
o % Line + Symbol theta, r
L % Line + Symbol r, theta

fhr) Symbol theta, r

ETTTTTTTTR TR T I i
- e

<)
=

=
=

TR ITERTIETIE M TTETTATIT I
==

r. 12 symbol r, theta

(A

Start with a Worksheet.

Select one or more Y columns or a range from one
or more Y columns. If there is an associated X
column, X column supplies X values; otherwise, Y
sampling interval or row number is used.

For data requirements and other information on

polar graphs, see Polar Graph.

Sin Wind Rose - Binned Data
i A
Fi Wind Rose - Raw Data
Start with a Worksheet.
P Select at least one Y column of values (or a range

Q)

“—*/ stacked Radial

g:: " Radial Bar Plot

Radial Stacked Bar

from at least one column). If there is an
associated X column, X column supplies X values;
otherwise, Y sampling interval or row number is
used.

For more information, see Radial Bar and Radial
Stacked Bar Plot

‘A
UK |
_:f Polar Vector 6r 6r]
Y

-~ Compass Plot

Start with a Worksheet.

For Compass, Select at least one Y column of
values (or a range from at least one column). If
there is an associated X column, X column supplies
X values; otherwise, Y sampling interval or row
number is used.

For Polar Vector Or Or, select two pairs of XY

columns in the order 6r or.
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Graph Types Notes

e  Start with a Worksheet.

® Select at least one Y column of values (or a range

from at least one column). If there is an

associated X column, X column supplies X values;
@ otherwise, Y sampling interval or row number is
Smith Chart
used.

e  For more information, follow the link in the Graph

Types column.

High-Low-Close

Jjapanese Candlestick e  Start with a Worksheet.

I 'l ®  For specific data requirements, follow links in the

OHLC Bar Chart Graph Types column.

[l 8w BloHLC-Volume

Select one X column and at least two Y columns.

||
EBullet Chart e  Start with a Worksheet.
MVertical Bullet Chart e  For more information, see Bullet Chart.

L]
ENormalized Bullet Chart

11.5.1.7 Categorical

Graph Types Notes

(] Start with a Worksheet.

= T
' 4 e Select at least one Y column as input data.
% ..r'
dS tt‘ Groupe ®  One or more column(s) of categorical data provide grouping information.
catter -
Indexed Data e  For more information, see the link in the Graph Types column.
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http://www.originlab.com/doc/Origin-Help/SmithChart-Graph
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
http://www.originlab.com/doc/Origin-Help/High-Low-Close-Graph
http://www.originlab.com/doc/Origin-Help/Japanese-Candlestick
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http://www.originlab.com/doc/Origin-Help/Bullet-Chart
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http://www.originlab.com/doc/Origin-Help/GroupedScatter-IndexedData
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Bubble

+ Color
Mapped

Start with a Worksheet.

If there is an associated X column, X column supplies X values; otherwise, Y

sampling interval or row number is used.

For specific data requirements, follow links in the Graph Types column.

EIJGrour_)e

d Columns -
Indexed Data

=

Groupe

d Floating Bar

Start with a Worksheet.

Select at least one Y column (Grouped Columns) or two Y columns (Grouped
Floating Bar).

If there is an associated X column, X column supplies X values; otherwise, Y
sampling interval or row number is used.

For Grouped Columns - Indexed Data, an additional column supplies the
Group information.

For Grouped Floating Bar Graphs, subgroup by size (i.e. number of

columns) or by column label.
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http://www.originlab.com/doc/Origin-Help/Color-Mapped-Graph
http://www.originlab.com/doc/Origin-Help/Color-Mapped-Graph
http://www.originlab.com/doc/Origin-Help/Bubble-Color-Map-Graph
http://www.originlab.com/doc/Origin-Help/Bubble-Color-Map-Graph
http://www.originlab.com/doc/Origin-Help/Bubble-Color-Map-Graph
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
http://www.originlab.com/doc/Origin-Help/grouped-column-index-data
http://www.originlab.com/doc/Origin-Help/grouped-column-index-data
http://www.originlab.com/doc/Origin-Help/grouped-column-index-data
http://www.originlab.com/doc/
http://www.originlab.com/doc/
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
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Graph Types

Notes

-'na'ﬂrEl Groupe
d Box Charts -
Indexed Data

Figw [j: Groupe
d Box Charts -
Raw Data

. Groupe
d Column

Scatter
Indexed Data

by 3t

Groupe
d Interval Plot
- Indexed Data

it

H | |‘E Groupe
d Mean Bar -
Indexed Data

:!?-"' 1 .

i

Groupe
d Violin -
Indexed Data

1
7 T "Groupe
d Half Violin -
Indexed Data

Groupe
d Half Box -
Indexed Data

Start with a Worksheet.

Select at least one Y column (or a range from at least one Y column), plus a
second column with grouping information. If there is an associated X column, X
column supplies X values; otherwise, Y sampling interval or row number is

used.
Plots of Indexed Data are all style variations of the Grouped Box.

For more information, follow the links in the Graph Types column.

For Origin 2023, the template Grouped Box Charts -
Indexed Data adds a Data Points Color by control when
Graph Theme includes plotting of individual data points
(e.g. Box_Column Scatter). This allows coloring of individual
points using worksheet column

values.
Group Column(s) [BooklA]sheetlla
‘ [BookiA]Sheet1!B
Graph Template GBOX E‘i\u’co
Graph Theme Box_Column Scatter o

ull
-

Data Points Color by || [Book1A]Sheet]!C

“ NTrellis

Start with a Worksheet.

Select at least one Y column as input data. Optionally, you can have an
additional associated Y error column for each Y column. Other column(s)

generally contain grouping information.

For more information, see the link in the Graph Types column.
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http://www.originlab.com/doc/Origin-Help/GroupedBoxCharts-IndexedData
http://www.originlab.com/doc/Origin-Help/GroupedBoxCharts-IndexedData
http://www.originlab.com/doc/Origin-Help/GroupedBoxCharts-IndexedData
http://www.originlab.com/doc/Origin-Help/GroupedBoxCharts-RawData
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Graph Types

Notes

& [}
J'I" ." f:;
(¥ ¥ bouble
Y Trellis Plot

Start with a Worksheet.

Select two Y columns as input data. Optionally, you can have an additional
associated Y error column for each Y column. Other column(s) generally

contain grouping information.

For more information, see the link in the Graph Types column.

Start with a Worksheet.

You need at least two Y columns, one of which should contain grouping
information.

Grouping columns can be used to create separate panels in the horizontal
and/or vertical directions and/or to modify plotted points (color, scatter point

size, scatter point shape, etc.).

Parallel

P
,
:L Parallel

Start with a Worksheet.

Select at least one (ideally, two or more) column(s) or a range from one or
more columns. Column designation does not matter. Each column will be
treated as data on a single variable.

Variables may be numeric (Parallel Plot or Parallel Index) or they may be
categorical (Parallel Sets).

Parallel Sets plots have a "curvature" option that is sometimes seen in plots
termed "Alluvial Diagrams" (see next).

For more information, follow links in the Graph Types column.

ISankey
Diagrams

=

=Alluvial
Diagrams

Start with a Worksheet.

For Sankey Diagrams, select exactly two columns of categorical data + 1

column of numeric data. Column designation is ignored

For Alluvial Diagrams, select two or more columns of categorical data. Column

designation is ignored.

For more information, follow links in the Graph Types column.
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http://www.originlab.com/doc/Origin-Help/Trellis-Double-Y
http://www.originlab.com/doc/Origin-Help/Trellis-Double-Y
http://www.originlab.com/doc/Origin-Help/cluster-plot
http://www.originlab.com/doc/Origin-Help/cluster-plot
http://www.originlab.com/doc/Origin-Help/Parallel-Plot
http://www.originlab.com/doc/Origin-Help/Parallel-Plot
http://www.originlab.com/doc/Origin-Help/Parallel-Sets
http://www.originlab.com/doc/Origin-Help/Parallel-Sets
http://www.originlab.com/doc/Origin-Help/Parallel-Index
http://www.originlab.com/doc/Origin-Help/Parallel-Index
http://www.originlab.com/doc/Origin-Help/Sankey-Diagram
http://www.originlab.com/doc/Origin-Help/Sankey-Diagram
http://www.originlab.com/doc/Origin-Help/Alluvial-Diagram
http://www.originlab.com/doc/Origin-Help/Alluvial-Diagram
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Graph Types

Notes

Uh' Chord

Diagram

o Chord
Diagram with
Ratio Layout

Start with a Worksheet or Virtual Matrix.

Select at least three columns of values (worksheet) or a block of values (virtual

matrix) from at least three columns.
The first column will be treated as X and should be monotonic.
For more information, see Chord Diagram and Chord Diagram with Ratio

Layout.

Start with a Worksheet.
Select at least two Y columns of values (or a range from at least two columns).

If there is an associated X column, X column supplies X values; otherwise,

sampling interval of the Y column or row number is used.

i Network

Start with a Worksheet.

The plot requires one of three data arrangements: Adjacency matrix, Incidence

Matrix or Edge List.
A dialog box is used to specify input and analysis parameters.

Regardless of data arrangement, an intermediary worksheet will be created to

tabulate node and link information.

ji-f"r Sunbur

st Plot

Circula

r Packing
Graph

Start with a Worksheet.

Select multiple categorical X columns and one Y column.

11.5.1.83D

Origin 2023 supports a minimum Z axis length of 10% -- reduced from a previous 25%
(Plot Details layer level, Axis tab).
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http://www.originlab.com/doc/Origin-Help/Chord-Diagram
http://www.originlab.com/doc/Origin-Help/Chord-Diagram
http://www.originlab.com/doc/Origin-Help/Ribbon-Chart
http://www.originlab.com/doc/Origin-Help/100percent-Ribbon
http://www.originlab.com/doc/Origin-Help/100percent-Ribbon
http://www.originlab.com/doc/Origin-Help/Network-Plot
http://www.originlab.com/doc/Origin-Help/Sunburst-Plot
http://www.originlab.com/doc/Origin-Help/Sunburst-Plot
http://www.originlab.com/doc/Origin-Help/Circular-Packing
http://www.originlab.com/doc/Origin-Help/Circular-Packing
http://www.originlab.com/doc/Origin-Help/Circular-Packing
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Graph Types Notes

e Data requirements vary by plot type. See links in the Graph Types column.

For Origin 2023, these plot types all support Spline or B-
Spline for connecting lines between data

| :'i i ':- points.

Scatter
1 E -|-:|nJ|
3D 2RI
Scatter Yy 200
Error Bar i
Z 0
3D 100
Line o L]

Iz
W 3D b

Trajectory

o [
3D (] Start with a Worksheet.
Vector XYZ XYZ e  Select 6 worksheet columns, designated as XYZ XYZ.
o
- e  For more information, see links in the Graph Types column.
3D
Vector XYZ
dXxdydz
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http://www.originlab.com/doc/Origin-Help/Mat-3DScatter
http://www.originlab.com/doc/Origin-Help/Mat-3DScatter
http://www.originlab.com/doc/Origin-Help/3D-ErrBars
http://www.originlab.com/doc/Origin-Help/3D-ErrBars
http://www.originlab.com/doc/Origin-Help/3D-ErrBars
http://www.originlab.com/doc/Origin-Help/3DLine
http://www.originlab.com/doc/Origin-Help/3DLine
http://www.originlab.com/doc/Origin-Help/Trajectory-Graph
http://www.originlab.com/doc/Origin-Help/Trajectory-Graph
http://www.originlab.com/doc/Origin-Help/3DVector-XYZ-XYZ
http://www.originlab.com/doc/Origin-Help/3DVector-XYZ-XYZ
http://www.originlab.com/doc/Origin-Help/3DVector-XYZ-dXdYdZ
http://www.originlab.com/doc/Origin-Help/3DVector-XYZ-dXdYdZ
http://www.originlab.com/doc/Origin-Help/3DVector-XYZ-dXdYdZ
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Graph Types

Notes

Start with a Worksheet.

Select at least one Y column (or a range from at least one Y column). Ideally,
select at least two Y columns (or a range of at least two Y columns). If there is
an associated X column, X column supplies X values; otherwise, Y sampling

interval or row number is used.

For more information, see the link in the Graph Types column.

StackedWal Is

3D
100% Stacked
Walls

Start with a Worksheet.

Select at least one Y column (or a range from at least one Y column). Ideally,
select at least two Y columns (or a range of at least two Y columns). If there is
an associated X column, X column supplies X values; otherwise, Y sampling

interval or row number is used.

For more information, see the link in the Graph Types column.

@Wate rf

< v waterf

Waterf
all: Z Color
Mappin

3D
Waterfall

4 V" 3p
Waterfall: Y
Color Mappi

3D
Waterfall: Z
Color Mapping

Start with a Worksheet.

Select at least one Y column (or a range from at least one Y column). Ideally,
select at least two Y columns (or a range of at least two Y columns). If there is
an associated X column, X column supplies X values; otherwise, Y sampling

interval or row number is used.

For more information, see the links in the Graph Types column.

Waterfall, Waterfall: Y Color Mapping and Waterfall: Z
Color Mapping, are only available from the 2D Graphs
toolbar.
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http://www.originlab.com/doc/Origin-Help/Ribbon-Graph
http://www.originlab.com/doc/Origin-Help/Ribbon-Graph
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
http://www.originlab.com/doc/Origin-Help/Wall-Graph
http://www.originlab.com/doc/Origin-Help/Wall-Graph
http://www.originlab.com/doc/Origin-Help/Stacked-Wall-Graph
http://www.originlab.com/doc/Origin-Help/Stacked-Wall-Graph
http://www.originlab.com/doc/Origin-Help/100-Stacked-Wall-Graph
http://www.originlab.com/doc/Origin-Help/100-Stacked-Wall-Graph
http://www.originlab.com/doc/Origin-Help/100-Stacked-Wall-Graph
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
http://www.originlab.com/doc/Origin-Help/2DWaterfall-Graph
http://www.originlab.com/doc/Origin-Help/2DWaterfall-Graph
http://www.originlab.com/doc/Origin-Help/2DWaterfall-Y-ColMap
http://www.originlab.com/doc/Origin-Help/2DWaterfall-Y-ColMap
http://www.originlab.com/doc/Origin-Help/2DWaterfall-Y-ColMap
http://www.originlab.com/doc/Origin-Help/2DWaterfall-Z-ColMap
http://www.originlab.com/doc/Origin-Help/2DWaterfall-Z-ColMap
http://www.originlab.com/doc/Origin-Help/2DWaterfall-Z-ColMap
http://www.originlab.com/doc/Origin-Help/3D-Waterfall-Graph
http://www.originlab.com/doc/Origin-Help/3D-Waterfall-Graph
http://www.originlab.com/doc/Origin-Help/3D-Waterfall-YColor-Mapping
http://www.originlab.com/doc/Origin-Help/3D-Waterfall-YColor-Mapping
http://www.originlab.com/doc/Origin-Help/3D-Waterfall-YColor-Mapping
http://www.originlab.com/doc/Origin-Help/3D-Waterfall-ZColor-Mapping
http://www.originlab.com/doc/Origin-Help/3D-Waterfall-ZColor-Mapping
http://www.originlab.com/doc/Origin-Help/3D-Waterfall-ZColor-Mapping
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
http://www.originlab.com/doc/Origin-Help/2D-Graph-Toolbar
http://www.originlab.com/doc/Origin-Help/2D-Graph-Toolbar
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Notes

X

3D

Color Fill
Surface

fBD X

Constant with
Base Surface

fBD Y

Constant with
Base Surface

Projection

Y]
)

Wire Fraﬁe

.,

Wire Surface

Start with a Worksheet or Matrix.

For specific data requirements, follow links in the Graph Types column.

Color Fill
Surface with

m
=
=
o
=
|3]
)
=

Multipl
e Color Fill

Surfaces

3

Multipl

e Color Map
Surfaces

Start with a Matrix.

For specific data requirements, follow links in the Graph Types column.
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http://www.originlab.com/doc/Origin-Help/Color-Fill-Surface
http://www.originlab.com/doc/Origin-Help/Color-Fill-Surface
http://www.originlab.com/doc/Origin-Help/Color-Fill-Surface
http://www.originlab.com/doc/Origin-Help/X-Const-Base-Surface
http://www.originlab.com/doc/Origin-Help/X-Const-Base-Surface
http://www.originlab.com/doc/Origin-Help/X-Const-Base-Surface
http://www.originlab.com/doc/Origin-Help/Y-Const-Base-Surface
http://www.originlab.com/doc/Origin-Help/Y-Const-Base-Surface
http://www.originlab.com/doc/Origin-Help/Y-Const-Base-Surface
http://www.originlab.com/doc/Origin-Help/Color-Map-Surface
http://www.originlab.com/doc/Origin-Help/Color-Map-Surface
http://www.originlab.com/doc/Origin-Help/Color-Map-Surface
http://www.originlab.com/doc/Origin-Help/Color-Map-Surface-Projection
http://www.originlab.com/doc/Origin-Help/Color-Map-Surface-Projection
http://www.originlab.com/doc/Origin-Help/Color-Map-Surface-Projection
http://www.originlab.com/doc/Origin-Help/Color-Map-Surface-Projection
http://www.originlab.com/doc/Origin-Help/Wire-Frame
http://www.originlab.com/doc/Origin-Help/Wire-Frame
http://www.originlab.com/doc/Origin-Help/Wire-Surface
http://www.originlab.com/doc/Origin-Help/Wire-Surface
http://www.originlab.com/doc/Origin-Help/Color-Fill-Surface-ErrBar
http://www.originlab.com/doc/Origin-Help/Color-Fill-Surface-ErrBar
http://www.originlab.com/doc/Origin-Help/Color-Fill-Surface-ErrBar
http://www.originlab.com/doc/Origin-Help/Color-Fill-Surface-ErrBar
http://www.originlab.com/doc/Origin-Help/Color-Map-Surface-ErrBar
http://www.originlab.com/doc/Origin-Help/Color-Map-Surface-ErrBar
http://www.originlab.com/doc/Origin-Help/Color-Map-Surface-ErrBar
http://www.originlab.com/doc/Origin-Help/Color-Map-Surface-ErrBar
http://www.originlab.com/doc/Origin-Help/Multi-Color-Fill-Surface
http://www.originlab.com/doc/Origin-Help/Multi-Color-Fill-Surface
http://www.originlab.com/doc/Origin-Help/Multi-Color-Fill-Surface
http://www.originlab.com/doc/Origin-Help/Multi-Color-Map-Surface
http://www.originlab.com/doc/Origin-Help/Multi-Color-Map-Surface
http://www.originlab.com/doc/Origin-Help/Multi-Color-Map-Surface
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—
3D
Stacked

Start with a Worksheet or Matrix.

For specific data requirements, follow links in the Graph Types column.

These two graphs are new for Origin 2023.

G,

Stackedalrs

G

100% Stacked
Bars

Start with a Worksheet (XYZ) or a Virtual Matrix or Matrix of Z values.

For specific data requirements, follow links in the Graph Types column.

XYY 3D
Stacked Bars

@XYY 3D

100% Stacked
Bars

Start with a Worksheet.

Select at least one Y column (or a range from at least one Y column). Ideally,
select at least two Y columns (or a range of at least two Y columns). If there is
an associated X column, X column supplies X values; otherwise, Y sampling

interval or row number is used.

For more information, see the links in the Graph Types column.

Symbol

Start with a Worksheet.

Select two Z columns (XYZZ) or a range of data from two Z columns (Z

columns may be multiples of 2).

For more information, follow links in the Graph Types column.
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http://www.originlab.com/doc/
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http://www.originlab.com/doc/
http://www.originlab.com/doc/Origin-Help/3D-Bars
http://www.originlab.com/doc/Origin-Help/3D-Bars
http://www.originlab.com/doc/Origin-Help/3D-Stacked-Bars
http://www.originlab.com/doc/Origin-Help/3D-Stacked-Bars
http://www.originlab.com/doc/Origin-Help/3D-100PC-Stacked-Bars
http://www.originlab.com/doc/Origin-Help/3D-100PC-Stacked-Bars
http://www.originlab.com/doc/Origin-Help/3D-100PC-Stacked-Bars
http://www.originlab.com/doc/Origin-Help/3DBar-Graph
http://www.originlab.com/doc/Origin-Help/3DBar-Graph
http://www.originlab.com/doc/Origin-Help/3DBars-Side-by-Side
http://www.originlab.com/doc/Origin-Help/3DBars-Side-by-Side
http://www.originlab.com/doc/Origin-Help/3DBars-Side-by-Side
http://www.originlab.com/doc/Origin-Help/3DStackBar-Graph
http://www.originlab.com/doc/Origin-Help/3DStackBar-Graph
http://www.originlab.com/doc/Origin-Help/3D100PC_StackBar-Graph
http://www.originlab.com/doc/Origin-Help/3D100PC_StackBar-Graph
http://www.originlab.com/doc/Origin-Help/3D100PC_StackBar-Graph
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
http://www.originlab.com/doc/Origin-Help/3d-ternary-colormap
http://www.originlab.com/doc/Origin-Help/3d-ternary-colormap
http://www.originlab.com/doc/Origin-Help/3d-ternary-colormap
http://www.originlab.com/doc/Origin-Help/3d-ternary-colormap
http://www.originlab.com/doc/Origin-Help/3d-ternary-symbol
http://www.originlab.com/doc/Origin-Help/3d-ternary-symbol
http://www.originlab.com/doc/Origin-Help/3d-ternary-symbol
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e  Start with a Worksheet.

e Select two Z columns (XYZZ) or a range of data from two Z columns (Z

3D columns may be multiples of 2).

Tetrahedral e  For more information, follow links in the Graph Types column.

e  Start with a Matrix.

' . e  The matrix should have, at minimum, 3 objects in the same matrixsheet.

u Param

etric Surface (] For more information, follow links in the Graph Types column.

For an overview of Origin's 3D graph types and their source data requirements, see these topics:

e Creating 3D Graphs

(] 3D and Contour Graphing

(] Creating Contour Graphs

® Creating 3D and Contour Graphs from Virtual Matrix

11.5.1.9 Browser Graph

Select Al

Unselect All

Select every Sth
Select every 10th
Select every S0th
Select evary 100th
Select evary Hih...

[#] auta Rescate - Hare
Auto Rescale - ¥ Daly
Aiito Rescal - 211

200 1000 1100 1200 1300

Browser _graphs are useful for selectively plotting data from worksheets containing many columns (and rows),
into a single graph layer:

e Select a single plot or every Nth column for plotting.

e  Easily change column selection.

e  Stretch the window in either dimension to obtain the best view.

e  Specify automatic rescale and/or common display range for all plots.
e  Works with other Origin tools including Gadgets.

®  Plots can be further customized via Plot Details dialog box.
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http://www.originlab.com/doc/Origin-Help/3d-Tetrahedral
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http://www.originlab.com/doc/Origin-Help/Parametric-Surface
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The page-level Mini Toolbar includes an Add Browser button so that you can add a
Browser panel to a regular 2D line plot.

Browser Graph

Graph Types

Notes

3

Black Lines
IColor Lines
ﬂﬂ Histogram

Stack

Starts with a Worksheet.

Plot selected Y columns, plot every nth column or
plot all columns.

For more information on use and configuration of

Browser Graphs, see Graph with Browser Panel

For Origin 2023, you can export a Browser Graph as a video (GIF, TIFF, AVI):

L
Click the menu button !

and choose Flip Through.

Click the Export button and set File Type = GIF, TIFF or AVI.

Modify other settings as needed and click OK. Unless it has been turned off, export

will dump a clickable link to the Messages Log.

11.5.1.10 Function Plot

Graph Types

Notes

N/

(X5 =New 2D Plot

i New 2D Parametric Plot

Function plots are not created from physical data.
Once a function plot is created, you can obtain the
derived dataset.

For more information on function plots, follow links

in the Graph Types column.
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Graph Types Notes

®  Function plots are not created from physical data.

[ v | e When a 3D Function is plotted, a matrix of Z
fix.v'=|New 3D Plot values is simultaneously generated.

;%- e  For more information on function plots, follow links
{u.v/¥= |New 3D Parametric Plot in the Graph Types column.

11.5.1.11 My Templates

Dialog Box Notes
e This Category lists and gives direct access to the
@ custom templates in your User Files Folder.
My Templates

11.5.1.12 Other Graphing Tools

App Notes

e The Graph Maker app is pre-installed in your
Origin software.

e Launch the App from the Plot menu or from the
Graph Maker app icon in the Apps Gallery to the

right side of your Origin workspace.

e Use the Graph Maker app with Preview pane, to

re interactively plot grouped data.

f“' Graph Maker App ® Choose from line, scatter, line+symbol, column,

box and histogram chart types.

®  Supports fitting for scatter plots.

e Drag-and-drop worksheet columns to set up the
graph.

®  Graph settings are saved and can be re-loaded.

e Use this dialog to organize your custom graphing

ﬂ_ p templates.
Template Library
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11.6Topics for Further Reading

(] The Page-Layer-Plot Hierarchy

(] Page Viewing Modes

e Graph Template Basics

® Creating Graphs from Graph Templates

e The Graph Template Library

e  Graph Axes

(] Zooming In or Out on the Graph Page

(] Creating Multi Layered Graphs

e Adding Data Plots to the Graph Layer

e The Layer Contents Dialog Box

e The Object Manager

e  Graph Layers
(] Linking Layers

(] 3D and Contour Graphing

e  Graph with Data Slicer

e  Plotting Mathematical Functions

. Batch Plotting

e Appendix 2 - Complete Listing of Origin Graph Types
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12.1 Introduction

Double-click an
Legend to
Customize

Legend

Show Contour Labels l

This chapter introduces you to various aspects of graph customization. All Origin graphs start from a graph
template. If the graph you are making is fairly standard for its type, the options that were stored in the graph

template may be entirely adequate to produce a polished-looking graph. The business of basic graph creation
was covered in the last chapter, Graphing.

Sooner or later, however, you are going to want to add annotations, modify axis scales, or change plot colors.
Hence, the purpose of this chapter is to introduce you to some key Origin graph customization tools and

techniques, as well as to point you toward resources that will help you manage more complex graph
customization tasks.

We begin with a discussion of the graph customization-related toolbars, as these toolbars have tools that are

commonly used for quick modifications of graph elements.
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12.2 Dockable Toolbars

Toolbar buttons useful for graph customization tasks, include the following:

o Toolbar
DEECH[PUe (default configuration)

Format toolbar buttons:

e Creating and
customizing text

objects.

Style toolbar buttons:

e  Editing colors, line

thickness, fill patterns.

Tools toolbar buttons:

e Add text objects, lines,

curves, arrows, b &+ @S- P TEH A-w-E- M- D

rectangles/circles/poly

gons.

Graph toolbar buttons:

e Add graph layers incl.
inset graphs, merging

or extracting graphs;

T 0 0

exchanging axes; anti-
aliasing and Speed
Mode.
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Toolbar

e (default configuration)

Add Object to Graph toolbar
buttons:

e Add legends/color

scales/bubble scales;

date & time and ;@%@,i'vﬁ QEZ@

project path stamps;

XY scale; table

objects.

Object Edit toolbar buttons:

e Arranging and aligning
o T (R ' e LM e .

objects and layers on i R A (o I?:I 8 5 OO offe %‘ ﬁ !i 0 Ek ﬁ IEI

the page.

12.3Menus, Dialogs and Buttons Used in Graph Customization

Many quick graph customizations can be done using Origin's graphing Mini Toolbars. More complex
customization options can be accessed from commands on the Format or Graph menus. The following table
lists key menu commands and dialog boxes plus a few toolbar buttons, used in customizing graphs.

Merge Graphs, Arrange Layers and Layer Management dialog additions for Origin

Eir’; 2023:
e  Origin includes "merge graphs" utilities in Merge Graph Windows, Arrange Layers

and Layer Management dialogs; plus Merge Graphs to Layout. For Origin 2023,

the merge utilities now get a Direction drop-down so that you can better control the

resulting layer arrangement.

B Arrange Settings

Mumber of Rows

Mumber of Columns

Direction Harizontal First

B LU T L L e S T T

Yertical First

lp Telhn b e el
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Merge Graphs and Arrange Layers get a Use Alternate Side to Show Ticks and

Labels checkbox for labeling axes of graphs arranged in a single row or column

(Number of Rows = 1 or Number of Columns = 1).

Task

Dialog Name

Method

Customize the graph
Page, Layer, or Data
Plot

Plot Details dialog

e  Double-click on Page, Layer or Data Plot
(] Format: Page... menu
(] Format: Layer... menu

(] Format: Plot... menu

See, Customizing Page, Layer and Data Plots

(] Double-click on axes or tick labels
(] Format: Axes... menu

. Format: Axis Tick Labels... menu

Customize Axes Axis Dialog
. Format: Axis Titles... menu
See, Customizing Graph Axes
e Click the Reconstruct Legend
B
(CTRL+L) "=ll putton on the Add Object
to Graph toolbar
fggei(?efamt e  Right-click on the legend object and
(most 2D N/A choose Legend: Reconstruct Legend
graphs)

® Choose Graph: Legend: Reconstruct

Legend from the main menu

See, Graph Legends

Customize the
Legend

(Text Object -)
Legend dialog

e  Ctrl + double-click on the legend object

text

See, The (Text Object Properties) Text tab
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Task

Dialog Name

Method

Update Legend
dialog

e Right-click legend and choose Legend:
Update Legend or choose Graph:
Legend: Update Legend...

See, The legendupdate Dialog Box

Legends/Titles tab
at Page level of Plot
Details dialog

e  Double-click in the white area just inside
graph window frame (but outside of the
data plot), then click on the
Legends/Titles tab

e Choose Format: Page and click on the

Legends/Titles tab

See, The (Plot Details) Legends/Titles tab

Add a Color Scale

(] Click the Add Color Scale ™= button on

the Add Object to Graph toolbar

N/A
(color-mapped plots)
See, Color Scales
e Click the Add Bubble Scale @ button
Add a Bubble Scale N/A on the Add Object to Graph toolbar

(symbol-size mapped
plots)

See Bubble Scale

Merge multiple graph
windows into one
graph window

Merge Graphs dialog

e Graph: Merge Graph Windows... menu

See, Merge and Arrange Graphs (tutorial) and
The Merge Graph Dialog Box.

See New button

’ -,'-i-_ L= Ii above.
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Task

Dialog Name

Method

Adjust multi-layer
graphs:

resize, move, swap,
align, or add layers

Layer Management
dialog

e Graph: Layer Management... menu

e  Right-click on the layer icon.

See, Layer Management-Quick Start

See New button
above.

Simple adjustment of
multi-layer graphs:
arrange and/or resize
layers

Arrange Layers
dialog

e Graph: Arrange Layers... menu

e  Right-click on the layer icon.

gy See New button
y AT above.

Save settings as
graph template

Save Template As
dialog

e File: Save Template As... menu

®  Right-click graph window title and choose

Save Template As...

See, Graph Template Basics

Manage graph
templates,
plot to a template

Template Library

e Plot > Template Library menu

(worksheet or matrixsheet is active)

See, The Graph Template Library

Save settings as
graph Theme

Save Format as
Theme dialog

® Right-click and choose Save Format as

Theme... context menu (graph is active)

See, Saving Formats to a Theme

Manage Graph
Themes: edit,
combine, apply
Theme, set as
System Theme

Theme Organizer
dialog

® Preferences: Theme Organizer.. >

Graph tab.
e  F7 hotkey.

See, Theme Organizer
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12.4 Quick Editing: Mini Toolbars and Object Manager

While the dialog boxes listed in the previous section will provide full access to plot properties, settings are
sometimes buried and hard to find. Often, the most convenient way to carry out common graph editing tasks
is to use Mini Toolbar buttons or Object Manager short-cut menu commands -- or a combination of the two.

For Origin 2023, you can disable selection of individual graph layers, plots and graphic
objects with a newly-added Selectable Mini Toolbar button.

a13n
W Graph Object Manager

o @ Selectable u 4ak @ Selectable | 5 %

@ & 88 S I =
. e e Layerl
%J | .—'sm(;a 3 4, E o

Note that these elements remain selectable in the Object Manager. To restore graph
window selectability, highlight the element in the Object Manager, and click the Mini
Toolbar Selectable button again (Hint: If Object Manager (OM) doesn't list plots in the
active graph window, right-click on OM and Show Plots. Likewise, if OM only shows plots,
right-click on OM and Show Graph Objects).

12.4.1Mini Toolbars for Graph Editing

Most Origin graphs support a set of "quick editing" tools for interactively modifying common graph object
properties. Tools are context-sensitive so that -- (1) depending on where you click inside the graph window, (2)
what the selected object is and (3) whether you have selected an individual plot or a plot group -- you will

have a different set of tools available to edit your selection.

Click on ... c @ £ B &5 gz | HideLocks

Hide Recalculation Locks
1
an empty ilO 6

spot on the @ _+ | Layer Frame
graph page . c ) Hide Show Layer Frame
O .
.. an empty :
spot inside the ey
graph layer &
03
L ]
...on a data h
02 £ plot 1
° .. 10 edit
Set Font ) o o - ... onatext or common
o—Ekl—e—LEkl—e—E3 1
e E5 + Ec e E1_e gg) | Grawnoblect properties of

| I W vl I Vi I W v v v I v IVIU vil \_I@ these Objecrs
[me - LA o - ona

graph axis
ABOOS I or tick label

Font Size

e  Workspace display of Mini Toolbars is controlled via View: Mini Toolbars.
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e There are five levels -- i.e. five groupings of graph properties -- that can be edited with Mini Toolbars:
page, layer, plot, text or drawn objects and graph axes.
e When editing grouped plots, a single click will select a single plot. The Mini Toolbar displays two tabs --

one for the customizing the group, the other for customizing the single plot.

aroup —  single
tab _—" tab
— ‘ )

®  Most Mini Toolbars have a "properties” : button that opens a related Origin dialog box where you will

find the full range of available controls.

Unless you have changed your selection, you can do a one-time restore of a Mini
Toolbar after it has faded by pressing the SHIFT key.

12.4.1.1 Controlling Buttons that Increment

Some Mini Toolbar buttons will increase or decrease some property by some increment, each time you click
the button (e.g. font size, rotation angle, layer grid spacing). In such cases, you can modify that increment by
manipulating the value of a LabTalk system variable.

LIZOOS

Q0 BBk &

N
g{;lLarger Gap, increment=5, change increment by setting @IMC5G to other value, I

For information on these LabTalk system variables, see this Appendix in Origin Help.

12.4.2Manipulating Graphs with the Object Manager

In previous versions, you had to open Plot Details to rename the layer. Starting with
i Origin 2023, right-click on the layer icon (e.g. Layerl) in Object Manager and choose

e -=|-~ Rename.

The Object Manager is general tool for managing Origin windows but it is especially useful for manipulating
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graph windows. When a graph window is active, the Object Manager offers alternate views -- toggled by right-
clicking in an empty portion of the Object Manager and choosing Show Plots or Show Graph
Objects(Ctrl+Shift+S):

® Show Plots: a collapsible, hierarchical list of plots by layer, plot group, etc.
e Show Graph Objects: a collapsible, hierarchical list of window objects (legends, text objects, images,

etc.) by layer.

=15 Layer
—— B
2] Grapha * E=REoR = ifl——Tital Rum 1
_I_ﬁ B Trial Run 2
= Tral Run 3
== T T =H 5
- =g
B Tl ﬂ right-click
1. ni
i
| kA Trial Aun 3
= = Layer3 Mini Toolbars
) B ES Toich P 1 View in Order of Appearance
T K ] L ] |E| View in Drawing Order
Time (sec) | Tral Run 2
- _ =i Trial Run 3 , Show Graph Objects Chri+Shift+5
P

A7

¥
- = E' ".-:I.'F;rlh:li- = |._'-.|";.=.|.':}-'I;.'
1/ =5 Layert
T (AT Legend
Time (sec) T ¥ Axis Titke (YR)
] T % Auis Titke (XT)
[ T ¥ toda Title (YL)
BT X et T 0B u right-click
= Layer2
[T ¥ s Titke (YR
[T x fwis Title (£T)
. : : [ T Awis Tithe (LY
Time (s6¢) [ T * Awia Tithe (XE)
(=[] Layer3
[T ¥ Axis Tite (YR)
[T * s Tithe {xT)
& T ¥ fuis Title (YL)
[ T x Ais Title (XB)

Mini Taolbars

View in Order of Appearance

L. L]

View in Drawing Order

Show Plots Ctrl+5Shift+5

Vrpaien v

Object Manager Tips:

e  Whether in Show Plots or Show Graph Objects view, right-clicking on an element will open a shortcut
menu of relevant actions (ungrouping a set of plots or designating a plot as the first plot in a plot group,
for instance).

e Common to both views is a check box beside each element; when checked, the element displays in the

graph window, when cleared, the element is hidden.
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e  Additional shortcuts give quick access to source data, to Plot Details, allow you to rearrange plot or object
order and to other relevant tasks such as opening an inserted image in an Image window for further

editing.

12.4.3Editing Graphs Using Object Manager and Mini Toolbars

When a graph is active and you select graph elements in the Object Manager, a Mini Toolbar will show (make
sure the Mini Toolbars option is checked in the Show Plots/Show Graph Objects shortcut menu as shown

in the image above).

With the available buttons, you can make quick customizations to common plot properties such as line color,
line thickness, display of labels, etc.

2] Graphd * =58 ‘—* oA {3 8 e ot

JJ 3 sma r—
— TR m——T ingle By Points By Plots

rerment list: Bold2 -

/
|

y .——_— |
\\ - Object Manager * 0

Time (sec) Palettes
o .
1 _u u
i/ EAREE| O e
P i [ Tral Fun 3
i ) ' = Layer2
{ -
] [l
- — ] ——— Trial Run 1
Time (sec) [ Trial Aun 2
[+ Trial Run 3
- -
f = [ Layerd
| . T
L = Trial Run 1
B [ Trial Aun 2
A Trial Run 3
Time (sec)
LY In Object Manager Show Graph Objects view, there is a Select All with Same

Name shortcut menu entry. Use in combination with Mini Toolbar buttons (e.g. Font
Size) to make quick graph changes.
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Origin 2023 introduces support for a new "1 layer, 2 Y axis" plotting mechanism.

Previously, "2 Y axes" meant "2 layers." While Origin 2023 includes some new

CNEW templates for simple cases (see the New button here), the new mechanism has general

=

applications for 2D scatter, line, line + symbol (incl. variations such as the "Before-
After" graph), column, box, histogram, and area charts. Using new GUI controls, the

user can create such a graph using only the basic plot type templates. In addition to
the following simple example, you can find an example of a single-layer Double-Y
Violin Plot in your Learning Center samples by pressing F11 and searching on "2023".

In the following simple example, the user has plotted four Y datasets against a single X dataset. Because
values in two of the Y datasets are of an order of magnitude larger than values in the other two, two plots
appear "flat" and seem to show little variation with changes in X. However, using a combination of Object
Manager and Mini Toolbars, we can select the "flat" plots and Plot on Right Y. With a more appropriate
scale, the plots no longer appear flat. As mentioned, it has long been possible to create "double-Y" plots; the
difference now is that these can be made with a single graph layer.

om s
[ 8% A3

Plot on Right Y

Object Manager * 0O X
* E
Graph1 E@ (5 Graph1 - Plots |
1 2 [ Layer L&
=k at
AR
]
Graph1*
LE 1
o
1 104
2]
A4
o
&
g H H Y a 1 a
2l
04
: H H 8 8 0

Other controls that are added to support this new "1 layer, 2 Y axis" plotting mechanism:

e The Plot Details Group tab now has a Subgrouping = By Axis option. In the graph above, we did not

use this setting. Instead, we chose to use a single group and make use of line+symbol template's default

increment lists for line color and symbol shape. However, we could just as well have split the left and right

Y plots into two separate groups and thus, implement separate Plot Details Group tab behaviors for each

group.

Subgrouping
Enable subgroup

I MNone

() By Size

() By Column Label

(®) By Axis
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e  The aforementioned plot types now include a Display tab at the plot level in Plot Details. Use radio

buttons Plot Data on the Left Y Axis or Right Y Axis.

B Plot Details - Plot Properties ? *

~ {7y Graphl Display  Line Label  Offset
v Layer
: [~] [Book1]Sheet]! A(X), BOY) [1%:10%]
[ [Bookl]Sheet1! AR, TOY) [1%:10%]
- [Book1]Sheet1! A(X), D(Y) [1%10°] @ Right ¥ Axis
~[7] [Book1]Sheetl! AMX), E(V) [1%:10%]

Plot Data on () Left ¥ Axis

® The Axis dialog box now has a Rescale Each Axis Independently check box that should be enabled for
a "double-Y" graph (If for some reason, your two vertical axes don't seem to want to scale independently,

check on this setting).

B Y Axis - Layer 1

Show 5Scale Tick Labels Title Grids  Line and Ticks

Show Left Axis
Show Right Axis
Rescale Each Axis Independently

Vertical

12.5Customizing Page, Layer and Data Plots

A graph window is a collection of objects, organized in a hierarchical structure. As we shall see, there are
editable properties at the Page, Layer, Data Plot and Data Point levels.

Quick formatting of many plot properties can be done using Mini Toolbar or dockable toolbar buttons, as
mentioned above. However, more comprehensive access to plot properties is available from each graph's Plot
Details dialog box.

To open Plot Details:

e  Double-click on your plot.

e  Click the Format menu, then choose Page..., Layer... or Plot..., to open Plot Details at the

corresponding level.

The figure below shows an example of the Plot Details dialog box:

e  The left panel depicts the Page > Layer > Plot hierarchy as an expandable/collapsible tree.
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To customize an object, select it in left panel and modify the corresponding properties that appear on

the various tabs in the right panel.

[¥] [BockaCTnestl! TEX). FiYI (17227
a & Lz
=] IBook2Cishesill T [lgrry |
7] [Book 20 Eheett] Tefl, gt * ™
a [F Lagerd
[¥] [Bock2CEhesttl Tof<],

& Geometic
Single Alphabetic
ncremental Aphabetics
Row Mumber Numesics

Jear Defirad Symibols

The right panel contains controls, organized by tabs, that pertain to the object that is currently selected in

Selected Left Panel

Right Panel, Controls for...

Object
Settings that pertain to the whole page -- Print/Dimensions, layer drawing orders,
Page : .
page display color, legendsttitles, etc.
Settings that are specific to the graph layer -- Layer background colors, layer size
Layer and speed mode settings, layer display settings, stack settings for applicable plot

types. Some plot types will include extra tabs/controls specific to the plot type.
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Selected Left Panel .
Object Right Panel, Controls for...

Plot-specific properties. The tabs and controls vary by plot type (e.g. Scatter plots

Plot have a Symbol tab with controls pertaining to scatter symbols, Line plots a Line tab
with controls pertaining to line plots). Anything to do with a particular data plot --

color, fill patterns, colormapping, labeling -- will be found at this level in Plot Detalils.

Properties that apply to user-specified "special points”. Available for any plot for
Data Point which plots discrete points (scatter, line + symbol, column/bar, etc.). The tabs and

controls are generally similar to those available at the Plot level but any property that
you set at the level of a special point, will apply only to that point.

[ 1 Phot Details - Plok Propertie:

r— clear check mark to hide object
{layer, plot, point)
[hue1! T ———— =
Fl u’_. 2 . L J Edge Thickresa Dl -
¥ [BookZClshest1] T, Ta{‘r’][l-"ﬁ . .
ook 2CI5heatl! Tege). TalvL. Evfed [1227 sybo Cor [ 2Ped  ~
i Book2C
Shaat]
SakE Sheert| Tefe, DTt 3 Y TeAmesing o
X TcTransiien” Tranepaserey g a &
i \Overlapped Points Offset Plofing
click layer name,
pause and click Cuusom Cionst
again to rename &) Gecmeln:
Sngle Sphshetc
ncremental Alphabebics
R Murmbesr Mpmance

Liser Disfined Symibols

Hrl: T ship poride, yois fieed bs uss the "Dep Lrse/Skip Pla™ e

switch plot type
(plot level only) Hide/show left panel
of dialog box

click to return to source worksheet

{plot & point levels only)

Prevent text and label objects from scaling when resizing layer, by going to the Size
tab of Plot Details (Layer level) and setting Fixed Factor to 1.
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12.5.1Customizing Grouped Plots

Beginning with Origin 2020, there was a change in selection behavior that affects
grouped plots. Now, a single-click on a plot selects the plot. A second click (or
CTRL+click) selects a single point. SHIFT+click selects the entire group. Note that when
using the new mini toolbars, a single click on a plot group displays tools for editing the
plot group or the single, selected plot. To revert to the old plot selection behavior, set

@GSM=0.
aroup —  single
tab _—" tab

‘d__..a-""

When you select and plot multiple data ranges to a single graph layer, the plots are grouped in the layer.
Generally speaking, plots within a group are automatically differentiated by assigning styles built from one or
more customizable "increment lists", one for each plot property (symbol shape, symbol color, line style, etc.).

By default, some properties are configured to increment "by one" (e.g. line color is assigned according to the
"Candy" color list and each successive plot is assigned the next color in the list) and some will be configured
not to increment (e.g. line style is solid for every plot), though this is ultimately controlled by the user. In any
case, the increment lists for each property are saved with the graph template (.oggu) or Theme file (.oth) so
that you can easily use them later to create graphs with the same look.

G |Line | Symbol | Fanel | Drop Lines | Label | Offset

Sepll
Rewll_ Line Color, Symbol Type, and Symbol Edge
Reoti color increment By One Between Subgroups
ol Line Style and Symbol Interior do not increment
Sepl! (Line Style and Symbol Interior are "Solid")
Sepli
Sl
[ o | eovn | oo | e | eee) | eom | wom | owem | sem | wow | o |-
Long Harne | Sensof Ax | SensorAy  SensorBax SensorBy SensorCax SensorCy SensorDx | SensorDy SensorEx SensorEy | SensorFx (B
Hane By Sirw (@ By Cohmn Label) Unts | concgt [2e 1=kl 002 £Oncl2 £00H03 o003 cofepd LOnc0d Conzds Lncls 21
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8 000471 82 000421 84 007385 85 010535 88 0220 1
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The above image shows the Plot Details Group tab settings for a line + symbol plot in the upper-left. On this
Group tab, the first column lists Line Color, Symbol Type, Line Style Symbol Edge Color and Symbol
Interior. Properties of Line Color, Symbol Type and Symbol Edge Color are set to increment By One and
Between Subgroups (subgrouping occurs using the column Comments), while Line Style and Symbol
Interior are set to increment by None (they do not vary).

As previously mentioned, this arrangement is completely customizable and you can save customizations with
the graph template:
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e To find out more about customizing of grouped and subgrouped plots, see The Plot Details Group Tab

Controls.

e To find out more about saving graphs as templates, see Graph Template Basics.

12.5.1.1 Using Object Manager with Grouped Plots

e To highlight a single plot and dim others (grouped or ungrouped) in the layer, click once on the plot in
Object Manager. Conversely, clicking once on a plot in the Object Manager, highlights the plot in the graph

window, while dimming others.
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e To reorder plots in the layer, drag a plot icon within the group; or right-click on the plot (in Object

Manager) and choose Move Up or Move Down.

Ohbject Manager v Q3 X
= Ly Graph3
=10 Layerl

=ik g1
fA—e—E1
f]—e—E2
]—e—E3

] —es— E5
B EE - EE

e To group or ungroup data plots in the layer, right-click on the group icon ("gN") and choose Ungroup. To

group plots in the layer, right-click on a plot and choose Set as Group Begin.
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e To move a plot from one group to another, drag the plot to the other group.

e To move a series of plots out of the group, right-click the last plot that you want to keep in the group and

choose Set as Group End.
e Toremove a plot from the layer (and the graph), right-click on the plot and choose Remove.

e To move a plot to a second Y axis, or move the plot to another layer, right-click on the plot in Object

Manager and choose Move Plot to Second Y Axis or Move Plot(s) to Other Layer ....

12.5.2Customizing Multi-layer Graphs

The graph layer is a fundamental concept in Origin and it is a primary building-block of most complex Origin
graphs (e.g. a graph with both left and right Y axes may be constructed by overlaying one layer on another,
and sharing a common X axis between the two layers). While the graph layer is, fundamentally, a self-
contained unit it is, at times, desirable to create dependencies between layers:

e  One type of dependency is what we call "linking" of layers, which involves establishing spatial relationships

or relationships between axis scale values. You can read more about linking graph layers, below.

e  Another type of dependency is based on what we call "common display" and this is most useful in a
situation where we have multiple similar panels in a graph and we want to do something like change the

background color of each graph, or perhaps the change plot colors used in each layer.

At the graph page level in Plot Details, you will find a Layers tab that has controls that affect all layers within
a given graph page. The Common Display controls can be used to enable simultaneous editing of layer, plot
and axis properties of multi-layer graphs. For instance, in the following example, we have a two-layer trellis
plot -- the two layers being necessitated by there being a left-Y axis and a right-Y axis with two completely
different scales -- and as a simple illustration, we have used the Common Display controls to simultaneously
add a background color to both layers. We could have accomplished the same thing without using the Common
Display controls but this would have required twice the work -- set the background color of layer 1, then set
the background color of layer 2.
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This was a simple illustration but we can use the Common Display controls for application of more complex mix
of layer, plot and axis properties. Some of Origin's built-in multi-layer graph templates have Common Display
elements turned on by default. When working with multi-panel graphs, you may want to choose Format:
Page, click the Layers tab in Plot Details, and check the Common Display settings. See Common Display
for more information.

. The Common Display Apply to control supports including or excluding certain layers

¥ ' from common display customizations. For instance, you might have a 4 panel graph,
each with an inset layer and using this control, you could apply a common background
color to the inset layers without applying the same background color to the 4 primary
layers (panels). See Common Display for more information.

12.5.3Special Points: Customizing a Single Data Point
For some plot types such as scatter, column or pie, you can modify the display properties of a single data
point.

To edit a single point:

1. Click twice (slowly) or press CTRL + click on a data point to select it. Use the Mini Toolbars to edit
properties of the data point; or click available buttons on the Style or Format toolbars.

2. For access to a wider range of customization options, (a) double-click on the selected point or (b) CTRL +
double-click on an unselected data point. This opens the Plot Details dialog box with the focus set to edit

the data point (identified in the left-panel of Plot Details by its row index number). Then use controls on
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the tabs in the right panel to modify the appearance of the data point, add drop lines, data label, etc.

Changes you make to the special point will not affect the appearance of other points in the same plot.

| Plot Details - Plot Properties

{3y GraphZ Symbol | Drop Lines | Label
+4 - Preview Size Auto v
] [Group DAT)Growp! A[X), BIY] [1%6%]
¥ [Group.DAT]Group! A[X), C(Y) [1%6"] v
4 (7] [Group DAT]Group! A, DY) [1%:6%] A _‘G}Hck for Symbaol Galleryj
3]
Edge Thickness | Auto w
Single data point symbol Color [l Auto -
selected for editing.
When this box is cleared, -
you can select a custom ] fute Tranzparent
symbol shape from the
Symbol Gallery |
| Custom Censtruction
® Geometne
Single Alphabetic 7 4 DownTriangle
Incremental Alphabetics
Fows Number Numerics B 5ohd
User Define baols

Note:: When the Custom Construction box is checked, you can use these controls to customize the

plot symbol of the selected point. Custom Construction can be applied to any plot symbol -- not

simply those that are designated as special points.

Custom Construction
(@) Geometric

(C) Single Alphabetic Shape 24 3 UpTriangle v
() Incremental Alphabetics

(7 Row Murmber Mumerics Irteriar B solid W

() User Defined Symbols

Origin supports adding your own plot symbols. For more information, see User
Defined Symbols Grid.
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To remove customizations made to a single data point:

® Right-click the single point in the left panel of the Plot Details dialog and choose Delete.

. In the graph window, click on the single point to select it, then press DELETE on the keyboard.

The point itself is not deleted; only the custom style is removed, with the point reverting to the style of the
containing data plot.

i Adding a special point at the beginning or end of a plot is not always easy, but there is a
' simple, foolproof technique:

1. Select a special point anywhere on the plot, then double-click on the point to open Plot

Details.

2. In the left-hand panel of Plot Details, click once on on the point index number and

wait until the index number becomes editable.

8 | Plot Details - Plot Properties

¥ 1 Graphd Line
v A Layerl Previe
~ A [Waterfall.dat]Waterfall! "X" (), "606" (¥) [1%:512%]

L ‘
R

3. To add the special point to the first point in the plot, type Begin; to add to the last
point type End. If you know the index number of the first or last point, you can type
that instead.

4. Click outside the edit box. Make other special point customizations as needed, the click
Apply or click OK to close Plot Details. The special point will be added to the

beginning or end of your plot.

12.6 Customizing Graph Axes

Many common edits to axis properties can be done quickly from Mini Toolbar buttons. Click on an element
to edit.
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For more complex edits of axis properties, open the Axis Dialog:

e from the Axis Mini Toolbar > Open Properties Dialog.

e from the Origin menu > Format: Axes.

12.6.1Customizing Axes with Mini Toolbars

For quick adjustments to axis properties, you can use Origin‘s axis Mini Toolbars. As with all Mini Toolbars,
available tools will vary by plot type and selected object. For instance, note that clicking on a graph axis line
brings up a different set of buttons than clicking on the axis tick labels.

& - - ul l:Erli::I ILinles: I E]DD;S
-0.1

Special Ticks... 'D 2

Reference Lines...

Axis Breaks... _U 3

:gg Axes Dialog

A AW a— 7:\/\* Vi 1

4 8 8 0 ||Default v[[18 ]|A" A7 |
Time (Hrs) AB OO SE

Axes Dialog...

Note that clicking the "gear" button on the axis line Mini Toolbar produces a popup menu with simplified "Mini
Dialogs" for axis line elements. For access to all axis settings, click Axes Dialog on either toolbar.

12.6.2Customizing Axes with the Axes Dialog Box

All graph axis customizations can be made in the Axes Dialog box. Click on the Mini Toolbar "gear" button

and choose Axes Dialog; or double-click on the graph axis or tick labels. This will open the Axis Dialog -
Layer N dialog box.

This image shows the tab-based axis dialog used by most 2D and 3D graphs.
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® 7 X Auis - Layer 1 I %
Scale Ticklabels Title Grids Lineand Ticks Special Ticks Reference Lines Breaks Rug
A
From | 20
To 180
Type .;!Eunur V
Yeical Rescale Normal v
Rescale Margin(%) 8
Reverse N
B Major Ticks
Type H}r Increment i
Value 20 '
Firt Tick | |
El Minor Ticks v
Select multiple axes to customize together,
| AppyTo.. | [ Ok || cancd || Asph

e In the left panel, you can select one or more icons (hold the CTRL key to select multiple icons) to specify
the axis or axes to be customized, then select the desired tab and choose your options.

e Click the Apply To... button to apply the axis format settings of the currently selected axis to another axis.

Tab Controls for

Scale range of values, scale type, rescale mode and margin, reverse scale, major and minor

Scale ticks.
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Tab Controls for

Display and Format options for major and minor tick labels, including custom labeling using

LabTalk substitution or mathematical expression. For information on custom formatting of

numeric data including display of percentages, fractions, pi, and geographic (Lat/Lon) formats,

see Origin Custom Formats.

Origin 2023 adds support for scaling of Minor Tick Labels
(Axis Dialog > Tick Labels > Minor Tick Labels > Font
o THENY | Scaler(20)).
Tick ]
Labels @
5000 o -
=
L} I L] L} L} I L] L} L} I L]
75 100 125 150 175 200 2
. Axis title (often set using variable notation) and font options. Note that you can directly edit by

Title N S

double-clicking the text object in the graph.
Grids Control display and properties of grid lines at major and minor ticks.
Line and . . . .
Ticks Global axis line and tick display options for all axes.
Special Placement of special tick labels
Ticks )
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Tab Controls for
Reference lines are optional lines that you add to your graph, either for emphasis or to mark
some key statistic. Additionally, they can be paired to add fill color to some portion of your
graph (e.g. "recession bars" in plots of financial data).
W
You can use named ranges to place Reference Lines on a
raph.
Reference grap
Lines
-\ Additions for Origin 2023, see below.
Breaks Enable line breaks and configure each break.
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The axis Reference Lines improvements for Origin 2023:

e There are more label location options. Previously, there were only five (Begin,

Middle-Above, Middle, Middle-Below and End).

B Label
Show =
Label Farm CQuantity w

Identity of Plot  |Short Mame

Text Mean+ 5D

Position Qutside End w
Outside Begin h v
Inside Begin-Above

Inside Begin-Below
Select multiple reference lines to customize tegeth Middle - Above
Middle

Middle - Below
Inside End-Above
Inside End-Below

Add Insert Delete Cancel Apply

e The Reference Lines label now recognizes the Tick Labels > Divide by Factor (i.e.

tick labels will correctly show the converted value).
®  You can set a default line style for Reference Lines -- either in the Reference Lines

dialog or in a customized graph -- by right-clicking on the Reference Line and choosing

Set as Default Line Style.
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40 Fens s R G
E Axis Begin ~
o Axic End Value Type Statistics -
g 35w Mean(plotdata(*, ¥) | At Axis Value Mean(plotdata(*, ¥))-StdDeviplotdata(®, ¥ >
E Mean(plotdata(®, V). E.g. x+1, x means x axis.
EB'O _ N Copy Format means all plot's Y data, plotdata(1, ¥) means 1st plot's Y data.
g;] Paste Format
254 “__; Duplicate )
@ Set as Default Line Style at [
Color B 000 ~
20 .
Style ———Dash "

polar, ternary, radar chart.etc), refer to:

Help: Origin: Origin Help > Graphing > Graph Axes

Note: For more information on axis customization and for axis controls for specialized graph types (e.g.

12.7 Customizing Data Plot Colors

Origin ships with a number of installed color lists or palettes. If you prefer to create your own color lists or you
have a standard set of palettes and want to port them over to Origin, there are a number of tools available in
the software for doing that. See the next section, Color Manager, for more information.

12.7.1Color Manager

Use the Color Manager for importing, creating and organizing the color lists and palettes that you use in

Origin:

To open the Color Manager:

1. Choose Tools: Color Manager.
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Set Default Plot Colors 10, Cancel

The following list numbers correspond to controls shown in the image above:

Click these radio buttons to display installed Color Lists or Palettes.

2. Click Import from Web to open a dialog where you can specify a URL to install palettes. Support for
Scribus (.xml), Office Color Table (.soc), Adobe Color (.aco), Adobe Color Table (.act), Adobe Swatch
Exchange (.ase) and JASC PaintShopPro (.pal).

3. Click to install locally-stored palettes. Support for Scribus (.xml), Office Color Table (.soc), Adobe Color
(.aco), Adobe Color Table (.act), Adobe Swatch Exchange (.ase) and JASC PaintShopPro (.pal).

4. Click to open the Build Colors dialog where you can build a color using a number of tools: using standard
color controls, direct entry of HTML codes or use an eye-dropper tool to pick onscreen colors. You can read

more about the Build Colors dialog in the Origin Help file.

5. Right-click on the Available list to Delete or Rename lists (you can also rename by clicking directly on
the name). Lists that are dimmed have already been Selected for GUI. Those that are Selected for GUI

appear from drop-down lists throughout the user-interface -- in Plot Details, from the Fill Color button

on the Style toolbar and from the Mini Toolbar Fill Color button when a plot or special point is
selected.
Use the list control to set Category = Undefined, Sequential, Diverging or Qualitative.
Use these controls to add or remove color lists and palettes from the user-interface (GUI).

Use these controls to move a selected list or palette up or down in the various GUI color lists.

© ® N o

Click Set Default Plot Colors to open the Theme Organizer's System Increment Lists tab, where you

can set default colors for use in your plots.

10. Drag list-number icons to rearrange GUI color list order.
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The Build Colors Interpolate dialog gets several enhancements for Origin 2023:

ey
w e Merge Color: In the Color Manager, select two or more Color Lists/Palettes in the
Color Manager, then right-click and Merge Color. Note that the total number of colors
in selected lists/palettes cannot exceed 256 (i.e. Merge Color will not be available).
° Interpolate by Group: New check box added. When checked, two edit boxes are
added:

e  Group Member specifies the number of color blocks to group together in
the existing sequence of colors (minimum of two blocks needed for a
"group").

e No. of Colors for each Group specifies the number of interpolated colors

that should result from each "group.”

Existing Sequence of Colors - 2 members per "group™

1| I #FF0000 B Interpolate
2| [ 7 B6FEF
3 [ H063FF “linterpolate by Group

4| [ ##580086 Interpolation Type | Linear v A Sgea.

No. of Colors 256 |
Apply 0K I Cancel
=1

Rename

Mame ‘r =t A

Celors Add as New
1) [l Red 57 Interpolate ? X
2
Interpolated colors - | 2| Bl #D2:24
4 resulting colors | 3 I rcasds [ Interpolate by Group
N Bl BN Group Member [2 ] A Soed.
5| I #0631FF \ Interpolation Type Linear - Al Rensme
6 I 22006 No. of Colors for each Group | 4 | New
7 I #eE10AE
8 I 58005 Apply OK Cancel
Luminance: |0 = e

— Current
| HIML: s000000| By [3 o
| Name v | |Palette v oK Cancel

12.7.2Applying Color to Your Graphs

There are many options for applying color to your graphs. We will try and cover the basics here, pointing you
to other resources for more in-depth discussion.
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List of key topics on the subject of plot color:

(] The Color Manager

(] Customizing Data Plot Colors

L] Using a Dataset to Control Plot Color

e The Plot Details Color Map/Contours Tab Controls for 3D and Contour Plots

12.7.2.1 Applying Colors Singly

N )

Picking and applying a single custom color has been made easier with the addition of
the "eyedropper" tool to the Single tab of the Color Chooser. Previously, the
eyedropper tool was buried in the Build Colors dialog.

Applying colors singly simply means applying a single color to a plot as opposed to applying color from a color
list to a series of plots. It is the most basic way to apply color to a single plot or special point. Simply select a

color well from anywhere on the Single tab -- from the LabTalk colors at the top, from a selected color list, or
from a custom or recently used color.

By Points

. Auto |:| Mone

AN TEEEEEESE s
L.

More Colors: Systern Color List -

ERENCOENEEEEEE

BEOOOOOO0OCEEE
EREACNOEEAO S .

EEREEN+Z

ecent colors

ENCNEN

Select a plot (e.g. scatter plot) and click the Fill Color button on the Mini Toolbar that appears.
e Select a plot and click the Fill Color button on the Style toolbar.

Double-click on a plot to open the Plot Details dialog box where you can click on a tab to the right side

(e.g. Symbol tab for a scatter plot) and set color for the element.

e To create a special point -- i.e. to assign special characteristics to one data point in your plot -- press

Ctrl+click to select the point, then use the Mini Toolbar, Style toolbar or Plot Details controls to
customize color for that point.
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Origin 2023 adds a new way to color to 2D and 3D bar charts. The method works best for

gl 3D bars as it aIIows_ you to apply a color pa}lette t_Jy Z value (this is not "applying a
W colormap" as described below, but something unique to 3D column/bar plots).

r
&0

“
2 2 e
2 1 . ~
&
E 10 -
%‘ ~
5]
Gradient Fill
More Colors w | [#] By Z Value
Palette M Inferno -

Transparency

Directicn -
Bottom Top

[=1

- i
| Auto

To find out more about this graph customization, press F11 and on the Learning Center
Graph Samples tab, set the drop-down list to 3D Bar Charts and search on "gradient.”

12.7.2.2 Applying Colors By Points

Applying colors By Points generally means applying a color to each point in a plot by one of several schemes
The simplest involves picking an Increment From color from a predefined color list and assigning colors, in
sequence, to each point in the plot.
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Color List: Bold2

| |

Color Options
() Indexing
() Direct RGB
() Color Mapping
() ¥ Value: Plus- Mmus

(® Increment from v

L= B

As in the case of applying a single color, you can apply these settings using controls in Plot Details; or by
selecting the plot and using the Fill Color buttons on the floating Mini Toolbar or Style toolbar docked to the
top of your workspace.

Other schemes typically make use of a column of values to assign color to points:

o Indexing assigns point color by associating an integer or text string (categorical value) to different colors

in a list.
e Direct RGB assigns color using a value derived from columns of RGB values.

®  Color Mapping -- used for 2D, Contour and 3D plots -- assigns colors in a list or palette, to values across

the range of the plot's Y or Z values.

There are several other schemes which are specific to a certain plot type (or family of plots), but the list above
covers most of what you will use. For more information see Using a Dataset to Control Plot Color.

12.7.2.3 Applying Colors By Plots

You apply color By Plots when you want to assign differentiating colors to a series of plots. Typically, this
series of plots comprises a "plot group." In a plot group, plot attributes including color, are assigned to each
plot by incrementing through a style list -- color, line-style, symbol shape, etc.

Single By Pointsl__By Plots

Increment list: Bold2
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12.7.2.4 Applying Colormaps to 2D, 3D and Contour Plots

Customizing Graphs

While you can use a color list with a contour or 3D plot, it is probably more common that you will use a color
palette. This allows a wider range of color variation and can add realism to 3D surfaces and 3D function plots.
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You can add new color palettes to Origin by drag-and-drop. Support for Scribus (.xml),
Office Color Table (.soc), Adobe Color (.aco), Adobe Color Table (.act), Adobe Swatch

Exchange (.ase) and JASC PaintShopPro (.pal).

Colormapping can also be applied to 2D plots. This allows you apply a greater range of color variation to data
points than would be possible with incrementing or indexing. A good example of applying a color map to a
scatter plot would be Origin's Density Dots plot in which, typically, thousands of scatter points are plotted
and an algorithm is used to calculate point density and assign color to ranges of point densities.

8
6
4
T 2
g
.q
w -2
[
4
6
8
10
4 3 2 1 0 1 2
POP3

0.63
o
0.53

- 0.50
- 045
- 0.40
- 0.35
- 0.30
- 0.25
0.20
0.15
0.10
0.050
0

Applying a colormap to a 3D or contour plot is much the same as applying color singly, by points or by plots.
You select a plot -- then using the Palette button on the floating Mini Toolbar or the Style toolbar. You pick

a palette.
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10

Y Axis Title

Color Scale Title

@ﬂl Palettes I

Palettes

-:|Beach
-Blue

-] BlueYellow
-:| Gray5cale

B |LiteBlue
-:| Lite Green
' Lite LT Cyan

F Lite LT Red

B |LitcRed

-] BlueGreenYellow

P Meight
-] Blue Planet
l:. BlueQrange

-:| Fire
- Green

- HeatmapdColorBlind - HeatrapBio

.:|Lite Cyan
B LiteLTBlue
I Lite LTPurple

Lite Orange
I ¥ Maple

- WaTa R

You can also use the controls on the Colormap/Contours tab of Plot Details. This tab gives many more
options beyond simply picking and applying a colormap.

Surface  Fill

Colormap / Contours

Mesh Error Bar  Side Walls

Click celurnn header or single cell to edit, Double-click Level cells to edit values,

P

4

Level Filll,
< 700
700
720
740
780
780
200
820
240
260
280
900

920

Missing values

= [ ]

| Level

Fill

Color Generaticns by Interpolation
() Limited Mixing
() 3-Color Limited Mixing
() Introducing Other Colors in Mixing
(®) Load Palette
(") Color List

B | Beach
[] Link to Palette/C . G
[ Fiip P |BlueGreenVellow
B |Bluevellow
Stretchto Full Ra [ | GrayScale
I HestmapdColorBling
B | Lite Blue
B | Lite Green
B |Lite LT Cyan

[JEnable Contours

Rescale Mode Mormal
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For more information on applying color to colormapped plots, including contour and 3D surfaces,
see these topics:

The Plot Details Colormap/Contours Tab

(] Tutorial: Contour Plots and Color Mapping

(] Surface Graph

e  Symbol Plot with Size and Colormap from Other Columns

e Parametric Surface with Colormap from Data

12.8Graph Legends

12.8.1How the Default Legend is Created

A graph legend is automatically created when you plot data. For most 2D and some 3D graph templates, the
default legend combines (A) plot style information stored with the graph template, with (B) dataset
information stored in the worksheet column label rows, and places the resulting legend object on the
graph page.

E: AGX) B(Y) | cwm | om
Long Mame Time _ | Delta Temperature | Magnetic Field | Position
Units | (sec) [134] (Oe) (mm])
Comments | S15-12503 51592503 31502503 81512503
Fix)=
Sparklines . Y
: !_,—""J \_\__ ‘_’,ﬂ- . Delta Temperature (K)
—ve=e 24 = 2.1% —— Magnetic Field (Oe)
Mo, of points 1000 1000 1000 100 45 —— Position (mm)
Sample fBCO milled YBCO milled YECO milled YBCOn
Measurad o |1 1 ! 12/01/2004 1 . 104 1 13 - \ - -'_'__rlllrﬁ.;l
!
€ v i \

Note that the default legend object is not created with literal text and plot symbols but instead is created from
LabTalk script.

e  This allows the legend object to be dynamically linked to plotted data and worksheet metadata, so that
the legend can be updated when data or plot metadata change.

e  Because construction of the legend object relies on scripting rather than literal information, you can save
customizations to a graph template and recreate the graph with its accompanying legend object using new

data, as often as is needed.

The legend script relies on "substitution notation" to convert variable values to readable symbols and text. You
can see this notation when you double-click inside of the legend object (as if to edit it).
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m Calcium{pg/ml) m 0%(1)
®  bMagnesium{pgiml) ® 05(2)

Fotassium(pa/ml) ’ 06(3)
¥ Sodiumipgiml) v %(4)

®  You control which dataset metadata are used in constructing the default legend text by setting the the

Translation mode of % (1), %(2) list in the Legends/Titles tab of the Plot Details dialog box

(Format: Page...).

e Custom strings can be constructed using LabTalk substitution. Customizations can be saved to the graph

template for repeat use.

Origin has a Eit Layers to Page tool that is useful for arranging a graph and a large,
text-wrapped legend on the page.

12.8.2Adding and Updating the Default Legend

The table below lists tasks associated with adding or updating the graph legend, and where to find editing
controls for each legend type. Before proceeding, we should point out that there are two legend refresh modes:

e Updating a legend will preserve any customizations that you might have made to the existing legend,
including size and position adjustments and legend symbol and text customizations.
® Reconstructing a legend will overwrite any customizations. When you add or reconstruct the legend, you

are creating a copy of the legend that is stored in the graph template.

In addition, the graph template stores a Legend Update Mode setting that determines how the legend is
refreshed when adding or removing data plots from the graph. See Controlling Legend Update, below.

Task Method (graph is active)

® Graph: Legend: Reconstruct Legend menu.

—E
e Reconstruct Legend button (Add Object to Graph toolbar).

e CTRL+L.
Add or reconstruct
legend

Legend customizations not saved with the template,
will be lost when you reconstruct.
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Task

Method (graph is active)

Update legend

Open the legendupdate dialog box:

e Graph: Legend: Update Legend menu.

e Right-click on legend and select Legend: Update Legend.

Note: "Updating"” a legend does not overwrite legend customizations.

Customizing
special legends

Right-clicking on these special legends opens a dialog box with customization
options specific to each legend type:

(] Categorical legends.

(] Box chart legends.

e  Point-by-point legends.

Add color scale

Only available for color-mapped plots (e.g Contour Plots).

e  Click the Add Color Scale button == (Add Object to Graph toolbar).
e  Right-click in the layer and select New Color Scale.
. Insert: Color Scale menu.

e When you have multiple color-mapped plots in a single graph window, you

can click on each plot to select it, then add a corresponding color scale.

Control color scale

Available when a color scale object has been added to a graph. To open the Color
Scale Control dialog:

e  Double-click on the color scale object.

®  Right-click on the color scale object and choose Properties.
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Task Method (graph is active)

Available for bubble plot, or when symbol size is controlled by a dataset.

e Select Insert: Bubble Scale.

e  Right-click in the layer and select New Bubble Scale.

Add bubble scale e Click the Add Bubble Scale button @ in the Add Object to Graph

toolbar.

e  Right-click the legend to select Add Bubble Scale from the context

menu.

Available when bubble scale object has been added to a graph. To open the
Bubble Scale Control dialog:

Control bubble ] .
scale (] Double click on the bubble scale object.

e  Right-click on the bubble scale object and choose Properties.

I The legendupdate dialog box and the Legend/Titles tab at page level of Plot
Y Details both have an Auto Legend Translation Mode drop-down that determines
which worksheet metadata (e.g. column Long Name, Comments, etc.) is used to
generate the legend text. For a list of Custom options, see Legend Substitution
Notation.

Note: For more information on creating and customizing graph legends, see:

Help: Origin: Origin Help > Graphing > Graph Legends and Color Scales

12.8.3Controlling Legend Update

When a data plot is added or removed from a graph layer, the default behavior is to update the legend. The
Legend/Titles tab at the graph page level in the Plot Details provides a Legend Update Mode drop-down
to control this behavior.

The default setting Update when Adding only affects the legend display of data plots that are added or
removed. Previous legend customizations to existing plots, such as literal text entered manually, will be
maintained.

Tutorial: Customize legend and add data plots

Start with a new project in Origin.

2. Open Windows Explorer and navigate to the subfolder <Origin EXE
folder=\Samples\Import and Export\

3. Shift-select the files S15-125-03.dat, S21-235-07.dat, S32-014-04.dat and
then drag-and-drop the files onto an empty Origin workbook. The three files will be

imported into three separate workbooks.
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Click on one of the workbooks, select the column B, and create a line plot.
Right-click on the legend and select Legend: Update Legend... to open the
legendupdate dialog.

6. Change the Auto Legend Translation Mode drop-down to Custom, and in the
edit box that appears below, enter the string:
@WSs, @LD3
and then press OK to close the dialog box. The legend updates, displaying the
sheet name and the third user parameter.

7. Click on the second workbook, select column B, move the mouse over the right-

y kg .
edge of the column until it changes to , and then drag-and-drop this data
onto the graph to create a 2nd data plot.

8. Repeat the procedure with column B from the third workbook. The graph will now
display three data plots, and the legend will automatically update to display the
identifier for all three plots.

9. Click on each individual curve and use the Style toolbar to set a different line color

for each. The legend will automatically update and display the new line color.

2] Graphl [r= = ]
i
—— Tral Run 1, YBCO milled
45 - —— Tral Run 2, YBCO milled
—— Trial Run 3, YBCO milled-square

Delta Temperature (K)

Time {sec)

12.8.4Special Legend Types

As mentioned, Origin supports these specialized legends for use with specific graph types. These legends can
be customized and updated similarly to the Data Plot legend used by most 2D graph types.

273



UserGuide 2023

Legend Type Menu to Create Used in situations where ...

At least one plot attribute (e.g. color,
symbol shape.etc) is controlled by data
Legend for Graph:Legend:Categorical indexing.

Categorical Values Values
See the Legend for Categorical Values
help page.

The plot symbol style is controlled by data

Point by Point indexing, an increment list, or color

Graph:Legend:Point by Point ing.
Legend ph:Leg y mapping
See the Point by Point Legend help page.
The graph is a box chart, or a grouped
Legend for Box Graph:Legend:Box Chart box chart.
Chart Components Components
P P See the Legend for Box Chart
Components help page.
Prior to Origin 2023, the Point by Point Legend was sorted by row index (i.e. the order
i in which data points listed in the worksheet). Now, in addition to Row Index, you can sort
'3- '_'i:-i'I'E by X, Y or Alphabetical Order, and, optionally, in Descending mode.
1 . :
= Bantam Lake (1)
Update Legend Point by Point 7 > ® GBantam Lake(2)
4 Bevin Pond
weol(l) Col(A) Plot v Candlewood Lake (1)
- - Candlewood Lake (2)
Legend for: | [Piper.dat]Piper A(L), G(X), D(Y) ~ 4 Candlewood Lake (3
B — Candlewood Lake (4)
Label Form: | Custom //-’ o
- - #* Lake st (2)
E:" OWT. 2.1 / @ Lake Forest (3)
@ Pinewood Lake (1)
3 § £ P 2
[ Show Unique Entries Only d P:::ES t::: Eﬂ-;
7 # Pinewood Lake (4)
Sort by Alphabetical Order v ~  Pinewood Lake (5}
DDﬁcendinq | Squaniz Pond
Select from menu to insert notation refered to other columns
K Cancel Apply

(4]
R TR WV LY
"}l}) 'u ‘.!; 'L;-_'.-.\\r%) @ TN
£ S eI VL -
Pl VANV VYR VAV V- ™ AR I
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12.8.5Tips for Quick Legend Edits

Many edits to the graph legend can be made from the legend's Mini Toolbars. The default legend for 2D graphs
has two Mini Toolbars:

e The Legend toolbar -- available when you select the legend object -- has general controls for font, legend
reconstruction, reversing order, etc. Click on the legend object to produce the blue selection handles.

Default v|[22  |A* A7 A [F]

S A =]y § o

You also gain quick access to more complex controls such as Data Plot Legend Translation Mode --

identifying the column label row metadata that you wish to use to create your graph legend.

Sales REpUI’t Update Data Plots Legend: legendupdate ? *
Dislog Theme | act yseds ﬂ
Update or reconstruct graph legend
100
Update Mode Update e
&0 1 Auto Legend Transiation Mode Custom v
60 - Legend Custom Format(@D,@LU etq | SL0Erand’ @LC «| >
Combination of legend notations with any literal before, after and in
40 - between Is allowed.
Fy
20 4 Additional Format (for @L, @V etc) | ]
i Show Legend for Visible Plots Only [
0 ' . . Hide Legend for Fitted Curves O
Feb Mar Apr May Jun Jul Aug I

T - = 1
Ferrari East I:IFerra.ri Central [ Ferrar West, |/ "| BvATA A Data Plot Legend Translation Mode
BMW East -BMW Central -BMW West [_"Eljl = [_ f,q, :_:l _m

e The Legend Symbol toolbar becomes available when you click on a legend symbol. Use it to change

symbol or pattern block height and width, line thickness, etc.

In addition to the Mini Toolbar for the default legend, there are toolbars specifically for Color Scales and
Bubble Scales.
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To format your legend or scale using a Mini Toolbar:

v Title go-1 012,
1 B~z o5 | Arrangement

T
1684 1187 78.95 35.25 S l:"’t . ﬁ} -1198.6

1. Select a legend or legend component (e.g. legend symbol). A Mini Toolbar with context-specific buttons

will show.

2. If the toolbar fades too quickly, restore it by pressing the Shift key.

| To format multiple legend objects on a page using a Mini Toolbar, press Ctrl and select
Y the objects. Release Ctrl to display a Mini Toolbar for editing. Alternately, when the
graph window is active, go to Object Manager and right-click on a legend object and
choose Select All with Same Name and use the Mini Toolbar that appears in the
Object Manager space

12.8.5.1 Other Legend Editing Tips

e  Apart from the Mini Toolbar buttons, you can also right-click on the legend object, choose Legend and
open a shortcut menu with some useful commands such as Text Color Follows Plot, Reverse Order,
and Show Legend for Visible Plots Only. The same menu commands are available from Graph:
Legend.

e  Both the Mini Toolbar and the shortcut menu have an Arrange in Vertical/Horizontal button/command
for changing the legend aspect; or you can modify it interactively by selecting the legend object, then

pressing CTRL while dragging a selection handle (e.g. drag horizontally to create a legend that is all on

one line).

Press CTRL, grab a blue handle and pull or push the legend

@ i Germany] | Greece] !Icelancﬂ !Ire]and

Denmarls

Fi] 3 A
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You can modify the white space around legend entries in the default 2D legend, by clicking precisely on

the legend frame and dragging the selection handles.

While plot metadata stored in column label rows is an ideal source for legend text, you can simply

overwrite the existing legend text with literal text. Either double-click on the legend text to enter in-place

edit mode or if that proves to cumbersome, right-click on the legend and choose Properties (taking care

not to overwrite the "\I( )" notation that creates the plot symbol). CTRL + double-clicking on the legend

will also open the this dialog.

Double-click a legend symbol to open the Plot Details dialog box.

Any changes that you make to the legend can be saved with the graph template (Eile: Save Template

As) If you do not want a legend object added to your graph each time you create the graph, delete the

legend object and re-save the graph template.

| If you are adding special characters to the legend manually, there is a simplified Symbol
' Map dialog for doing that. Most-used symbols are arranged on tabs for easy access. To
access the full Symbol Map dialog, click the Advanced button.

Symbol Map
Greek Math FEuropean Combining Armow Miscellaneous
Add..,
V|| O B XX | *|#w|*|B|t|d]|€]|£f Delete...
(¥ |O|®|92|0|R|&F| =8 EE AR S NoNRo NN Reorder
Reset to Factory Defau
KSR ERER
Append from Factory [
Recently used symbols
L e Ao [T [ [T[A] ][]
Close dizlog on insen Advanced... Insert Close

As discussed above, the default legend is automatically-generated by combining worksheet
! metadata with customizable plot styles. However, there are times when your auto-
y FIEET generated legend needs some "tweaking" and these Origin 2023 additions will help with

"_pi..';"‘ that:
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l_ Text Object - Legend |

Text Symbol Frame Position Programming

Fent | B Default: Arial v| Size |22 v| Color I Black = FRotate (0~

Line Spacing(%) | <auto> | Tab |8 = [Jwhite Out 2] Align Columns  [] Verbatim

Alignment __E w @ N B rs u = =, =i op A ﬁ A

| 8 Add Legend Symbol ? x £

) Symbal O
- Line |

B Color Block E| ‘-.._E
l; BorderThick:1. 'U, ; WidthEa) «autox W
' z

Heightiss) | <autox W |
]
Applyte  Layer " Pattern None 2

Z 25%""?5% Edge Calor . Black . -

T Range withif 1.5 “*"" L~
Gradient Fill Haone ~
Mea n Transparency | 0 ¥
Out“e 'S Transparency for fill anly [
Add Close

Nationwide Price Range

e One common legend customization is to manually add legend symbols and text that

are independent of any data plot (you can read about that here). For Origin 2023,

you can now add an independent Color Block (1):
1. Right-click on the legend object and choose Properties to open the Text
Object - Legend dialog.
-
Click the Add Legend Symbol button
Enable Color Block, customize the block and click Add.
Manually add text at the end of the string that is used to generate the block

before closing Properties.

e  Another desirable adjustment is to add some white space between legend entries. This

is done using the Separator button | on the Text Object - Legend toolbar (2).
1. In the upper panel of the Text Object - Legend dialog, place the cursor at the

end of the line preceding where you want to place the separator, then click

the Separator button = (hint: separator thickness can be controlled by
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editing the numeric portion of the inserted syntax \sep:50).

12.9 Annotating Your Graph

When we speak of "annotating" a graph, we are talking about adding text or drawing objects to the graph.
Generally, these "annotations" help to enhance the graph in some way -- add a page title, add an arrow to
draw attention to some graph feature, label data points, add a date-time stamp to note the time of graph

creation, etc.

Annotating a graph can be as simple as adding a static text object and formatting it with Mini Toolbar buttons.
Or you might add a more complex object that is dynamically linked to a variable value or to some LabTalk
script that is executed whenever some user-specified event occurs.

The following table lists some common graph annotation tasks and available tools for accomplishing those

tasks:

Task

Method

Label Data
Points and
Plots

Choose Format: Plot ..., then click the Label tab and select Enable (not

available for all plot types).

=

Select a plot and use the Mini Toolbar Show Data Labels button L_T to turn on

labels. Some label buttons may support formatting options for the data labels

(hint will be a downward pointing arrow as on the button shown here).

To label a single data point, click twice on the point (hint: not a double-click but
a click, pause, click). When the single-point is selected, click the Show Data

Labels button on the Mini Toolbar.
For format options not supported by Mini Toolbars, you will generally use
controls on the Label tab of Plot Details. Note that labeling options will depend

on the plot type.

Add Text
Objects

T
Click the Text Tool button, then click on the graph to place the object.
Right-click on the graph and choose Add Text from the shortcut menu.

Double-click on text to do rich text editing; or click on the object and use the

text object Mini Toolbar to change font color, bold, align, wrap text, etc.
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Task

Method

Add Page Title

ik

To add a page title to the graph window, hover near the top of the page (just
below the title bar) and click the Add Page Title Mini Toolbar button.

The page title object is new for Origin 2023. Previously, the

user simply created an ordinary text object, manually

NEW ] positioned and sized it, and decided whether to wrap text or
not. Now, you can hover in graph window, just below the title

bar, and click the page-level Mini Toolbar's Add Page Title
button.

o %%- Ili I.é @m Add Page Title
WS &RE %%

Behavior of this new page title object is controlled via the
LabTalk _ptitle.box property:

e  ptitle.box=70 (default): Box width is set at 70% of
page width (modifiable by user). There is no GUI resizing.
e  ptitle.box= 1: PowerPoint/Word-like text box but can

drag handles to resize it.

e  ptitle.box= 0: Old style text object. Placement not

precise. Size is decided by wrap result.
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Task

Method

Add Layer Title

e To add/modify layer title in the active layer, click on the graph layer, then click
the Add Layer Title Mini Toolbar button; or right-click on the graph and choose
Add/Modify Layer Title from the shortcut menu.

Origin 2023 adds an Add Layer Title button to the layer-
level Mini Toolbar. This is a new type of text object which is
e TWE 1 (a) center-aligned horizontally on the layer and in which (b)
"—,H“ wrap-text is enabled. Once a title is added, it can be toggled
ON/OFF with the Mini Toolbar button.

.
'}
=

| Australia Land Temperature (1900 ~ 2007) I L. & @tjﬂrdu Layer Tith
3o

—— Above Avg. —— Under Avg. T Ry =51

S

Behavior of this new layer title object is controlled via the
LabTalk _title.box property:

e _title.box=80 (default): Box width is set at 80% of layer

width (modifiable by user). There is no GUI resizing.

e title.box= 1: PowerPoint/Word-like text box but can

drag handles to resize it.

e _title.box= 0: Old style text object. Placement not

precise. Size is decided by wrap result.

e With a 2D graph active, use the Insert: Straight Line... menu item. Note that

this tool allows use of a simple LabTalk expression in the At Value field (e.g.

Add
Vertical/Horizo "mean(plotdata(1,Y))" which translates to "mean of 1st plot's Y dataset™) for
ntal Line positioning the line object. For information, see At Axis Value.
e This is another another option for labeling individual data points. Click the

Annotate a
Data Point Annotation tool on the Tools toolbar. See The Annotation Tool.

Use the corresponding toolbar buttons on Tools toolbar. Origin supports:
Add Drawing e  Arrow, Curved Arrow.
Objects e Line, Polyline, Curve, Freehand Draw.

e Rectangle, Circle, Polygon, Region.
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Task

Method

Insert Equation,
Word Object,
Excel Object,

Insert Equation button group on the Tools toolbar. For equations, note that you
can download a free App from the OriginLab File Exchange, for adding LaTeX

objects to worksheets and graphs.

Other OLE
Object
Right-click on the graph and choose Insert Images From Files. You will be
asked whether you want to insert your image as a background for the active
Insert Image graph layer. Answering yes will cause the image to be imported and placed
behind plots, graph legends, text objects, etc.
) . EHH .
Click the New Link Table button on the Add Object to Graph toolbar and
then click on the graph.
From the main menu, choose Insert: Table.
To edit table content, double-click the table object.
To format the table, select it and use the available Mini Toolbar.
::t""““ _ ”“B""‘ Eef LM s v:—‘—'HCuuhrsandednm
Weight o Weighting n - None
Add Table Tnte rcept 020419002943 || . AEEETE EEEEEEEDE
097864 2005682 | HEm om
ual Sum of Squares 023102 Mare Colors: Bold2
2anson’s r T 04526 EEEEEEEE
R-Square (COD) EEH
Bd} T 1 1L 1
Degrees of Freedom 30 E‘?—‘.. - |_.I
- e
AEEEEEEN
Custom: Bold2 »
EEEEEENN+

Recent colors

Insert Date &
Time Stamp

e Date & Time EE' button on the Add Object to Graph toolbar.

Insert Project
Path

e Project Path Ea button on the Add Object to Graph toolbar.

282



https://www.originlab.com/fileExchange/details.aspx?fid=221
https://www.originlab.com/fileExchange/details.aspx?fid=221

Customizing Graphs

Task

Method

Add Bracket
with Asterisk

Origin 2023 adds a new Mini Toolbar Bracket Type button
for quick access to bracket shapes.

- o] e EE T e

*E
§ = = e -|: :|- ™ J5quare Bracket

i

(T \Round Bracket
| *\Brace

0.1+

3

[ ]
Therapy Therapy Therapy
Period Period Period
1 2 3

.3
e To indicate statistical groupings, click the Add Asterisk Bracket 1 putton on
the Add Object to Graph toolbar.

e  Manually adjust the size and placement of brackets by dragging handles on the

object.

e To format the bracket, click the bracket and use the Mini Toolbar buttons.

Add XY Scale

This is useful when using a nonlinear xy scale.

e New XY Scale button E and click on a graph layer.

e  Select Insert: XY Scaler.

12.9.1Tips for Editing Your Graph Annotations

Beginning with Origin 2021, use Alt+Enter when creating multi-line text objects. To
revert to using Ctrl+Enter to insert a line break, set @FCA=1.

Origin 2023 allows for greater control when editing long text objects -- of both
wrapped and unwrapped text. See items marked NEW, in the following list.

_ . . O . i ) )
e  Pressing CTRL when drawing with the Rectangle or Circle tools, will draw a square or circle (as

opposed to a rectangle or ellipse).
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Use Mini Toolbar buttons for quick edits to selected objects. For more complex edits, right-click an object
and choose Properties to edit object properties and set defaults.

For text objects, including the axis titles and graph legends, you can edit text objects directly in "In-place
Edit" mode. Double-click on a text object to edit. Use the Format toolbar buttons to add superscript,

subscript, and Greek characters.

You can enable text wrapping for text objects, including legend objects. Open the object's Properties
dialog, click the Frame tab and enable Wrap Text, Adjust Height; or select the object and click the
Wrap Text Mini Toolbar button.

NEW: By default, there is an 80 character limit (with spaces) to in-place editing of wrapped text. Below
this threshold, double-clicking on the object will put you into in-place edit mode; above the threshold,
double-clicking will open the Properties dialog. You can adjust this threshold using system variable @TLIP.
NEW: When long text objects are not wrapped, you can use system variable @TLIPN (default = 60) to
determine the character threshold for entering in-place edit mode or to open the Properties dialog, upon
double-clicking.

Note that while manual editing of axis titles and legends may be the best "quick solution", in most cases,

you are better off using worksheet column metadata to automatically create axis title and legend text.

Do NOT set font size while in "In-place Edit Mode" unless you need to mix font sizes within a single text
object. The correct way to change font size is to click the text object once so that the green selection
handles appear, then select font size from the Format toolbar. If you set while in In-place Edit mode,
Origin will not indicate the proper font size when you hover on the text object.

When you are in In-place Edit mode, you can right-click and choose Symbol Map to insert special
characters into your text object.

You can insert data from of a worksheet cell into a text object by copying and pasting the cell contents.
While in In-place Edit mode in the text object, right-click and choose Paste or Paste Link. Data added by
Paste is static; Paste Link is dynamic and thus, the text object will update if the data in the linked cell
changes.

Also, when in In-place Edit mode, you can right-click and choose Insert Info. Variable... to insert

project variables into the text object. Since the pasted information is linked to a LabTalk variable value,

the inserted data updates if the variable value changes.

You can insert variable values into a text object using the LabTalk %6, and $ substitution notation by

setting the Link to (26,%$), Substitution Level to 1 in the text object's Properties dialog box,
Programming tab. Right-click on the text object and choose Properties from the shortcut menu.
Alternately, you can use the Link to Substitution Mini Toolbar button, saving you from having to open

the Properties dialog.

(1. @ WY Be (1. @WS el
[Defautt v |22 v|A® A7 A | ik to Substitution

B S350 042

i

[Book1]Trial Run 1

#
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Origin 2023 improves support for inserting worksheet cell values into text labels (see
Return value in current column format with "W" and "@WL"):

r e  The display format of column label row numeric values is now kept

(e.g. %([Bookl]Sheetl,@WL, B[D1],W) for user-parameter 1 in column B, with
the "W" argument to preserve format).

Keep cell display format (label row or data) when using a plot index syntax
(e.g. %(1@W,2,D”’mean”,W) for first plot source worksheet, 2nd column, user-

parameter "mean”, with the "W" argument to preserve format).

You can use controls on the Programming tab of Properties to associate your LabTalk script with a text

or drawing object (for instance, see Linking Text Labels to Data and Variables). Enter your script in the

text box and specify a Script, Run After condition for running the script. Use the Apply to drop-down to
set the scope for the script.

You can copy a range (of cells) from a workbook and paste it into a graph as a table object. Table content
is (a) edited by double-clicking on the object and (b) can be formatted using Mini Toolbar buttons.

E: :G."E*' [
OL1EETE 042145
00014 OETTEE
051633
[ [
s
DTS5
[ b
[EE- o

O MEELZ[05 v|== —T| Table Style
Default ~|| 9  «~|A" g",_ﬁ_

You can add text formatting (e.g. super-/subscripting) to non-consecutive characters
via the text object's Properties dialog:
Right-click on the text object and choose Properties.

On the Text tab, press CTRL and in the text box, highlight multiple characters by
dragging with your mouse.

Click the desired text formatting button above the text box and click OK to close.

12.9.1.1 Simple Symbol Map

The Simple Symbol Map, added in Origin 2022b, is further enhanced for Origin 2023.
There is now a "settings" menu to assist in managing symbols.

] 1. To insert a symbol, highlight the symbol and click Insert.

2. For help with Advanced or other dialog settings, see the Origin Help file.
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Symbol Map
Greek Math E Combi A Miscellaneous
reel uropean ombining mow Add“.
SISO B|F|X|X|*|#=|*|B|¢|c|€|£ Delete...
¥ |®| 2|0 |R|&F | 8|4 x| @0 O ( Reorder
Reset to Factory Default
AESR AR
Append from Factory Default
Recently used symbols
" i " , » “ 3 N o — . -
L[ fe]Af] -] [A]
[ Close dizlog on insert Advanced... Insert Clese

From the "gear" icon...

e Add: Enter space-separated Unicode 4-character sequence. Symbols will be appended

to the current tab.

e Delete: Enter space-separated Unicode 4-character sequence. Symbols will be
removed from the current tab; or click Select to pick symbols to remove.

e Reorder: Drag to reorder, click Done to apply changes.

e Reset to Factory Default: Resets to default symbol set for current tab.

e Append from Factory Default: Restores previously-deleted default symbols to
current tab (does not affect user symbols).

For more information, see the Origin Help file page Adding Unicode and ANSI Characters in Text Labels.

12.9.2Grouping, Aligning and Arranging with the Object Edit Toolbar

&8 000o & e Blnofe= They oocm Py

You can group text labels and drawn objects so that they move or resize as a unit:

1. To select objects, press SHIFT + click; or drag out a box around objects using the Pointer M tool.

I’

2. To group the selected objects, click the Group button on the Object Edit toolbar.

I

3. To ungroup objects, click the Ungroup button J on the Object Edit toolbar.

You can align multiple text labels and/or drawn objects with one another using the tools on the same Object
Edit toolbar:
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1. Select objects to be aligned by holding the SHIFT key while selecting (or drag out a selection box using

g

the Pointer tool), then click one of the align objects buttons on the toolbar. Note that objects will be

aligned with respect to the first-selected object.

You can bring overlapping objects to the front or send them to the back:

1. Select the objects that you want to move to the front or the back.

Th T

2. Click the Front button or the Back button on the Object Edit toolbar.

Note: For more information on graph annotations, see your Origin User Guide:

Help: Origin: Origin Help > Graphing > Adding Text and Drawing Objects

You can also use the Object Edit Toolbar to manipulate graph layers. Use buttons to
align and set a uniform size for multiple graph layers or to swap layer order.

12.9.3Using Page or Layer Grids to Place Objects

For manually placing objects -- graph layers, text objects, legends, etc. -- you can turn on a non-printing, non-
exporting page or layer grid:
e  With the graph active, choose View: Show: Page Grid/Layer Grid (displays only one at a time).

e Alternately, you can turn on grids by clicking near the page margin and clicking the Mini Toolbar Show

Grids button. In addition, you'll find buttons for increasing or decreasing grid size by increments.

Show Grids Increase Grid Spacing Decrease Grid Spacing l
Layer and Object Grids

w! S A SE

1
b B ’ A
k) [ ¥ BECGREA

-"{ Global Mobile Phone Sales by Vendor
140 | s O1M0 s G20 s Q30 + Q440
| B1M1 & Q21 & Q31 = Q41 |
s Q1MZ o Q242 ¢ 032 o 04124
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12.9.3.1 Control of the Grid

Grid display and related grid settings are found by clicking on the Show Grids button.

1. Click Show Grids, then click Page Grid Settings.

Show Grids r Grid Settings %
Layer and Object Grids No Grid Lines

Layer Grid Unit Inch w

LRSI Harizontal Vertical
FPage Grid Settings... —I_’_-
Offset 0 0
Snap Layers to Grid ) .
Snap Objects to Grid SR Auto ~| Auto -]

[15nap Layers ta Grid

[15nap Objects to Grid

12.9.40bject Attachment and Scaling in Graphs

There are two settings that you should know something about, particularly if you subsequently modify axis
scales or resize the graph layer after adding annotations: One is the object's Attach to method, the other is
the layer's Scale Elements behavior.

12.9.4.1 Object Attachment

When you add a text or drawing object to an Origin graph window, the object becomes part of the active graph
layer. Thus, if you resize or delete that graph layer, you will resize or delete the added object.

In addition to being part of the graph layer that was active at the time of object creation, note also that
objects are attached to the graph in one of three ways, depending upon the type of object and where it is
created on the page.

To view the "Attach to" setting for any object:
1. Right-click on a text or drawing object and choose Properties....

2. Click on the Programming tab and note the object’'s Attach to setting.
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Border | Fill | Dimentions | Programming

Mame Circle Attach to | Layer Frame W

Visible Selectable [ |real-Time | Editable

Script Run After |Mone

Though objects remain a part of the layer that was active at the time of their creation, you can manage some
object behaviors by changing the object attachment method. An object is attached in one of three ways:

e Page. When attached to the page, objects are not affected by moving or resizing the graph layer, nor are
they affected by a change in axis scales. These objects are still associated with a particular graph layer
and they will be hidden or deleted if the layer is hidden or deleted.

e Layer Frame. Objects that are attached to the layer frame, are resized and moved with respect to the
layer frame. However, they are not tied to axis scales and are not affected by changes in the layer's axis
scale values. Objects are hidden or deleted if the associated layer is hidden or deleted.

e |ayer and Scales. Objects are linked to a particular range of axis scale values. If you resize the layer,
the object is resized accordingly. If you rescale the axes, the object moves in relation to the visible scale
and will disappear from view if the linked axis scale range is not displayed. These objects are hidden or

deleted if the associated layer is hidden or deleted.

To briefly illustrate why object attachment is important, let's look at the following graph. After the graph was
created, arrows and text objects that point to their respective data plots, were added to the graph. Both
arrows and text objects are attached to the graph Layer Frame.
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Now, consider what happens to these objects when we modify the graph's X axis scale (recall that objects
attached to the Layer Frame "are unaffected by changes in the layer's axis scale values"). Note that by
changing the axis scale display range, we have shifted the data plots but the text objects and arrows did not

move with them.
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Objects attached to Layer Frame

Objects attached to Layer and Scales

The remedy for this is to change the text and drawing objects' Attach to method to be Layer and Scales
because "if you rescale the axes, the object moves in relation to the visible scale.” Sometimes we may want an
object to move with scale changes; at other times we may not. You can force either behavior if you keep in

mind the Attach to setting.

12.9.4.2 Object Scaling

Object scaling often comes up when manually resizing the graph layer or when merging separate graphs into a
single multi-panel graph (Graph: Merge Graph Windows). By default, added objects are set to Scale with
Layer Frame -- that is, when the graph layer is resized, associated objects such as text objects, axis lines and
ticks, and axis titles -- will be scaled proportionally. In the case where you merge four single layer graphs into
a single, four layer multi-panel graph, these objects will be scaled down with the reduction in size of the layer

frame.
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However, this is another default behavior that you may want to change (e.g. you have set your font size to 10
pt. and you want to preserve that size), and you can do this using the Scale Elements control on the Size tab
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(Layer level) of Plot Details. If our goal is to keep objects at their current size when merging graphs, for
instance, we can open the Plot Details dialog box and at the layer level (Format: Layer...), click on the Size
tab, choose the Fixed Factor radio button and set the scaling factor to 1.

i If you have resized the graph layer, either by merging multiple graphs into a single

' graph or by manually resizing the layer, you will find that the font sizes do not display
at their "correct" size (i.e. if you select a text object, the Font Size list on the Format
toolbar shows the original font size). Further, if select a text object, the Status bar will
report two font size numbers -- "size" and "actual". You can reset font size so that they
are shown as actual size, not scaled size, by choosing Graph: Fix Scale Factors. For
more information, see FAQ-441 How do | export graphs with exact size and resolution
as specified by publishers?

12.10Inserting Images to Graphs

There are two general approaches to adding images to graph windows:

. Insert the images as floating or background images.

. Insert images within a text object.

12.10.1 Floating or Background Images

e Images can be inserted to graphs from file or from Image Windows.
. Images can be inserted as floating images or as a layer background.
e  Double-click on a graph image to open the image in an Image Windowv.

® Once opened in the Image Window, define a region-of-interest (ROI) and Clip the image (graph image

clipped to ROI) or Crop the image (image is cropped in Image Window and graph).
e Use the Image Window to Set (image) Scale or Set (image) Coordinates of the inserted image.

. Images may be saved with the project or linked to an external file (Link File) to control project size.

Prior to Origin 2022b, images linked to an external file had to be manually reimported
on project open. Now, linked images are automatically reimported, including modified
source images. Disable or modify auto import with system variables @LFAU and @LFC.

12.10.1.1 Inserting Image from File

You can insert an insert an image into graph page, with the option of inserting it as a background image that is
linked to layer and scales.

With the graph layer active, choose Insert: Image from File. The image is inserted as a floating image.
To convert the image to a background image, double-click to open it in an Image Window.

Right-click on the Image Window image and choose Set as Layer Background.

4. Click the Close button on the Image Window.
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12.10.1.2 Inserting Image from Image Window

You can also insert images to graphs from an Image Window:

B 1 Insert from Image Window ? X
Image Window | Image5s - red camellia.jpg v|
Layer Background

Rescale Layer using Image Coordinates

Cancel

1. With the graph window active, choose Insert: Image from Image Window. The Insert from Image
Windowv dialog opens.
Set the Image Window drop-down to the desired image.
Optionally, choose to insert the image as Layer Background and to Rescale Layer using Image

Coordinates (Layer Background only).

Rescale Layer using Image Coordinates 5 - red camelliajpg *

| 600x450 pixels; D1; (229,1), RGB(0,21,8)

B 8 2

¥ Avis Titla
&

g B

X Aods Title

12.10.1.3 Manipulating Images with the Image Window

12.10.1.3.1 Mini Toolbar

Clicking on an Image Window image produces a Mini Toolbar with buttons for simple image manipulations
(flip, rotate, convert to gray scale, etc.).
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[ images - carbmp * Lo B

500375 pixels; 1/1; (198,72), RGB(208,39,45)

Display Actual Size

12.10.1.3.2 Region-of-Interest (ROI)

Placing an ROI object on the Image Window image allows you to perform certain image editing operations.

Add an ROI to the image by one of the following:

(] Click the Add ROI button E on the Mini Toolbar.

e  Right-click on the image and choose Add ROI.

e Click the Rectangle Tool on the Tools toolbar.
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& imagez - carbmp * =N =R

| 500%375 pixels; 1/1; (403, 166), RGB(101,56,47) |

Once added, the ROI can be resized (by dragging handles) or moved. Additionally, various operations can be
performed on the ROI, including:

e Clip graph image to ROI, Crop image to ROl or Copy ROI as image to graph.
e Copy Positions/Paste Positions for copying ROl dimensions to a second ROI on another Image Window.

e Export ROI or Import ROI to save or apply previously-saved ROl dimensions.

For more information on the Image Window, see the Origin Help File.

12.10.2 Inserting Images into a Text Object

Images can also be inserted as part (or the entirety) of a text object. Source images can be from:

e Local image file or Web image URL

e Worksheet cell
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12.10.2.1 Local Image or Web URL

When you insert an Image from File or Image from Web using the following methods, the image is linked
and not stored in the Origin project file. This helps control project file size.

1. On the Tools toolbar, click the Text tool T and click once on the graph to enter “in-place" edit mode.
2. Enter text if needed and when ready to insert image, right-click and choose Insert: Image from File or
Image from Web:
O When inserting an image from file, browse to your local image file and click Open.
O When inserting an image from Web, you'll need a URL (hint: locate your Web image, then right-
click and copy the address (Copy Image Address, Copy Image Link, etc, depending upon

browser).
To examine (or modify) the syntax used for inserting an image, you can select the inserted object and choose
Properties. In the Text Object dialog, you should see something like these examples:

Examples:

\img(file://"C:/Program Files/OriginLab/0Origin2023/Samples/Image Processing and
Analysis/white camellia.jpg',w=200)

\img(https://www.originlab.com/images/header_logo.png, w=200)
... where option "w="is the default width in pixels, of the inserted image. Width is user-modifiable by editing

the "w=" value in Properties or -- if no width is specified -- by simply dragging the object's selection handles.
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12.10.2.2 Worksheet Cell

You can also insert an image from a worksheet cell into a text object, but you'll need to make use of a special
syntax. The syntax is not complicated and combines a \cel 1 ( ) escape sequence with a cell reference --
either a range reference (e.g. [Book1l]Sheetl!col(C)[1] ) or a named range reference.

1. On the Tools toolbar, click the Text tool T and click once on the graph to enter "in-place" edit mode; or
right-click and choose Add Text from the shortcut menu.
2. Enter your string into the text object using the examples below as a guide:
O If you are copying and pasting a string (e.g. \cel I ([Book1]Sheet1!B[1])), click outside the
text object to leave edit mode. Your cell image should display in the text object.
O If you are typing directly into the text object in "in-place" mode, enter your syntax (e.g.
\cell([Book1l]Sheetl1!B[1])) and when finished, right-click on the object, choose
Properties and on the Text tab, remove one of the leading "\" characters from your cell
reference (Origin automatically "protects” "\" characters entered into text objects which is why

you'll need to remove one "\". See Escape Sequences).

O If you are typing directly into the Text Object (Properties) dialog, enter your syntax (e.g.
\cell([Book1l]Sheetl1l!B[1])) directly to display the cell image.

Examples:

\cell([Book1]1!col(C)[2]) // Bookl, Sheetl, col C, row2, size = current font height
\cell(alpha,200) // named range "alpha", width=200 logical pixels

\cell(alpha,h=300) // named range "alpha', height=300 logical pixels
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12.11Working with Map Data

CONUS, Precipitation * =N EcR

LT 1

Long Name Monthly Average of Daily Accumulated Precipitation
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1548-06-07 00:00
]
1348-08-07 D0:00
1548-05-01 00:00
1548-10401 D0:00 264
1548-11-01 00:00
1548-12-01 00:00
15450107 00:00
1545-02-01 00:00
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1545-04-01 D0:00 "

-120 -110 -100 -80 -B0 -70 -80

You can overlay geopolitical boundaries on graphs or Image Plots of NetCDF data from the Insert menu.

e Insert: World Map will apply boundaries within the graphs current Lat and Lon ranges.

e Depending upon the graph's Lat and Lon ranges, other options may be available (e.g. Continental USA

Map, Map of China, etc.).

12.11.1 Importing Shapefiles

You can also import locally-stored shapefiles using Origin's Shapefile Connector:

1. With a workbook active, choose Data: Connect to File: Shapefile.

12.11.2 Map-related Apps

There are at least two add-on Apps for inserting geographic data:

e  OriginLab's free Google Map Import App lets you place a Google Map as background on the graph page

using specified coordinates.

e Maps Online is another free OriginLab App that lets you connect to one of several map databases.

You can find and install these Apps by pressing F10 and searching on maps. For information on App
installation, see Where Do | Find Apps?
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12.12Arranging Graphs and Layers

Task Method

e Graph: Merge Graph Windows... menu command

or
, ool
Merge multiple e Merge Graph Windows button on the Graph toolbar.
graph windows
into a single

graph window.

Origin has two dialog boxes -- Fitting Layers to Page and Fit
Page to Layers -- that are useful for arranging multiple graph
panels on the page and for adjusting graph margins.

—
e Extract to Layers button on the Graph toolbar.
Extract data

plots in one
layer to
multiple layers =
’ before

Hint: to preserve your original graph, click the Duplicate button
extracting to layers.

e Graph: Extract to Graphs

or

e Click the Extract to Graphs button BN 5n the Graph toolbar.

Extract

multiple layers

in a single All layers are extracted to individual graph windows, even if a layer is linked to
grap.h to another layer.

multiple graph

windows By default, the layextract dialog box has Extracted Layers set to 1:0, which

specifies that all layers be extracted. To extract only certain layers, clear Auto and
use the layextract X-Function's comma/colon notation to control which layers are
extracted. The notation 1:0 means starting with layer 1, extract all layers to graphs
(O denotes all). Specifying 1,3:4, for example, tells Origin to extract only the first,
third and the fourth layer. Note that you can enable Keep Source Graph to preserve
the original graph.

Add, arrange, (] Graph: Layer Management... menu.

resize,
position, swap, e  Position selected layers using Object Edit toolbar buttons. Hold SHIFT + click to
Iaa{l)?enr,sor link select multiple layers and Align Left, Right, Top, Bottom, etc.
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Task Method

Add, arrange,

resize, ] You can use the Layer Management tool's Swap control (Graph:

position, swap, 3 Layer Management,Size/Position tab) to physically swap layer

align, or link positions without reassigning layer numbers. Before doing so, set

layers each linked layer's Units to 26 of Page (Size/Speed tab of Plot
Details).

e Graph: Arrange Layers... menu.

Simple e Row by column layer arrangement with control of page size and spacing between
arrangement of
layers layers.

e Linked Axes Scales tab, layer level of Plot Details dialog box.

e Link tab of the Layer Management dialog box.

When linking layers, the child layer must have a higher layer number than the parent
layer.

Linked layers can be moved and resized together.

You can link layers' axis scale values to be Straight (1:1) or you can specify a
Custom mathematical relationship.

Beginning with Origin 2023, each set of linked layers can share

the Spacing tab Gap Between Bars (926) setting of the Link to
W EVY layer (requires that page-level Layers tab Column/Bar/Box
Gap Across Layers be enabled). Previously, all layers shared the
spacing of the Layerl, possibly causing bars in other layers to be
drawn too thinly.

¢

Link graph
layers
i 2 3 : 5
Reorder layers There are several ways to reorder graph layers (reassign Layer number for each
Layer). Learn more about reassigning layer numbers in the mini tutorial below this
table.
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Task Method

Reorder layers

e Method 1: Open the Layer Management dialog and click the row header
continued
( ) (shown in image below) and drag it up or down to change the Layer order.

-

7 | Layer Management

Layer Selection Add

= 5

For more information, see the Layer Management tool.

e Method 2: Enter the following LabTalk script in the Command Window

(Window:Command Window), then press Enter to execute.

page.reorder(n,m)

The command changes the nth Layer to the mth Layer.

e Method 3: Use the Front and Back buttons on the Object Edit toolbar (these

buttons work on the active layer as indicated by the graph layer icon mJ)
Alternately, right-click on the graph layer icon and change layer order using

shortcut menu commands (e.g. Bring to Front).

| When two layers are linked by a common X axis (e.g. Double-Y
graph), you can swap layer drawing order by right-clicking on the
"front" layer in Object Manager and choosing Push to Back. This
will not break layer linking.

Note: Reordering layers may break layer linking relationships.

I A Note on Inset Graphs: In certain situations (see Tutorial,
below), the order in which the layers are drawn on the screen
becomes an issue. In this image, we have added an inset graph
using the Add Inset Graph with Data button (Graph toolbar).
The problem is that the data plot of the parent layer (red symbols)
shows through the inset layer (small, black symbols). To fix this, we
do two things:

e  Set the inset layer background Color = White -- by default, it
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Task

Method

Reorder layers

(continued)

is None (Format: Layer, then Background tab).
e  Set the layer Drawing order to Draw layer by layer

(Format: Page then Layers tab).

5 10 15 3 25 30 35

Inset X ‘\
> kS

By default, an inset layer is added "on top of" the parent layer but if
needed, you can click on the inset layer to select it, right-click and
choose Bring to Front.

-—
]
73]
£
ool T @ M

~

Exchange X-Y
Axes

e Graph: Exchange X-Y Axes menu command

XY
e Exchange Axes ™ button on the Graph toolbar.

Move a plot(s)
to another
layer

e Method 1: Open Plot Setup dialog(by selecting Graph:Plot Setup), expand the

bottom panel, select a plot and drag it from a layer to another layer.
e Method 2: Run laymplot -d; (e.g. open the Script Window, type the

command and press <Enter>) to open the Move Plot dialog to specify plot(s) to

move and a target layer.

I You can move a plot by Copying (CTRL+C or Copy Range
context menu) and Pasting (CTRL+V or Paste context menu)
operations, between different layers or different graphs. Please
note, the pasted plot won't be associated with the source data of
the copied plot, but exists as a loose dataset.

In a multi-layer graph, layer order determines drawing order. The 1st layer is plotted and
then 2nd layer is plotted on top of it, and so on. The layer with higher number is drawn on
top of the layer with lower number. This is important when plots in one layer overlay plots
in another layer. When necessary, you can change layer order to change plot drawing
order.

This mini tutorial shows you how layer reassignment works. Use the preview window to
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see how layer number reassignment affects your graph.
Click Help: Origin Central or press F11.

Click on the Graph Sample tab, set the Samples in drop-down list to Area Plots

and double-click on this graph:

2wt iy i

L auanBEELEEIENY

Activate the graph Area Plot With Horizontal Color Gradient, then click the

—

=Ll on the Graph toolbar. Set both number of rows

Extract to Layers button
and columns to 1, click OK, then, click OK again for the page spacing. The green
layer is on the top of the yellow layer in the figure. The purpose of this last step
was simply to create a two layer graph in which the data in one layer partially
hides the data in the other layer. What we will do now is to reorder the layers and

set the yellow layer on the top, giving you a better view of the two plots.
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Area Plot With Honzontal Color Gradient il e B

1 J E mission vs Excitation forSample NF172
2800

8007 B 1054
2400
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= 1800
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1400 o
12090 +
10990 4

Emission Intensity

800

600
400
200

1000 1050 1100 1150 1200 1250 1300 1350

Excitation W avelength {nm}

Choose Graph: Layer Management... menu, then drag the row header "1" of the
Layerl in the Layer Selection downward under the Layer2 (indicated by a blue line),
and click OK.

You can see the yellow layer is on the top now.
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[

=] Area Plot With Horizontal Color Gradient [ & | = & | -
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Ty

Alternate Method: You can use the Front T;‘l.' or Back toolbar buttons (located in
the Object Edit toolbar, or at the top of Layer Selection box in the Layer Management
dialog) to bring a layer forward or push it backwards. As happens when you rearrange
layer order with the Layer Management dialog, this method swaps layer numbers.

|, You can easily add an inset layer with data by clicking the Add Inset Graph With
S
Data button on the Graph toolbar or Insert: New Layer(Axes): Inset With
Data (Linked Dimension) .

o

You can copy a layer from one graph window to another graph window. Click to select
the layer first (a frame shows around the layer). Then press Ctrl+C or right-click and
choose Copy. Click on the target graph window, then right-click to Paste.

Note: For more information on merging graphs, see your Origin User Guide:

Help: Origin: Tutorials > Graphing > Layers > Merqging and Arranging Graph Layers

Help: Origin : Origin Help > Graphing > Reference > The Merge Graph Dialog Box
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12.13Templates and Themes

Origin's flexible Page > Layer > Plot hierarchy, plus an extensive list of editable object properties makes it
easy to customize and save your graph settings for repeat use. You can preserve your custom settings in a
couple of ways -- either with templates or with Themes. These concepts are introduced below.

Note: For detailed information please refer to Origin Help file, see:

Help: Origin: Origin Help > Graphing > Creating Graphs from Graph Templates

Help: Origin: Origin Help > Customizing Your Graph > Graph Formats and Themes

12.13.1 Templates

A new Origin installation lists close to 240 plot types, each one backed by an Origin graph template file (*.otp
or *.otpu). For most users, a Plot menu graph is the starting point for customizing and saving your own
custom graph templates. The basic process goes like this:

Plot your worksheet or matrixsheet data using the Plot menu (or equivalent graphing toolbar button).
Customize the graph's default settings.

Save the graph as a graph template file (*otp or *.otpu) by choosing File: Save Template As and filling

in the requisite information. By default, custom templates are saved to your User Files Folder (hint:

easily find this folder by clicking Help: Open Folder: User Files Folder).

A few things to note:

e The Plot menu is the definitive list of built-in plot types. At one time, a graphing toolbar button was
created for each new plot type but in recent versions, few toolbar buttons have been added as toolbar

space has become limited.

e In a fresh Origin installation, each one of Origin's 240 built-in graph types uses a specific "system"

template when creating a particular graph type. When you click on a Plot menu graph or graphing toolbar

button (e.g. Area b ), one of these system templates is used to plot the selected data.

e System templates are installed to the Origin Program Folder. They are completely customizable but as the

Program folder is write-protected, you cannot overwrite the original system template file (see next).

. Instead, when you customize and save a system template, it is saved by default to your User Files Folder
(UFF). If you save the customized template to the same system template name, the customized template
replaces the system template as the template associated with the Plot menu command or corresponding
toolbar button used to create that plot type. Additionally, the customized template is added to the user's
Template Library.

e To view your custom graph templates, click Plot (workbook or matrix should be active) and click Category
= MyTemplates.

®  You can save a graph template anywhere (and with any name) that you like -- it does not need to be
saved to your UFF. However, by saving customized templates to your UFF, they will be collected in one,
easily-remembered place and they will be readily available when you upgrade your Origin software (since

Origin 2018, all Origin versions have shared a common User Files Folder).
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For an overview of graph templates, see Graph Template Basics.

For information on the Template Library, see The Graph Template Library.

For information on "cloneable" templates, see Cloneable Templates.

12.13.1.1 The Template Library

Learning Center

Scan User Files Browse to Select
g iririog Fapis List Cloneable
P Templates
System
P -
BN Library
. R / "Manage”" Mode
e + for User Templates
s e List under System W E
s uabnsiiions Plot: My Templates
E D BStack_Big 222021 123038 User A
cr . | Al Categories
ExceiBrdge 6472018 151948 User
Climate | Caw rical
Madr I O 31272018 113814 Son by Name' Ll
e B o ~| Date, Category,
- - E BOX ! Basic 20 3/20/2018 113711 Location User
lgﬂhﬁ“i ghoe | statistical 22072018 113347 Use
|
Hafiol Com-:uur;‘Hi'atmar: 22009 125755 Usar
Graph Samples Hatfvioli pOT|  Specialized 2/20/2019 13:2708 User
1
Kite | <] 7172018 154432 User
A W
MeraeGra' + [ ] 202002015 13:02:22 User
Graph Sampiles Create Prototype Plot Setup Piat Close

o

ANN

Model Data for
Cloneable Template

Open the Plot Setup Dialog to
Manually Create a Plot

Summary of Features:

® Toggle between list and thumbnail view modes. Thumbnails images are automatically generated when you

save a template.

e In either mode, you can hover on the template to preview, read template location, comments, etc.

e In list mode you can sort; or opt to list a User or Extended template under Plot: My Templates.

e Templates are listed as System, Extended or User. System templates are Origin's default templates for
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or Scan functions. Note that User templates can include customized System templates that you have

saved to \User Files.

® To scan your User Files folder (UFF) for custom templates, click the Scan User Template icon. To browse

and add a template file to the Library, click the Add Template icon.

e  Click the List Cloneable Templates icon to show only cloneable templates.

e Click the Manage Mode icon to delete, show or hide a given template. Hiding a template removes it from
My Templates but does not remove it from the Template Library (note that you can also remove a
template from My Templates simply by clearing Show in Menu). Deleting a template removes it from the

Library and moves the template to User Files\DeletedTemplates.

e Click the Template Center icon to open a dialog and search the OriginLab site for additional graph

templates.
i You can search for Template Center templates and install them directly from the
' Start menu.
Worksheet top left corner with sheet selected->Con
Templates
1 Triangle Heatmap
Il Heatmap with Significant Mark
Find |heatmap]| x {3}
a << Start Menu [F1)
12.13.2 Themes and Copy/Paste Format

An Origin Theme is a file containing a set of object properties. There are four kinds of Theme files in Origin:
graph Themes, worksheet Themes, dialog Themes and function plot Themes.

Graph Themes are a collection of properties of different elements in a graph window. A graph Theme can be
very simple (e.g. graph axis major and minor tick direction settings) or it could be something more complex
(e.g. a combination of page dimensions, layer background, axis scales, and color palettes). Whether simple or
complex, the purpose of graph Themes is to allow you to quickly change one or more object properties in an
existing graph, or to apply a consistent set of properties to a selection of graph windows, without having to
recreate a suite of settings, or to apply those settings one-by-one to individual graph windows.

All graph objects have a customizable set of properties that are specific to the object type. Therefore, it follows
that the properties that can be saved as a Theme differ depending upon the selected object. You can (1) copy
a Theme from one object and "paste" it to another object of the same type or (2) you can save a Theme from
one object as a named Theme and apply that named Theme to other like objects at a later time.

1. Right-click on an object in a graph window (e.g. a plot) and choose Copy Format. Depending on what
you click on, there may be sub-menu items under the Copy Format shortcut menu, which give you the

option as to what exact format to copy.
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O To apply the copied formats to a single object, right-click on your target graph and choose Paste
Format To. Again, this shortcut menu might has some sub-items that limit what to paste. In this
way, the formatting option(s) from your source object should be applied to your target object.
O To apply the copied formats to multiple windows in the project, keep the source graph window
active and select Edit:Paste Format(Advanced)... from the Origin menu. This opens the Apply
Formats dialog box. Here you have the option of editing or selectively applying formats to one or
more graph windows in the Origin Project.
2. If you would prefer to save formats to a named Theme file that you can re-apply at a later time, choose
the Save Format As a Theme... shortcut menu item, then use Preferences: Theme Organizer to

apply the Theme when needed.

12.13.2.1 Theme Organizer
Use the Theme Organizer (Preferences: Theme Organizer) to organize and apply Themes to graphs.
With this dialog box you can apply a graph Theme simultaneously to multiple graphs in the Origin project file.

To combine multiple Themes in the Theme Organizer dialog box:

1. Press the CTRL key while selecting multiple Themes, then right-click and choose Combine from the
shortcut menu. The shortcut menu in the tool provides an option for editing a Theme, allowing the user to

add/delete properties from an existing Theme.

| Theme Organizer » IEH
[ a systemn theme can be applied automatically when making new graphs

Current system theme:  Light Grids

Right-click to set system theme or to choese other operations

Graph | System Increment Lists | Worksheet Dialog | Function Apply Theme To

Name Size Path Date 2 Current Graph W

Nadiic

Physical Review Letters 17:53

Piat Group Simple Line + Symbol Edit |‘I.T:53

Plot Group Simple Scatter Delete 17:53

profile_cline_x1 h7:53

profile_chne_x2 Duplicate 17:53

profile_hline_x1 Combine 1 7:53

profile_hline_x2 [:E' 1753

profile_sep_x] Setas System Theme |'|?':53

profile_sep_x2 Clear System Theme 1753

profile_vline_x1 — 7:53

profile_vline_x2 Ex] Thow Tooltips 17:53

Speed Mode OFF 2 System 31572017 1753

Speed Mode ON 5 Systerm 51572017 17253

Ticks All Cut 2 System  5/15/201717:53 Apply Mow

Ticks ¥L XB Out YR XT In 8 System 5/15/2017 17:53

Times New Roman Font T System 571520171753 W ndo App
[ Bxclude increment lists [ Close

e The Theme Organizer has separate tabs for managing graph, increment list, worksheet, dialog boxes and

plotted mathematical function Themes.
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e If you right-click on a graph Theme and save it as your System Theme, then each time you plot a new
graph, this System Theme will be applied regardless of the settings that were saved with the graph
templatet.

e Use the System Increment Lists tab to manage increment lists and selectively apply them to project
graphs.

®  You can load a graph Theme in the Export Graph dialog and the Theme will be applied to the exported

image file.

T If you don't want a System Theme to be applied automatically to the graph, save the
graph as a template (File: Save Template As) and clear the Apply System Theme
to Override check box.

12.14Topics for Further Reading

®  Plot Details: Customizing Graph Page Elements

®  Plot Details: Customizing Graph Layer Elements

e  Plot Details: Customizing Plot Elements

(] The Preferences: Options: Axis tab Settings

(] The Preferences: Options: Graph tab Settings

(] Graph Axes
(] Controlling the Graph Axis Display Range

e Graph Legends

®  Color Scales

(] Customizing Data Plot Colors

(] Using a Dataset to Control Plot Color

L] Using a Dataset to Control Plot Attributes

(] Labeling Data Points

e Adding Text and Drawing Objects

e Adding Unicode and ANSI Characters in Text Labels

(] Linking Text Labels to Data and Variables

® Associating Script with an Object

° Hiding Labels, Data and Layers

e  Working with Maps

e  Graph Template Basics

e Graph Template Library

(] System Templates

e System Themes
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13 Graphical Exploration of Data

Start with a data plot .. I
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Select a range of data, click pointer to
restore
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},f; Unmask Points on Active Plot
ﬁ Unmask Points on All Plots

": Draw Data

Free-form drawing of data
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otherwise X dir; Mouse wheel{or =,
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Origin includes a number of tools for graphically exploring your data including those for zooming and panning
data plots, reading XY coordinate values and other data point metadata, or highlighting or masking selected

data points
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P With Origin 2016, OriginLab began releasing add-on tools called Apps. Many
' exploratory and analysis-related tools have been added to OriginLab's File Exchange
since that time. If you find you need some exploratory or analysis tool that is not a
standard part of Origin, you might check to see if the tool exists as an App. If it does
not, request it!.

13.1Plot Highlighting

While plot highlighting can be used to select a subset of data for more in-depth analysis, at a basic level it is
useful for quick visual comparisons.
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To engage plot highlighting:

Click on one plot in the graph layer. Other plots in the layer and in linked layers sharing the same X axis,

will be dimmed.
Click on the plot in the Object Manager.

To highlight/dim plots on hover (without clicking), click the Highlight Plot when Mouse Over Mini

Toolbar button (page-level).

% % . I-i I-é Highlight Plot when Mouse Cver
" B B B (][ Aly5 1

Other Origin features useful for quick visual inspection of data plots:

312

If you have many columns of Y data, plotting a Browser Graph, or adding a Browser panel to an existing
2D line plot, can be useful for quick visual inspection. Clicking the menu on the Browser panel, you can
plot every Nth column or Flip Through plots using a specified Move By factor.

For scatter data, use the customizable Data Point Tooltip to read coordinate values and column
metadata on mouseover.

You can also use Tools toolbar buttons to zoom or pan your graph, as you will see in the next section.
Origin has various other tools available for visually inspecting and recording information on your data plots

and those are covered in the remaining subsections of this chapter.
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13.2 Data Slicer

If you are plotting worksheet data where a data filter has been applied, you can enable a Data Slicer panel,
make quick changes to filter conditions and see the effect on your plot. The tool is intended for plotting and
comparing single categories.

A ‘%.rk_rg Data Slicer
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Apply one or more filters to your worksheet data and create your plot.

2. Hover just inside the graph window but outside the layer and when you see the Mini Toolbar cursor, click
and look for the Data Slicer button.

3. Once the Data Slicer panel is enabled, you will want to right-click on the title bar of both the worksheet
and the graph and Duplicate the two windows. Duplicating the two will allow you to make side-by-side
comparisons.

4. In the left panel of the duplicated graph, click on the listed filter(s) and choose another category from the

drop-down list.

13.3Zooming, Panning and Rescaling

This section discusses the use of toolbar tools, and keyboard and menu commands that change the view of
your 2D graph. We have split these tools and commands into two groups:

® Page-level zoom and pan operations that do not change axis scales.

® Axis rescale operations which zoom and pan the graph by changing axis From and To values.
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P Page level zoom and pan do not alter the graph; they only determine which portion of
; the graph page is visible within the graph window. You can read the current zoom level
in the Zoom dropdown list of the Standard toolbar. Page-level zoom and pan will not

affect the printout or export of the graph. On the other hand, axis rescaling tools (e.g.

Q@ Q

=" land *“* ) do alter the graph and, thus, will affect the printout and export of the

graph.

gets  Tools ormat  Window

= A =

= © | Bp Default: Arial |0

13.3.1Page-level Zoom and Pan

Action Button Shortcut Key

Menu

Notes

A+
+/- keys
Zoom-Panning: Zoom @ (zoom)
and pan the graph page. or
arrow keys
(pan)

Click the toolbar button; or

with the Pointer tool

e

active, place the cursor on the
graph page and press "A",

then ...

Use +/- keys or
mouse wheel to
zoom in or out.

Use the arrow keys
to pan horizontally or

vertically.

Stepped Zoom-Pan':
Zoom graph in or out, by
increment.

CTRL +1
CTRL + M

5 5

View:Zoom
In and
View:Zoom
Out

Stepped zoom.
CTRL+I1 activates
zoom in; click on the
graph to establish
the focal point.
CTRL+M zooms out;
clicking on graph not

needed.
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Action Button Shortcut Key Menu Notes

(] Reset the view of the

page after using the

. View:
Whole Page: Show the E CTRL +W Whole Zoom-Panning tools,
whole graph page. P
age above.
e Can be used to
locate "lost" objects
Zoom All: All objects in View: Zoom . .
! - - [ tside th
the window are shown. All ying outside the

graph page.

"Notes:These are older tools and methods that have been deprecated. Toolbar buttons are not shown by
default. To add them to the workspace, use the Customize Toolbars dialog box (View: Toolbars > Graph
button group).

13.3.2Axis Rescaling

For Origin 2023, there is a new shortcut key combination for Rescale in both the X
JEW and Y dimensions. Press Z + right mouse button, then and drag vertically (scale in Y)

e THE!
—'H:?I- or horizontally (scale in X)

Action Button Shortcut Key Menu Notes

e Scroll mouse wheel to
rescale X.
e SHIFT + scroll to

rescale Y.

e Drag with the left
Rescale: Rescale 9

. +1i
and pan the graph in .@.-E éuttgr?r:nrgzl:zg B mouse button to pan
(tj)_oth Xand Y vertically/horizontally (will rescale both X
imensions. av
an .

e Select the Pointer
tool to exit Rescale

mode.

® Rescale the graph in

Z + scroll wheel

Rescale the graph in the X dimension

the X dimension. or without limits.
Z + +/- keys
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Action

Button

Shortcut Key

Menu

Notes

Pan the graph in the
X dimension.

X + scroll wheel

or
X + +/- keys

Rescales X.

Does not rescale Y.

Rescale X: Rescale
the graph in the X
dimension.

Rescales (Resets) X to
full X range + some

padding factor.

Rescale the graph in
the Y dimension.

SHIFT + Z + scroll
wheel

or
SHIFT + Z +
+/- keys

Rescale the graph in
the Y dimension

without limits.

Pan the graph in the
Y dimension.

SHIFT + X + scroll
wheel

or
SHIFT + X +
+/- keys

Rescales Y.

Does not rescale X.

Rescale Y: Rescale
the graph inthe Y
dimension.

Rescales (Resets) Y to
full Y range + some

padding factor.

Rescale XY: Rescale
the graph in both X
and Y dimensions.

Rescales (Resets) X
and Y to full range +

some padding factor.

Rescale Z: Rescale
the graph in the Z
dimension.

Rescales (Resets) Z to
full range + some

padding factor.
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Action Button Shortcut Key Menu Notes
® Select Scale In
button, then drag out
rectangle(s) to define
axis scale range
desired.
e Reset by clicking on
Scale In/Scale Out: ] the Scale Out button
Rescale the graph in ==and - -
X and Y dimensions. Q\ (no need to drag)
several times.
® Rescales both X and Y.
® Press ESC (or select
another tool) to quit
maghnifying mode.
® Rescales (Resets) all
Resca.le: Rescale the Sgsggé éxes to display all data
g:’;{;ﬁ;?ot:s all H CTRL+R to Show in thé layer (+ some
All padding factor).
3D Graphs

Rescale in the X
dimension.

Z + scroll wheel

Rescale inthe Y
dimension.

SHIFT + Z + scroll
wheel

Rescale in the Z
dimension.

D + scroll wheel

If the plot extends beyond
the 3D frame, go to Plot
Details > Miscellaneous
tab (layer level) and set
controls under Clipping.

If you do not see a toolbar button, it may be turned off. To add or remove buttons from
a toolbar, see The Customize Toolbar Dialog Box.
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Notes:

e

®  You can use the Scale In button =™ to copy an enlarged portion of your 2D graph to a new
window. This will also work on any graph that has multiple linked layers as long as the layers are
overlapped and share a common axis (2o of Linked Layer has Left/Top set to O and

Wwidth/Height set to 100, plus Straight (1 to 1) linking to the parent layer). With a graph

=

your 2D graph. Note that this Enlarged graph is dynamic. Move or resize the rectangle on your

active, press Ctrl then click the Scale In button (Tools toolbar) and drag out a rectangle on

original graph and the Enlarged graph is updated.

e To prevent an axis from rescaling when using one of the axis rescaling tools, set Rescale =
Fixed. If both X and Y axes are set to Fixed and you pick one of these axis rescaling tools, you
are reminded that X and Y axes are in "Manual Rescale mode" and are prompted to proceed.
Answering Yes will allow you to override and manually rescale in one or both dimensions. If you

need to block such manual overrides of Fixed axis scales, set @nrm = 1.

13.4Rotation of 3D openGL Graphs

This openGL toolbar that previously displayed when a 3D layer was selected, has been
replaced by layer-level Mini Toolbar buttons.

2,

When you click inside the layer of a 3D graph, the layer is selected and a Mini Toolbar appears. Click the
Rotate Mode button to enter rotation mode; then use one of the hotkey/mouse combinations listed below; or
drag the radial rotation handles in the graph with your mouse.

Hot Key Menu/Action Context

Rotate 3D graphs with the 3D floating buttons

Rotate the 3D graph around

X + Arrow key the X axis

With graph layer active and with Rotate Mode
Rotate the 3D graph around

Y + Arrow key the Y axis. button selected in the 3D floating button group.

Rotate the 3D graph around

Z + Arrow key the Z axis
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Hot Key Menu/Action Context

Q + Arrow key ngéi'the 3D graph in LI:L}-J'Z @ Rotate Mode
RN SFEAAE o

*

Rotate the 3D graph around

W + Arrow key any axes

Rotate 3D graphs using R key

Drag to rotate the 3D graph

R+ Mouse in an arbitrary direction.
Press "R" before pressing other keys.
R + Ctrl + Rotate the 3D graph around
Mouse/Arrow key the X axis. Hovering on a 3D graph while pressing "R"
changes the Pointer tool [:% toa O . Press Ctrl
R + Shift + Rotate the 3D graph around and/or Shift as needed, and rotate by (a) dragging
Mouse/Arrow key the Y axis. with your mouse or (b) pressing the arrow keys on

your keyboard.

R + Ctrl + Shift + Rotate the 3D graph around
Mouse/Arrow key the Z axis.

13.5Reading Coordinate Values and Distances

Origin provides several tools to aid in labeling and graphical exploration of your data plots. Most of these tools
are available from the Tools toolbar (View: Toolbars). There is a related tool -- Vertical Cursor -- available
from the Gadgets menu.

13.5.1Data Point Tooltip

Most 2D plot types, 3D Scatter, XYY Bar and XYZ Bar plots support a floating, customizable tooltip that reads
data point values when you hover on a data point.
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Tooltip Shortcut Menu

For tooltip customization and other options, right-click directly on the data point tooltip.

Goto Sheet
Show Data Plot Tooltip
= Pick Data Points...

Copy
Copy Coordinates

Row: Preferences...
Make: Infinit I}

Power: 38 4

0~60 mph:|12

Weight: 867

e Go to Sheet pops up the worksheet with source data highlighted.

e Show Data Plot Tooltip toggles display of a non-customizable data plot tooltip in place of the

customizable data point tooltip (see, below).

e Pick Data Points puts the cursor into data reading mode and opens a Pick Points dialog. Double-click

on points in the graph and when finished, click Done. This generates summary data (source, X-Y

coordinates, etc.) for your picked points.
e Copy copies data point tooltip information, including labels, to the Clipboard.

e Copy Coordinates copies only coordinate values. Right-click on a cell and Paste each value to a separate
cell within the row; or Paste (keep spaces) to paste values to the selected cell as a space-separated

string.

320


http://www.originlab.com/doc/Origin-Help/Picking-Points

Graphical Exploration of Data

e Preferences opens the Data Point Tooltip dialog allowing you to customize tooltip content and

formatting. Use documentation of the Data Info window, below, as a guide to configuring your tooltips.

The Data Point Tooltip dialog is a slightly simpler version of the Data Info window's preferences dialog (Data
Info Report Settings). See The Data Info Window for help with customizing your Data Point Tooltip.

|, By default, the Data Point Tooltip displays with a moderate degree of transparency. You
can affect tooltip transparency by changing the value of LabTalk System Variable
@TDT. For information on changing the value of a LabTalk System Variable, see this
FAQ.

13.5.2Data Plot Tooltip

There is a second tooltip that can be displayed in place of the Data Point Tooltip and this we refer to as the

Data Plot Tootip. This non-customizable tooltip displays the source book, worksheet and coordinate datasets,
on hover.

Go to Sheet

Goto Sheet

Show Data Point Tooltip Show Data Plot Tooltip
40 -

Pick Data Points... 1 Pick Data Points...
35 | @ 4 Copy
-
T 20 - ‘automobile.dat T 30 A Copy Coordinates
E automobile E
@ 25 ] ° X C.:IEDI"'IEF.. ) o 25 Preferences...
] ? F'Gas Milsage @
E 204 AEDIIIDN Da 2 = 20 4
& SRl @ PR @ a
@I IR I W Ll

o a0 @ @ o @0 @ o L

154 : R v Bl ' e 15 *

& 2 @ 2

> -1~ a3
&> 2 @29 a3 @
@ aa * @ @ @ @ L]
104 @ @ a ‘n 104 a ‘n
T T T T T T T 1 T T T T T T T 1
prin) 40 ] 80 100 120 140 160 180 20 40 [v] 80 100 130 140 1680 180
Power (kw) Power (kw)
Data Plot Tooltip Data Point Tooltip

The Data Point Tooltip displays by default. If you prefer to use the Data Plot Tooltip, right-click on the Data
Point Tooltip and choose to Show Data Plot Tooltip. Conversely, right-click on the Data Plot Tooltip and
choose Show Data Point Tooltip.

13.5.3Managing Tooltip Display

You can turn off display of data tooltips by activating the graph window, clicking on the View menu and
clearing the check mark beside Data Tooltips.

There is a second way to control tooltip display that is more complicated but allows a greater degree of control.
This entails changing the value of LabTalk system variables @PT and @PTI.

@PT=0; //Disable both data plot and data point tooltips

@PT=1; //Enable data plot tooltips for 2D graph
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@PT=2; //Enable data plot tooltips for 3D OpenGL graph (default)
@PT=3; //Enable data plot tooltips for both 2D graph and 3D OpenGL graph
@PTI=0; //Disable only data point tooltips

@PTI=1; //Enable data point tooltips (default)

13.5.4The Annotation Tool
The Annotation tool shares a "split-button” with the Distance Annotation and Angle Annotation tools.

EEF w* EEF Annotation

% Distance Annotation
@ Angle Annotation

Use the Annotation tool to label a data point. The tool works with Symbol/Line+Symbol and Column/Bar plots.
Choose from several standard data point labels or create your own custom label using LabTalk script.

To annotate a data point:

Ef

cursor and the Status Bar will display the current label form.

Cursor —_—

Eliéstum ,/,— Status Bar

| double click=add an annotation, TAB=toggle annotation label. current label :Custom {this point's x location is 5m]|

1. Click the Annotation button on the Tools toolbar and move the cursor to the desired data point. The

2. Use the TAB to toggle between the following standard annotation forms: (X coordinate value, Y coordinate
value); (X coordinate value, Y coordinate value)[index number]; X coordinate value; Y coordinate value;
index number (row number); or Custom (see Tutorial, next).

3. When you've selected your label form, double-click to add a label to the data point; or single-click on the

point and press Enter.

Tutorial: Customizing the Annotation String

The annotation string can be customized by combining literal characters with the X and
Y coordinate values:

1. Start with a graph of your data
2. Open the Script Window (Window:Script Window) and type the following
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command, then press Enter:

system.annotation.customlabel$="X value: $(x,.2), Y

value: $(y,*5)

x}

several times to cycle through the annotation choices until the custom string

3. Click the Annotation button , hover on your graph, then press the Tab key

format specified above is displayed in the Status Bar. The cursor will display the
word "Custom".

4. Start double-clicking on data points (or single-click and press Enter) to add the
custom annotation string. The X values will be displayed with two decimal places
and the Y values will be displayed with 5 significant digits, as specified by your

script.

Adjustments using the Pointer Tool:

e To move a label to another data point, click the Pointer tool , press the ALT key and drag the label.
e To re-position overlapping labels, drag the label. A leader line is automatically added.

e To copy a label to another data point, press CTRL + SHIFT and drag the label to a new data point.

Note: Please view more information on string formatting in the Programming help file:

Help: Programming: LabTalk > Language Reference > Object Reference > Alphabetical
Listing of Objects > String

13.5.5The Screen Reader Tool

The Screen Reader uses the Data Display window to report the XY(Z) coordinates of the cursor on the
graph page. Note that the Screen Reader is not reading data point coordinates; rather it is reading page
coordinates relative to the graph axes.

The Data Display window opens automatically when you select the Screen Reader tool from the Tools toolbar
(by default, the Data Display window is docked at the bottom of your Origin workspace).

Data Display
[Bookl]Sheetl!B[14]: X =14,% =14
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You can alter basic properties of the Data Display window by right-clicking on the window title bar or by right-
clicking inside the window.

To use the Screen Reader:

Click the Screen Reader button on the Tools toolbar. This opens the Data Display tool.
2. Click on a location in the graph page to read its X,Y, and Z coordinates (ternary and contour only).
Coordinate values show in the Data Display window.

3. To increase cross-hair size, press the space bar.

e

4. Click the Pointer button on the Tools toolbar to exit screen reading mode.

13.5.6The Data Reader Tool

E3
The Data Reader is used to read information associated with a data point in your plot. This could be
coordinate values or it could be more complex information including metadata or even images that relate to
the data point. The Data Reader works in concert with the customizable Data Info window.

The Data Reader tool is grouped with two related tools -- the Data Cursor and the Data Highlighter

ﬂ. Only one of these toolbar buttons will show at any given time. To select a hidden tool, click on the small
arrow to the right of the button and select a tool from the pop-up menu.

4
i

EH)

Fd Data Reader

éI} Data Cursor
{¥¥ Data Highlighter

=1

T

You can zoom into the graph while using the Data Reader. While the tool is active,
press CTRL and use your mouse wheel to zoom in or out on the page.

To use the Data Reader tool:

Ed
Click the Data Reader button on the Tools toolbar. This opens the Data Info window.
2. Click on a data point to read its X,Y (and Z, if they exist) coordinates. Coordinate values display in the

Data Info window (and Data Display window).
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3. To move the cross-hair to the next data point along the data plot, use the LEFT and RIGHT arrow keys or
click on the data point using your mouse. If you have multiple plots in a layer, use the UP and DOWN
arrow keys to move to a data point on another plot or use your mouse to click on the point.

4. To change the vertical and horizontal cross-hair size, click on a point and press the spacebar.

s

5. Click the Pointer button on the Tools toolbar or Esc key to exit the Data Reader tool.

There are a number of system variables that control Arrow key acceleration and data-
increment for the Data Reader. For more information, see the summary table in
Reading Coordinate Values in the Graph.

13.5.7The Data Cursor Tool

The Data Cursor tool -- grouped on the Tools toolbar with the Data Reader tool -- allows you to place one
or more cursors on a data plot and (using the Data Info window) read the cursor coordinates or measure the
X and Y distance between two cursors, or the distance between a cursor and a point selected with the Data
Reader.

Tutorial: Using the Cursor Tool to Measure Relative Distance
1. Import the file Samples\Spectroscopy\Sample Pulses.dat and create a line plot.

2. Click and select the Data Cursor button from the Tools toolbar.

o
Ed Data Reader

+
+ &b Data Cursor

+ L
2257 {3 Data Highlight%

+n.§vl

3. Double-click on one of the peaks or click once on a data point and press

ENTER, to add a cursor object.
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Repeat to place a second cursor object on another peak.

5. Double click in the Data Info. window to open the Data Info. Report Settings
dialog. If this window is not visible, select the View: Show Data Info menu item
to open the Data Info. window.

6. Switch to the Columns tab and then right-click in the gray area to the right of the
columns and choose Add Column.

7. In the new column that is added, click on the source row of new column, and select
Relative (Cursor2 - Cursorl) from the drop-down, and then press OK to close
the dialog.

8. Now you can drag and move the cursor objects and the third column in the Data

Info window will display the X and Y distances between the two cursors.
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13.5.8Distance Annotation Tool

The Distance Annotation tool @ shares a Tools toolbar "split-button” with the Annotation and Angle
Annotation tools.

EEf w EEf Annotation

{%' Distance Annotation

& angle Annotation

Use the Distance Annotation tool for drawing a scale-labeled, double-headed arrow between two points on a
2D graph.

— 30

78431 .
= 20

T,=20.0 4

- 10

.' - . - i >
t,=197.4 t, =082 t;=15264 'O

1. Click the Distance Annotation button ﬁ on the Tools toolbars.
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2. On a graph, place the crosshair on the starting point and drag with your mouse. Press Shift to force the
double-headed arrow to the horizontal or vertical
3. To fine-tune arrow placement, right-click on the drawn arrow and choose Properties. Use Dimensions

tab settings to control exact placement of object.
13.5.9Angle Annotation Tool

New Annotation Tool for Origin 2023: The Angle Annotation tool "-Q@_ shares a

Tools toolbar "split-button” with the Annotation and Distance Annotation tools.

EE[cl & EEF Annotation

‘f@ Distance Annotation
@ Angle Annotation

Use the Angle Annotation tool to draw and label an interior angle of < 180°.

2 i _
z/ _I——'___'_- -
_______ P L x A
13.5.10 The Data Highlighter Tool

The Data Highlighter is grouped on the Tools toolbar with the Data Reader and Data Cursor tools. Use the
Data Highlighter to pick one or more points in the your graph and simultaneously highlight the corresponding
data row in the worksheet. Unselected points are dimmed in the graph and the worksheet.
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2
3 |
= o4
m g
E £ ... & 1007
2 - 2 #= axt) | moen | con | oo | Em | Fom | 5012)
= ! 1 Long Name Yeal Make Power O~B0 mgh  Weighl Gas Mileage Engine Displacement
= » 104 Unils o s8C ] mpg o
T 3 Comments
* E3 Data Reader " -
] N P, ot Wi Ml
= = & Data Cursor 1 S "'d-"x
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While in Data Highlighter mode ...

® CTRL+click to select multiple points in the graph.

e Drag out a rectangle/freehand object on the graph to select multiple points.

e Use SPACE to toggle between rectangle and freehand selection modes.

e Use left/right arrow keys to highlight individual points in sequence by row index.

. In the worksheet (still in Highlight mode), CTRL+click multiple rows or SHIFT+select blocks of rows, and
highlight corresponding points in the graph.

® Press ESC to exit Highlight mode in the graph while keeping highlighted rows selected in the worksheet.

Some users did not know about ESC'ing (Highlight mode) in the graph window and
found that when trying to plot selected data in the worksheet, the Plot Setup dialog

; opened. So, for Origin 2023, you can skip pressing the ESC key by setting system
variable @QDHT=1. This will allow you to go directly to the worksheet and directly plot
the highlighted data.

Another option, is to use the graph window's Create Subset Sheet Mini Toolbar button
to output selected points to a new worksheet.

M
Create Subset Sheet

3| ®

LN

13.5.10.1 Collect Data from Multiple Sheets

When the Data Highlighter is active, a Mini Toolbar displays at the upper-right corner of the graph or
worksheet window. The toolbar has buttons to Create Subset Sheet, Delete Points, Mask/Unmask
Highlighted Points or Dimmed Points; plus a Highlighter Properties for configuring how to pick and
collate data from multiple worksheets.

=N EER T
M
Create Subset Sheet
| @
_qqm

LR
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How to Pick Points Plotted from Multiple Sheets

Use this method for picking a subset of points from a graph window containing plots from multiple worksheets,
and adding them to a single sheet:

1. Pick the Data Highlighter tool ﬂ then CTRL+click to select multiple points from a SINGLE plot; or
drag out a rectangle/freehand object on the graph to select multiple points (hint: press spacebar for ROI

shape).

iyl

2. When finished, click the Create Subset Sheet button on the Highlighter Mini Toolbar.

3. Click the Open Properties Dialog button ﬁ} on the Mini Toolbar and set Add Data Mode = Append

or Append with Gap.
4. Continue to pick points from other plots (worksheets) as in step 1, clicking the Create Subset Sheet

button each time you finish picking points from one of the plots.

|

5.  When you have finished, pick the Pointer tool

13.5.11 The Data Info Window

i}

Data Cursor tools . When you click on a plotted data point with one of these tools, the Data Info window
displays information about this particular data point.

H
The Data Info window opens when you choose either the Data Reader , the Annotation or the

Data Info - [SamplePulses]... + O X
[SamplePulses]"Sample Pulses"[51]

X 51
¥ 0.243015229

In its default configuration, the Data Info window reports only a column short name, plot designation (e.g.
"X™) and the XY coordinate values of a data point. However, the window is capable of displaying any of the
worksheet-contained information that is associated with a data point including metadata and images.

Data Info - [Book1]Sheet1!{A"Name",D"Mass")[1] x

Name Ethane Ethane is a chemical compound with chemical formula
Mass 007 C2ZHB. It is the only two-carbon alkane that is an aliphatic
CAS number 74840 H LA H hydrocarbon. At standard temperature and pressure
= 10 0 am Yy e\ "'/ ethane is a colorless, odorless gas.
Formula C2HB hr —C

R S
Appearance  [Colorless gas H™ [ 'ﬂ"‘H Ethane is isolated on an industrial scala from natural gas
Melting point -181.76 H and as a byproduct of petroleum refining. ts chief use is as
Boiling point -39 petrochemical feedstock for ethylene production

To customize the Data Info window:

1. Double-click on the Data Info window; or right-click and choose Preferences....
2. Use the controls in the Data Info Report Settings dialog box to customize the display of the Data Info

window:
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0K Cancel

The Data Info window can report any information in the source data worksheet. You are not limited to

displaying plotted data.

The window can display anything that can be inserted into the worksheet cell, including inserted graphs

and images.

The window can be customized with a Window Title and Report Title.

Window configurations can be saved as Themes, including Save to <Graph>, Save to <Layer> and

Save to <DataPlot>. This allows, for instance, all graph windows in your project or all graph layers in

your multi-panel graph to have a unique Data Info window. Saved Themes can loaded and applied to the

current Data Info window.
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If you save your Data Info Theme settings in the graph, then save the graph window
as a standalone graph window file (OGG, OGGU), know that the OGG/OGGU file travels
only with the data that are plotted in the graph. Therefore, if your Data Info Theme
uses data in other columns in your worksheet, the Data Info display will be incomplete
if, for instance, you reopen the window file in a new project.
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& I X OK Cancel

Save to <Graph>

Save to < Llayer>

Save to <DataPlot=

Save as < default>
Save

Save As..

For more information on customizing the Data Info window, see:

(] The Data Info Window.

e Tutorial: The Data Reader Tool (discussion on customizing the Data Info window).

13.5.12 Gadgets

Origin provides several Gadgets for data exploration and analysis. These gadgets are accessible from the
Gadgets menu when a graph window is active. Three gadgets in particular are suitable for data exploration:

e Vertical Cursor

e  Statistics

e  Cluster (OriginPro)

The Vertical Cursor gadget is especially useful for reading XY coordinate values for data points in stacked
panel plots or multi-plot graphs, where plots share a common X scale.

To open the Vertical Cursor:

1. With a graph window active, choose Gadgets: Vertical Cursor... from the main menu. This opens the

Vertical Cursor dialog box.

Using the controls in this Gadget's dialog box, you can add data labels to the graph, increase or decrease label
font size, hide labels, etc.
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When labeling plots with the Vertical Cursor, you can opt to combine separate data labels
into a single label by clicking the gadget's Show All Info in One Label button.
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The Statistics gadget returns basic statistics on data points falling inside a rectangular region-of-interest (ROI)
on the graph.

e Display basic statistics for data inside the ROI.
e Display mean and nth Standard Deviation lines inside the ROI.

e Update results dynamically as ROl is moved or resized.
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The Cluster gadget (available in OriginPro) provides the following features:

e Display basic statistics for data inside a region of interest (ROI).
e  Switch between rectangular or elliptical ROI.

® View statistics for points inside and outside of the ROI.

e  Edit, copy, mask, delete or group data points.

e Update results dynamically as ROI is moved/re-sized.

e  OQOutput results to a worksheet.

When you use the Cluster gadget to define a category (points within a ROl on a plot), you
can apply a differentiating color to points within the ROI.
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Note: To learn more about these gadgets, see:

Help: Origin: Origin Help > Gadgets
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13.6 Drawing Data Points on the Graph

This section discusses methods of graphically creating and modifying data plots.

This collection of tools and menu-driven operations is helpful in exploring certain "what if* scenarios, or to
quickly generate some data for purposes such as testing a fitting function. These procedures work only with 2D
scatter plots.

13.6.1Drawing a Data Point
1. Activate the graph window.
2. Click on the Draw Data Tool

3. A small dialog opens and displays the graph window short name. Click the Settings button to expand

the options as below:

B [Graph1]1 >
Current Count: O Total Count: 0

o T,
e A
Settings J Start
I

Add Data Mode: Start Mew Sheet ﬂ

Symbol Size: g

4. Set Add Data Mode to Append With Gap. Click the Start button, then hover on the graph and double-

click to set a data point. Continue clicking to set as many data points as you need.

5. Points drawn on a new graph window will be added to a new sheet in the GAData book. Click the

Worksheet button to pop-up this new Workbook.

@ GAData - Graph Annotator Data ™ EI@
A | B | cw | A
Long Mame Picked Points Lakel i

1 7.05027 | 2233022
2| 11.06874 2541808 . Current Count: 3 Total Count: &
3| 161987 28.16638 =TT -
4 — - ~.
5| 2118331 7.718549
5| 2239774 995756 Settings inish | Reset
7| 2755301 | 14 42487
g
9
10
11 [l

| «[» |\ Graph1-1 £ Graph2-1 f || < >
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6. Click Finish to end the point series.

O Each time you click Finish, a "--" separator is added to the worksheet columns to delineate a
group of XY coordinates (drawn points).
O Points drawn on a new graph window will be added to a new sheet in the GAData book. Each

graph window will have its own sheet in the workbook.
To label data points, go to the new Worksheet and enter label information in the Label column. Note that

Label column info can also be used to create plot groups by opening Plot Details and editing controls on

the Symbol tab (e.g. Symbol Color is indexed, by points, using the Label column data).
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13.6.2Moving or Deleting Data Points in the Graph

13.6.2.1 Moving a Data Point

You can move individual data points in the graph. Understand that when you do this, you are changing the plot
and the underlying data:

1. Select Data: Move Data Points (you'll be warned that you are about to change your data).

2. Click on the point you want to move (change X and Y coordinates). Place crosshairs on the point and drag;

or use the arrow keys.

3. Click the Pointer button D@ on the Tools toolbar or press ESC to exit the Move Data Points mode.

The data point is moved in the plot and the X and Y coordinates are changed in the worksheet cell.

Prior to Origin 2023, invoking the Move Data Points function caused scatter points
to revert to the template's default style. This is still the default behavior but now you
can press the TAB key to toggle between default symbol and customized symbol.
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13.6.2.2 Deleting a Data Point

You can delete individual data points from your graph:

1. Select Data: Remove Bad Data Points.
2. Double-click on the data point, or click to select the data point and press ENTER key.

3. Click Arrow button on Tools toolbar or press ESC key to exit the Remove Bad Data Points mode.

The data point is deleted from both the data plot and the worksheet cell. In the worksheet, only the data cell
for the Y value will be cleared and shown as missing value.

13.7 Topics for Further Reading

e  Gadgets

e The Data Analysis chapter of this User Guide

e The Cluster Gadget (OriginPro)

e The Vertical Cursor Gadget

(] The Digitizer
(] The Statistics Gadget

(] Masking Data
(] Data Filtering

. Drawing or Deleting Data Points in the Graph

. List of Origin Built-in Toolbars and Buttons
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14 Gadgets

Gadgets provide a quick and easy way to perform exploratory analysis on plotted data. The concept is simple:
While each Gadget has a specific purpose, each is built around applying a set of customizable analysis
operations to a range of plotted data defined by a movable, resizable, region-of-interest (ROI) object.

You can drag to modify the ROI at any time, then change your analysis options and recalculate results by
clicking the arrow button in the upper-right corner of the ROl and choosing one of the menu options. For
general access to Gadget formatting and analysis options, choose Preferences at the bottom of the context
menu. Use the Preferences Dialog Theme box to save a group of Gadget settings to a Theme file.

Multiple Gadgets are supported on a graph. You can distinguish ROIs by giving each a different color. Click on
an ROI object to bring it forward. When an ROI is selected, you can use the TAB key to switch the ROI.

//_ Gadgets perform some \

mathematical or statistical operation
on data within

Click for contextual menu

lew Output (0]

Mew Qutput for Entire Curve

] a moveable, resizeable,
N Region of Interest (RO)
£00 - b peakisifound
/¥
450 4
§E5E
400 4 §c 8
5
B =2
E 350 -
[ab]
g‘ T o=
3 zo0 § EE
= = RE
= H ER
250 A A
2 2R
200 A »L [ LI
150 4

H MNew Output for All Curves [N)
Mew Qutput for All Layers (L)
Subtract Baseline

Click to hide Tag Peaks

or show ROI Fit Peaks v
box({es) for _
analySi S or Switch to Peak Analyzer...

graphic export J update output

Go to Report Worksheet

Change Data b
Expand to Full Plot(s) Range
Fioe ROI Position

Save Theme...

! Save a5 <default>

34.0 35.0 35.5
Time {SEE]I Load Themea »
Preferences...
I L e
(" Click the ROl to add Click the ' Click to adjust
selection handles for to close the Gadget format
_ moving or resizing Gadget and output

|, Origin 2016 introduced add-on tools called Apps. Since being introduced, many new
exploratory and analysis-related tools have been added to OriginLab's File Exchange
and more tools are being released all the time. Please visit the File Exchange to review

available tools.

14.10rigin Gadgets

The Gadgets main menu is available when a graph window is active. There are 14 gadgets available in Origin.
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Cluster
Gadget

View statistics on points inside or outside of a graphically-defined region-of-interest
(rectangular, circular/elliptical or arbitrarily-shaped).

The Cluster Gadget gains some new functionality for Origin
2023:

®  You can now obtain "Z" stats for an XY scatter plot that is
color-mapped to a Z column of values.

®  Previously, Preferences had a Color Inner Points check
box. This is now changed to a Point Indicate Mode drop-
down that allows you to Color Inner Points, Fade-out

Outer or None.

]

B Script Window @ LabTalk

File(Text)] Edt Hide Tools

CB/1B8-2822 16:39:41>
sults
Result_ ¥
Inner Points
Input Legend Y

H Saa
Sum <¥>  3113.63636
Hean (¥> 6£.22727
Hedian C(¥> 622727
8D <¥>» 8.52473
Minimun ¢¥Y> 5.36364
Maximun €Y 7.89891
Sum <Z) 677.3661
Mean <Z> 1.35473
Median (> 1.3555

Differentiate

Calculate and plot the nth-order derivative of selected data.

Gadget
FFT Gadget View FFT spectrum of selected data.
Integration
Gadget Calculate the area under a curve, or between two curves.
Inte ZrE':It'on Calculate the 2D integration for a contour or image graph created from matrix or XYZ
i
ngget worksheet data.
Inge;gg:;te Perform linear, spline, b-spline or Akima spline interpolation of selected data.
Intersect ) ) _
Gadget Calculate the intersection points of two or more data plots.
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Perform linear, polynomial, or nonlinear fitting of selected data.

Quick Fit I
Gadget The Quick Fit Gadget supports custom labeling of the ROI
Box .
Quick Peaks Locate peaks, and compute area and other peak properties.
Gadget
Quick
Sigmoidal Fit Perform Sigmoidal fit of selected data.
Gadget
Rise Time ) ) ) )
Gadget Analyzes rise/fall time for the step-like signal.
Compute and display simple descriptive statistics of selected data on the graph.
Statistics |
Gadget The Statistics Gadget supports custom labeling of the ROI
Box .
Vertical . .
cursor Reaq coordinate values and label data plots across multiple graph layers that share the same
Gadget X axis.
Image/Conto . . )
ur Profile Analyze the image or contour from matrix data and generate profiles.
Curve
Translate Drag a curve in the vertical or horizontal direction, adjusting source data in the process.
Gadget

Note: To learn more about these gadgets, see:
Help: Origin: Origin Help > Gadgets

Help: Origin: Origin Help >=Matrixbooks Matrixsheets and Matrix Objects > Viewing and
Profiling Matrix Data

Tutorial: Using the Integrate Gadget to Output Results to a Worksheet

1. With a new workbook active, import the file Peaks on Exponential Baseline.dat

located in the Samples\Spectroscopy subfolder under the Origin installation folder.
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10.

Create a line plot of the data in column B.

With the graph active, go to the main menu and click Gadgets: Integrate....

In the dialog box that opens, click the Baseline tab and select Straight Line from
the Mode drop-down list.

Click the Output tab, and under the Output Quantities to node, select Append to
Worksheet and clear the other check boxes.

Expand the Quantities node, select None from the Dataset Identifier drop-down
list and enable Beginning X and Ending X.

Press OK to close the dialog box. The Region-of-Interest (ROI) rectangle object is
added to the graph.

Resize and move the ROI object to cover just the first peak in the data plot, then

press the arrow button E]located at the top-right of the ROI and select New Output;
or press ""O" on your keyboard. This will write the parameters for the first peak to a
worksheet.

Drag and move the ROI to cover the second peak, and repeat the steps above to

generate output for the second peak.

Press the arrow button E]again and this time select Go to Report Worksheet. A

worksheet with the integration results will open.



Gadgets

E] Grapht o) ® ==
1
Aren=-25 00687
5 - F'-.I‘-.HM-13213_E‘4
x| »
4 4
3 4
w2
=
Z
= 14
E
=L
|:|_
o
_1 -
-7 4
_3 T T T T T T L T 1
0 50 100 150 00 250 aon 350 400
Channel
Fa ___'\
EQHnttg o | = ER
Am[am|cm]nm]5m|rm:
Long Name | Beginning X Ending ¥ = Max Height  Mathematical Area  Centroid FyvHM | =
LInits
comments
1 77 120.25 1.814965 24 6575 10263673 1295943
2 253.25 2965  -1.80847 -26.8868Y | 278.32372 13.21364
3 -
= 1l
m"ﬁﬂl;’ || « n | » |r

|, Click the flyout menu button E] (top right of the ROI) and output results for all curves
in the current layer (New Output for all Curves (N)) or for all layers of the graph
page (New Output for All Layers (L)) or press the corresponding N or L hotkey. This
allows for batch analysis of multiple curves in a graph.

14.1.1Custom Label for ROl Box

Origin supports custom labeling of the ROl Box for the Quick Fit and Statistics gadgets. Custom labels are
preserved and updated when you select new output. Further, they can be saved as part of a Dialog Theme.
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14.1.2Custom Label and Button Size

Beginning with Origin 2023, you can customize the label font size and button size (both

14.1.2.1 Quick Fit Gadget

the close button and the menu flyout button):

Open \User Files\Origin.ini and search for the [Font] section.

1. Choose a gadget from the Gadgets: Quick Fit menu.
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Add two lines to this section as shown in the image below, then save the file with your
additions.
Any new Gadgets added to the window should use the new font and button size. Adjust
as needed.
Intercept = 116 60822, Slope = -3.84257
4 Xlntercept = 30.34644 \User Files\Origin.ini
] pd
', sl ([Font]
H umber Controls the font used fo

;FontNumber is 0 for disable
;1 for OEM FIXED FONT

;2 for ANSI FIXED FONT

;3 for ANSI VAR FONT

;4 for SYSTEM FONT

;5 for DEVICE DEFAULT_ FONT
;6 for SYSTEM FIXED FONT
FontNumber=0

GadgetButtonSize=20
GadgetLabelsSize=24

;MsgLog = Courier New
;output = Terminal




Gadgets

2. Open the gadget dialog (hint: if the ROl is already added, click the menu button E]and choose
Preferences).
Click the ROI Box tab and enable Custom Label.

Build your custom label using a mix of (a) literal text (b) escape sequences (e.g. Greek symbols or

superscripts) and (c) custom variables. Specify decimal places, etc. using Origin custom formats.

Dialog Label Custom Variable Example
Reduced Chi-Sqr chisgr Chi-Square \g(c)\+(2) = $(chisqr, .2)
R-Square cod R-Squared n+(2) = $(cod, .2)
Pearson's r r r=3$(r, .2)

Y Intercept intercept Y Intercept = $(intercept, .2)
Slope slope Slope = $(slope, .2)
X Intercept xintercept X Intercept = $(xintercept, .2)

14.1.2.2 Statistics Gadget

1. Choose Gadgets: Statistics: Open Dialog (hint: if the ROI is already added, click the menu button

E]and choose Preferences).
Click the Show on Center-Top of ROI Box tab and enable Custom Label.

Build your custom label using a mix of (a) literal text (b) escape sequences (e.g. Greek symbols or

superscripts) and (c) custom variables. Specify decimal places, etc. using Origin custom formats.

Dialog Label Custom Variable Example
N n Count = $(n)
Mean mean \g(m) = $(mean, *4)
SD sd \g(s) = $(sd, .2)
Minimum min Min = $(min, .2)
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Dialog Label Custom Variable Example
X at Minimum xminy X Min = $(xminy, .2)
Maximum max Max = $(max, .2)
X at Maximum xmaxy X max = $(xmaxy), .2)
Sum sum Sum = $(sum, .2)

14.2 Topics for Further Reading

(] Gadgets

e The Image/Contour Profile tool

e  Tutorial: Using Multiple Gadgets

e  Tutorials for Individual Gadgets

e Peak Analyzer

(] Digitizer
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15 Data Analysis

15.1 Introduction

Origin contains powerful tools for all of your data analysis needs, including curve fitting, statistics, peak
analysis and signal processing. Most of Origin's analysis tools can make use of a stored collection of settings --
something known as a Dialog Theme -- that makes repeat analyses a snap. Furthermore, the output from
one operation can become the input for another operation, thus allowing you to set up a chain of operations,
with results that update whenever there are changes to source data, as would happen when importing a series
of data files.

The following sections cover (1) selecting the data that you wish to analyze and (2) the Origin and OriginPro
tools available for analyzing that data. Please refer to the How to Handle Repetitive Tasks chapter of this User
Guide for more information on Analysis Templates, Dialog Themes and other time-saving features.

Apps are add-on tools that extend Origin's graphing and analysis capabilities. Many
analysis-related tools are available free-of-charge from OriginLab's File Exchange. To
find out more about Apps in Origin, see the Apps for Origin chapter of this User Guide.

15.2 Data Input

Origin's analysis tools will work with workbook, matrix and/or graph data, depending upon the tool. By default,
analyses will be on done on selected data (note that in the case of matrix data, "selected data" will the the
matrix sheet or matrix object, depending on the analysis). When working with worksheet or graph data, you
may want to restrict your analysis to a subset of the data -- say, a certain range of rows or columns in a
worksheet or a certain X range in a graph.

Data selections can be made before or after opening an analysis dialog. Most of Origin's X-Function based
analysis tools have a Input branch with a range selection control that you can use to interactively select your
data (as explained below).

15.2.1Selecting Data in the Worksheet

When you highlight a range of worksheet data, then open one of X-Function based dialog boxes -- that would
include nearly all of those that open from the Analysis or Statistics menus -- you will see your range
selection already entered into the dialog box Input branch. Most will find that selecting worksheet data prior
to opening an Analysis or Statistics dialog box, is the easiest way to specify which data you wish to analyze.
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I Signal Processing: smooth

Dialog Theme ﬂ
Description  Perfarm smoothing to iregular and noisy data.
M
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“
[ &wuto Preview [ Fresie ] [ k. l [ Cancel ] ﬂ

If you open one of the X-Function dialog boxes without pre-selecting your data, the first thing you should do
upon opening the dialog is to select data in Input branch:

Click to go to
worksheet data
selection mode

Multi-D ata Fit Mode
Input Data
= Range 1
*
Y
" Error

Rows

|ndependent Fit - Conzalidated Repart

All -

1. Click the range selection control next to Input (or Input Data). The dialog box will roll up.

2. Go to worksheet and highlight your worksheet data, then click the Elbutton at the right end of the

rolled up dialog box. The Input branch will now show the selected range.

Note that you do not have to select entire datasets (columns). You can select a portion of your worksheet data
and analyses will be confined to that selected subset of your data. Also if the analysis supports multiple
datasets, you could support multiple ranges such as multiple Y columns or Y ranges. If the analysis only
supports one dataset, you may be able to select multiple ranges in the worksheet, but only the 1st range will

be picked in the analysis.
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The Input Data branch has a hierarchical structure. If the analysis supports multiple datasets, you can
add multiple ranges under Input Data and they will show as Range 1, Range 2, etc., each with its

corresponding X, Y, Error and Row controls.

Mousing over each level will show a tooltip indicating where the data on that level is from (i.e. book, sheet

and column).

A Rows control under each range node lets you set range by row index or X value. If you want to apply
the same row range to all ranges under Input Data, click the arrow button to the right of the range node
and choose Apply Row Range to All.

Depending on where you are in the Input Data hierarchy, the range selection button may have some
limitations ( e.g. if you click range selection control next to Y, though you could select multiple columns in
a worksheet, only the 1st column is accepted).

Clicking the arrow button to the right of the range selection control will show more selection options,
including individual worksheet columns that can be quickly added to your data selection.

Depending on which level you are in, the selection options when clicking the arrow button may vary. For
instance, clicking the "arrow" button next to Input Data and clicking the Select Columns... menu item,

will open the Column Browser allowing you to select multiple columns from different worksheets.
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Click for data selection options

Independent Fit - Conzolidated R epaort

BEY]) : Decay 1
) : Decay 2
DY) : Decay 3

| 3 E] Add

All Columns

r Reset
-
Select from Warksheet

‘ Select Columns... j

1. Use the List Datasets drop-down list to filter which sheets you want to pick from. The top panel list can

be sorted by clicking any of the column headings, making it easy to select, for example, all columns that
share the same LName or Comments.

Then click the Add button to add the column to your selection list in bottom panel.

To modify the data input range of any dataset, click the range button to the right of any dataset added to

the bottom panel and edit the From and To values.

15.2.2Selecting Data in the Graph

When a graph window is active and you select one of the Analysis menu tools, the default behavior is for the
analysis dialog box to open showing the selected range of the active dataset as your Input Data (note that
analysis dialogs include an Input Data node that allows adjustments -- adding more datasets with the
interactive range selector button, changing a data range, etc.).

15.2.2.1 The Data List and the Active Data Plot

The active data plot is the one that shows in the data list (bottom of the Data menu) with a check mark next
to it. If the active graph layer contains a plot group, the default behavior is to make the first plot in the group
the active data plot (note the "gl1" beside each range in the following image, indicating that all are members of
plot group 1). You can activate a different plot by clicking on another of the data plots listed at the bottom of
the Data menu. Subsequently, when you open an analysis dialog box, this newly-selected plot will be listed as
your input data.
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Data | Analysis Gadgets Tools  Format  Window  Help

Set Display Range

Reset to Full Range

M| Mark Data Range Ctrl+ Al -+
Analysis Markers »
Lock Position r

Mask Data Points
Mowe Data Points

Rernove Bad Data Points

1 g1 [Waterfall2 dat Jwaterfall2! &0, By [1*:1000%]
2 gl [Waterfallz2 . dat Jwaterfall2! A, COv) [1%:1000*] %
3 gl [Waterfall2 dat Jwaterfall2! A0, D) [1*:1000%]

However, for most purposes, you can ignore the data list and select your plot data directly in the graph
window or using the Object Manager:

e |f your data plots are part of a plot group, select the entire group by pressing SHIFT + clicking on a plot.
Alternately, click on the group icon in the Object Manager. Either will set Input Range to all plots in the
group.

e To select just a single plot -- whether it be an independent plot or part of a group -- click once on the plot.
Alternately, click on the plot icon in the Object Manager. Either will set Input Range to only the selected

plot.

Object Manager 3 X Object Manager w 3 X

== Graph2 = Graph2
= =] Layerl =l [+ Layerl
=k gl

KIRIE]
(XN |
0O m

Select Plot Group Select Single Plot
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P You can also indicate the active dataset by placing a red box around the plot's legend
' entry. In the case of grouped plots, the red box shows on the first plot in the group.

To turn this feature on or off:

®  Click on your graph window, select Format: Page..., click on the Legends/Titles

tab and enable or clear the Indicate Active Dataset box.

e Select the graph legend, then right-click on it and choose Legend, then

select/deselect the Indicate Active Dataset menu entry.

e  Select the graph legend, then right-click on it and choose Legend: Update

Legend and enable or clear the Indicate Active Dataset box.

15.2.2.2 Customizing X scale range using Analysis Dialog "Rows" controls

You can adjust data range using the Rows controls under the Input Data branch of most analysis dialogs. If
you have an analysis dialog box open:

Click on Input Data branch to expand.
2. Change the Rows drop-down list to By Row or By X and enter your From and To values. Note that each

Range N will have its own Rows controls.

Multi-Data Fit Mode |Independent Fit - Consolidated Report -

El Input Data | [Graph2]1!(1"B"[10:201,2"C",3"D") BAC
| B Range 1 | [Graph2]1!1"B"[10:20] |=,é ,
X | [Book1]Sheet1!A EIC
¥ | [Book1]Sheet1!B FIC
vEror 4| =
H Rows | By Row )

From | 10

To |20
| @ Range2|  [[Graph2]12"c” G
| @ Range3|  [[Graph2]113'D" BIC

15.2.2.3 Customizing X scale range using Axis Scale Mini Dialog

Before opening an analysis dialog...

1. Click on an axis then click the Mini Toolbar Axis Scale button to open the Axis Scale dialog box.
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6

Adjust the X axis scale to your desired range.

Now open your analysis dialog (e.g. Linear Fit) and click the arrow button beside the Input Data box and

select Use X Scale Range from the context menu:

ik BT Auis Scale x
14
- Axis Haorizantal st
« || Bl Horizontal Set X axis
i - . 0 Log B scale
B From [2 |
@ L] . e ] e
a4 P < B - - To 8 |
] 7
44 g ’I Tick Increment | 2
- 4
I P :
i [i4 Mere.. appty [ ok || Cancal
2 H H B
ol |
[ & 2 \ :
L | LinearFit (N 7 =
Dizlog Theme -« \\ »
~
Perform Linear Fitting \\
~
Recalculate  |Manual -
= — S
Input  Fit Control Quantities Residual &nal]!s.ﬂ \q-uh:ut Fitted Curves Plot  Find XY  Residual Plots
o
-~ ~
Multi-Data Fit Mode  Independent Fit - Consolidated Report - L
- 5
= input Data I [Graph2]111°B"[x2:8] S FE Add Flot{1)*: B 9
© Range 1 {[Graph2]1!1"B"[x2:8] I | aodail piots in active page
X |[Lim!arFi‘l]"Linzal Fit"lA | Bl e Add all plots in active layer
Y |[LinearFit]"Lintat Fit"!B | =l » Reset
¥ Error | | » Reselect All Data from Graph
| Use ¥ Scale Range
B Rrows ByX L 6 -.f‘.. s I & I
- Select Columns...
Fram |2 T T ——
T |8 |

As you can see, the customized scale range of X axis on the graph has been used to specify the input data
range for your analysis (Rows = By X).

15.2.2.4 Selecting data graphically using The Regional Data Selector

You can graphically select a range of data using the Regional Data Selector tool:
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+*
1. With a graph window active, click and hold on the Regional Data Selector button e on the Tools

toolbar, and then choose either the Selection on Active Plot or Selection on All Plots button.

2. Drag out a rectangle or freehand object to select an area of the plot(s). Note that you can press Space to

+

2
toggle between rectangle and freehand modes .

5| £ Selection on Active Plot
+
p-3 fﬁ Selection on All Plats

When you make your selection, Data Markers are placed on the graph to mark the selected range(s). You can
now use Origin's analysis tools (e.g., Linear Fit) to perform an analysis on the selection, but note that some
analysis dialog boxes do not work on multiple data ranges. The smoothing dialog box, for example, (Analysis:
Signal Processing: Smooth...) will only smooth data in the active dataset or a single, selected plot.

| There is a new Mini Toolbar for controlling X scale range when using Data Markers.
; Click on a Data Marker and use the buttons to Set Display Range or Reset to Full

Range.
|
|::‘ "I I" Reset To Full Range
== :!
_iw
!ﬂ@uﬁ
%&mu“

Tutorial: Linear Regression on Partial X Range

1. Import the file \Samples\Curve Fitting\Exponential Decay.dat into a new

workbook.
Select all Y columns and create a line plot.

3. Click and hold the Regional Data Selector button on the Tools toolbar, and then

- %
choose the Selection on All Plots button .
4. Drag out a rectangle to select the tail-end of the three curves between values of
approximately 0.6 and 1.0 along the X axis.
Use the Analysis:Fitting:Linear Fit menu to open the Linear Fit dialog.
Input Data branch is filled with three ranges. Mouse over Input Data branch will
show tooltip which shows 1X,1Y, ...3X and 3Y.

7. If you want to change the data selection, click the arrow button in Input Data
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and choose Reselect All Data from Graph. The dialog will roll up. Drag out a

rectangle in graph again to make your selection and then click the EI button at
the right end of the rolled up dialog box. The new data selection will show in Input
Data branch.

8. Accept default Linear Fit settings and press OK to close the dialog. Linear fitting

will be performed on all three curves over the selected range.

e e e
1
il
— Decay 1
200 Decay 2
\ Decay 3
| Fit Cyrve of Decay 1
250 4 Fit Curve of Decay 2
| —— Fit Curve of Decay 3
@ P00 - I'-_
=
2
= \
E 150 - . )
100 .'II W, L -:-u\_r-ﬂ_.'.‘,.,_,—_'_,_H_,‘__'.FH_.:
50 \ ) e -
o b i""‘ﬁ" Y
0 T T T T T T T T T T |r 1
0.0 0.2 04 06 08 1.0

Time {sec)

In addition to the data selection and data masking methods discussed in this

section, Origin offers data filtering and data reduction tools. Please visit the linked
pages for details.

15.2.2.5 Editing a Data Marker

To edit a Data Marker:

To modify a data range, right-click a data marker and choose Edit; or double-click on the data marker.
The red marker changes to a dark color with arrows on both ends and the cursor changes into a cross-hair.
Drag the beginning or ending marker to a new position or use one of the keyboard shortcuts listed below

and modify the data range. To escape edit mode, double-click on the marker or press the Enter key.

There are other options when right-clicking the data marker such as Delete Marker, Delete Data, etc..
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Edit %
Move to Begin/End
Move to Begin

Mowve to End
Delete Data

Delete Marker Delete

Note: If you have used the Regional Data Selector tool to place markers on multiple plots (Selection
on All Plots), be aware that moving markers will affect the data range of the active plot only; the ranges
of other selected plots will not follow that of the active plot. This is a limitation of the Regional Data
Selector.

Alternately, you can use these keyboard shortcuts to select and edit data markers:

1. Select data markers using these keys ...

Hot Key Action
S Select the first pair of data markers on the graph (those marked with "1").
Tab Select the next pair of data markers (not in edit mode) or the other data

marker of the pair (in marker edit mode).

Home Return to the first data marker.
End Go to the last data marker.
2. ... then activate and edit the data marker using these key combinations:
Hot Key Action
Enter Activate the_: selected data marker for editing. (Press Enter again to exit
data selection mode.)
Arrow Move the active data marker exactly one data point.
Ctrl/Shift + Arrow Move the active data marker multiple data points.
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Hot Key Action

Delete Delete the active data marker.

15.2.2.6 Difference between Data Markers and Analysis Markers

e Data Markers define a sub-range that you select using the Data Selector tool.

If you want to remove the data markers from a graph, you can select Data: Clear Data Markers from

[

the main menu, or click the Clear Data Markers button on the Markers and Locks toolbar.

Graph1 |Z|b__<|

io -

T n

1 | |
a4

m | " u -
[ am ]
[ |
4 ]
Data Markers

24 n u

T =i
o4 [ |

T T T
[x] 2 [} 5] =] [x] 12

® When the analysis routine is completed, Data Markers are replaced with Analysis Markers. By default,
Analysis Markers will not show if the analysis is done on the entire dataset. If performed on a subrange,
Analysis Markers will show at the beginning and end of that subrange. To modify the data range and rerun
your analysis, you must right-click an analysis marker and choose Change Parameters.... Change the

Input Data range and rerun the analysis.
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= Graph1

B
Line ar Fit of Linear Fit B

Analysis Markers _/_/

[
-

Note:

If you set Recalculate to None in the analysis dialog box, then no analysis markers are

generated.

Data markers and analysis markers are not exported when you choose File: Export Graphs.
To select the exact same range again for another analysis, click the green lock and choose Plot
Input Data with Data Markers to create a new graph and do analysis on it.

There is a Markers and Locks toolbar to control analysis markers and locks, such as Marker

Hide Show to toggle analysis markers on or off, etc. There is also an Analysis Markers
submenu, available from the Data menu; or when you right-click on an analysis marker or green

lock and choose Analysis Markers.

15.2.2.7 The Pick Points Tool

You can also pick the data points in the graph using the Pick Data Points tool. This works best for scatter or
line + symbol plots of smaller datasets.

1.
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Select Data: Pick Data Points. The Pick Points dialog will pop up.

With the square cross-hair, you can read the coordinate of current data points in the Pick Points
dialog (also the Data Source). Double-click on the point you want to pick until the cross-hair cursor

became round, the actual X&Y values will be recorded and the total number of picked points will be

counted up.
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i '

7 Pick Points 2

Total Picked: £
X: 29 ¥: 06815388471
Data Source: [Bcokl]Shest1[25]

e Cone Cancel

3. Once you finished the picking, click the Done button to output the results to a new workbook.

15.2.2.8 The Data Highlighter

In some cases, the Data Highlighter on the Tools toolbar, can be useful for selecting some portion of your
data for further analysis. For instance, you have a 2D scatter plot and you are interested in data points in a
particular region of the graph.

Click the the Data Highlighter button ﬂ on the Tools toolbar.

2. Highlight the desired group of data points. Note that you can toggle between rectangular and freehand
selection modes by pressing the spacebar while the Highlighter is active. Selection points in the graph
simultaneously highlights selected rows in the source worksheet.

3. Go the source worksheet, right-click on it and choose Create Subset Sheet.

You now have a secondary worksheet named as wcopyN, that contains only the data points that you selected
in the graph.

For more information, see The Data Highlighter Tool.

15.3Data Output

Origin's analysis tools typically have an Output branch (the exact name varies by tool), in which you can
specify the output that you wish to generate and where you would like that output to go. This happens to be
the output branch of the Integration tool.

|| [+ Inpy_t fl sad-Ul4-U4H A Time”, L IMagnetic Field”) I_; F |
Output Quantities
Bl [ Integral Curve Data || [<input>,<new>) | % | »
= Range 1 || (=input> <new>) | | b
X [ <input> B
¥ [ <new> EE
Integration Result " [<input>]<new: | B3 [<input>]<input>: Input Book, Input Sheet
Plot Integral Curve None v <news>: New Sheet
[=new=>]<new:>: Mew Book
Related Apps | oK | Cancel Custom... [:}

Output can be directed to various places -- a range of worksheet cells or columns, or possibly to a worksheet,
a workbook, a matrixsheet, or a graph layer. Output options depend upon the target object as well as the type
of window that was active when the tool was opened. You can determine your output target by:
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e  Typing directly in the associated text box, using a standard range notation

®  Selecting data with the interactive range control.

e  Type or select your target using a set of predefined range strings.

This being an introductory manual, we will stick with the simplest to use -- using predefined range strings.
For information on other options, follow the links above.

15.3.1Specifying Output Using Range Strings

Referring to the image above, note that range strings are enclosed by < > characters. Valid strings will differ
from dialog to dialog (e.g. <source> is available from the Book list under the Output Fitted Values To
branch of the Fit Linear dialog, but it is not used to specify Output in the Smooth dialog).

The most common strings:

® <none>: Generate no output.
e <new=>: Create a new Origin object -- a column, a worksheet, a graph, etc.

e <input>: Use the input object for output.

You can type these strings directly into the edit box but the easiest thing to do is to just select them from the
flyout menu (options will vary by tool). Alternately, you can click the Custom button and open the Range
String Builder. Despite the intimidating name, it is just a way to step through the process of specifying your
output target. For more information on range strings and Range String Builder, see Qutput Results in the
Origin Help file.

15.4 Data Masking

Masking is another technique that you can use when you want to analyze only a subset of your data, or
when you have spurious data points that you do not want included in your analysis. Masking or unmasking
data will trigger recalculation of linked operations.

®  You can mask data points in both worksheets and graphs.

e When data exist in both the worksheet and the graph, masking data in one will mask (and mark) the

corresponding data in the other.
e  Mask toolbar buttons work on both graphs and worksheets.
e Tools toolbar buttons work on graphs.
®  When data are selected in the worksheet, a Mini Toolbar Mask Data button becomes available.

e  Additionally, you can mask worksheet data by mathematical condition.

The active worksheet's Masked and/or Unmasked Data Count can be reported to the
Status Bar.
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15.4.1Masking with the Mask Toolbar (worksheet, graph)

These toolbar buttons are used to mask and manipulate masking of selected data. Note that this includes
graphs, once data have been selected (see the next section on Tools toolbar buttons for graph selection).

. Toolbar
Action Button Shortcut Command Notes

Mask the selected data range.
Mask data El Mask: Range Masked data will display in the mask
color.

Unmask the selected data range.
Unmasked points are included in
analysis operations and plot
"normally".

Unmask data m Mask: Clear Range

Swap masked and unmasked points

Swap mask il Mask: Swap in the active dataset.

Change the mask color of the

Change mask p‘-ﬂ
masked data range.

Mask: Change Color
color

Toggle display of masked points ON
Mask: Hide and OFF on-screen, and in printed
and exported graphs.

Hide/Show ...I
masked points 3

Toggle the mask ON or OFF for all

masked data in the worksheet.
Disable masking :::I Mask: Disable Masking When toggled OFF, all data points
are analyzed and included in printed
and exported graphs.

15.4.2Masking with the Tools Toolbar (graph)

I There was a change made to the default masking mode, starting with Origin 2021:

e Default is changed from mask by row index number to mask by

rectangular region.

e  Otherwise, behavior remains as before: toggle between masking modes

(see next) by pressing Spacebar.

e Use system variable @MTI=1 (persistent) to revert to mask by row

index as default.
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To mask points, click on the graph window to activate it:

1. Choose Data: Mask Data Points from the main menu or click the Mask Points on Active Plot button or
Mask Points on All Plots button on the Tools toolbar, then hover on the graph.

2. To mask a single point, double click on the point. To mask a region of points, press the Space bar to
toggle among masking by row index number, by rectangular region or by freehand region (differences
explained below), then drag out a region.

3. Once data are masked in the graph, you can use the Mask toolbar buttons, described above.

Mask Points Mask Points on All

. Plots of Active Purpose
on Active Plot Layer
e s Mask data points by rectangular region. Only the data points inside
the rectangle that you drag out, will be masked.
h‘ } Mask data points by freehand region. Only the data points inside
the region that you drag out, will be masked.
Mask data points by row index number. All data points between the
%@| EE]’E lowest and highest selected index numbers are masked regardless

of whether they lie inside your rectangle.

To remove the mask from data points in the graph window:

.* o
1. Choose either the Unmask Points on the Active Plot ﬂ tool or the Unmask Points on All Plots of

-
Active Layer “é‘ tool on the Tools toolbar.

2. Use the space bar, as needed, to choose points by index, rectangular region or by freehand region, then

b

drag to unmask your data points. The tool will be active until press ESC or click the Pointer tool.

15.4.3Mask Mini Toolbar Button (worksheet)

When worksheet data are selected -- cells or entire columns -- A Mini Toolbar Mask Data button
becomes available. The button works as a toggle to mask or unmask data within the selection.

15.4.4Mask Cells by Condition (worksheet)

There is a tool for masking worksheet data values by condition (e.g. <= 0).

1. With the data selected (cells or one or more columns), choose Column: Mask Cells by Condition. This
opens the colmask dialog.

2. Choose your Condition and Value, plus other options as needed and click OK.
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15.5Mathematics

Origin provides a number of mathematics tools to perform basic calculations, interpolation, and area or volume
calculations.

For Origin 2023, there is a change to normalized (X-Functions = rnormalize,
cnormalize, vnormalize) and interpolated (X-Functions = interpl, interpltrace,
1= interlxy) output:

e label row Method is created to hold key methods information (system variable
@CCL = 1).
e lLong Name and Units from source sheet used in output sheet (previously, output

might have been tagged with generic information about the analysis operation).

15.5.1Basic Math

For Origin 2023, the rnormalize X-Function dialog (Analysis: Mathematics:
"ME Normalize Columns when the worksheet is active) gains a Group control for
[T specifying one or more "group" columns for normalizing values within the group(s).

Tool Name Description Menu Entry

e  Simple Column
Math/Simple Curve

Math

. (] Perform basic calculations
(] Normalize

on worksheet columns or Analysis:Mathematics

Columns/Curves
XY data plots (workbook, graph)

®  Average Multiple

Curves

(] Differentiate

e  Perform element-wise

e  Simple Math is: i
arithmetic on two matrices. AnaIYSIS'Mathematlcs
(matrix)

e  Subtract Reference e  Subtract one dataset from
Analysis:Data Manipulation

5 h
ata another (workbook, graph)
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Tool Name

Description

Menu Entry

e  Subtract Straight

Line

Subtract a straight line
defined graphically by
clicking in the graph.

Analysis:Data Manipulation
(graph)

e  Subtract

Subtract matrices in sheet

by another matrix.

Analysis:Mathematics
(matrix)

e  Vertical Translate

(] Horizontal Translate

Use a Gadget to
graphically translate
curve(s) in vertical or

horizontal.

Analysis:Data Manipulation
(graph)

e Differentiate Gadget

Perform differentiation
over a region of interest in

a graph

Gadgets:Differentiate...
(graph)

. Intersect Gadget

Calculate the intersection
points of two or more data

plots.

Gadgets:Intersect... (graph)

e  Vertical Cursor

Read and tag X, Y
coordinate values for data
plots across multiple
graphs that share the

same X axis.

Gadgets:Vertical Cursor...
(graph)

(] Set Column Values

Use formulae to
set/transform worksheet

column values

Analysis:Mathematics
(workbook)

(] Inverse

Generate pseudo inverse of

a matrix

Analysis:Mathematics
(matrix)
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Tool Name

Description

Menu Entry

e Median Filter
®  Special Filter

L] Custom Filter

Apply
median/special/custom

filter to a matrix

Analysis:Mathematics
(matrix)

15.5.2Interpolation

Tool Name

Description

Menu Entry

e Interpolate Gadget

e  Perform interpolation

over a region of

interest

Gadgets:Interpolate...
(graph)

Graph)

Graph)

. Interpolate/Extrapolate

® XYZ Trace Interpolation(3D

®  Trace Interpolation(2D

(] Perform

interpolation/extrapola

tion on a group of XY

data.

e  Perform periodic

interpolation on XYZ

worksheet data

e  Perform interpolation

on cycle or periodic

curves

Analysis:Mathematics
(workbook, graph)
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Tool Name

Description

Menu Entry

. Interpolate/Extrapolate Y

from X

e 3D Interpolation

e  Perform
interpolation/extrapola
tion on a group of XY
data to find Y at given

X values.

e  Perform 2D
interpolation on a
group of XYZ data to
find Z at given XY
values w/ choice of 8
methods.

e  Perform interpolation
with a 3D function on

XYZ dataset.

Analysis:Mathematics
(workbook)

e 2D Interpolate/Extrapolate

e  Perform 2D
interpolation/extrapola

tion for a matrix

Analysis:Mathematics
(matrix, graph from
matrix)

15.5.3Area/Volume Calculation

Tool Name

Description

Menu Entry

. Integrate Gadget

Perform integration over a
region of interest in a 2D

Graph

Gadgets:Integrate... (graph)

e 2D Integrate Gadget

Calculate max height,
volume, FWHM (X,Y) for a
contour or image graph
created from matrix or XYZ
worksheet data (OriginPro
Only).

Gadgets:2D Integrate...
(graph)
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Tool Name

Description

Menu Entry

. Integrate(2D Graph)

e  Polygon Area(2D
Graph)
®  XYZ Surface Area

(3D Graph)

Perform integration on
input data

Calculate the area of
enclosed plot regions
Calculate the area of the

XYZ surface

Analysis:Mathematics
(workbook, graph)

e 2D Volume Integrate

. Matrix Surface Area

Calculate the volume
beneath the matrix surface
from zero plane

Calculate the area of the

matrix surface

Analysis:Mathematics: 2D
Volume Integrate (matrix, 3D
graph from matrix)

or

Analysis:Mathematics:
Matrix Surface Area (matrix,
3D graph from matrix)

15.6Curve Fitting

In addition to Origin's built-in curve-fitting tools, there are a number of add-on Apps designed for various
curve-fitting operations that are available for free from the OriginLab File Exchange. To find and install these
Apps click Analysis: Fitting: Find Apps. The App Center will open, displaying only fitting-related Apps.

Browse available Apps and click the Download and Install button

to install an App.

You can use named range values as X "From" and "To" values, initial parameter values,

lower and upper bounds and fixed parameter values, in the linear fit, nonlinear fit
(NLFit), polynomial fit and multiple linear regression dialog boxes.

15.6.1Linear and Polynomial Fit

Most curve fitting and peak finding analyses add an optional Result Table with equation,

weighting, slope, intercept, etc., to the active graph. There is a Mini Toolbar button for
adjusting displayed digits in the Result Table.
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Linear and polynomial fitting can be performed on worksheet data or data plots in a graph. Linear Fit of
Matrix Stack is performed on a series of matrix objects.

Tool Name

Menu Entry

(] Linear Fit

or

Analysis:Fitting:Linear Fit

Gadgets:Quick Fit (graph)

(] Fit Linear with X Error

Analysis:Fitting:Fit Linear with X Error

e  Multiple Linear Regression

Analysis:Fitting:Multiple Linear Regression

e  Polynomial Regression

or

Analysis:Fitting:Polynomial Fit

Gadgets:Quick Fit (graph)

e  Perform a linear fit on a series of

coordinates.

matrix objects for each pair of XY

Analysis: Linear Fit of Matrix Stack (matrix)

15.6.2Nonlinear Curve Fit

You can perform nonlinear curve fitting using one of many built-in fitting functions, or you can create a user-
defined fitting function. OriginPro supports implicit function fitting, surface fitting, and fit comparison. Some
tools are available only in OriginPro.
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The table below summarizes available nonlinear curve fitting tools:

Data Analysis

Tool Name

Features

Menu Entry

Quick Fit Gadget

Fit a region of interest in a
graph interactively

Fit with built-in or user-
defined fitting functions

Fit one or multiple datasets
Choose from a number of
pre-defined analyses (incl.
Linear, Cubic, Peak and

Sigmoidal).

Gadgets:Quick Fit (graph)
or

Gadgets:Quick Sigmoidal
Fit (graph)

Nonlinear Curve

Fitting

Fit with built-in or user-

defined fitting functions
Fit one or multiple datasets

Compare fit, multiple

parameter sets

Global fit with parameter

sharing

Global fit, parameter
sharing with multiple
functions

Fit with replicas

Advanced options including
bounds, constraints, fit

control

Analysis:Fitting:Nonlinear
Curve Fit (workbook, graph)

Implicit Curve Fitting

Fit with implicit functions

Orthogonal Distance
Regression (ODR)

algorithm

Analysis:Fitting:Nonlinear
Implicit Curve Fit (workbook,
graph)

Surface Fit

Fit data from a matrix or

worksheet XYZ columns

Analysis:Fitting:Nonlinear
Surface Fit (workbook, graph)
or

Analysis:Nonlinear Matrix
Fit (matrix)
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Tool Name

Features

Menu Entry

e  Fitting Function

Builder

Create or edit user-defined

fitting functions

Tools:Fitting Function
Builder

e  Fitting Function

Organizer

Manage fitting functions by
categories
Move or share functions

between categories

Tools:Fitting Function
Organizer

e  Fitting Function

Library App

Download fitting functions
from originlab.com
Request or Share a

Function with OriginLab

Click the Fitting Function
Library icon in the Apps
Gallery

e Simulate

Simulate a curve from a

given function

Simulate a surface from a

given function

Analysis:Fitting:Simulate
Curve

or
Analysis:Fitting:Simulate
Surface

e Fit Comparison

Compare fit results from
two datasets using one
function function
Compare fitting results for
one dataset using two

fitting functions

Analysis:Fitting:Compare
Datasets

or
Analysis:Fitting:Compare
Models (workbook, graph)

(] Fit and Rank

Functions

Compatre fit results of two
or more functions for a

single dataset

Analysis:Fitting:Rank
Models (workbook, graph)

User Defined fitting functions support an EMF or SVG image of the Formula (Equation)

to display in lower panel of Nonlinear Curve Fitter (NLFit) or Fitting Function

Organizer.
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To add an EMF or SVG image to your user-defined function:

1. Create the EMF/SVG using an equation editor (hint: Origin's LaTeX App can convert a
user-defined fitting function into a LaTeX equation object).

2. Name the EMG/SVG image just as you named the user-defined fitting function (e.g.
MyFunction.SVG), making sure to add the correct file type, and place the image in

\User Files\fitfunc.

15.7 Peak Analysis

Origin provides several tools for peak analysis. With these tools, you can define and subtract baselines, find
peaks, integrate peaks, and fit peaks. Some tools are available only in OriginPro.

Note that a number of free Apps designed for peak analysis are available from the OriginLab File Exchange. To
find and install these Apps click Analysis: Peaks and Baseline: Find Apps. The App Center will open,
displaying only peak-fitting related Apps. Browse available Apps and click the Download and Install button

to install an App.
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The table below summarizes various built-in tools available for peak analysis:

Tool Name

Features

Menu Entry

®  Quick Peaks Gadget

Perform peak analysis over

a region of interest
Create baseline
Subtract baseline
Find peaks
Integrate peaks

Fit peaks

Gadget:Quick Peaks (graph)

e  Multiple Peak Fit

Pick multiple peaks

Fit peaks

Analysis:Peaks and
Baseline:Multiple Peak Fit
(graph, workbook)

e Peak Analyzer

Create baseline
Subtract baseline
Find peaks
Integrate peaks

Fit multi-peak datasets

Fit baseline
Find hidden peaks

Compute many peak

characteristics

Analysis:Peaks and
Baseline:Peak Analyzer
(graph, workbook)

e Batch Peak Analysis

Use a theme file created
using Peak Analyzer tool
Perform batch peak
analysis on multiple

datasets

Analysis:Peaks and
Baseline:Batch Peak
Analysis Using Theme
(graph, workbook)

15.8Signal Processing

Origin provides signal processing tools for many tasks, including producing signal transforms,
smoothing/filtering, and correlation on 1D and 2D signals. Advanced tools are available in OriginPro.

You may refer to the tables below for the signal processing tools and their menu entry.
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15.8.1Signal Transforms

Tools

Menu Entry

e FFT Gadget

Gadgets:FFT... (graph)

e  Fast Fourier Transform (FFT)

. Inverse Fast Fourier Transform

Analysis:Signal Processing:FFT

(IFFT) (workbook, graph)
e 2D FFT
e 2D IFFT Analysis:Signal Processing:FFT (matrix)

(] Short-time Fourier Transform

(STFT)

Analysis:Signal Processing:STFT
(workbook)

(] Hilbert Transform

Analysis:Signal Processing:Hilbert
Transform (workbook, graph)

. Image Profiling

Plot>2D:Profile:Image Profile (matrix,
worksheet, XYZ data)

15.8.2Filtering

Tools

Menu Entry

e  FFT Filter

Analysis:Signal Processing:FFT Filters
(workbook, graph)

e 2D FFT Filter

Analysis:Signal Processing:2D FFT
Filters (matrix)

. IR Filter Design

Analysis:Signal Processing:lIR Filter
(workbook, graph)

Data Analysis
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15.8.3Smoothing

For Origin 2023, there is a change to Smooth output:

Label row Method is created to hold method information (e.g. 5 pts SG smooth of

“Magnetic Field").

Long Name and Units from source sheet used in output sheet (previously, output

might have been tagged as "SmoothedX1" or "SmoothedY1").

Tools

Menu Entry

L] Smooth

Analysis:Signal Processing:Smooth
(workbook, graph, matrix)

15.8.4Correlation

Tools

Menu Entry

e  Correlation

Analysis:Signal Processing:Correlation
(workbook, graph)

e 2D Correlation

Analysis:Signal Processing:2D
Correlation (matrix)

15.8.5Convolution

Tools

Menu Entry

e  Convolution

Analysis:Signal
Processing:Convolution (workbook,
graph)
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15.8.6Wavelet Analysis (Pro Only)

Tools

Menu Entry

®  Continuous Wavelet Transform

. Discrete Wavelet Transform
(Decomposition)

® Inverse Discrete Wavelet

Transform (Reconstruction)

(] Multi-Scale Wavelet

Decomposition
e  Smoothing

(] Noise Removal

Analysis:Signal Processing:Wavelet
Analysis (workbook, graph)

e 2D Wavelet Decomposition

e 2D Wavelet Reconstruction

Analysis:Signal Processing:Wavelet
Analysis (matrix)

15.8.70ther Advanced Tools (Pro Only)

Tools

Menu Entry

e Rise Time Gadget

Gadget:Rise Time (graph)

. Decimation

Analysis:Signal Processing:Decimation
(workbook, graph)

e Coherence

Analysis:Signal Processing:Coherence
(workbook, graph)

e  Envelope Curves

Analysis:Signal Processing:Envelope
(workbook, graph)

15.9 Image Processing

Data Analysis

Origin provides a collection of tools for basic image processing. These tools are accessible from the Image

menu when a matrixbook is active. Some tools are only.
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The tools are organized in the following sub-menus:

Image:Adjustments
Image:Arithmetic Transforms
Image:Conversion
Image:Geometric Transforms

Image:Spatial Filters

15.10Topics for Further Reading
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Analysis Dialog Boxes: Specifying Your Input Data

Outputting Analysis Results

Recalculation of Analysis Results

Generating Analysis Report Sheets

Performing Math Operations on Datasets

Linear/Polynomial Regression

Nonlinear Curve Fitting

Peak Analysis using Origin

Signal Processing

Image Processing and Analysis
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16 Statistics

16.1.1Apps for Statistics

Origin 2016 introduced add-on tools called Apps. Since being introduced, a number of statistics-related

agraphing and analysis Apps have been added to OriginLab's File Exchange and more tools are being released
all the time.

A few Apps are installed with your Origin software. Note that as of the fall of 2019, all Apps are available at no
extra cost and they are easily added to Origin. Click Statistics: Find Apps. This opens the App Center to

show only statistics-related Apps. Browse available Apps and click the Download and Install button * to
install an App.

Origin includes a pre-installed App called Stats Advisor. This App uses an interactive "wizard" interface to
help you choose appropriate statistical tests and to tell you where to find them in your Origin software, or -- if
the test is available from another add-on App -- where to find it on the OriginLab File Exchange.

Look for this App in the | Stats Adviser - O %

Apps (IEalleTy, located >» What do you want to do? >> Your options >> Suggested feature(s)
to the right side of your

Origin workspace

O Summarize, describe, or present 2> 1. Which kind of data do you have? Please answer all guestions in the left panel first

data with basic statistics You may need to scroll down to view all

® Have columns of numeric data and queations.
O Compare means/medians, want to examine or calculate
\ vanante, proportion in groups distribution QO Normality Test
Stats Advisor and datasets )
NE—— O Have numeric data and want to find O Distribution Fit

® Examine distribution of data o comelations between columns.

find cornelation of data O Randomness Tests (XD @D

i X O Have two categorical data columns for
o ::g"—‘rgg”u;‘_’s'::ﬂm on predictors cross tabulation analysis © Rank Data @D
O Have no data but want to calculate a Q© Probability Plot €T
O Reduce number of variables distribution
) ) QO o-c Pt M
O Ciassify data into groups O Have no data but want to generate or
simulate random data

O Miscelianeous Multivariate o Histogram €T

Analysis Qe -

aussian Mixture Modets QIR

O Pearforin DOE, delaiming powar >> 2. Is your data in individual columns or

and sample SIIZE po paired XY columns?
O Parform survival analysis or ® Individual columns

ROC curve

O Paired XY columns

O Analyze time series data O Muttiple columns

O Piot advanced statistics graph

Open Help Open Dial

5]

g

16.2 Basic Statistics

Many of Origin's advanced statistical tests are available only in OriginPro. Users of
standard Origin will see these Pro-only tests marked as (Pro) in the main menu. If you
own the standard version of Origin but find that you need features of OriginPro, you can
upgrade by contacting your Origin representative.

If you wish to continue using standard Origin without seeing (Pro) menu commands, click
Preferences: System Variables and enter the following in the Set System Variables
dialog box and click OK (Comment is optional):
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B Set System Variables ? *
Variable Value |Comment =
RPhA 1 Turns off menu display of (Pro) features
W
System Variables List
OK Cancel

16.2.1Basic Statistics on Worksheet

Descriptive Statistics

Menu entry with worksheet active

(] Statistics on
Columns

(] Statistics on Rows

Statistics:Descriptive Statistics

Improvements to Statistics on Columns output for
Origin 2023:

To Plots > Histograms, add a Data Height drop-
down with Count, Relative Frequency and
Density options for labeling vertical axes.

Replace vertical axis titles incorporating data range,
with Long Name (Unit).

Better Identifier labeling in DescStatsCurves
output sheet.

The Data Range flyout menus for Statistics on
Columns/Rows (as well as many other tools) gets
All Columns and Dynamic Ends entries for

selecting all columns in the sheet.

More...

Exclude Empty Dataset O

Exclude Text Dataset O All Columns

[l iInput Data Independent Columns w Dynamic Ends
El range 1 Reset

| Data Range | I Select from Warksheet

|v A o e Select Columns..,
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Statistics on Y by X
Bin

No menu access. To open the dialog box:

1. Click Window: Script Window.
2. At the cursor, type statsxy -d and press Enter.

Cross Tabulation

and Chi-Square

Discrete Frequency
Frequency Counts

2D Frequency

Counts/Binning

Distribution Fit

Normality Test

Correlation

Coefficient @

Partial Correlation

Coefficient @

Grubbs Test

Dixon's Q-test

Statistics:Descriptive Statistics

Statistics:Descriptive Statistics

For Origin 2023, Discrete Frequency will simply
write input-column Long Name to Comments
(instead of Short Name"Long Name").

Statistics:Descriptive Statistics

Statistics:Descriptive Statistics

Statistics:Descriptive Statistics
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16.2.2Descriptive Statistics on Graph

Origin provides a couple of gadgets to explore and summarize data plotted in graphs.

Descriptive Statistics

Menu entry with graph active

e  Cluster Gadget

Gadgets:Cluster...

e  Statistics Gadget O

Gadgets:Statistics...

The Statistics Gadget supports custom

labeling of the ROl Box.

16.2.3Descriptive Statistics on Matrix

Descriptive Statistics

Menu entry with matrix active

e  Output descriptive statistics (mean, sd, min,

max, etc.) on the matrix stack (series of matrix

objects), for each pair of XY coordinates.

Analysis: Descriptive Statistics
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Statistics

16.2.4Statistics on Selected Range

Origin provides some quick ways to obtain basic statistics on a selected range of worksheet cells, or data plot(s)
in a graph.

16.2.4.1 Status Bar
Select a range of cells in a worksheet. Note that the selection can include cells from one or more columns, and

you can use the CTRL key to select non-contiguous groups of cells.

Basic statistics (average, sum, count, min, max) for your selected data will be displayed in the status bar.
Right click on the status bar to customize what quantities to display.

16.2.4.2 Command or Script Window

Statistics, Report to Script/Command Window

1. Select a range of cells in a worksheet, or click and select a group of data plots or an individual data plot in
a graph.
2. Open the Command Window or the Script Window from the Windows menu, and type one of these

commands, then press ENTER:

stats

moments
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quantiles

With the Command Window, the results are typed out below the command line. With the Script Window, you

will need to issue an additional command to return your results:

stats;

stats.=;

Note: For more information, please refer to the:

Help: X-Function > X-Function Reference > Statistics

16.3 Statistical Graphs

Origin provides numerous statistical graph types. All graphs can be easily customized and saved as a template
for repeat use. View the Graphing and Customizing Graphs chapters of this guide for more information.

Graph Type

Plot Menu
Category

Box Charts: Box, Interval Plot, Bar Charts, Box Overlap, Box Normal, Half
Box, Bar Overlap, Bar Normal, Scatter Interval, Double-Y Box, Marginal Box
Charts.

For Origin 2023, you can add a Box Scale to your
"NE box charts. The Box Scale diagrams key user-selected
L Ayl box statistics.

Statistical

Box Charts, Violin Plots, etc., Grouped: Grouped Scatter - Indexed Data,
Grouped Box Charts - Indexed Data, Grouped Box Charts - Raw Data, Grouped
Column Scatter - Indexed Data, Grouped Interval Plot - Indexed Data,
Grouped Mean Bar - Indexed Data, Grouped Violin - Indexed Data, Grouped
Half Violin - Indexed Data, Grouped Half Box - Indexed Data.

Categorical

Violin Plots: Violin Plot, Violin with Box, Violin with Point, Violin with Quartile,
Violin with Stick, Split Violin, Half Violin.

Statistical

Histograms: Histogram, Histogram + Rug, Histogram + Probabilities, Multi-
Panel Histogram, Distribution, Distribution + Rug, Histogram with Labels,
Stacked Histograms, Marginal Histograms.

Statistical
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Statistics

Population Pyramid Statistical
2D Kernel Density Contour
Heatmap: Heatmap, Heatmap with Labels, Split Heatmap Contour
Contour - Categorical Z Contour
Cluster Plots Categorical
Probability: Probability Plot, Q-Q Plot. Statistical

Pareto and QC Chart: Pareto Chart - Binned Data, Pareto Chart - Raw Data,

QC (X-bar R) Chart. Statistical
Bland-Altman Plot (Tukey mean-difference) Statistical
Scatter Matrix Statistical
Trellis Plot: Trellis Plot, Double-Y Trellis Plot, Double-Y Trellis Plot Categorical
Parallel Plot: Parallel Plot, Parallel Sets, Parallel Index. Categorical

The following statistical graphs are only available within the Plots branch of the statistical analysis dialogs.

Graph Type

Menu Entry

(] Means Plot

e Means Comparison
Plot

Statistics: ANOVA: One-Way ANOVA, Two-Way ANOVA

Statistics: ANOVA: One-Way Repeated Measure ANOVA
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Graph Type

Menu Entry

Survival Curve

One Minus Survival

Curve
Hazard Curve

Log Survival Curve

Statistics:

Survival Analysis: Kaplan-Meier Estimator

Scree Plot

Component Plot

Statistics:

Multivariate Analysis: Principal Component Analysis

Dendrogram

Statistics:

Multivariate Analysis: Hierarchical Cluster Analysis

Classification
Summary Plot
Classification Fit
Plot

Canonical Score

Plot

Statistics:

Multivariate Analysis: Discriminant Analysis

ROC Curve

Statistics:

ROC Curve

16.4Comparing One, Two or More Groups

Origin provides parametric and non-parametric tests to compare one, two, three or more groups.
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16.4.1Parametric Hypothesis Tests

Statistics

Feature

Menu Entry

®  One-Sample t-Test
e  Two-Sample t-Test
®  Pair-Sample t-Test

® One-Sample Test for

Variance = ME

Variance

e  Two-Sample Test for Iiﬂ

Statistics: Hypothesis Testing

For Origin 2023, the Two-Sample
t-Test "Powers" table gets a helpful
footnote: " The sample size is for all
data. SD of both groups are used in
power calculation. "

®  One-Sample Proportion

Test

Test

e  Two-Sample Proportion Statistics: Hypothesis Testing

e Two-Sample t-Test on

Rows

Rows

e  Pair-Sample t-Test on Statistics: Hypothesis Testing

16.4.2ANOVA

Feature

Menu Entry

e  One-Way ANOVA
e  Two-Way ANOVA

e  Three-Way ANOVA
® One-Way Repeated-Measures ANOVA

e Two-Way Repeated-Measures ANOVA

(Supports both Balanced and Unbalanced data)

Statistics: ANOVA
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16.4.3Non-parametric Tests

Feature Menu Entry

e  One-Sample Wilcoxon Signed Rank Test

®  Paired-Sample Wilcoxon Signed Rank Test
®  Paired-Sample Sign Test

e  Mann-Whitney Test

e  Two-Sample Kolmogorov-Smirnov Test Statistics:Nonparametric Tests
e  Kruskal-Wallis ANOVA
e  Moods Median Test

(] Friedman ANOVA

Notes:

Multiple nonparametric tests can be run simultaneously. (Accessible from the
Statistics:Nonparametric Tests menu ) Available options are:

e (NPH) K Independent Samples: Kruskal-Wallis ANOVA and Mood's Median Test
e (NPH) Paired Samples: Paired-Sample Wilcoxon Signed Rank Test and Paired-Sample Sign Test

e (NPH) Two Independent Samples: Mann-Whitney Test and Two-Sample Kolmogorov-Smirnov

Test
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16.5 Advanced Statistics

Several additional tools are available in OriginPro.

16.5.1Multivariate Analysis

Origin offers several multivariate analysis methods to help you simplify, classify, or make predictions from
your data.

Feature Menu Entry

e  Principal Component Analysis
e K-Means Cluster

e Hierarchical Cluster

e Discriminant Analysis Statistics:Multivariate Analysis
e  Canonical Discriminant Analysis

e  Partial Least Squares

Notes: Canonical Discriminant Analysis is integrated with Discriminant Analysis. It is accessible from the
Statistics:Multivariate Analysis:Discriminant Analysis: Canonical Discriminant Analysis(System)

menu.

16.5.2Survival Analysis

OriginPro includes widely used survival tests to quantify survivorship in a population.

Feature Menu Entry

e  Kaplan-Meier Product-limit Estimator
e  Comparing Survival Curves
e  Cox Proportional Hazards Model Statistics:Survival Analysis

e  Weibull Fit Model

Notes: Comparing Survival Curves is accessible in the Kaplan-Meier Product-limit Estimator

feature.
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16.5.3Power and Sample Size

Statistics, Power and Sample Size Origin provides eight types of power and sample size analysis, useful in
designing experiments. Origin can compute the power of the experiment for a given sample size and can also
compute the required sample size for given power values.

Feature Menu Entry

® One-Proportion Test

® Two-Proportion Test

e One-Sample t-Test Statistics: Power and Sample Size

® Two-Sample t-Test o
For Origin 2023, (PSS) Two-Sample t-Test

e Paired-Sample t-Test result tables "Power(s) for Hypothetical Sample
) MEW Size(s)" and "Sample Size(s) for Hypothetical
® One-Variance Test " = Power(s)" get a helpful footnote: "The sample

e Two-Variance Test size is for each group.

® One-Way ANOVA

16.5.4ROC Curve

ROC Curve analysis is useful in determining if an incident has occurred, or in comparing the accuracy of two
methods that are used to discriminate between diseased and healthy cases.

Feature Menu Entry

(] ROC Curve L.
Statistics: ROC Curve

16.6 Topics for Further Reading

®  Statistics on Worksheet Columns

e  Statistics on Worksheet Rows

. Descriptive Statistics

e  Statistics Charts, General

e  Appendix 2 - Origin Graph Types

e Appendix: Statistical Graph Types by Template

(] Normality Testing
e  Distribution Fit

e Parametric Hypothesis Testing

e ANOVA

(] Nonparametric Tests

(] Multivariate Analysis
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Statistics

Survival Analysis
ROC Curves

Power and Sample Size Tests

LabTalk Supported X-Functions: Statistics
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17 How to Handle Repetitive Tasks

17.1 Analysis Report Sheets
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Click for .
Change Parameters... Menu L& 1) Poiynomial Fit (27872020 1616 53)
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Analysis operations, such as those performed with the tools listed in the Analysis chapter or in the Statistics
chapter, create detailed Analysis Report Sheets.

e Analysis Report Sheets contain tables that are organized in a tree structure.

e Expand or collapse each branch to show or hide table contents.

e Tables are not static reports. They are constructed using placeholders linked to particular analysis results

and thus, results can be recalculated with changes to input or analysis parameters.

®  You can add comments to the sheet or copy tables and paste or paste-link them to other windows in your

project.

e  Analysis Report Sheets often contain embedded graphs such as fit curves or residual plots. To customize

these plots, double-click on them. This opens the embedded graph in a separate window where -- as with

any Origin graph -- you can customize it using Mini Toolbar buttons or Plot Details controls. When you are

done customizing, click the Close button and re-insert the customized graph back into the report

sheet.
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For more information on Analysis Report Sheets, see the Origin Help File.

17.2 Recalculation

All Analysis and most data processing dialog boxes in Origin include a Recalculate control. This control
allows you to tie output operations to the source data. When Recalculate is set to Auto or Manual, changes to
the source data will trigger an update of the output (pending, in the case of Manual). This allows you to
analyze multiple datasets by, for instance, serial import of a new data file to replace existing data. This feature
is also the basis for creating Analysis Templates. The Analysis Template concept is explained below.

Linear Fit l ? -5 -
Dialog Theme ﬂ

Description  |Perfarm Linear Fitting

Mone I
Input Fitcmttities|F‘.esidua|Ana|y‘sis Cutput | Fitted Curves Plot | Find X/ | Residual Plots
P &kl

Errors as Weight | Fgtrumental
Fix Intercept =

Fix Intercept at 0

Fix Slope =l

Fix Slope at 1

Usze Reduced Chi-Sqr
Apparent Fit

[ Ok ] [ Cancel ]

The Recalculate control has three modes:

e No lock is displayed in the output.

None e Changes to the input data will not result in an update of the output.

e An auto green lock @a displays on the output columns and graphs of the output data.
The main operation lock displays on the left-most column as ﬁ. while any related
operations columns to right of the main operation display the "+" icon &,

Auto e  The output will be automatically updated when input data is changed.

®  You can also click on a lock icon and open the dialog to make changes to the analysis

settings, including changing the Recalculate mode.
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¢ A manual green lock @. is displayed in up-to-date output columns, and graphs that
contain plots of the output data. Any related operations columns to right of the main
operation display the "+" icon 3.

e Avyellow lock |T_ﬁ:. indicates that input data have changed and recalculation operations
are pending. You can trigger updates individually by clicking on a yellow lock and

Manual selecting Recalculate from the shortcut menu; or you can update all pending

operations by clicking the yellow Recalculate button '5’7% on the Standard toolbar.

®  You can also click on a lock icon and open the dialog to make changes to the analysis

settings, including changing the Recalculate mode.

Tips for Managing Recalculation Operations

e A left-click on the lock displays a menu that provides multiple options including changing analysis
parameters, opening source data sheet, switching to result sheets, and controlling the status of the

operation such as switching from manual update to auto update.
e The Standard toolbar displays a Recalculate button that shows green 5’% when all project operations

are up-to-date and yellow '@ when there are recalculation operations pending. If you have opened a
project and you see that the Recalculate button is yellow, understand that calculations are pending and

that the data and data plots you see in the project may not be up-to-date.

. If a lock icon appears dark gray in color ﬂ this indicates that the associated operation was performed in
OriginPro and the window or project has been opened in standard Origin. The operation is not supported
by standard Origin and to modify or re-run the analysis, you will need to locate a computer with an

OriginPro license.

2L
. If a lock icon appears red li.‘ something has occurred which makes recalculation operations impossible.
Such conditions are rare but would occur if, for instance, you passed a project file that included a user-

defined curve fitting operation to a colleague but failed to pass along your user-defined fitting function.

e Having many recalculation operations in your project file can slow down your work. You can block
recalculation -- both Manual and Auto recalculation -- by clicking on a lock icon and choosing Block

Recalculation from the popup menu. Placing a block on pending recalculations places a yellow "block"

icon |@ on each associated operation in the chain. Placing a block on up-to-date calculations places a
T

green "block™ icon |E‘ on each operation in the chain. To remove the block, click on the "block" icon and

clear the check mark (Note that clicking the yellow Recalculate button gg on the Standard toolbar does

not update blocked operations).

e To suspend all recalculation, press Ctrl+0, choose Analysis: Pause Auto Recalculate (worksheet only)

or click the Pause Auto Recalculate button j on the Standard toolbar.

®  You can hide the lock icons on your graph window by clicking on the graph and, from the main menu,
choosing View: Show and clearing the check mark beside Lock Icons. This does not remove associated

operations from the graph window. To re-display the icons, repeat the procedure.
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17.3Dialog Themes

Settings in analysis dialogs and most other data processing dialogs can be saved as a Dialog Theme file.
Once saved, these Theme files containing your custom settings can be recalled as needed. Multiple theme files
can be saved from a dialog, allowing for easy repeat analysis of datasets that may each require different

settings.

Last used dialog box settings are automatically saved as a <last used> Theme. Origin also allows you to save
your custom settings as the <default> Theme. The default Theme, last used Theme, and any named Theme
that you have saved, can all be accessed from the Dialog Theme fly-out menu that opens from the dialog box.
The same Themes are also available from the main menu item associated with the analysis dialog box.

Statistics
BMathematics

Data Manipulation
Fitting

Zignal Pracessing
Peaks and Baseline

1 Linear Fit: <Llast used»> ..
I Linear Fit: «<defaults ..

3 Smooth: <last useds ..
4 Smooth: <defaults_.

5 Single Feak Fit: «Last used»...
6 Single Feak Fit: < defaults...

| Anaiysis | Gadgets Tools Format Window  Help

[ ] me e, 1

Fit Linear with ¥ Error...
Polynomaal Fit,..

* w w . w w

Maonlinear Curve Fit... Chrl =Y
Honbinear Implict Curve Fit...

Haonlinzar Surface Fif...

Simulate Curve...
Simulate Surface..,

Exponential Fit...
Zingle Peak Fit...
Sigmoidal Fit..,

Compare Datasets_.,
Compare Models...

1 = default>

2 «last wseds

named Theme

3 Zero Intercept I:}

Oipen DHalog...
LI
s
e
by
LB ';/
b .4
" L]
B4 - I./
"
4 P
A
24 Lo
< u
o L - . -
a 2 4 ] 10

12

Dialog Themes are managed with the Theme Organizer tool, available from the Tools menu.
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Tutorial: Saving and Re-using a Dialog Theme

Import the file Linear Fit.dat from the Samples\Curve Fitting\ subfolder.

Highlight column B and select Analysis: Fitting: Linear Fit...

In the Linear Fit dialog that opens, check the Fix Intercept checkbox (under Fit

Options) and set the Fix Intercept at edit box to O.

Click the ﬂ button next to the Dialog Theme control and select Save as .... In

the Theme Name box, enter Zero Intercept and press OK. Press OK again to

close the Linear Fit dialog box and perform the analysis. FitLinearl and

FitLinearCurvel result sheets are added to the workbook.

Return to the source data and highlight column C. Select Analysis: Fitting:

Linear Fit from the menu. You will see a fly-out menu with multiple Theme options

including the Zero Intercept Theme you saved in the previous step.
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6. Select your saved Theme. The analysis is automatically performed on Column C

using the settings saved in the Theme. Note that the dialog box does not open.

i Tips for Working with Themes:

e Hold the SHIFT key while clicking on your Theme in the main menu and the
associated dialog box will open with settings from the selected Theme loaded into
the dialog box.

e  The default Theme Origin shipped for an analysis is called System Default. Click

the fly-out menu in the analysis dialog and choose System Default to load it.

®  Click the fly-out menu in the analysis dialog and choose Delete to delete Themes
you have created, including any customized <default> Theme.

® The customized <default> Themes for all analysis dialogs are saved in

Defaults.xml in the User Files Folder. Deleting this file restores system default

settings of all analysis dialogs.

17.4Workbook and Project Templates

There are a number of reasons for saving a single workbook or an entire project, as a "template" file. Here
are a few typical scenarios.

®  You might import data files that always have a fixed number of columns with a repeating pattern of
column designations (e.g. XYyError, XYyError, etc.) so you create a custom workbook just for importing
these files (File: Save Template As).

®  You regularly import data files of similar structure and you perform some routine graphing and analysis
operations on the data, then generate a report using a worksheet or a workbook embedded Notes window.

This would be a typical example of an Analysis Template (File: Save Workbook As Analysis Template).

®  You perform some operations similar to those described in the previous example but you can't save your
workbook as an Analysis Template because all data are cleared from the workbook on saving and that
would destroy a sheet of reference values that you rely on for your analysis. Instead, you could opt to
clear only the imported data and save your workbook as a window file (File: Save Window As). This
preserves the sheet of reference data and like the Analysis Template, saves analysis and graphing

operations with the workbook.

®  You routinely import data, do some analysis and generate a report and would like to make use of the
Analysis Template concept (as in the second bullet point), but you have multiple windows in your project,
including Layout windows that cannot be embedded in the workbook. So, a single workbook Analysis
Template won't do the job. In this case, you could save the project without data by "cloning" it (File:

Clone current Project).
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17.4.1The Workbook as Template

The workbook can contain worksheets with data, metadata, floating or embedded graphs, embedded matrices
and notes, plus scripts, variables and other supporting data.

You can save a workbook as a template for repetitive graphing and/or analysis tasks. Depending on your
needs, there are three options for saving your workbooks -- as a workbook (OGWU), as a template (OTWU)
or as an Analysis Template (OGWU):

e Workbook (OGWU): Choosing File: Save Window As saves all workbook content.

e Analysis Template (OGWU): Choosing File: Save Workbook as Analysis Template clears all data

columns that are used in analysis operations in the workbook before saving. Operations are preserved as

are data that are not associated with analysis operations.

e Template (OTWU): Choosing File: Save Template As saves the structure of the workbook, plus any

analysis operations that exist in the workbook, but all data including data that are not associated with

these analysis operations, are cleared.
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The New Book dialog is a template library for managing workbook, matrixbook and
Analysis Templates. See Workbooks for an overview of dialog box features.

Tutorial: Creating an Analysis Template

Start with a new workbook and import the file Samples\Curve
Fitting\Sensor0O1l.dat.

Select column B and use the Analysis: Fitting: Linear Fit and open the Linear
Fit dialog.

Change the Recalculate drop-down to Auto.

Click the Fit Control tab, check the Fix Intercept check box and enter O in the
Fix Intercept at edit box.

Click OK to close the dialog and perform the linear regression.

Answer "Yes" to the prompt and switch to the FitLinearl report sheet to view
results including plots of the best-fit line and residuals.

Now switch back to the original data sheet and import the file Samples\Curve
Fitting\Sensor02.dat. The analysis results will be automatically updated with this
new data. Note that you could continue to use this workbook for importing other
data; or you could right-click the workbook window title and choose Duplicate
without Data to create a new workbook with the linear fitting operation saved
into it. This allows you to import new data into the new workbook and thus save a
project with multiple such workbooks, if desired.

With the workbook active, select the menu File: Save Workbook as Analysis
Template..., and in the dialog that opens, give a name such as Linear Fit of
Sensor Data and click Save.

Choose File: Recent Books and select the template that was saved in the

previous step. The workbook will open and the data sheet will be empty.
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10. Import the file Samples\Curve Fitting\Sensor3.dat into the empty data sheet

(1st sheet). The analysis results will be automatically generated upon data import.

Analysis Templates can include summary sheets and custom report sheets (worksheet-based or HTML),
making them an ideal medium for importing, analyzing, plotting and reporting the results of your routine
analyses. When used in combination with the the Batch Processing tool, you can repeat a set of analyses
and graphing operations for any number of data files and create a PDF summary report for each one, as itis

processed. View the Batch Plotting and Batch Analysis sections of this chapter for examples of using the
workbook as a template for handling repetitive tasks.

|, Notes windows now support HTML. Notes windows can be added to the workbook
(right-click on sheet tab and Add Notes as Sheet) making it easy to incorporate HTML

reports into your Analysis Templates. For more information, see HTML Reports
Erom Notes Windows.

17.4.2The Project as Template

The Origin project file can also be used as a "template" for carrying out repetitive graphing and analysis tasks
-- particularly when your analyses and graphing tasks can't be resolved within a single workbook.

The basis steps of creating a "project template™ are as follows:
1. Create the desired graphs and/or analysis results from data in your workbook(s) and save the project.

2. After saving the project, choose File: Clone current Project. A small dialog opens for configuring your

cloned project:

Data Manipulation: clr&llData 4 x

Dialog Theme | aq1 yoeds b

Clear data to make Analysic Template Project

Add Data Connectors |-
Clear Data (W) Cizar All
l:' Clear Imported Data and Delete Calculations

E\Project_Data\Origin 20190\Project Data\simple_fit_results.opju

O Add Data Connectors: Check this box to add Data Connectors from the cloned project to your
saved project. Each cloned worksheet will have a connection to the original worksheet in the
saved project. If you plan to import data from other similar files in your cloned project, you
should CLEAR this box.

O Clear All: Clear imported data only. Analysis operations are preserved in the cloned project.

O Clear Imported Data and Delete Calculations: Clears imported data and analysis operations.

3. Click OK to create your cloned project. Selected data are cleared and the cloned project named UNTITLED

is added to the workspace.
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4. Name and save the cloned project and when you are ready to process more data files, you can open it and
import new data:
O If your analysis and graphing operations are linked to a particular set of data files that are
periodically updated, you don't necessarily need to use Connectors. You can simply re-import the

files (Data: Re-import... or Re-import Directly).

O If your operations are linked using Data Connectors, click the Connector icon % and from the
popup menu choose Import (this Connector only) or Import All (all Connectors in the book).

O One possible scenario is that you store all of your data in a single Origin project file. If you have
added Data Connectors from your cloned project, to your original project then you can selectively
import just the data that you need to perform your graphing and analysis operations. When you

have finished, you can save the file to a new name, preserving your cloned project for re-use.

17.5Batch Plotting

Origin provides several methods for batch plotting of graphs from multiple datasets or files. The following two
sections outline how to create multiple graphs from (1) data that is already in worksheets, or (2) multiple data
files. In addition to these two procedures, batch plotting can also be performed programmatically using
LabTalk script or Origin C.

Origin 2023 has improved handling of Graph Short Name (e.g. no longer will "G09"
increment to "G010").

17.5.1Duplicating Graphs with Data from Other Books/Sheets/Columns

If you have several workbooks, worksheets or columns with similar data structure as you the data used to plot
the graph, you can have Origin clone that graph via Window: Duplicate (Batch Plotting) menu with new
data. There are two cases:

. If you have plotted a graph with a single dataset and customized it, and want to clone the graph with
other data in the same worksheet: Choose Window: Duplicate (Batch Plotting): Duplicate with New
Columns. Pick other data (columns) that you want to plot. Each column will be plotted as a new graph.

. If you have plotted a graph with data in one worksheet or workbook and customized the graph, and you
want to clone the graph with other worksheets or workbooks with a similar data structure: Choose
Window: Duplicate (Batch Plotting): Duplicate with New Sheets/Duplicate with New Books.
Origin will list all worksheets or workbooks with a similar data structure. Pick the worksheet or workbook

you want to plot from. Each worksheet or workbook will be plotted as a new graph.

Tutorial: Duplicating a graph with data from other books/sheets

1. Press the New Project D button on the Standard toolbar.

o
2. Press the Import Wizard @ button on the same toolbar. This opens the Import
Wizard dialog box.
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Click the browse button E] to the right of the File box. Browse to the Import
and Export folder and select the files S15-125-03.dat, S21-235-07.dat, and
S32-014-04.dat. Click Add File(s), then press OK. In the Import Wizard dialog
box, press Finish. The files are imported into three separate workbooks.

Drag and select all three Y columns in one of the workbooks, then select the menu
item Plot=>2D: Multi-Y: 3Ys Y-YY to create a graph with multiple Y axes and one
shared X axis. Make any desired customizations to the graph.

Right-click on the title bar of the graph window then select Duplicate (Batch
Plotting) shortcut menu.

In the dialog box that opens, press Ctrl and select the other two
workbooks/worksheets then press OK. Two more graphs are created with data

from the other two workbooks/worksheets.

17.5.2The Workbook as a Template for Processing Multiple Files

If you want to plot graphs from many data files but don't want to import all files to workbooks before plotting,
you can import one file, create the desired graph(s) based on that data, then add the graph(s) to your
workbook and save the workbook as a template. Using this template you can process multiple files, creating a
workbook for each file and its corresponding graph.

Tutorial: Creating graphs from multiple data files

1.

With a new workbook active, choose Data: Import From File: Single ASCII and
import the file SensorO1.dat from the Samples\Curve Fitting subfolder of the
Origin installation folder.

Highlight column B and create a line+symbol graph of the data.

Double click on the X axis to open the Axis dialog. Make sure Scale tab is active.
Select both Horizontal and Vertical on the left panel and set Rescale to be Auto
and click OK. This will ensure that the graph scale will update automatically on
data change.

In the workbook, right-click on the worksheet tab and select Add Graph as
Sheet, then select the graph created above and click Done. This will add a new
workbook sheet containing an embedded graph.

Switch to the data sheet, double-click on the tab rename the sheet as Data.
Select the Worksheet: Clear Worksheet menu item to clear the data in this
sheet. Note that this step is optional. Clearing the data will reduce the size of the
template saved in the next step.

Select the File: Save Window As... menu item, assign a name such as Sensor
Data and Graph and press Save.

Now we can use this template to process multiple files. Select the File: Batch
Processing... menu item.

In the dialog box that opens set the Batch Processing Mode to Load Analysis

Template, then set the Analysis Template control to point to your saved
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10.

11.
12.

template.

Set Data Source to Import from Files and select the three files SensorOl.dat,
Sensor02.dat, and SensorO3.dat from the Samples\Curve Fitting subfolder.
Set the Data Sheet(s) to Data and set Result Sheet to <none>.

Press OK to close the dialog box. You should get three workbooks with the data
imported into the first sheet and the graphs updated in the 2nd sheet. To further
edit any of the graphs, double-click on the graph to pop up an editable page.

If processing of your data requires some custom import settings, those settings will be
saved to the data sheet by default. Settings thus saved to the sheet will be used for
import when batch processing of multiple files using the workbook as a template.

17.6Batch Analysis

Origin provides several ways to perform batch analysis of multiple files, data columns, or data plots.

17.6.1Analyzing Multiple Datasets in Dialogs

Some analysis dialog boxes, for instance Linear Fit and Nonlinear Fit, support analysis of multiple datasets.
Report sheets created by these dialog boxes include a summary table listing the parameter values for each
dataset and other pertinent results such as goodness-of-fit indicators. The summary table can be copied to an
external sheet for further processing.

Tutorial: Fitting Multiple Datasets

Open a new workbook and import the file Samples\Curve Fitting\Multiple
Gaussians.dat from the Origin installation folder.

Set the Long Names of the four Y columns as Peak 1, Peak 2, Peak 3 and Peak 4.
Select all four Y columns, and use the Analysis: Fitting: Nonlinear Curve Fit...
menu item to open the NLFit dialog box.

Select Gauss from the Function drop-down list, then press the Fit button to perform
fitting and close the dialog box.

Switch to the FitNL1 report sheet. You will see a table named Summary which lists

the fit parameters and fit statistics for each dataset.

T Bummary T
v HE w A sitima  PAHM  Height Statistics
\\ Walue Edfror Wl Efror Walue Ermof ‘Walue Efror Walue Reduced Chi-Sgr Adl. B-Soquaie
Peak 1 1833 065 24888 0247 12724 DEL3 1151 6.B03 E362 14901 7219 0444 0837
Peak 2 4954 0087 200086 0144 &N 0325 3187 1LE2E A3 1008 4 RE7 0028 08E2
Peakd 0147 006 24973 0242 12383 0.620 116 0643 BA8T 14592 0716 0.004 0837
Peak 4 2033 0048 20015 008F 46N 01132 81 453 1188 X305 5429 2403 0.na7 0825
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|, In the NLFit report sheet, click on the downward-pointing arrow button ﬂnext to the
table named Summary and select Create Copy as New Sheet. This will create a copy
of the table in which all cells are linked to the report. Any updates/changes to the fit
will automatically update the values in this copied sheet. This sheet can then be used to
plot or to perform secondary analysis on the fit parameters.

I When enumerating something like a column Long Name, as you did in step 2 above,
/ enter the string in the first cell (e.g. "Peak 1"), select the cell and hover over the lower-
right corner. When the cursor becomes a "+", drag across the other cells and the
contents of the first cell will be extended to those cells.

17.6.2Using Gadgets for Analyzing Multiple Curves

Origin includes several gadgets for performing interactive analysis on plotted data. Gadgets allow selecting a
data range of interest, switching from one dataset to another, and setting various preferences specific to the
analysis being carried out.

Most gadgets offer an option to perform the analysis on all data plots in the current layer, or all data plots in
the graph page. This allows for performing repetitive analysis on multiple datasets using the same settings,
and generating a table of results across all datasets.

Tutorial: Using the Integrate Gadget to Integrate Multiple Curves

Open the project "Samples\Spectroscopy\Absorbance Spectra.opj".
With the graph window active, choose Gadgets: Integrate from the main menu.

3. In the dialog that opens, click the Baseline tab and set the Mode drop-down to
Straight Line.

4. Click the Output tab, expand the Output Quantities to node, and check Append to
Worksheet. Press OK to close the dialog box.

5. A region of interest (ROI) object is placed on the graph. If necessary, click on the ROI
and resize this object to cover the entire data range plotted in the graph. The

integrated area will be displayed as a shaded region.

6. Click the arrow button E]at the top right of the ROI object, then choose Change
Data from the context menu and switch to another plot in the layer. Check that the

current baseline setting works for other curves in the layer.

7. Click the arrow button E] select New Output for All Curves (N) or simply press

the "N" key. Integration is performed on all curves.

8. Click the arrow button E]again and select Go to Report Worksheet. Expand the
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report worksheet to view the integration results from all curves.
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17.6.3Batch Analysis Using an Analysis Template

The Batch Processing tool allows you to process multiple files or datasets using an Analysis Template.
Simply perform the analysis on one of the files, include all desired results and report sheets in one workbook,
and save that workbook as an Analysis Template. The Batch Processing tool then uses the Analysis Template
to process multiple files/datasets. You have the option to retain one workbook for each file/dataset, and
additionally, to create a summary table with select analysis parameters and other metadata that you have pre-

configured in your analysis template.

Tutorial: Batch Analysis of Multiple Files using an Analysis Template

1. From the main menu, choose File: Batch Processing.... This opens the Batch

Processing dialog box.

2. Set Batch Processing Mode to Load Analysis Template.

3. Press the browse button g to the right of the Analysis Template box and browse to

and select the file <Origin Program Folder>\Samples\Batch Processing\Sensor

Analysis.OGW. This Analysis Template contains multiple sheets set up for linear

regression analysis, reporting, and summary tables.

4. Set Data Source = Import From Files, then click the browse button E] to the right
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of the File List and from the Samples\Curve Fitting folder, select files
Sensor01l.dat, SensorO2.dat and SensorO3.dat .

Set Dataset ldentifier to File Name, Data Sheet(s) to Data, and Result Sheet to
Result. Note that these are the names of existing sheets in the Analysis Template.
Uncheck Delete Intermediate Workbook.

Click OK to close the dialog box and process the three files (you can answer "No" to
the prompt). You will obtain three books with the data, analysis results, and report for
each file, and a fourth book containing the summary table of analysis results from all

files.
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File Dt TRAS01E
L e et s et
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i= & Walse _[Standard Error
L - o Intercept 0460 | 043 s
i e Bl tasr | uoed
|IL1 i= . Fit Statistics
S o Foarson's 1 (R
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Open Book(s)| Reprocess Update
By | coo | owm | EveEm) | Fm | coEm) | H |
LongMame | Dataset D Intercept  Intercept Slope Slope Statistics | Statistics
Parameters Value dtandardErc  Value tandard Errodj. R-Squan Pearson's r
1|Sensor01.dat 0.112 0.504 1.448 0.078 0.947 0.975
2 | Sensor2.dat -0.858 0.363 28627 0.056 0.991 0.996
3 | Sensor03.dat 0.460 0.435 4.437 0.068 0.996 0998 |
4 L
L« [» ]\ Resuits / Il < >

Saving the initial workbook as an Analysis Template is optional. You can simply save
the Origin project (.opj) and next time replace the data in your workbook to update all
results and graphs. The Batch Processing tool also has an option to repeatedly import
files into the active window, allowing you to simply re-use an existing book within a
project (which contains all desired analysis and graphs) as an on-the-fly template for
the batch analysis.
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| You can batch generate analysis reports using a custom MS Word template, with the
option of outputting a PDF and/or an MS Word file for each report. Additionally, you
can opt to combine reports into a single file. For information on Batch Processing
with a Word Template for Reporting, see this tutorial.

17.7 Repeating Analysis on Other Datasets or Data Plots

For some analysis operations, you can perform the analysis on one dataset or data plot and then repeat the
analysis for all other data. This feature is available via a special shortcut menu entry, when you click on the
lock associated with the operation.

. In worksheet columns or reports, clicking the lock will show the menu command Repeat this for All Y

columns. Selecting this will repeat the analysis on all other Y columns in the source data sheet.

. In a graph, clicking the lock will show the menu command Repeat this for All Plots. Selecting this will

repeat the analysis for all other data plots in the graph page, even if the plots are in different layers.

This is particularly useful for such analysis dialog boxes as smoothing or interpolation that support input of
only one dataset. As long as the data are contained in one worksheet or plotted in one graph, the analysis can
be repeated on all other datasets.

Users should note a change for Origin 2022b: In earlier versions, if the original
analysis output created a new sheet or book, Repeat this for All would create a new
sheet or book for the remaining Y columns or plots. Users expressed a desire to send
all output to a single sheet regardless of the original output specification. If input
columns share a common X dataset, the X dataset will be written to the output sheet
only once. To roll back to the previous behavior, set @RAO = 0 (default is 1).

Tutorial: Smoothing Multiple Columns in a Worksheet

1. Import the file Samples\Curve Fitting\Multiple Gaussians.dat into an empty
workbook.

2. Select column B and click Analysis: Signal Processing: Smooth to open the
smooth dialog box.

3. Accept the defaults and press OK to perform smoothing. A new column will be
added with the smoothed data.

4. Click on the lock @.in the output column and select Repeat this for All Y
columns. Three more columns of smoothed data with same settings will be

generated from the data in columns C thru E.

17.8Duplicate this Operation

Output produced by the Origin's analysis operations is linked to its source data by a particular analysis and a
particular set of analysis parameters. This linkage is signified by the placement of an "operations lock" on
analysis output and -- unless the user turns off recalculation for a particular operation -- such results are
generally "locked" to editing. You can find out more by reading about Analysis Report Sheets and Recalculation,
in the introductory sections of this chapter.
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The lock icon placed on analysis output can be clicked on to open a menu, giving you post-analysis access to
operation parameters and other information. This includes the dialog box and parameter-set used to produce
the analysis output, opened by clicking Change Parameters.

Towards the bottom of this menu, you will see a Duplicate this Operation entry.

E] Graph1 * BN HoB =)

™

H:'-| i B .:. L
Recalc

Change Parameters... i
Delete
Go to Source

o to Results

Amalysis Markers L3

Flot Input Data with Data Markers

[ ] Recalcutate Mode: Manual
Recaloulate Mode: Auto A 19

Recaloulate Mode: None

— Block Recalculation l

Ignore Hidden Fows L3

Show Info [FitLinear)

Sawe Theme AS..,

Copy Operation
] Duplicate this Operation »]
Repeat this Tar G1E

One possible use of the feature goes like this:

1. The user performs an analysis operation on a data plot, say, a fitting operation using the nonlinear curve
fitter (NLFit).

2. The user is not sure which fitting function best models her data so she tries a fit using one potential
function.
The user clicks the resulting operations lock and chooses Duplicate this Operation.
A duplicate analysis is run and a second operations lock is added to the graph window.
The user clicks the second operations lock, chooses Change Parameters and when the NLFit dialog
opens, chooses her alternate fitting function and performs a new fit operation. The new fit operation
results in new output which can now be compared to the output generated by a fit of the first fitting

function.
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Previously, when you selected Change Parameters and changed the Input Data
" ME y Range, it was not possible to change the Group column range selection to new input
£ -=|‘-’~ data sheet. This has been corrected in Origin 2023.

17.9Repeating Analysis Using Data Filters

Large multi-column datasets can be quickly reduced by applying filter conditions to one or more columns. This
Data Filter feature can also be used in conjunction with the colcopy (column copy) X-Function to produce
multiple graphs from the same source data using different filtering conditions. The filtered data can also be
analyzed, allowing you to compare graphs and analysis results across multiple filter conditions.

Selected columns from the source data sheet can be copied to create child sheets where the filter condition
stays synchronized with the parent sheet, or is locked to the child sheet. When the source data sheet is
updated, all child sheets, associated graphs and analysis results will automatically update using their
respective filter conditions. Additionally, the filter condition of a particular child sheet can be pushed back to
the parent sheet at any time.

The image below displays the source workbook with data for several makes of automobiles. Two books were
created with a subset of columns and a data filter to restrict the data to a particular make of automobile.
Linear regression analysis of the filtered data was performed, allowing comparison of the results across the
two filters.
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Tutorial: Locking a Filter Condition on Copied Columns

1. Import the file Samples\Statistics\Automobile.dat

i

2. Click on the Make column, then click the Add/Remove Data Filter button

on the Worksheet Data toolbar.

3. Click on the filter icon g that was added to the column, and uncheck all makes
but Honda (Hint: Clear the check mark beside Select All, then check Honda and
click OK).

4. Hold down the CTRL key and click and select the Make, Power and Engine
Displacement columns. Next, right-click and select Copy Columns to... from the
shortcut menu.

5. In the dialog that opens, expand Copy Labels and place a check mark beside
Long Name and Units, then click OK. A new worksheet will be added to the
workbook and it will contain only the Honda data, for Power and Engine
Displacement.

6. Click and hold the tab of the new worksheet and drag it to an empty spot in the
Origin workspace to create a separate workbook.

7. Click on any of the locks in the columns of this copied sheet, and select
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10.

11.

12.

Worksheet Filters: Lock. The filter conditions will be locked to this sheet. If you
change the filter condition in the original data sheet, this copied sheet will not be
affected.

You can now return to the original automobile book, click the filter icon and
change the filter condition to Toyota, then use Copy Columns to to create another
worksheet.

Highlight column B in your Honda workbook, then right-click and choose Set As:

X. Do the same for the Toyota book.

Highlight column C in your Honda workbook and click the Scatter button ﬂ on
the 2D Graphs toolbar. Do the same for the Toyota book. This gives you two plots
of Power vs Engine Displacement, one for Honda, one for Toyota.

Click on the Honda graph and choose Analysis: Fitting: Linear Fit. Accept the
dialog defaults and click OK. Do the same for the Toyota graph. A linear fit is
performed for both datasets and an Analysis Report Sheet is generated for each.

Compare the fitting results for the two automobile makes.

By default, when there is a data filter on a column that is input for an analysis
operation, filtered data (hidden rows) are ignored in the analysis. To include hidden
rows, click on an analysis lock icon and set lgnore Hidden Rows = No.
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17.10Automating Tasks Using Programming

In addition to the above mentioned methods for automating tasks using the interface, graphing and analysis
features can also be accessed programmatically from the LabTalk scripting language, from Origin C or from
Python (internal or external). Access to Graph Themes and templates, and Analysis Templates can be
programmed. You can set up some of the procedures manually by first creating templates (graph templates,
Analysis Templates™, etc.) using the graphical user interface, and then write your code to call the templates
as needed.

You can get a broad look at what programming options are available in Origin by browsing the Programming
Chapter of this User Guide. More in-depth programming-related information is linked to from that chapter.

17.11Topics for Further Reading

. Recalculation of Analysis Results on Data or Parameter Change

e  Saving Analysis Dialog Settings as a Theme

(] The Theme Organizer, Dialog Themes

®  Analysis Templates

(] Batch Processing and Analysis Templates

e Copy and Paste Operations

. Using Data Filters to Obtain Different Views of Your Data

e  Analysis Report Sheets and Columns

(] Tutorials: Batch Processing

e Video: Batch Processing

e  Tutorial: Combine Quick Peaks Gadget with Peak Analyzer
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18.1 The Master Page

The Master Page feature is used to add one or more common objects to exported or printed graphs. Use
the master page to add a set of properties and objects -- a custom background, a company logo, text labels,
images, etc. -- to selected graph windows in your project.

Z] Mustar - Mmtur Dage o ba uned an backgrosp for otar grapia R |
Bricinlab |
Save Master Template Fotate
Apply Dimension
MBster e caN b uSed %0 pavie bac kgrund ekesants for ginar o All Graphs
graphs Besides the exampie prowided a1 e botiom b=, some us=hu
s¥ing mgislers Inckde
LIRS |35 CAgInLAD Conposmon o
Company Hame aiginiad . BEG 1 EEG 2 ﬁEG 3
Graph Lomg mame: Maxier Page iobs used 3z hackgroup for ofher graphs 2.0y
n

15610 - !

10 10* o

5010 4
name ncho  dabe 2202013
path COlsersmibcaliesktop Test_Data opi

|:| |: -
cc (] cC Mi CcC (]l
name noho
path Collssrsy Test Data opju

To make use of this feature, you must first create your Master Page. The Master Page should contain only the
properties and objects that you want to display on your selected graph windows:

From the menu, choose File: New: Master Page. If you are not in the project root folder when selecting
this menu item, you will be asked to switch to the project root folder.

Customize the Master Template. Note that the comments that show beneath the Save Master Template
button are "hidden" and will not be applied to your graph windows.

Click the Save Master Template button. When you save, the Master Template will be saved to the
User Files Folder as "name of active window".otpu (e.g. "C:\Users\YourName\Documents\OriginLab\User

Files\Master.otpu").

Things to know about the Master Page:
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Master items will only show in graphs pages of the same dimensions as the template. Apply Dimension
to All Graphs applies Master Template page dimensions to all graphs of the same aspect ratio.

If you create a graph and modify page size, then choose File: New: Master Page and load a Master
Template into the workspace, the Master Template will be loaded with the page dimensions of your
modified graph page.

The Rotate button swaps the Master Template page dimensions (toggles orientation between landscape
and portrait).

When you click Apply Dimension to All Graphs you are prompted to apply dimensions only to graphs of

the same aspect ratio, or to all graphs of the same orientation (portrait or landscape).


http://www.originlab.com/doc/Origin-Help/UserFilesFolder
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®  Master Page items on a graph with portrait orientation will not show on a graph with landscape orientation
and vice versa.

e  When NOT using Master Items, Edit: Copy Page (CTRL + J) will place an OLE-editable Origin graph
object on the Clipboard. When using Master Items, Edit: Copy Page will place an image on the Clipboard;
the Copy Graph as Image dialog will open asking you to accept or adjust image settings before clicking
Copy.

o If a graph uses Master Items, Send Graphs to PowerPoint does not support Insert Graphs as

Embedded Object. Instead, use Insert Graphs as Picture which does support Master Items.

e There is a mechanism for selectively excluding Master Items in your exported or printed page. Any object
that you do not want to appear in the exported or printed page should begin with "NoExport" (e.g. open
an arrow object's Properties dialog and on the Programming tab, rename "Arrow" to
"NoExport_Arrow").

e When you customize and save your Master Page to the User Files Folder, the next time you choose File:
New: Master Page, you load your customized template.

. If you don't want to show Master Items in the workspace, click View: Show: Master Items and remove
the check mark. The exported graph will still contain the Master Items (they just won't show in the
workspace).

. If you want to remove Master Items from a graph in both the workspace and exported images, click

Format: Page..., Display tab and clear the Use Master Items check box.

I You could use the Text tool to add project and system information to your Master
' Template as static text objects, but since the idea is to build a template for re-use,
consider "soft-coding" information in your text labels. To learn more, see these topics:

®  Substituting Variable Values in Text Labels]

(] LabTalk String Registers

18.2The Export Margin Offsets Dialog Box

By default, the margins of your copied or exported graph are determined by the Margin Control in Copy
Page Settings group of Preferences: Options (Copy actions) or the Export Settings branch of Export
Graphs (Export actions). You can interactively modify the default margins using the Export Margin Offsets
Dialog Box.
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1. Click on the graph window (to activate) and choose Edit: Set Export Margins. This opens the Export
Margin Offsets dialog.
2. Drag the blue selection handles that appear at the page margins; or enter values into the dialog edit

boxes and click Apply.

18.3Fit Page to Layer and Layer to Page

There are two small dialog boxes that are also helpful for removing white space or placing a margin around
your graph before exporting:

e Fit Page to Layers: Choose Graph: Fit Page to Layers to open the pfit2l dialog box.

e Fit Layers to Page: Choose Graph: Fit Layers to Page to open the gfitp dialog box.
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Both dialogs can be used to remove white space. Both can perform resizing, with or without changing graph
aspect ratio. You can view the documentation for both to decide which might work best for you but basically it

boils down to whether you need to keep a particular page size. If so, you'll likely want Fit Layers to Page; if

not, either one may work for you.

Fit Layers to Page is improved to for Origin 2023. There is now more precision when
drawing fractional margins (e.g. previously, a margin of 0.1 - 0.4 drew at the same

18.4Copying and Pasting Graphs to Other Applications

location). In addition, there is LabTalk support for independent margins for left, top,
right and bottom; plus support for negative margins (e.g. -0.1).

There are two ways you can include Origin graphs in another application's files (e.g. Microsoft Word .docx

files):

® As animage

e As an editable OLE graph object

When you paste as an image, you are pasting a static object. In MS Word, for instance, you may be able to
modify the image using Word's picture-editing tools, but you cannot make edits to the graph in Origin and
have it update the graph in Word (short of deleting the existing image and replacing it with a new one).

By contrast, when you paste an editable OLE graph object you can later double-click on the object in the host
application to launch a new instance of Origin. The graph and any associated data sheets will be available for
editing. After editing, use Origin's File: Exit and Return to... menu item to update the embedded object,

close Origin and return to the host application.
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18.4.1Copy Graph as Image

1.

3.

Click on your Origin graph to activate it, then ...

Choose Edit: Copy Graph as Image (CTRL+ALT+J). Alternately, click on the graph window near the

page margin and click the Copy Graph as Image button on the Mini Toolbar.
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In your host application choose Paste or press CTRL+V.

Copy Graph as Image...

When copying the graph as an image (CTRL+ALT+J), you have a choice of image formats (PNG, EMF, DIB,
HTML, JPG). Additionally, you can make quick size adjustments and specify background transparency (PNG).
The Copy Graph as Image (copyimg) dialog includes a Dialog Theme control which allows repeating <Last
used> settings, saving current settings as default Save as <default> or saving settings to a named Theme

(Save As...).
Copy Graph as Image: copyimg ? >
Dialog Theme < | act yseds * 3
Copy to clipboard without using OLE
Image Format PMNG e
Transparent Background E
Graph Size 10.72 x 3.21 (inch)
Pl 300 R
Size Factor (%) 100 ~
Image Size:
10.72 x 8.21 (inch), 3216 x 2462 pixels
You can cpen Preferences = Options = Page
to set Ctrl+C etc.
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There is a Copy control on the Preferences: Options: Page tab that lets you assign
the CTRL+C hotkey combination to either Copy Graph as Image <last used> or
Copy Page (CTRL+J) (i.e. "editable OLE graph object™). This allows you to bypass the
Copy Graph as Image dialog and speed up placing a standardized image on the

Clipboard using CTRL+C.
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18.4.2Copy Graph as Editable OLE Graph Object

1. Choose Edit: Copy Page (CTRL+J).

2. In your host application choose Paste or press CTRL+V.

Note: For more information, please refer to the:

Help: Origin: Origin Help = Exporting and Publishing Graphs > Pasting or Embedding Graphs
in Other Applications

18.50rganizing Your Graphs for Presentation or Export

If your Origin project file contains a large number of graphs that you plan to export or use in an Origin slide
show, you can make things easier by adding shortcuts to your graphs to a Project Explorer Favorites folder
and arranging them there:

e  Right-click on a window and choose Add Shortcuts to Favorites. This will add a shortcut to each graph
window, to a new Favorites subfolder (visible in Project Explorer).
e  When sending graphs to PowerPoint or creating an Origin slideshow, you can (1) set slide order in the

corresponding dialog box or (2) set slide order following this procedure.

If you are preparing a manuscript for publication, you may want to see FAQ-441 How
do | export graphs with exact size and resolution as specified by publishers?

18.6 The Layout Page

|, Origin versions 2022b and later support export of layout pages to .SVG files. When
adding graphs to the layout, choose Add Graph from the layout shortcut menu and
elements of your SVG file (e.g. text) will be editable in applications such as Inkscape or
Adobe lllustrator.

A layout page, as the name implies, is a window useful for laying out different elements for publication or
export. Use it to assemble graphs, result tables, text objects, etc. onto a single panel.
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Typically, you start by creating a blank panel:

Click the New Layout button on the Standard toolbar.

2. Right-click on the blank layout to paste Clipboard content, add text, insert images from files, add graphs,
tables, etc.

3. When inserting an image from file, right-click in the area where you want to insert. When adding graphs
or worksheets, pick a window in the Browser and drag out an area on the layout with your mouse. Note
that added objects can be moved or resized by dragging with your mouse.

O You can make edits to inserted images, by double-clicking on the image. This opens the image in
the Image Window.

O You can make edits to the graph by double-clicking on the inserted graph object. This opens the
source graph for editing. Edits to the source graph will update the graph on the layout page.

O Inserted tables can be edited by double-clicking on the table object. Style adjustments can be
made by selecting a table object and using available Mini Toolbar buttons.

4. Note that selected elements on the layout page can be aligned using Object Edit toolbar buttons.
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i For Origin 2023, keep graph and worksheet Dimensions when pasting between
layouts of different sizes by pressing the ALT key while pasting (for more information,
see this Origin Help page).

For more on the layout page, see Using the Layout Page Window in the Origin Help file.

18.6.1Merge Graphs to Layout

As an alternative to manually creating layouts, Origin offers a tool that will merge select graphs into a single
layout page of equal spacing. In this case, merged graphs are images and, therefore, not editable using the
procedure described in step #3 of the previous section. However, if further graph edits are not needed, you
can use this method to quickly produce a nice-looking layout.
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In addition to Merge Graphs to Layout, Origin includes "merge graphs™" utilities in several

other dialogs: Merge Graph Windows, Arrange Layers and Layer Management. For

Origin 2023, these merge utilities now get a Direction drop-down so that you can better
control the resulting graph arrangement.

B Arrange Settings

Mumber of Rows

Mumber of Columns

Direction
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To merge graph images into a single layout:

1. With a graph window active, click Graph: Merge Graph to Layout: Open Dialog.
2. Use the Selection drop-down to specify how to select graphs. To choose individual graphs, choose

Specified and use the browse button beside Graphs to open the Graph Browser and pick graphs.

Use the Fit Page to Objects menu command (Format: Fit Page to Objects) to apply
a uniform margin to the active Layout page. This works the same as the
aforementioned Fit Page to Layers does for graph windows.

18.7 Exporting Graphs and Layout Pages to an Image File

Origin 2021b added a simplified graph export routine to complement the existing graph export routine:

e File: Export Graph: If you simply want to export one or two graphs to one of several common image
format (PNG, BMP, JPEG, TIFF, EMF) and need only minimal control of image size, this routine is quick and
easy.

e File: Export Graphs (Advanced): If you want to batch export graphs (e.g. All in Active Folder, All in
Project, etc.), or export to vector types such as PDF or EPS, use this routine. The dialog supports
outputting to a specified path, auto naming, application of Speed Mode settings to exported graphs, plus

margin control, image size and other filetype-specific settings.
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Beginning with Origin 2023, the following export dialogs will add a date-time stamped
; clickable link to the Messages Log. Click the link to open the file using an internal Origin
y TENY viewer (see below):

Messages Log * o X

[7/28/2022 11:4%:28 expGraph]
Graph114 is exported to

"ChUsers\mike\Documents\OriginLabiUser ) body weight_height.dat - Notepad =~ — 0 W
Files\Graph01.pdf” File Edit Format WView Help
F F M M
[7/28/2022 15:56&:32 expAS5(C] height weight height weight
UnstackCols1 is exparted to 148 42.2 148 38
"CAlsers\mike\DocumentsiOriginLa Y S =Y o
= - 136 33.2 12¢ 35.9
Files\baody, t height.dat" 163 65 160 44.5
1z8 28.7 155 46.9
148 50.6 143 42.6
~ 150 47.9 146 35.2
' ; 155 42.2
. ] _ . 58 44
+ expm2video: Export matrix objects as an image stack &0 536
* expG2img: Export graph with a simple dialog 158 41.3
» explmage: Export matrix image to file : ’ “1‘
+ expExcel: Export worksheet data as Excel sheet 8¢ e
* expASC: Export worksheet data as ASCII file 3= 57.
» cvExport: Export the active image as file 4

In addition, two system variables are added to manage Messages Log output for images:

e @VID is added to select image viewer (raster, EMF): 1 = use Origin viewer (default); O
= use system default application.
® (@MSG is added to control what is output to the Messages Log: 0 = output both file and

and link (default); 1 = output link only; -1 = disable message output.

To open file location in Windows Explorer (without opening the file):

1. Right-click on a link and choose Open File Location; or press Ctrl while clicking on the

link.

For Origin 2023, the default Color Depth of raster files is increased to 24-bit
(previously, some remained at 256 Colors).

18.7.1File: Export Graph

File: Export Graph (X-Function = expG2img) is a simplified routine for exporting the active graph page to
one of the following formats: PNG, BMP, JPEG, TIFF, or EMF. It does not offer the level of control or flexibility
as File: Export Graphs (Advanced) (next section) but it works well for simple export of individual graph
pages.
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"i"‘"“-"'l-“" For Origin 2023, exporting a graph using expG2img will generate a clickable link in
k the Messages Log.

To export a graph or layout page to raster image using the simplified expG2img dialog:

When a graph window is active, choose File: Export Graph.
2. For EMF images, set a size factor relative to the Image Size reported at the bottom of the dialog. For

raster formats, choose an output DPI setting. Alternately, clear the Auto check box and specify a Width

in Pixels.
5 Grouped Stackd Calorme [E=E(S=R~|
i .
8 Export Graph: expG2img [4 *
Dialog Theme <[ act yseds * 4 |
Export graph with a simple dialog
Image Type |5‘|.I'G w
PHG
File Mame BME e | wn
IPEG — -
File Path TIEE e'\Documents) OriginLabiUser Files), v | -
EMF
Graph Size nich)

File will be saved as:
Ci\Users\wsiia’,Documents\OriginLab\ User Files\phatPhile.svg

Imiage Size:
10.67 x 8.00 (inch)
oK Cancel
—
o For Origin 2023, the simplified File: Export Graph (X-Function = expG2img) dialog
HWEW gets a Preview button. Clicking Preview opens the graph-to-export in an internal

viewer.

18.7.2File: Export Graphs (Advanced)

File: Export Graphs (Advanced) (X-Function = expGraph) is Origin's primary tool for exporting graphs and
layout pages. It supports raster or vector output, flexible multi-page export (e.g. All in Active Folder), DPI
and Speed Mode control and more.
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Improvements to Advanced (expGraph) export for Origin 2023:

New CTRL + ALT + G hotkey for File: Export Graph (Advanced) <Last used>.
The default Basic Object Resolution of PDF files is increased from 72 to 96.
When you select Image Type = TIF/TIFF, and select multiple graphs for export
(e.g. All in Active Folder), an Export as multi-frame TIF check box is added to

the dialog. Check the box to export selected graph windows to a single TIF image
(TIF stack).

To export a graph or a layout page as an image file:

1. Select the menu File:Export Graphs (Advanced).
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The expGraph routine exports graphs to one of 15 file formats:

Raster Formats

BMP, GIF, JPG, PCX, PNG, TGA, PSD, TIF;

Vector Formats

CGM, DXF, EPS, EMF, PDF, SVG, WMF

18.7.2.1 Saving Export Settings to a Theme

As is the case with many other Origin dialog boxes, you can save your graph export settings as a Dialog

Theme for repeat use.

B Export Graphs: expGraph ? >

Dialeg Theme =Graph> » ||

Export graphs as rast

er or vector files

~l
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Once you have determined your export settings:

e  Click the flyout button to the right of Dialog Theme and choose one of the Theme save options.

e Using any group of custom settings creates a temporary default Theme called <Last used>. This Theme
then becomes available for loading your last used settings and you can access it from the expG2img or

"expGraph dialog boxes or from the File: Recent Exports menu.

expGraph dialog box File: Recent Exports menu

p | saveto<Graph> Recent Exports k 1 expGraph: <Last used= [
Save as < default>
Save
Save As..

System Default
Delete...

Compare...
Generate Script

<Last used=

Since Origin 2021, expGraph dialog box settings are saved to the graph automatically on export.

e To save current settings withtout exporting, choose Save to <Graph=>.

® To restore saved settings after you've modified them in the export dialog, choose <Graph=>

1" Export Graphs: expGraph 7 >
Dialeg Theme = Graph> "l Save to<Graph= b
- SAVE 4% < derauns
Export graphs as raster or vector files
Save
N Save As...

System Default
Delete..,

Compare...

Generate Script

<Graph>

<Last used=
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Note: For more information, please refer to the:

Help: Origin: Origin Help > Exporting and Publishing Graphs > Exporting Your Graph or

Layout Page to an Image File

You can export multiple graphs, such as all graphs in a folder or all graphs in a project file,
to a single, multi-page PDF file. Choose File: Export Graphs and open the Export Graphs
dialog box. Set Image Type to Portable Document Format (*.pdf) and Select
Graph(s) to one of the following options and you will see a checkbox for Export as multi-

page PDF file.

Portable Document Format [*.pdf]

Allin Project w

Active Page i
All in Active Folder
All in Active Folder [Recursive) k

All in Active Folder [(Open) I
All in Active Folder [Include Embedded]
L&l in Project

[Specified l

Export as multi-page PDF file

18.8Exporting Browser Graphs to Video

For Origin 2023, you can export a Browser Graph as a video (GIF, TIFF, AVI):

1. Activate the Browser Graph. Before going further, confirm that the graph is in Page View (click just

below the window title bar and when the Mini Toolbar appears, verify that there is NOT a red check

mark beside the Window View button. If there is, clear it).

t&% I-i |’g tnll‘: Window View i
R io A oo &

#EE

In the panel to the left, click the menu button - ¥ and choose Flip Through.

Click the Export button and set File Type = GIF, TIFF or AVI.
Modify other settings as needed and click OK. Unless it has been turned off, export will dump a clickable

link to the Messages Log. Click the link to run the video in the supporting application.
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18.9Exporting Images to a Raster or Video File

Using File: Export Image (X-Function = cvExport) Image window you can export images to one of several
raster formats: BMP, GIF, JPG, PNG, TIF.

For Origin 2023, exporting an image to file will generate a clickable link in the
Messages Log.

To export an (image window) image using cvExport:

1. With the image window active, choose File: Export Image.

2. Choose from the list of raster images; or save as a video file (*.avi).
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® Export Image: cvExport ? x
Dialeg Theme = b
Export the active Image as file o
File Type PMNG e
DPI | 60D
File Name | <auto> |
File Path | ChUsersh xDDcumentsiGriginLab\q L
Width in Pixels 300
Height in Pixels 373
File will be saved as:
C:\Usersy WDocumentst COriginLabh User
FileshCar.bmp.png
OK Cancel

18.10Exporting Matrices

18.10.1 Export Matrix as ASCII

This will create an ASCII file of the data contained in the active matrix object.

1. With the matrix active, choose File: Export: ASCII.

18.10.2 Export Matrix as NetCDF

This will export all objects in the active matrix to a .nc file:

1. With the matrix active, choose File: Export: NetCDF.

Publishing and Export

2. For Base year for sampling across years, note that when the matrix data are averaged across years,

the time variable is not exported with the NetCDF file. Use this to specify how to indicate time:
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MetCDF: expMatMC ? ey
Dialog Theme »
Export Matrix Sheet to nc file
im | [MBook1]MSheet] »
File path |]ncumentsiﬂriginLah\USH Files\MSheet2.ne
Base year for sampling across years  Mone B
oK Cancel
None Do not specify a time variable

Use Starting

Year Use starting year as time variable

Use Ending Year |Use ending year as time variable

For more information on Exporting NetCDF data, see the Origin Help file.

18.10.3 Export Matrix as Image

Matrix images can be exported using File: Export: Image (X-Function = explmage).

Improvements to exporting matrices to image file For Origin 2023:

Agmtat e  Exporting an matrix to file will generate a clickable link in the Messages Log.

® There is better auto-detection of GeoTIFF data in the matrix and therefore the File

Type drop-down will be preset to TIF/TIFF format.

To export a matrix image to raster file including as Grayscale GeoTIFF:

1. With the matrix active, choose File: Export: Image.
2. Verify that the File Type is correct. For GeoTIFF data, the TIF/TIFF format should be pre-selected but to

export as grayscale GeoTIFF, check the Export as Grayscale GeoTIFF box.
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1 |mage: explmage
Dialog Theme

Expert image to file

x

Input Matrix
File Type

File Mame
2 image Settings

B GeoTiFF Options
GT Model

EPSG
Angular Units
Vertical Units

B TiF options

DM Resolution

Comprassion

18.10.4

[ [A2021]"2020°11
Tag Image File [* tif,*.tiff)

Chlisers $\Documents\Originlab\User Files\2001_D.tif

Export as Grayscale GeoTIFF v_’

s20detic

Export Matrix as Video

Cancel

Matrices containing multiple matrix objects can be exported to GIF, TIF and AVI (X-Function = expm2video).
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To export a series of matrix objects as a video file:

1. With the matrix active, choose File: Export: Video.

B Video: expm2video 7 Y
Dialog Theme b

Export matrix objects as an image stack

File Type GIF e

Frames Per Sec | 2 |

File Name | <auto> w |

File Path | Chlsers' \Drocuments\OriginLabiUser Files, w

Width in Pixels 720
Height in Pixels 3260

File will be saved as:
ChUsers\ i Documents\ OriginLabh User Filesh\2020.tif-2020.gif

QK Cancel

18.11Exporting Worksheets

! For Origin 2023, exporting worksheet data to ASCII or Excel will generate a clickable
e ) link in the Messages Log.

With a worksheet active, the File: Export menu item provides the following options:

18.11.1 As ASCII, NI TDM (TDM, TDMS), and Sound (WAV)

These apply only to sheets containing data columns, and are not available for analysis report sheets (see other
options, below). The exported file will contain only data from the worksheet columns. Floating or embedded
graphs placed in the worksheet will be ignored.

18.11.2 As Excel

Export books of worksheet columns with text and numeric data to an MS Excel file (XLS, XSLX, XSLM). Note
that analysis report sheets with their hierarchical tables, and things such as embedded graphs and images, are
not exported to the Excel file. Analysis results that are output to regular Origin worksheets are exported.

1. With the worksheet active, choose File: Export: Excel.

2. In the dialog that opens, set Export Sheets to Whole Book or Active Sheet Only.
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3. Optionally, check the Export Cell Formats box.

For Origin 2023, you can opt to Export Cell Formats including numeric and style
formats (decimal digits, font, background color, etc.).

' He"' W Excel: expExcel 7 4
Dialeg Theme = »

Export worksheet data as Excel sheet

Input Worksheet || [Bookl] | B
File Name | E'\Project_Data\Origin 2023\Projects_and_Test_Data\Bookl_ - | .
Export Sheets Active Sheet Only -

Export Cell Formats i~

QK Cancel

For information on copying analysis report sheets and pasting to MS Office applications,
see FAQ-815 How do | copy report sheet tables and paste them into Word, Excel or
PowerPoint?

18.11.3 As SQLite

This option exports the active worksheet(s) as an SQLite file. Specify a file extension of .sqlite, .sqlite3 or .db
(note that file structure is identical). Options to skip hidden columns or rows. Limited to export of data in
worksheet columns.

18.11.4 As Multipage PDF File

This option is available only on sheets with data columns, and not for analysis report sheets. Use the View:
Page Break Preview Lines menu item to view the vertical and horizontal page break lines that determine
which columns and rows will be included in each page of the export. Floating or embedded graphs placed in
the worksheet will be included in the exported image.

18.11.5 As Image File

This option is available on both data and analysis report sheets:

1. With the worksheet active, choose File: Export: As Image File.

2. In the dialog that opens, set Export Area to Visible, Whole or Selection.

Image file formats including PDF and SVG are supported. Floating or embedded graphs placed in the
worksheet will be included in the exported image.
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Worksheet Export: As Image File is improved for Origin 2023:

Afgma e, e  Empty rows no longer exported when Export Area = Whole.
e  Automatically apply <Last used> Theme.

e Add border to exported worksheet. Change border width or remove border, set the

Frame Thickness drop-down.

Descriptive statistics
Valid N Mean Median  Minimum Maximum Standard Deviation
Power 340 79,85 71 33 168 28.07561
0~60 mph 340 15.58824 15 8 23 314842
Weight 340 1337.75882 1204 724 2324 341.95962
Gas Mileage 340 21.74706 21 10 36 589141
Engine Displacement 340 340843735 2901.05 11145 74574 1719.2832
18.11.6 As PDF File

This option is available for both data and analysis report sheets. In the dialog that opens, you can opt for
exporting the entire sheet, the visible area, or a selection. Floating or embedded graphs are included in the
exported PDF.

When creating a custom report from a worksheet that combines data, numeric results
and graphs, the best option is to export the entire sheet as a PDF file, or export the
sheet as a multi-page PDF file.

18.12Send Graphs to PowerPoint

You can send a group of Origin graphs to MS PowerPoint as pictures or as embedded objects (see limitations
of embedded objects and Master Items, explained above). Graphs inserted as embedded objects can be
further edited in your Origin software. Double-click on the graph in PowerPoint to open the graph in an OLE
instance of Origin.

To Send Graphs to PowerPoint:

1. Click the Send Graphs to PowerPoint button on the Standard toolbar.

or...
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]
1. Click the Send Graphs to PowerPoint icon ™F in the Apps Gallery, docked to the right-side or your
Origin workspace (if you do not see the Apps Gallery, click View: Apps or press ALT + 9).

or...

1. Right-click in the lower-pane of Project Explorer and choose Send Graphs to PowerPoint.

Tutorial: Send Graphs to PowerPoint

1. Run Origin and open the sample file <Origin EXE

Folder=>\Samples\Graphing\Column and Bar.opju.

Click the Send Graphs to PowerPoint button on the Standard toolbar.
Click the Select Graphs button and choose Specified.
Select all except Graph5B in the left panel and move them to the right panel by

clicking the in the middle of the dialog box. Click OK. A scrollable list of
graphs is added to the left panel in the App.

Set Insert Graph as = Picture.

Set the Slide Margin top dimension as 8% and leave the others as O.

Set Title Line = Top of Slide, and Title = Window Long Name.

Set Starting Slide Index = 3 and Slide Mode = Start New.

© O N oo

Use the browse button beside Load File/Template (optional) to load the file
<Origin EXE Folder=>\Samples\Import and
Export\Column_Plots_in_Sample_OPJ.pptx.

10. Specify a Save File as (optional) output path for the resulting PPTX file.

There is also a Send Graphs to Word App that is pre-installed with your Origin
software. This App is particularly useful for batch export of graphs to a book-marked
MS Word document.

18.13Slide Show of Graphs

Origin has a built-in slideshow utility for viewing or presenting your graphs while running Origin. The slide
show can be started in two ways:

e Right-click on any folder in Project Explorer and select Slide Show of Graphs...

or

®  Click the Slide Show of Graphs button .Er on the Standard toolbar.
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A dialog box opens offering options to set slide order, slide cycle time, whether to include graphs in sub folders,
etc. The dialog also lists shortcut keys for use during the slide show (e.g. G = go to the actual graph window
of the currently displayed slide).

Tutorial: Slide Show of Graphs

1. Use the File: Open Sample Projects: 2D and Contour Graphs menu to open
the sample project.
Click on the Slide Show of Graphs button in the Standard Toolbar.
Accept default settings in the dialog that opens, and press OK to start the slide
show.

4. You can use the up/down arrow keys or the mouse wheel to flip thru the slides.

18.14Creating Movies

Origin provides a Video Builder tool, accessible from the Open Video Builder button EEE on the
Standard Toolbar. This tool can be used to manually capture a series of graph windows, and write one frame
at a time to a video (.AVI) file.

Videos can be created using LabTalk script or Origin C code, by programmatically computing or updating data
and then writing out the graph as a frame in the video, at each step during the computation.

Note: For more information, please refer to the:

Help: Origin: Origin Help > Exporting and Publishing Graphs > Creating Graph Animation

For specific examples of programmatically created movies, including Origin Projects and
code, please visit www.originlab.com/animation.

18.15Notes Windows for Reporting

Over time, Origin's Notes window has morphed from a plain-text window for jotting down your research notes,
into a flexible medium for collating a variety of research-related materials.

Because the Notes window can contain linked objects -- graphs, images, worksheet cell values, etc. -- it can
be useful to add a Notes window to an Analysis Template™ for purposes of summarizing analysis results.
Alternately, you can save your Notes window as a PDF by clicking File: Print and choosing a PDF driver.

18.15.1 Notes Window Syntax

Origin's Notes window supports four syntaxes: Text, Origin Rich Text (default), HTML, and Markdown.

1. To switch syntaxes, choose Notes: Syntax: Text.

2. Once you have selected Text, you can freely choose other syntaxes from the Notes menu.
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18.15.2 Rich Text

With Rich Text, the Notes window has two modes -- raw text mode and Render mode. Toggle between these
modes using Notes: Render Mode or shortcut key combination CTRL + M.

To add text to the Notes window, you need to be in raw text mode. To style added text, use the Format
toolbar and/or apply pre-defined paragraph styles.

T Segoe Ul - 1 - . F U« x, sap X £=~-- A -
) | TR e——
, y . 4
pﬁzg::gﬂ::zzzz * Number of Points: 2 More Colors: System Color List
"-:lE{{style;Bulletec * Degrees of Freedom: 18 EEENCNEEEEEEn
\pi{style:Bulleteq « Residual Sum of Squares: 9.54378 o o 5 5
\plistyleBulleted o EESDOONOCENEE
\p{{style:Bulleted + Pearson's r; 0.99587 T P emEl T T
« R-Square (COD): 0.99175 EEEENNEEEEEEE
ANEEEEEEEEEEN
« Adj. R-Square: 0.99129 Custom «
+*

18.15.2.1 Adding Content to Your Notes

You can insert these objects to the Notes window by by right-clicking in the Notes window and choosing from
the shortcut menu:

‘imo(lmage1, w=300) ~
£} Undo Ctrl+Z
\p{{style:Heading 1}}({% T Cri=v 11, Wih
Insert r Graph/image: [Image2]
"w(%([Book2]!page.info. Paragraph Styles R Waorksheet Cell...
$([Book2]!page.info.File] Info Variable...
-f' cut clr=x New Table...
\pi{style:Heading Left}}(|=2 Loy Ctri+C
[ paste Ctrl=V S
\p{{style:Bulleted List}}({ | Paste Link Ctri=Alt=V LaTeX Equation...
\p{{style:Bulleted List}}({ | Delete Delete Hink...
\p{{style:Bulleted Li.S't}}{{ Select Al e Image from File...
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Object Comments

Opens the Graph/Image Browser where you can pick project graphs and images.
Note that you can Show Embedded Graph (see the first row of this table for a
definition of "embedded graph") and Project Explorer "Favorites" folder shortcuts
(Include Shortcut Page).

Graph/Image

Opens the interactive range selector. Use this to pick a cell value in a worksheet or
report sheet. Click Done to insert a linked cell value.

Worksheet Cell...

Opens the Insert Variables dialog for inserting project variables stored on data

Info Variable... .
import.

Opens the New Table dialog for configuring a basic table. Clicking OK closes the
dialog and opens a basic workbook containing a single worksheet. Customize the
worksheet, add data, etc., then use Notes window Render Mode to view the resulting
table.

New Table

Opens a simplified Symbol Map with characters sorted by tab. Click Advanced to
go to the full Symbol Map.

Symbol Map

Opens the LaTeX Equation Editor App (if you've not already installed this free App,

LaTeX Equation you are prompted to do so0). You can click the Equation button fiy to open a list of
Origin's fitting functions (incl. your user-defined functions). Pick a function (or enter a
function into the top box) and click Preview to see your equation rendered.

Opens a dialog box for entering Text to display and a Link. The link can be a URL
or it can be a link to such things as a worksheet data range (e.g.
range://[bookl1]sheetl!col(1)[100]). Additionally, you can run simple LabTalk
commands using a "labtalk://" tag (e.qg. labtalk://newsheet).

Link

Opens a dialog to browse for image files. Note that the inserted image is linked to an

Image from File external file and is not saved with the project.

Opens a dialog to specify a Image Link for a web image (hint: In your browser,

Image form Web right-click on an image and Copy Image Address, Copy Image Link, etc).

Add your content using raw text mode.

2. When you are ready to view your content, turn on (place a check mark beside) Notes: Render Mode or

=[]
press CTRL + M. Note that you can use the Zoom combo box on the Standard toolbar to

zoom in or out on the page (CTRL + mouse wheel also works).
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18.15.2.2 Text Styles Manager

In addition to styling text with the Format toolbar, you can apply a simple set of paragraph styles on a line-
by-line basis. Manage styles with the Text Styles Manager dialog box.

1.
2.

With a worksheet active, choose Tools: Text Styles Manager.
Select a Style to Modify and Apply or Close.
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8 Modify Text Style

Style to Modily

Font Face
Size Factor (%)
Color

[[] Justification
[=] Font Style
Bold
ltalic
Underline
[ Spacing
Extra Line Spacing (%)
Before Paragraph (pts)
after Paragraph (pts)
Indentation (% of font size)
List

Delete

7 x
Body Text w
T Default: Anal v |

100 w

. Auto -

[l

[l

U
-
R
T

None i

Apply Cloze

Note that you can add styles by selecting <new=> from the Styles to Modify drop-down list; or select a style

and Delete.

To apply a paragraph style to Notes window text:

Open the cell note in a Notes window.
2. With Render Mode off (CTRL + M, to toggle), click on a line of text then right-click, choose Paragraph

Styles and choose a style from the popup menu.

3. To check results, press CTRL + M (Render Mode).

To see a list of built-in paragraph styles, open a fresh Notes window, then from the

menu choose

Notes: Load Samples: Built-in Styles.txt.

18.15.2.3 Adding Rich Text Content to Layout or Graph

You can insert Rich Text content from a Notes window to a text object on a Layout or graph page.
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This s linked o he new ted Bbelin 2 greph or layout.
ou can replsce s 124 with your own and then press FE
in the layout'graph io updsie.

Frommin menu choose Notes > Load Samples
Right-click on text to apply styles.
Right-click 1o insest mages, ks, or squstions

Use CTRL+M i topgie betwesn edt and render modes

This is linked to the new text label in a graph or layout.

You can replace this text with your own and then press
F5

in the layout/graph to update.

From main menu choose Notes > Load Samples
Right-click on text to apply styles.

Right-click to insert images, links, or equations,

Use CTRL+M to toggle between edit and render modes. .

To add the content of an existing Note (Layout or Graph):

1. Select the Text tool ﬂ then click on the Layout/Graph and enter "@@@NotesN" (i.e. the Notes
window Short Name).

2. Click off the text object to insert Notes content.

To add content by creating a new Note (Layout only):

1. Right-click on the Layout and choose Insert Notes Text.

2. See Adding Content to Your Notes.

18.15.2.4 Print or Export to PDF

You can output Rich Text content to a physical printer; or print to PDF using a third-party driver such as
Microsoft Print to PDF.

To create nice-looking output, you'll need to pay attention to these settings:

e Paper Size: This is set in File: Page Setup or in the Advanced options for your printer driver.

e Margins: These are set in File: Page Setup.
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¢ Notes Display Margin: By default, the Notes display margin = 5 (units = points). Thus, you will note

that in Render Mode (CTRL + M), there is a slight margin to the left side of the Notes page. This display

margin is controlled by setting system variable @NDM.

e Notes Window Page Width: Page width is controlled by the property note.width (units = in/cm, etc).

Default = 0, which corresponds to an uncontrolled width.

18.15.3

When width is uncontrolled (note.width = 0), Notes Window Page Width is

approximately equal to Paper Size — Margins. This should produce a satisfactory printout

to PDF or paper.

If you do specify note.width, do not exceed Paper Size — Margins or your text may be

cut off.

HTML and Markdown

You can also use Notes windows to create HTML or Markdown reports. Similar to Rich Text, you can build your
HTML report using placeholders that link to report sheet elements such as metadata, statistical results or
graphs. The resulting HTML report can be printed or exported; or it can be incorporated into your Analysis
Template. If Markdown syntax is used, optional HTML syntax can be also included for advanced customization.

To use this feature, the user should have some basic familiarity with HTML or Markdown, and as with most
things, the more proficient the user is, the easier it will be to create professional-looking output. However, the
skill needed to generate a basic report can be easily mastered. See this OriginLab blog post for guidance.

Fsews HTML Report - w

ricinl b

(@ Analysis Report Sheet Linear Fit Report e_
S : - Iull Bl

ey et il

Sope 125683 010007 1258008 2351SIE

Ovigin Prajeet: O\ Userrimike| Dewndomds | HTML-Bleg-Anaiysis- Report| HTML Ring Amatysis Repart spju

File Information

File Mame: Linear Fit.dat
File Date: 12/12/2018 16:18:47

NEbE P 3 | Placeholder Sheet
[ A | B |

Long Mame Pracenoioen il
Commants
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User Chis

Top

= Equaticn yo=asbmx
fandard Emer  Value  Siad 1
064308 1 25eEd Weight Mo Weighting

Intercept . 064366
Slope 2!
Residual Sum of
Pearson’s v 56
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Adj. R-Square 089
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18.15.3.1 Adding Content to Your HTML Report

The basic steps of creating reports using an Origin Notes window, are as follows:

1. Create your project to include graphing and analysis results.

Click the New Notes button

E

to add a Notes window.

From the menu, choose Notes: Syntax, then choose HTML or Markdown (Hint: You can toggle

between text/view and markup modes by pressing CTRL+M and you can choose the default syntax by
setting LabTalk System Variable @NPS).
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4. You can write your code in the Notes window's markup mode or you can use a text editor such as
Notepad++, then copy and paste it to your Notes window. If you have no experience with HTML or
Markdown, you may want to load samples by activating your Notes window and clicking Notes: Load
Samples (HTML = ".html", Markdown = ".md").

5. You will likely want to incorporate graphing and analysis results from the current project, into your report.
The simplest way to do this is to insert "placeholders" for each Origin object that you intend to include in
your report, into your code. These placeholders can be named using any string that makes sense to you
and they should be enclosed in double-curly braces (e.g. {{MyR-SquareValue}}).

6. Right-click on the Notes window title bar and choose Edit Placeholders. Placeholders that you have
incorporated into your code will be picked up and added to a Placeholders worksheet in the workbook.
The sheet will list, in column A, all of the placeholders found in your code. A second column -- Column B --
is blank and is reserved for adding the associated Origin objects (i.e. the variables, analysis and graphing
results, etc.) that you want to include in your report.

7. For each placeholder in column A, find the associated Origin object and copy it to the Clipboard (e.g. if itis
a numeric quantity in a sheet resulting from some statistical analysis, select the cell quantity, right-click
and choose Copy, or press CTRL+C on your keyboard).

8. Return to the Placeholders sheet, right-click in column B, beside the associated placeholder and choose
Paste-Link. This associates your placeholder with the intended Origin object.

9. If you intend to include your HTML report in an Analysis Template, you can right-click on a workbook tab
in your Analysis Template and choose Add Notes as Sheet. This inserts your Notes window into

workbook and you can now choose File: Save Workbook as Analysis Template.

i When a Notes window is active, you can click the Notes menu and load a sample HTML file
' into the Notes window.

Motes | Tools  Preferences Connecivity Window Social Help

Load 5amples b Combo and Button.himl
Load... Hello Warld.html
Add Links b Linear Fit Report with Placehalders.html
Export to Webpage... Linear Fit Report.html
Peak Fit Report with Placeholders.hitml
Render Mode Ctri=M -

Edit Placeholders... Peak Fit Repart.html

Synta " Useful 5tring Registers.html

Display Line Numbers Hello Waorld.md

Linear Fit Report.md
Useful String Registers.md

18.15.3.2 Using Your HTML Report

As you fill in your Placeholders sheet, you should see your HTML report take shape in the Notes window. Once
completed, you can do various things with your HTML report, including:
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e  Print to hard-copy or to PDF (File: Print).
e  Export the window as a webpage (Notes: Export to Webpage).

® Click the embed button in the upper-right corner of the Notes window to embed the content into your

workbook, then save the workbook as an Analysis Template (File: Save Workbook As Analysis

Template).

18.16Topics for Further Reading

(] The Preferences: Options Page Settings

e  Pasting or Embedding Graphs in Other Applications

(] Exporting Your Graph or Layout Page to an Image File

e  Which Image Format Should | Choose?

(] The Export Graph Dialog Box

(] Send Graphs to PowerPoint

e Send Graphs to PowerPoint Dialog Box Settings

e View Graphs as a Slide Show

e The Slide Show of Graphs Dialog Box Settings

e Creating Graph Animations

(] Printing Graphs, Layout Pages and Analytical Results

(] The Print Dialog Box

e The Print Options Dialog Box

e Copying and Pasting Graphs inside Origin

. Inserting Graphs and Images into Worksheet Cells

e  Tutorial: Creating a Custom Report Sheet

(] Using the Layout Page Window

(] Creating a Master Page Layout for Graphs
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19 Apps for Origin

Origin 2016 introduced Origin Apps -- tools that you could easily add to your Origin installation by dropping
them onto your Origin workspace. This ever-expanding collection of add-on tools is extending Origin's already-
powerful graphing and analysis capabilities.

Because an App is a self-contained, easily-distributed tool aimed at solving a particular problem, it can be
developed and deployed quickly, sidestepping the need to wait for a new Origin product release. In addition,
an App can be developed by anyone with a basic knowledge of programming in Origin, making it attractive as
a means to create and distribute tools for your company or user-community.

At present, all Apps can be downloaded for free. Note that some Apps require OriginPro; these are denoted in
the App description by the symbol.

19.1Where Do | Find Apps?

Apps are listed on the OriginLab File Exchange. While you can download Apps from the File Exchange using
your web browser, it easier to obtain and manage your Apps using the App Center.

The App Center provides "one stop" App installation and maintenance: Browse and download new and
popular Apps, search for Apps, update existing Apps, request an App or submit an App via the OriginLab
website.

To open the App Center, click the Add Apps button that appears on all tabs of the Apps Gallery.

App Center - o

Fl Spectral Broadening m Allan Variance
ngenlab * nigenlLab V
ecl 8 T B

1. Version: OrignBro 2017 Min. Version: OrignPro 201

Maps Cnline D3 Import Files from a Folder
e o ey n
What to look for in the App Center:
o Installed Apps with an Up-to-date Version icon v beside them are up-to-date.
e  Apps with a clickable Download and Install icon beside them are not installed. Click

this icon to install.

e  Apps with an Update icon O beside them have an available update that you can install.
Click this icon to update.

e Click the New and Popular tab for a quick look at what's available. Download and update
Apps.

e Click the Search tab to find Apps by Category and Minimum Version. Download and
update Apps.

e The Updates tab will display a red circle icon when there is an update to one or more

installed Apps. Improvements and bug fixes are listed for each.
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19.1.1Finding Apps from Analysis and Statistics Menus
You can find Apps for these specific applications by clicking Find Apps... from Origin's main menu:
e Analysis: Fitting

® Analysis: Peaks and Baseline

e  Statistics

These menu commands open the App Center Search tab to show only relevant Apps that are currently

available from OriginLab's File Exchange. Click the Download and Install button beside an App, to
install the App.

5 App Center O x
Category Al , Q, it
Min. Version | ajl | _Updawd {Newest - Oldest) :-’l
Onset for Peaks - Bl Pulse integration (D3
ﬁb‘- OriginLab OriginLak = 3
Min 020190 S ¢
Low 3
Q)
T Align Peaks m Global Peak Fit
A CrniginLab L d‘. Onginlab L
Request App Mir. Version: Ongin 2019 SR Min. Version: OnginPro 2018 SRO
19.2How Do I Install Apps?
If you install your Apps using the Download and Install button in the App Center dialog, you don't
need to do anything else. The App is automatically downloaded and installed. When App updates become
Ty
s

available, you can use the Update button to update an installed App.

If your workstation does not have internet access:

If your workstation does not have internet access, you will need to find a computer that does (does not need
to have Origin installed), download the App from the OriginLab File Exchange to a thumb-drive and bring it
back to your workstation.

1. On the internet-connected computer, open a browser window and browse to
originlab.com/fileExchange.

2. Browse the list of Apps, go to the App's description and download page, then click the Download File
button and copy the file to your thumb-drive.

3. Return to your Origin workstation, plug in your thumb-drive and run Origin. Open Windows Explorer,
browse to your thumb-drive and once you locate the App (it will have a .opx file extension), drag the App

file to an empty portion of the Origin workspace. Make sure you are not running Origin as administrator or
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drag-and-drop operations will fail. The App will be installed and the App icon will appear in the Apps

Gallery, docked to the right side of your Origin workspace.

If you have questions, click the How to Install link below the Download File button on the File Exchange
App description and download page.

File Exchange > DataAnalysis > Sequen

Download File

How to Install

19.2.1Finding Apps from the Start Menu

You can also search for and install Apps directly from the Start menu.

Apps
v Peak Deconvolution
I} Cyclic Voltammetry

11 2D Peak Analysis

1 Onset for Peaks
@Inbal Peak Fit Ib

Fit multiple peaks in multiple datasets with parameter sharing.
Y Gel muiecwiEan weigne AndiyLen

Find |peak fit x {3}

a << Start Menu (F1)

19.3How Do | Run an App?

Upon installation, an App icon is placed in the Apps Gallery, docked to the right side of the Origin
workspace.

App operations may be window-specific. If the App is dimmed (grayed out), the active window cannot be
operated on by the App. Check the required window type (hover on the dimmed App icon in the Apps
Gallery).

If the Origin window type (worksheet, graph, etc.) is matched to the App, you can launch the App by
double-clicking on it in the Apps Gallery.

If you prefer to launch the App from a toolbar button, open the Customize (Toolbars) dialog box (View:
Toolbars), click the Button Groups tab, locate the App's toolbar button and drag the button to the
OriginLab workspace or to an existing toolbar. Close the dialog box.

Specific usage information is available on the description and download page for each App.
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19.4Managing Your Apps

You can use the App Center in combination with the Apps Gallery, to manage your Apps:

e Use the App Center (discussed above) to add and update Apps, search for Apps, request an App or

submit a review of an App.

. To launch the App Center, click the Add Apps button in the Apps Gallery.

ﬂ Spectral Broadening
Ongnlab

Min. Versionc OngnPro 2017 SR0

W

e  QOrganize your Apps by adding tabs to the Gallery. Right-click in an empty portion of the Gallery and

choose New Tab, then double-click on the default tab name and give the tab a meaningful name.

Apps lcon Spacing...

Uninstall All...
Refresh

MNew Tab [
Lag'

Show Connector Apps
Show Apps from Other Tabs
Sort Apps

L

/ fydesbojemo

e  Additional higher-level actions available from the shortcut menu:

e Apps Icon Spacing ...
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e Uninstall All ...

e Refresh

e New Ttab

e Show Connector Apps

e  Show Apps from Other Tabs

e Sort Apps (Alphabetically, Newest Install, Recently Used).

e A number of App-specific actions can be performed by right-clicking directly on the App icon in the Gallery

and choosing from the shortcut menu.

Apps »
T | Add Apps

TS

3

o

= send Graphs

%t to Word

L]

7| e

2 L

= |Send Graphs Show in Folder
5" | to PowerP. .

{ Uninstall

Open File Exchange Page

Send Feedback...

Show All
Refresh

-

Tab Views

. Graphing
Reporting L}

e  Show in Folder: Opens the user's \AppData\Local\OriginLab\Apps\ folder to the App
installation folder.

e Uninstall: Uninstalls the selected App.

e Open the File Exchange Page: Opens the App's description and download page on the
OriginLab File Exchange.

e Send Feedback...: Opens a Rate App dialog box to provide feedback.

e  Show All (user-added tabs only): Shows Apps from all Gallery tabs on the active tab.

e Refresh: Refreshes the tab view.

e Tab Views: Place or remove the check mark beside the App to determine on which Gallery

tab(s) the App shows.
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19.4.1Updating App Center

New Apps and App updates are continually made available to Origin and OriginPro users. Be sure to open your
App Center occasionally (press F10) and if it displays the red Download Now button, click to get the latest

list of available Apps.

New App
Information
Is Available

Download
MNow

19.4.2Docking the Gallery
By default, the Gallery is docked to the right side of the workspace.
* 0 X

¢ ma ¢

Add Apps Peak
Deconvolut...

G <

Speedy Fit Maps Online

y= [
= &

Rank Models Chromaticity
Diagram

Google Map Graph
Import Annotator

ST

li N

|!l|5!|ql'|d'}r" [’.‘IIJ!L]dEJE)'}-"bIJ!J.‘LH'}r"SJDJJEUUF_‘I:)

If you prefer, you can dock the Gallery to the top of the workspace, just below the toolbars:

1. Drag the title bar toward the top of the workspace. Guide it to and drop it on he workspace docking button

that appears (shown outlined in magenta).

2. Once docked, drag the bottom edge of the Gallery to adjust width, as needed.
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Add Apps Peak Speedy Fit  Maps Online Rank Models Chromaticit

19.5Will I be Notified When Updates are Available?
Several things will indicate when an App update is available:

e A red dot appears in the upper-right corner of the Add Apps icon in your Apps Gallery (docked to

the right side of your workspace). Additionally, the red dot shows on individual Apps when an update

is available.
e Q
Add Apps Simple Fit

e In the App Center, the App will appear with a clickable "update" icon beside it.

% Maps Online I3
CriginLab
Min. Version: Qrign 2017 SR2
hhAk Update

e The App Center Updates tab will show a red dot with a number indicating how many App updates are

available. The tab will list updated Apps and allow you to apply updates for individual Apps or all Apps.

Updatesﬂ

To update an App:

e Click the Update icon that appears next to the App in the App Center.
e Right-click on the App in the Apps Gallery and choose Download and Install Update

e Click the Update All Compatible button that appears on the Updates tab in the App Center; or click the
"update" icon beside each App.

e  Right-click on the Add Apps icon in the Apps Gallery and choose Update All.
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Apps
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* | Add# Show in Folder j
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You can verify the version of an installed App by hovering on the App in your Apps
Gallery.

19.6 How Do | Uninstall an App?

Uninstalling an App is easy. Right-click on the App icon in the Apps Gallery and choose Uninstall from the
shortcut menu.

Apps * X
= [ Multiple R... P
Fy
'f;/ Show in Folder

- c

Tangent Uninstall
E Open File Exchange Page
? Send Feedback...
= Lot
= Monte Ca Refresh
ix Simulatio Tab Views .
= M.
z 3 K
o Log Frincipal Enzyme

19.7How Do | Give Feedback on an App?

OriginLab relies heavily on customer input to improve our software products. We encourage you to give
feedback on Apps by right-clicking on the App icon in the Apps Gallery and choosing Send Feedback.... It
takes just a few seconds!
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19.8Can | Request an App?

As previously mentioned, Apps can be developed by anyone with Origin programming knowledge. However, if
you do not program but you find that you need some particular functionality that is not currently a part of the

Origin product, you can request an App through the OriginLab website. OriginLab is continually building and
posting new Apps to the File Exchange.

1. To request an App, open the App Center and click the Request App button in the lower-left corner of the
dialog box. This opens a web page on www.originlab.com.

Verify that the Your Reason for Contacting Us drop down is set to Request an App.

Fill out the remaining required fields and click the Submit Inquiry button at the bottom of the form.
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20 Programming in Origin

Origin Application I
Origin GUI:
Warkbooks, Matrices, Graphs,
Client Graph Templates
Applications: Analysis Templates __.
Excel VBA
LabVIEW
MATLAB
Python
R . LabTalk Python R
Visual C++ Origin C Scriotin origi ) (R Console,
Visual Basic ping onginpro RServe)
more...

NAG
Mumerical
Library

As you gain experience with Origin, you may want to access Origin features programmatically, add your own
custom routines and tools, or communicate with Origin from other applications. This chapter outlines basic
programming options available in Origin. For more detailed information, see the following Origin programming-
related resources:

e  Programming documentation including guides, language references, and examples are available from the

Help menu in the product.
e  Online programming documentation is available at www.originlab.com/doc.

®  You can typically locate online programming pages by performing a web search from your browser using

phrases such as: labtalk importing , originc interpolate, or labview origin send data.
e  An Origin Programming Forum can be found at www.originlab.com/forum.

e  Sample files for LabTalk, Python, COM Server and Client, etc. can be found in the \Samples folder of your

Origin software.
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20.1LabTalk

LabTalk-related additions and improvements for Origin 2023:

e  Updated Script Window with support for Unicode, code completion with syntax
coloring, improved font control.

e  Range definitions using page Long Name will preferentially search the active folder,
making it easier to copy folders and append projects without breaking range
references.

e Connect text objects to other graphic objects by defining

text.anchorontextframe.

e  For LT functions that can't use a range string (e.g. total()), use mkrng() --
defined in ORGSYS.CNF - to define a range variable.

e LabTalk method to add button to wks object (e.g.wks.addbutton(Click Me)).

LabTalk is a scripting language that provides access to most of Origin's functionality. With LabTalk you can
access and change properties of Origin objects such as worksheets, columns, graph layers, and data plots.
LabTalk script can include calls to X-Functions to perform advanced data processing and analysis.

There are many options for executing your LabTalk scripts. Multiple lines of script can be organized as sections
in a file, and those individual sections can be executed from the user-interface at the command prompt in the
Script Window or Command Window; from buttons added to worksheets and graphs; from included or
custom-made toolbar buttons; or from custom menu commands.

The following "mini-tutorial™ will demonstrate adding a button object to a worksheet,
associating a short LabTalk script with the button, then using the button to execute the
script and perform a basic statistical calculation while writing the results to the
worksheet.

3

1. Run Origin and start a new project by clicking the New Project button on the
Standard toolbar.

2. Click Data: Import from File: Single ASCII and browse to the file
\Samples\Graphing\Box Chart.dat. Select the file and click Open. The file is
imported into the active worksheet window.

3. With the worksheet window active, click Format: Worksheet. In the Worksheet
Properties dialog, click the Size tab and set Gap from Top to 25, then click OK.
A gap is added to worksheet window.

4. Click the Text Tool on the Tools toolbar. Click inside the gap that you just added
and type "Add Mean Label Row" into the text object. Click outside the text object
to exit edit mode.

5. Right-click on the text label and select Properties.... Choose Programming
Control tab, set Script Run After to Button Up. Copy and paste the following

script into the text box:
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wks.userParaml = 1;

wks.userParaml$ = "Mean'';

for (int i1 = 2; 11 <= wks.ncols; ii++)

range rr = $(ii);

Col($(i1))[D1]$ = $(mean(rr),.2%);

7. Click OK to apply settings and close the Text Object dialog box. Note that your
text object now looks like a button.

8. Click the button. Note that a new header row labelled "Mean" is added to the
worksheet and the mean value of each column of data is written to the Mean row

cell above the corresponding column.

Note: For more information on LabTalk, Origin's built-in scripting language, please consult your

product documentation at Help: Programming: LabTalk.

Sample files can be found in the \Samples\LabTalk Script Examples folder of your Origin software.

20.2Python

Python-related additions and improvements for Origin 2023:

i _' o e To prevent package version conflicts, Origin now supports multiple PyPackage

folders (set system variable @PYP).
e  Python interface for LabTalk set command for data plots.

e  Better error checking on Python functions using originpro op -save() function to

return true/false.
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Origin provides an embedded Python environment so that you can run Python in Origin. Origin supports
command line execution of Python code from the Python Console or Origin's Code Builder IDE. As of
September 2021, the embedded Python version is version 3.8.3.

Note: For more information on integrated usage of Origin and Python, see these topics in the Python

documentation:

(] Introduction to Python in Origin

. Embedded Python

e Sample Projects with attached Python Code.

There is an API for calling Origin from Python. See note under Automation Server,
below.

20.3R

Origin supports running R commands in the Origin environment. You can issue R commands in the Script
Window or from the built-in R Console, or you can run .R files. All releases of R are supported up through
version 3.6.

From Origin, you can connect with R in two ways:

e R. Installed on your local computer.

(] Rserve. Installed on a remote PC.

Note: For more information on integrating Origin and R, refer to the Origin Help file (R_Console and
Rserve Console) and the LabTalk Scripting Guide (Running R in Origin, R Objects, Rserve

Objects).

Sample files can be found in the \Samples\R folder of your Origin software.

20.4MATLAB

The MATLAB Console allows Origin users to issue MATLAB commands from Origin, and to transfer data
between the two applications either using a graphical interface or using a command line.

e The Console requires both Origin and MATLAB be installed on the same computer.

e  Origin also supports importing MATLAB (MAT) files from disk. There are two import routines, the older

Data: Import from File and the new Connector-based Data : Connect to File: MATLAB. Importing

MAT files does not require that MATLAB be installed.

Note: For more information on the MATLAB Console, refer to the Origin Help file (MATLAB Console.

The <Origin Program Folder>\Samples\COM Server and Client\MATLAB subfolder contains an example
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(CreatePlotInOrigin.m, CreatePlotInOrigin.OPJ) that illustrates how to connect to an Origin COM server
from a MATLAB client (requires MATLAB).

20.50rigin C

Origin C is a full-featured high-level programming language based on the ANSI C programming language
syntax. Origin C also supports a number of C++ features and a few C# features. Origin C provides access to
all aspects of Origin including data import, data handling, graphing, analysis, and exporting. You can access
Origin C functions from interface controls such as buttons, toolbars, and menu items, using LabTalk script.

Origin C is organized as a set of functions with support for passing arguments. Origin C functions are compiled
to object code and then loaded and executed inside of Origin. Origin C provides increased reliability and
manageability for developing and debugging code of greater scope and complexity.

Origin C also provides access to the NAG Numerical Library functions included in your Origin installation.
NAG functions provide you with a large selection of algorithms for performing computations ranging from
simple statistics and Fourier transforms to linear algebra and multivariate analysis. Origin currently supports
NAG Library Version Mark 26.1.

Note: For more information on Origin C, please refer to the Origin C documentation:
Help: Programming: Origin C
There you will find usage information, a language reference, developer notes, examples, etc.

Sample files can be found in the \Samples\Origin C Examples folder of your Origin software.

20.6 X-Function

An X-Function is a self-contained XML file that can be loaded in Origin as a special type of global function.
Origin C is the language used to create X-Functions. X-Functions provide a way to expand the functionality of
Origin by adding custom data processing features. Many of the built-in tools in Origin are based on X-Functions.
Once an X-Function has been created, it can be accessed from anywhere in the interface that allows for script
execution, such as the script window, toolbar buttons, or custom menu items.

Note: For more information on X-Functions, please refer to your product documentation that is

installed with your software:
Help: Programming: X-Functions

There, you will find information on creating and using X-Functions, a language reference, and tutorials.

20.7 Automation Server

Origin can be used as an Automation Server. Client applications such as National Instruments™
LabVIEW™, Microsoft Excel, Python, or custom VB/VC/C# applications can exchange data with Origin, and
can also send commands to be executed within Origin.
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Note: For more information on Origin's Automation Server functionality, refer to the product

documentation installed with your Origin software:

Help: Programming: Automation Server.

There you will find examples and language reference information. Sample files can be found in the

\Samples\COM Server and Client folder of your Origin software.

20.8LabVIEW

National Instruments™ LabVIEW™ is widely used for data collection. For example, many instrument and
sensor vendors provide LabVIEW drivers for acquiring data. Once the data is collected, the end user will need
to graph and analyze the data, and create reports for presentation. Origin provides powerful data analysis and
graphing tools, including the Analysis Template feature, which allows for repeat analysis on newly acquired
data. The ability to communicate between LabVIEW and Origin can thus greatly improve the efficiency of post-
acquisition analysis and presentation.

Origin ships with a collection of LabVIEW sub-Vls. LabVIEW users can simply incorporate these custom sub-Vis
in their main LabVIEW application to communicate seamlessly with Origin.

Note: For more information on Origin-LabVIEW connectivity, see the product documentation installed

with your Origin software:
Help: LabVIEW VI

Examples and tutorials are provided.

20.90rglab

Orglab is a freely distributed component DLL for directly creating or reading Origin Project (.opj) and other
Origin file types (.0gg, .ogw and .ogm). It is available as a free download. An Origin license is not required to
use Orglab. Typical use of Orglab is for instrument manufacturers and other third-party vendors to allow their
frontend software to output data as Origin files.

The Orglab module is available for 64-bit systems. To find out more about Orglab and to download the

Orglab module, go to the Products > Orglab page of www.originlab.com.
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21 Customizing Origin

21.1 Customizing Default Settings

21.1.1Setting Preferences with the Options Dialog Box

The multi-tabbed Options dialog box has controls for Origin global settings pertaining to numeric display,
file and system paths, text fonts, Origin program opening and closing behaviors, etc.

To open the Options dialog box:

e Choose Preferences: Options (any Origin window is active)

e |f you opened an Excel file inside Origin, choose Window: Origin Options (Excel workbook is active)

Controls For
e  Max number of ticks for numeric and date/time scales
e Distances from the tick labels to tick marks, axis titles
e Display of zeros and scientific notation in tick labels, units display in axis title
Two zero control check boxes were added and turned on by
. default for Origin 2020b:
Axis Tab 9
e Zerois'0O'
e No Trailing Zero
Beginning with Origin 2021, these options are turned OFF
by default.
e Use of default plot assignments
e  Scan datasets for legend text
Excel Tab
e  Prompt before opening Excel files by drag-and-drop or saving Excel workbooks
e  Set file paths to track last opened, last saved, last exported file
Eile Locations e  Set default path and file extension for importing different file types
Tab e Define applicable file types for ASCII import dialogs
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Controls For

Graph Tab

Dash lines definitions, line to symbol gap, user-defined symbols, etc.
2D graph anti-aliasing
Enable in-place editing of linked and embedded graphs in another application

Speed mode reminder watermark

I Origin 2022 improved support for user-defined symbols,
' removing some long-time restrictions and making it easier
to apply custom symbols to your graph:

User Defined Symbols

@SS € |7

[ 1Monochrome

e  Support for Clipboard, .bmp or .svg formats.

e  Support B&W or color symbols.

e Add symbols via the Options dialog or via Plot Details
Add from Clipboard button (Symbol tab > Custom
Construction check box > User Defined Symbols

radio button).

Miscellaneous
Tab

Proxy server configuration

Default templates for ASCII import
Custom date/time formats

Enable collapsible menus

Use of dataset names in the Origin workspace

I Origin's Python Packages dialog for managing installation
' of Python packages used with Origin, supports package
installation via proxy server. Open Preferences: Options,
go to the Miscellaneous tab, choose Use HTTP Proxy
Server and enter the proxy address.
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Controls For
e  Thresholds for displaying numbers in scientific notation
. Defaults for displayed digits in data and report sheets
Numeric . .
Fmb e Radians, degrees or gradians
e  Separators for decimal places
e  Default window closing behaviors
Open/Close ®  Project startup, backup and autosave options
Tab e  Options dialog save options
e Default percent of page size of OLE graphs copied to Clipboard, graph margin
and CTRL+C hotkey controls.
Page Tab
Until 2021b, the Size Factor (26) (formerly, Ratio) was
set to 40. The default is now 100.
e Default fonts for text objects
e WYSIWYG and in-place editing mode behaviors
® Size and positioning of superscripts/subscripts
e  Footnote size, analysis report sheets
Text Fonts
Tab
|
For information on controlling fonts used in the Origin
interface, see LabTalk's system.font(object).
e View/Change the location of the User Files, Autosave, Backup, Unsaved and
System Path Group folders
System Fatn
Tab e View locations of system folders (Program, License and Application Data)

21.1.2System Variables Dialog

System variables are internal Origin settings that allow for the fine-tuning of a wide range of Origin behaviors.
Origin's Set Systems Variables dialog box (Preferences: System Variables...) can be used to view and set
system variable values. In the dialog, there is a link named System Variables List which opens a web page
with a list of all system variables, the default value, and description.
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To customize a particular system variable:

1. Type the system variable name in the first column of Set System Variables, without the @ symbol. For
example, if you wanted to make a global change to the Recalculate mode of analysis dialog boxes, type:
DAM

2. Click on the 2nd column to view the current value, and type in a new value. For example, with DAM, to set
Recalculate to Auto, type the value: 1.

3. Add optional comments in the third column and click OK to close dialog.

This modified value will be remembered and applied in every Origin session.

You can quickly read or set the value of a writable system variable in the Script Window (Window: Script
Window) by typing @systemVariable= as, for example ...

@DAM=

... then pressing ENTER. When setting the value of a system variable in this way, note that that typing in the
Script Window sets the variable value for the current session only.

21.1.33D OpenGL Settings Dialog

Origin uses OpenGL (Open Graphics Library) for rendering of 3D graphs. OpenGL provides enhanced
performance including fast drawing, fast rotation and zoom, transparency, and lighting support.

For optimum performance, your card should support OpenGL version 3.0 or higher. To check your hardware's
support for OpenGL, run Origin and choose Preferences: 3D Open GL Settings.... Look under OpenGL Info
for information on graphics hardware and the supported version of OpenGL.

If your graphics hardware is older, you may experience compatibility issues with things such as transparency
settings and anti-aliasing. The controls under the Settings node in this dialog allow you do such things as
disabling transparency. The dialog box also provides information on disabling OpenGL.

For more information on OpenGL in Origin, see the links under "Topics for Further Reading" at the end of this
chapter.

21.2Customizing Menus

21.2.1Collapsible Menus

Like many software products, Origin uses an auto-expanding "collapsible" menu feature that shows only a
partial list of menu commands when opening longer menus. If you want to show all commands upon opening,
click Preferences: Options, click the Miscellaneous tab and clear the Enable Collapsible Menus check box.

[ ] Enable Collapsible Menus
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21.2.2Custom Menu Organizer

If you have scripts that are frequently run, you can add them to the menu for quick access. With the Custom
Menu Organizer you can...

e Create up to 3 main menus and corresponding sub-menus
® Assign LabTalk scripts and X-Functions to a menu item
® Restrict menu item access to specific window types

(] Hide unused built-in menu items, streamlining your Origin workspace

To open the Custom Menu Organizer, choose Preferences: Custom Menu Organizer... from the main menu.

-
Then press F1 or click the button —I in the upper-right hand corner of the dialog box for instructions.

Once you create and save a new menu configuration (.omc) file, you can then select that configuration from
the Preferences: Menu fly-out menu. Multiple configuration files can be created, allowing you to easily switch
from one configuration to another. A Default configuration is also available in the fly-out, to revert to default
menu settings. Configuration files can be shared among colleagues so that you use a common set of menu
commands.

21.2.3Displaying Bitmaps in Menus

You'll note that form some menu commands, a bitmap is displayed to the left of the menu entry. The bitmap
indicates that there is an equivalent toolbar button.

On some systems such as VirtualPC or Terminal Servers, such bitmaps may cause a long delay when opening
menus. To turn off the display of menu command bitmaps:

1. Select Preferences: Options to open the Options dialog box.

2. Select the Miscellaneous tab, clear Display Bitmaps in Menus, and click OK.

You can modify the size of the Plot menu icons using the LabTalk system variable
@PPS. To find out how to change the value of a system variable, see Customizing
Origin Using System Variables.

21.3Customizing Toolbars and Buttons

In addition to the standard Windows OS toolbar customizations, Origin provides some clever and easy-to-use
tools for creating, programming and distributing custom toolbar buttons. If you or your staff are performing
complex but repetitive Origin routines, you'll want to explore creating and sharing custom toolbars.

Toolbar layout is modified slightly for Origin 2023. A new Folders and Windows
toolbar is added for working with Project Explorer folders and folder contents. When
first running Origin 2023, you may see this new toolbar "floating" in the Origin
workspace. You can drag it (by the title bar) to an empty portion of the toolbar spacer;
or you can choose View: Toolbars and click the Reinitialize button to reset toolbars
to the standard 2023 configuration.

L

Folders and Windows w X

€3 A F,
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In addition, a couple of lesser-used toolbars (Arrow and Layout) have been hidden, by
default, in the workspace. For information on modifying toolbar configurations, see
Customizing Toolbars and Buttons, below.

21.3.1Displaying, Hiding or Moving Toolbar buttons

Click the small down arrow at the end of any toolbar and select the Add or Remove Buttons context
menu. Then select desired sub menu and check/uncheck to show/hide buttons. A Reset option is also

available.
Press ALT key and drag a button to any new toolbar location.
Press ALT key and drag a button to blank Origin workspace to create a new toolbar.

Press ALT key and drag a button to any window till X shows, then release to delete the toolbar.

21.3.2Customizing Toolbar Button Appearance

Use controls on the Options tab (View:Toolbars) to:

Show toolbar screen tips and shortcut keys on hover
Increase toolbar and toolbar button size

Toggle between "flat" or 3D toolbar buttons

21.3.3Displaying or Hiding a Toolbar

Double click the left/top end of any docked toolbar to undock. Double-click on title of floating toolbar to
dock.

In floating mode, click X button to hide the toolbar. Drag it to any new location to reposition. Drag it to

edge of the Origin workspace to dock.
In docked mode, drag the left/top end of a toolbar to reposition.

To show/hide multiple toolbars together, choose View: Toolbars... from the main menu. Use the check
boxes on Toolbars tab to show/hide toolbars. Click the New button to add a new toolbar, then drag

buttons from the Button Groups tab to add buttons on the new toolbar.

Use the Reset, Reset All buttons to reset toolbars.

21.3.4Creating New Toolbars with New Bitmap Images

Origin supports creating new toolbar buttons with Labtalk script, both built-in or user-defined script to run
when click it. Choose View: Toolbars... and create new button group on Button Group tab.
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e  Export the button group as an .OPX file and share it with others. The person who gets the OPX can drag

and drop the OPX file onto Origin workspace to install the toolbar.

Note: To learn more about creating and exporting user-defined toolbars, see:

Help: Origin: Origin Help > Customization and Automation > Customizing Toolbars

21.3.5Add a Custom Button to the Window Title Bar

Origin supports adding a system button to the left of the minimize button on the window title bar. A custom
LabTalk script can then be associated with this button.

Note: Please view the -tbb option of the LabTalk Page command in the Programming help file:

Help: Programming: LabTalk > Language Reference > Command Reference > Alphabetical

Listing of Commands > Page

21.4Customizing the Status Bar

Origin uses the Status bar at the bottom of the Origin workspace to report software hints, statistics and other
useful information depending upon current action, selection, window, etc.

®  Right-click on Status Bar to customize the display.

® Press ALT and drag items along the Status Bar to reorder.

21.5Customizing the Origin Workspace

Origin also supports customizing dockable windows such as the Project Explorer, Quick Help and Messages
Log windows.

e  Right click on the window title bar to specify dock, hide, auto hide, and other settings.
e  When auto-hide is unchecked, double click to float the window.
e Drag the window title to move or dock to a new location.
® Arrange dockable windows as multiple tabs along the edge of the workspace to save screen space.
® Choose View: Toolbars... from main menu. On the Toolbar tab:
O The Reinitialize button resets menu, toolbar and dockable windows to default settings.
O The Export button exports the current menu, toolbar and dockable window settings to an .OPX
file. Drag and drop the OPX file onto another Origin installation to configure the workspace to

match your customized settings.

I Occasionally, an Origin workspace component goes "missing” -- The Data Display
' window, one of the panels in Project Explorer, etc. When this happens, you can reset
your workspace by choosing View: Toolbars: Reinitialize. The downside has been
that this also resets workspace customizations and toolbar configurations. Beginning
with Origin 2018, clicking the Reinitialize button produces an attention message
asking if you want to restore the workspace settings from your previous version or use
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the 2018 system defaults.

21.6 Templates and Themes

The hierarchy of Origin objects such as graph pages, combined with extensive object properties, lends itself to
the creation of custom settings for repeat use. You can save your custom settings either as templates or
themes, described briefly in the following sections.

Note: For detailed information please refer to Origin Help file, see:

Help: Origin: Origin Help > Origin Basics > Origin Template Files (OTW, OTP, OTM)

21.6.1Templates

The Origin template concept applies to graphs, workbooks, matrixbooks, and Analysis Templates™. Templates
allow you to choose a set of properties or operations and save those for repeat use.

21.6.1.1 Template Center

Both the New Book (File: New: Workbook/Matrix: Browse...) and Template Library (Plot: Template

Library) dialogs include an Open Template Center button that opens a dialog for browsing and
downloading additional templates.

To open the Template Center directly, choose Tools: Template Center and set the Type drop-down to Graph
or Book.
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i You can search for additional templates and install them directly from the Start menu.

Worksheet top left corner with sheet selected->Con
Templates
[l Triangle Heatmap
Il Heatmap with Significant Mark

Find |heatmap]| x {3

a << Start Menu [F1)

21.6.1.2 Workbook Templates and Analysis Templates

You can save workbook or matrixbook settings, such as the number of columns and sheets, column plot
designations, fonts, colors, display formats, custom header rows, scripts associated with the sheet, or
dimension and coordinate settings, to OTWU (workbook template) or OTMU (matrix template) files.

When the workbook or matrix window is active and you choose File: Save Template As, you save any
window customizations, minus any data that might exist in the window at the time of saving, to a template file.
The template file can then be used to create new windows, as needed, for storing and analyzing your data.

You can use the New Book dialog box for managing your workbook, matrixbook and Analysis templates. The
New Book dialog is re-designed for Origin 2021b and is covered in the Workbooks chapter of this User Guide.

Use the same New Book dialog to manage your Analysis Templates™. An Analysis Template starts from a
workbook but differs in that when you save it as an Analysis Template (File: Save Workbook as Analysis
Template), it is saved with whatever analysis operations and dependent graphing operations, exist in the
workbook at the time of saving. Analysis Templates are discussed briefly in the Batch Analysis section of
How to Handle Repetitive Tasks chapter of this guide.

For a more in-depth discussion of Analysis Templates, see these topics:

®  Analysis Templates.

e Creating and Using Analysis Templates (tutorial).

. Batch Processing with Word Template for Reporting (tutorial).

21.6.1.3 Graph Templates

As mentioned in the Customizing Graphs chapter, Origin ships with about 240 built-in graph templates that are
used to create Origin’s many science and engineering graph types. Using one of these as a starting point, you
can create your own graph, adding more layers, setting scale or dimensional relationships between layers,
modifying data plot properties, etc., and then save your customizations as a user-defined graph template
(.OTP) file by clicking File: Save Template as.... See the "Templates and Themes" section of the Customizing
Graphs chapter for a general discussion of graph templates.

One important subset of graph templates are what are called “cloneable” templates. A cloneable template
requires a very specific data arrangement in your worksheet or matrix; the idea being that if you have once
created a complex arrangement between worksheet datasets, matrix objects, etc. and, for instance, layers or
panels in your graph, then you shouldn't need to recreate this arrangement every time you want to recreate
such a graph. Cloneable templates are identifiable in the Template Library by the presence of a “sheep” icon
next to the template name or thumbnail image.
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For more information, see the section on cloneable templates in Graph Template Basics in your Origin Help
file.

21.6.2Themes

An Origin Theme is a file containing a set of object properties or dialog settings. Thus for example, the
customized settings of a graph window can be saved as a Theme, or the customized settings in an analysis
dialog can be saved as a Theme. If you were to open the Theme Organizer (see below), you would see that
there are tabs for Graph, Worksheet, Dialog, Function and System Increment Lists.

Themes allow you to quickly apply a new set of properties to an object, such as a graph. For example, you
might apply a black-and-white Theme to a color graph in order to prepare it for publication. Or you might take
the object properties of one graph and apply them to all the other graphs in the same project.

Right-click on plot, layer, object, etc. in graph -- or right click with nothing selected in graph -- and choose
Copy Format context menu to copy format. Depending where you right click, the corresponding selection's
format can be copied. Then right-click on corresponding selection or right click in target graph and click Paste
Format to apply the copied settings to the target selection or graph. You can also choose Edit: Paste
Format... to paste the Format to multiple target graphs.
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The Theme Organizer dialog box is opened from the Preferences menu. Use this dialog to organize your
graph, worksheet, and dialog themes.

With this dialog you can apply a graph theme to multiple graphs to have consistent look. To combine multiple
graph themes in the Theme Organizer dialog, hold down Ctrl while selecting the Themes, and then right-click
to access the Combine context menu. The context menu in the tool provides an option to edit a Theme,
allowing the user to add/delete properties to an existing theme. Setting a Theme as a System Theme means
that it will be applied to new graphs automatically, if the graph template allows a System Theme to override
template settings (see the Allow System Theme & System Increment Lists to Override check box).

' Theme Organizer ? n :
A systern theme can be applied automatically when making new graphs

Current system theme: Light Grids

Right-click to set system theme or to choose cther operations

Graph | System Increment Lists | Worksheet | Dialog | Function Apply Theme To

Name Size | Path Date * | Current Graph w
Opposite Lines Add New

Physical Review Letters 17:33

Piot Group Simple Line + Symbol Edit. 17:53

Plot Group Simple Scatter Delate 17:53

profile_cline_x1 1753

profile_cline_x2 Duplizate 117:53

profile_hline_x1 Combine 1753

profile_hline_x2 [} 1753

profile_sep_x] Set as System Theme 753

profile_sep_x2 Clear 5ystem Theme T:53

profile_vline_x1 17:53

profile_wiine_x2 T! ShiwTaoMes 1753

Speed Mode OFF 4 Systemn  15/20017 17253

Speed Mode ON 5 Systern  5015/2017 17:53
TicksAilln | _ 2Sstem |sisa0i7irss |

Ticks All Qut 2 System 3152017 17253 Apply Neow
Ticks YL XB Out YR XT In 8 System 152017 153

Times New Rorman Font 1 System 511572017 17:53 W ndo Apply

[+ Exclude increment lists | Close

The Theme concept extends to dialog box settings, as well. For instance, you can choose a particular suite of
settings in the Linear Fit dialog box (Analysis:Fitting:Linear Fitting), and then save those settings to disk
as a named Theme file. You can save multiple Theme files for a given dialog box and then load them into the
dialog, as needed, using the dialog box's Dialog Theme drop-down list. Saving multiple Themes for a dialog
box allows you to customize your analysis routines from different experiments, when each requires using a
specific (and unique) group of settings.
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-
Lingar Fit

Dizdog Themea
Description  Pesform Linear Fitting
—

Recalculate | paryal

Input | Fit Options | Quantities | Residual Analysis = Output  Fitted Curves Plot  Find X7 | Residual Plots

Save as < default>

Save

Save As...
Theme Setting...

[

System Default
Delete..

Compare...

<Last used>

=)

My Limear Fit with Fixed Intercept

Emors as Weight restrumental
Fiz Intercept ™
Fiz Intercept at ]
Fix Slope [
Fiz Slope at 1 [ 1 " Theme Save as.-
Lol T R ] Please specily a theme name
Apparent Fit
Theme Mame
E Theme Setting
h Save X/How Range

[ ot || cance |

Dialog themes are explained in more detail in the How to Handle Repetitive Tasks chapter of this guide.

21.7 Topics for Further Reading

(] The 3D openGL Settings Dialog Box

Creating Custom Menus

The Custom Menu Organizer

Analysis Themes

How to Manage Multiple Menu Configuration (.OMC) Files

Managing Collapsible Menus

The User Files Folder
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22 Sharing Origin Files

s . Free Origin Viewer

Send Origin Files as
Attachments and
Recipient can Drop onto
Origin Workspace

Package your = § Share Files
Tools as OPX files : =t - with
and Recipient can ; : . i non-users
Drop onto Origin R with the
Workspace. E! | Free Viewer
To Share Files. ..

One User, Multiple Machines = User Files Folder is Shared or on Flash Drive
Multiple Users, Multiple Machines = Group Folder

You may want to customize some aspect of your Origin installation and then share your customizations with
other Origin users. Custom settings can be saved in many file types including graph templates (.otpu) and
themes (.oth), analysis templates (.ogwu or .opju), dialog themes, curve fitting functions, import wizard filters,
LabTalk script files (.ogs), and X-Functions.

22.1Drag and Drop Sharing

A quick and easy way to share a file with another user is simply to send it as an email attachment. The
recipient can then drag and drop the file into the Origin workspace.

Drag-and-drop is supported for most Origin file types. Origin project (.opju) and graph template (.otpu) files
automatically open when dropped into the workspace. Other files are copied to the appropriate subfolders in
the User Files Folder (UFF). For example, when you drop a fitting function (.fdf) file into the workspace, a
dialog opens asking how you want to categorize the new fitting function.

|, You can use a small dialog to remove formulas and links from the current selection, the
; active sheet, the active book or the entire project. This converts formulas and links to
raw numbers. Removing formulas and links can make it easier to share project data
with colleagues without having to share such things as externally-linked (DDE) Excel
files; or to significantly reduce project size before archiving data.

22.2Sharing Files with Multiple Machines for Single Users
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If you are a single user and have installed Origin on multiple machines, you can share your custom settings
across multiple installations. Set up the User Files Folder (UFF) on a shared location, such as a network drive,
or even a USB flash drive, and use the same UFF path with each installation.

Note: For information on changing the UFF path, see:

Help: Origin: Origin Help > Customization and Automation > Setting Your Preferences > The

User Files Folder

22.3Sharing Files with Other Users in a Network

You can set up and use a group folder to share files among users. Multiple groups are allowed, and each
group can have some power user(s) set as the group leader. The group leader can use the Group Folder
Manager tool to publish custom files for sharing with other group members. When a group member launches
Origin, the published files will be copied to their Origin automatically and made ready for use.

|, Origin supports setting multiple group folders, making it possible to share different files
between groups. A leader machine can set up multiple groups and publish different files
to different groups. A member machine can belong to multiple groups and thus receive
all files published by group leaders.

Note: For information on group folders, see:

Help: Origin: Origin Help > Sharing Your Origin Files with Others > Sharing Files with
Multiple Clients > Setting a Group Folder Location

22.4Packaging Files

Origin provides a Package Manager tool for packing multiple files into a single Origin Package (.opx) file.
This is a convenient way to distribute custom applications that may contain multiple Origin files, such as
templates, X-Functions, and LabTalk script files. The Package Manager includes options for running LabTalk
scripts before and after installation.

To access the Package Manager, click Tools, and then click Package Manager...

To install the contents of an .opx file, simply drag and drop into the Origin workspace.

Note: For information on packaging files, see:

Help: Origin: Origin Help > Sharing Your Origin Files with Others > Packaqing Multiple Files
as OPX

22.5The Origin Viewer

The Origin Viewer is a freely distributed, standalone application that allows viewing and copying of
information contained in Origin project files and window (graph, worksheet, matrix) files on computers that do
not have Origin installed.

e The Origin Viewer is distributed as a single EXE file - no installation needed.

® Available as a 64-bit Windows application, or as a native Mac application (Not compatible with 11.0.1, Big

Sur).
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Sharing Origin Files

®  Project Explorer-like folder view with graph previews on hover, icon or details views, X-large icon view
option.
e  Open a graph in a pop-up window for better viewing.

®  Supports viewing and rotating Origin‘'s OpenGL 3D graphs.

|, Origin 2018 introduced a new Unicode-compliant project file type (OPJU). Origin Viewer
versions 9.6.5 or later allow anyone to save the Unicode-compliant OPJU project files
to the pre-2018 OPJ format for sharing of projects with users of older versions of
Origin.

If you have Origin graphs or data that you wish to share with colleagues who are not currently using Origin,
you might direct them to the Origin Viewer page (www.originlab.com/viewer) where they can find out more
and download the free EXE.

22.6 Topics for Further Reading

(] The User Files Folder

e Attaching Files to the Origin Project

e Package Manager
e  Setting Up a Group Folder

(] Exporting Custom Button Groups

. Exporting Toolbar Settings

e  Apps for Origin
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23 Origin Toolbars

This is a list of Origin toolbars, and buttons by button group. Toolbars are shown in their default configurations.
You will note that some buttons are missing from default toolbar configurations. This may be because a button
has been deprecated, because it is duplicated on another toolbar, or simply because it is a lesser-used button.

To add or remove buttons from a toolbar:

1. Click View: Toolbars to open the Customize dialog box.
2. Click on the Button Groups tab and drag desired buttons to a toolbar or to an empty portion of the

workspace.
3. To remove a button/toolbar, drag it from the toolbar back to the Buttons list or click the small "x" in the

upper right-corner of the toolbar (removes entire toolbar from the workspace).

Note also that some toolbar buttons have a small downward pointing arrow next to them. Clicking the tool
displayed on these "split buttons™ carries out the action associated with the displayed tool. Clicking the arrow
beside it opens a menu, allowing you to pick another tool. A split button displays the tool that was last used.

Finally, toolbar buttons will be inaccessible (dimmed) if the object that they act on is not active. For instance,

the 3D-Rotation Toolbar is only available when a 3D graph is active.

In addition to these dockable toolbars, Origin has context-sensitive Mini Toolbars for
variety of common editing tasks. These toolbars are discussed in The Origin Interface
chapter of this Guide. For a complete list of those toolbars, see the Origin Help File.

23.1Standard

Standard

GERP=EE & AMERRN®

B/ B3 @AW

-

ErEHE £ 5%

X

1008 -
Button Description Hotkey Button Description Hotkey
D] New Project 3 New Folder
New Workbook New Graph
New Matrix fU New 2D (Function) Plot
§= New 2D Parametric Plot = New 3D (Function) Plot
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Button Description Hotkey Button Description Hotkey
ﬁ::‘:ﬁl New 3D Parametric Plot New Layout
ﬁ New Notes E-E Digitize Image
@ New Image = Open Ct(r)l *
ffib Open From Cloud E Save Project Ctrl +S
Recalculate Auto/Up-to-
E' Save Template # 5’% date vs Manual/Pending
Pause Auto - Zoom In and Out by
% Update/Recalculation H Percentage
=7 Print Ctg * =) Slide Show of Graphs
Send Graphs to . .
PowerPoint EEE Open Video Builder
E] Refresh F5 g Duplicate
e Custom Routine al Project Explorer Alt+1
Ll‘ti Object Manager Alé * Results Log Alt + 2
. Alt + . . Shift +
o
] Command Window 3 Script Window Al + 3
ok Code Builder Al + Add New Columns
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23.2Folders and Windows

ey This is a new toolbar for Origin 2023. It should be helpful when working with multiple
project folders and when needing to compare windows in separate folders.

€30 85, B

Button Description Hotkey Button Description Hotkey
@- Folder Backward @ Folder Forward
@ Seesaw Ctrl + Alt a’ Add Active Window Ctrl +
+ X Shortcut for Seesaw Shift + F7
é.. Add Shortcuts from st Arrange Windows (Last
Previous Folder iy Used)
1 | Pin Active Window
23.3 Import
12 iz
EmEms =me B N
Button Description Hotkey Button Description Hotkey
ﬁ Import Wizard 1?_‘? Import Single ASCII
E Import Multiple ASCII ﬁ Import Excel
% Re-import no Dialog Ct‘rll * }:’i Re-import with Dialog
mé Clone Import @ Batch Processing
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Button Description Hotkey Button Description Hotkey
i"" Connect\;\(;egata from @ Connect Multiple Files
i”__, Import All Connected
Data
23.4Edit
$ Ga 3
Button Description Hotkey Button Description Hotkey
'S Cut Ctrl+X Ey Copy Ctrl+C
FeY Paste Ctrl+Vv i) Undo Ctrl+z
23.5Graph
=g Bl b T U0
Button Description Hotkey Button Description Hotkey
= Enablep/\lliD;ss?:E;e Anti- 1 Rescale Ctrl+R
|4 Rescale X 1= Rescale Y
Té, Rescale XY al Rescale Z

o Exchange the X and .
XY Y axes 1% Enable/Disable Speed Mode
o Extract to Layers Extract to Graphs
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Button Description Hotkey Button Description Hotkey
Merge Duplicate with New

Columns/Sheets/Books

=

Add Bottom-X Left-Y
Layer

x]

Add Top-X Layer

E

Add Right-Y Layer

[x]

Add Top-X Right-Y Layer

7

Add Inset Graph

Iz

Add Inset Graph With Data

B

Zoom In

®»

Zoom Out

=]

Whole Page

23.62D Graphs

Note that only common plot types have a toolbar button. Complete access to Origin plot
types is found on the Plot menu.

VAR A AR YRS GR Rl

Button

Description

Description

Line

Horizontal Step

Vertical Step

Spline Connected

Scatter

Grouped Scatter - Indexed Data

Scatter Central

Column Scatter
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Button Description Button Description
T Y Error £ XY Error
il Vertical Drop Line &8 Bubble

Color Mapped

Bubble + Color Mapped

o~

Line + Symbol

Line Series

=

2 Point Segment

3 Point Segment

3

Row-wise

Column

I
r

Column + Label

Grouped Column-Indexed Data

"

Bar

B

Stacked Column

v

Stacked Bar

100% Stacked Column

100% Stacked Bar

Floating Column

Floating Bar

L]

3D Color Pie Chart

® 2D B&W Pie Chart @ Double Y Axis
& 3Ys Y-YY 73] 3Ys Y-Y-Y
2|l 4Ys Y-YYY 5] 4Ys YY-YY
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Button

Description

Button

Description

3]

Multiple Y Axes

il

Stacked Lines By Y Offsets

Ir.

Al

Colormapped Line Series

[

Waterfall

Waterfall Y: Color Mapping

[

Waterfall Z: Color Mapping

3D Waterfall

3D Waterfall Y: Color Mapping

@ 3D Waterfall Z: Color Mapping = Vertical 2 Panel
[ Horizontal 2 Panel e 4 Panel

it 9 Panel == Stack

ﬁ'* Multiple Panels by Label E Trellis Plot
T Cluster Plot B Box Chart

Violin with Box

g8

Grouped Box Charts-Indexed
Data

g8

Grouped Box Charts-Raw Data

[~

Interval Plot

Histogram

Histogram + Probabilities

Multi-Panel Histogram

Marginal Histograms

Marginal Boxes

B

Distribution + Rug
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Button Description Button Description
2D Kernel Densit Lid -
y =T QC(X-bar R) Chart
[ Pareto Chart-Binned Data [l Pareto Chart-Raw Data

]

Scatter Matrix

"

Probability Plot

g Q-Q Plot @ Parallel Plot
ﬂ Area ﬂ Stacked Area
ﬂ Fill Area @ Zoom

5

Polar theta(X) r(Y)

@

Polar r(X) theta(Y)

@

Wind Rose-Binned Data

@

Wind Rose-Raw Data

| Ternary £ Piper
@| Smith Chart @ Radar
o Vector XYAM «iﬁ| Vector XYXY

—_
=
—

High-Low-Close

=

Japanese Candlestick

=

OHLC Bar Chart

3

OHLC-Volume

[

Line (Stock)

=

Bridge Chart
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Button Description Button Description

iy Template Library

23.7 Add Object to Graph

=Q=s M5 H @ iE e

Button Description Hotkey Button Description Hotkey
; Add Color Scale @l Add Bubble Scale
% Add Box Scale Reconstruct Legend Ctrl+L
— Add Asterisk Bracket A Add Round Bracket

- Add Brace Bracket E Add XY Scale
'EE Date & Time Ea Project Path
E New Link Table

23.83D and Contour Graph

M. . &, E e A

Button Description Button Description
@ 3D Scatter Plot @ 3D Trajectory
@ 3D Scatter + Error Bar @ 3D Vector XYZ XYZ
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Button Description Button Description
22 3D Vector XYZ dXdYdZ Py 3D Tetrahedral
3D Bars @ 3D Stacked Bars

ENEE

3D 100% Stacked Bars

XYY 3D Bars

=

XYY 3D Stacked Bars

(i
i

XYY 3D 100% Stacked Bars

&

3D Ribbons

&

3D Walls

@

3D Waterfall

3D Waterfall Y: Color Mapping

3D Waterfall Z: Color Mapping

LY

3D Color Fill Surface

Multiple Color Fill Surfaces

3D X Constant with Base

3D Y Constant with Base

3D Colormap Surface

Multiple Colormap Surfaces

3D Color Fill Surface with Error
Bar

3D Colormap Surface with Error
Bar

3D Wire Frame

3D Wire Surface

3D Colormap Surface with
Projection

3D Ternary Colormap Surface

Contour - Color fill

Contour - B/W Lines + Labels

Gray Scale Map
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Button Description Button Description
ﬁ Contour Profiles i.@ Polar Contour theta(X) r(Y)
i@ Polar Contour r(X) theta(Y) ﬂ Ternary Contour
E Image Plot ﬁ Image Profiles
: Heatmap @ Heatmap with Labels

23.93D Rotation

PRV NATFLIXSI @10 -

Button Description Button Description

f Rotate counterclockwise fl Rotate clockwise

ﬂ Tilt left j Tilt right

Tilt down Tilt up

= Increase perspective [, Decrease perspective

Reset Rotation

E Fit frame to layer

w

@ Reset

Rotate on any direction

H Rotation Angle
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23.10Worksheet Data

BH LA R dillf YTXE

Button

Description Hotkey

Description Hotkey

=8

Statistics on Column(s)

Statistics on Row(s)

a7 Sort g Set Column Values Ctr+Q
il Set All Column Values Ctrl+F5 il Row number

Uniform random
numbers

Normal random
numbers

Add/Remove Data

Enable/Disable Data

W Filter X Filter
% Reapply Data Filter
23.11Column
H, X Y Z b oo [¢ ¢ 9 9
Button Description Button Description
* Set as X b SetasY
z SetasZ i Set as Y Error Bars

ab
[]

Set as Labels

HOHE

i

Set as Disregard

=l

Set as Grouping

=l

Set as Subject
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Button Description Button Description
|+ Move to First + Move Left
» Move Right »| Move to Last

"

Swap Columns

Add Sparkline

23.12Layout

Button Description Button Description
L] Add Graph +Ef Add Worksheet
23.13Mask

ElE & ] =]

Button Description

Button

Description

El Mask Range

Unmask Range

) Change mask color

Hide/Show masked points

:::I Swap mask

Disable/Enable masking
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23.14Tools

S _—

The Angle Annotation tool

E is new for Origin 2023.

&S+ @ - It wTHE A-w-0O-ME-E- 54

Button Description Hotkey Button Description Hotkey
D@ Pointer @. Scale In
Q Scale Out 4 | Screen Reader

&

Data Highlighter

Data Reader

®

Data Cursor

Data Selector

&

Selection on Active
Plot

Selection on All
Plots

+ Mask Points on + Mask Points on All
A Active Plot “é‘; Plots

+ % Unmask Points on ﬁ Unmask Points on
A Active Plot a4 All Plots
Draw Data T | Text Tool

EEF Annotation {%' Distance Annotation

I

Angle Annotation

N

Arrow Tool

il

Curved Arrow Tool

AN

Line Tool
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Button Description Hotkey Button Description Hotkey
M Polyline Tool ﬂ Curve Tool
ﬂ Freeh_?(r)lgl Draw ﬂ Rectangle Tool
ﬂ Circle Tool ﬂ Polygon Tool
ﬂ Region Tool ﬂ Zoom-Panning Tool Hzld
@ Insert Equation @ Insert Word Object
@ Insert Excel Object @ Insert Object
Insert Graph Insert Worksheet
% Rescale Tool HSLdIdZXch;r: ﬂ Rotate Tool Hgld
23.150bject Edit
&S fln &e3 Flooes Ty oo N
Button Description Button Description
= Left ! Right
g Top 0o Bottom
E Vertical ﬂ Horizontal
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Button Description Button Description
= Uniform Width [y Uniform Height
ﬁ Group I{_’_“I Ungroup

k]

Distribute Selected Layers/Graphic
Objects
Evenly in Vertical Dimension

3

Distribute Selected Layers/Graphic
Objects
Evenly in Horizontal Dimension

E Front E Back
! Forward H Backward
ﬂ Front(data) E Back(data)
23.16Arrow
ST SN
Button Description Button Description

Horizontal Alignment

Vertical Alignment

Widen Head

Narrow Head

Lengthen Head

Shorten Head
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Origin Toolbars

R A e = 05 @ [z 0 >
Button Description Hotkey Button Description Hotkey
ﬂ Fill Color g Line/Border Color
i Lighting Control Dialog @ Palette
EB Line/Border Style H Line/Border Width
Fill Pattern Fill Pattern Width
Z Pattern Color b Clear Borders
= Left Border 5 Top Border
Right Border Bottom Border
Frame Borders Insidgoljgéiéontal
o Inside Vertical Borders Inside g(c))rr(ijze?snd vert
— All Horizontal Borders [ All Vertical Borders
@ All Borders EE Merge cells Ctrl+R
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23.18Format

up A A E M, A

T Default: Arial

Button Descrzlptlo Hotkey Button Description Hotkey
| T Default: Arial b Font H Font size
B | Bold Ctrl+"B" I Italic Ctrli+"I"
i) | Und:rlln Ctrl+"U" x? Superscript Ctrl+"+"
x, | Subtscrlp Ctrl+"=" x2 Super;ubscn Ctrl+"-"
Ctrl+">" Ctrl+"<"
A Increase . ' Decrease .
Eont Ctrl+Shift+ Font Ctrl+Shift+
(i Greek Ctrl+"G" == Left
o Center .
= Horizont = Right
al
It m Center
I Top i v
Il Bottom ﬁ| Font Color
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23.19Auto Update

Button Description
5’% Pause Auto Update/Recalculations
23.20Database Access
]
B EE &K
Button Description Button Description
@’ Open SQL Editor @} Open Query Builder
= Load ODQ File 2 Preview Import
@ Import data @( Remove SQL
23.21Markers & Locks
M [ +% e+ @)
Button Description Hotkey Button Description Hotkey
M| Add Data Markers Ctrl+Alt+M || Clear Data Markers Ctrl+Alt+N
+4 Marker Size $~¢‘| Marker Hide Show
(=] Lock Positions
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